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Project Summary  
 The McMurdo Dry Valleys (MCM) region is among the most extreme deserts in the world: 

far colder and drier than any other LTER site.  The MCM contain a mosaic of perennially ice-

covered lakes, ephemeral streams, glaciers and exposed soils, all of which contain viable 

biological communities capable of surviving the extreme climatic conditions, particularly the 

lack of liquid water.  Subtle changes in climate have a major influence on the generation of 

liquid water, which produces a cascade of processes influencing the productivity, biodiversity 

and biogeochemistry within MCM.  

 MCM-I focused on the role of physical constraints on the structure and function of the 

ecosystem.  Our research indicated that small changes in temperature and albedo are amplified 

by large non-linear changes in hydrological cycle that propagate through the ecosystem.  The 

central hypothesis of MCM-II was that the legacy, or memory of past climate change upon the 

landscape, strongly overprints present ecological conditions in MCM.  These legacies include 

ancient lacustrine organic matter now available to the soil ecosystem and concentrated, ancient 

nutrients in the lakes that support present day phytoplankton productivity. Results obtained in 

MCM-II further implied that biodiversity and related ecosystem processes are controlled by a 

balance between legacies of past climates and contemporary processes.  Research in MCM-III 

continued to investigate the MCM as a climate sensitive “end-member” ecosystem, and began to 

focus on the roles of legacy and extant process on contemporary biodiversity and ecosystem 

structure and function. MCM IV focused on the hypothesis that climate warming in the 

McMurdo Dry Valley ecosystem will amplify connectivity among landscape units, leading to 

enhanced coupling of nutrient cycles across landscapes, and increased biodiversity and 

productivity within the ecosystem. MCM V will explore ecosystem responses to 

amplified landscape connectivity in the MDVs.  

 MCM5 incorporates an evolved conceptual model that explores ecosystem responses to 

amplified physical connectivity in the MDVs in response to changing climate. We will explore 

how those responses will be influenced by the resource legacies, such as the distinct 

biogeochemical patterns imparted by the history of lake inundation and recession. Anticipated 

outcomes of enhanced connectivity are changes in distribution of material (organic matter 

and nutrients) and biota toward greater homogeneity among and within landscape units, in effect 

dampening the influence of resource legacies. While the MDVs have undergone a 

decadal transition from summer cooling to a relatively stable summer temperature regime, 

the forecast for the coming decades is regional warming (Chapman and Walsh 2007, 

Walsh 2009). Hence, our expectation is that summers of intense ice melt and permafrost thaw 

(as were observed in 2002, 2009 and 2011) will become more frequent and drive greater physical 

connectivity. We have evolved our overarching hypothesis from MCM4 to emphasize an 

expected shift toward biotic homogenization, in which some taxa will increase while others 

decrease their abundance, with unknown changes in ecosystem function. The overarching 

hypothesis for MCM5 is: Increased ecological connectivity within the MDVs ecosystem will 

amplify exchange of biota, energy and matter, homogenizing ecosystem structure and 

functioning.
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Location of Sampling Sites 
Limnological sampling sites are located in an area of each lake that corresponds to the 

deepest portion of the lake.  A “Blue Instrument Box” on the ice surface is close to these 

locations.  The Blue Box contains Campbell data loggers that collect and store annual 

underwater photosynthetically available radiation (PAR) at 10 m below the piezometric water 

level, incident PAR, and lake ice temperature data.  In addition, there are two pelagic sediment 

trap arrays (flagged) deployed in the lakes, one on East Lake Bonney and one on West Lake 

Bonney.  The exact location of each sample hole varies from year to year and is dependent on 

sampling hut (Weatherport/Polarhaven) construction.  Every year the NSF contractors are 

provided with a map indicating the ideal location (within a 15 - 30 m radius of sediment traps) to 

construct the sampling huts (Figure 1).  However, the location typically depends on lake ice 

topographical features.  Once the huts are constructed, the sampling holes are drilled.  GPS 

locations are taken at the sampling holes on each lake each year using Garmin 12XL units. Two 

limnological sampling holes are located at each site, one inside the hut for sample collection, and 

one outside the hut (~20 m away) for in situ primary production incubations and instrument data 

collections (an additional hole is drilled for ice thickness during the first limno run, and is 

allowed to freeze over after L1).  These two holes are the primary limnological sampling 

locations used throughout the season for replicate data collection and receive the designation of 

“Limnological Transect 1” (i.e., Hor LT1, Frx LT1, MIELT1).  For the east and west lobes of 

Lake Bonney, the primary limnological sampling holes have been designated as Bon E30 and 

Bon W20, respectively.  This nomenclature follows a code developed by J. C. Priscu for synoptic 

sampling (Spigel and Priscu, 1998).  The holes located over the deepest portion of each lobe 

correspond to Bon E30, and Bon W20.  In addition, secondary sampling holes may be drilled in 

other areas of the lake to address specific limnological hypotheses.  For lakes that may be 

sampled once a year (i.e., Lakes Joyce, Trough, and Vanda) a centralized area has been identified 

with GPS coordinates, and efforts to collect in the same location are made every year.  These 

sampling locations have been identified as Joy LT1, Tro LT1, and Van LT1. 

 A 4 inch Jiffy ice auger is used to drill both sampling holes.  In the early part of the 

season (October) it is important not to penetrate the ice cap completely with the auger.  Drill 

down to a depth of about ~1 m above the expected bottom of the ice, this will prevent the auger 

from freezing into the hole.  Once the hole is complete, use the hole melter (a modified steam 

cleaner with a heated glycol loop) to penetrate the ice cap and melt the hole to a diameter of ~ 50 

cm.  Periodic melting of the hole will be necessary to keep the hole open the entire season.  Later 

in the season, the Jiffy augers may be used to penetrate the ice cap without freezing in the bit and 

flight extensions. 

 

Materials 

4 and10 inch Jiffy flight extensions and cutting bits 

5 kw generator 

Flight extension bolts 

Hole melter (Hotsy Models) 

Jiffy ice auger powerhead 

Standard allen wrench set 

Standard socket set 
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Construction of Weatherports at LTER sampling sites 
 

Weatherports should be at least 20m from other polarhaven or instrument holes on the lake, on a 

low flat area if possible. 

East Bonney Weatherport location from 1617: -77.71373 S, 162.44804 E    

West Bonney Weatherport location from 1617:  -77.71992 S, 162.30089 E 

Lake Fryxell Weatherport location from 1617: -77.61030 S, 163.14543 E 

Lake Miers Weatherport location from 1617: -78.09613 S, 163.84586 E 

Lake Hoare Weatherport location from 1617: -77.62753 S, 162.90939 E 

 

Example of set up of holes on lake ice cover. 
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Lake Water Sample Collection 
 

General Discussion 

The McMurdo LTER performs baseline limnological data collections on dry valley lakes 

to address unilateral LTER core areas of research.  These core areas include primary production, 

trophic structure, accumulation of organic matter, nutrient cycling, and ecosystem disturbance.  

To address these core areas, the MCM LTER typically performs three replicate samplings 

(Limno Run) of Lakes Bonney (east and west lobe), Hoare, Miers, and Fryxell during the austral 

summer.  Baseline analyses performed during each limno run include the following: 

 
Primary production (PPR) 

Chlorophyll-a (CHL) 

Phytoplankton [(PHYTO) enumeration and 

biomass] 

DNA for Extraction and Sequencing (DNA) 

Bacterial production (TDR) 

Bacteria [(BAC) enumeration and biomass 

Dissolved inorganic carbon (DIC) 

Dissolved organic carbon (DOC) 

Particulate organic carbon and nitrogen (CN) 

Particulate Phosphorus (PP) 

Macronutrients (NUT) 

Anions/Cations (AN/CAT) 

Dissolved oxygen (DO) 

Hydrogen Ion concentration (pH) 

Conductivity, temperature, and depth (CTD) 

Profile/Logged Photosynthetically active radiation 

(PAR) 

UW spectral fluorometry (Fluoroprobe) (new 0405) 

Profiling natural fluorescence (PNF)

 

These analyses are performed at specific depths in each lake to capture important vertical 

characteristics. Appendix 6.1 lists the target depths at which samples are collected. However, due 

to environmental conditions (ice thickness, bottom depth in area of sample hole) these depths 

cannot always be sampled. We aim to collect the top sample at approximately 0.5m below the 

bottom of the ice cover (at least 0.5m but not more than 1m); and the bottom sample as close to 

the bottom of the lake as possible without disturbing the sediment. This section discusses the 

collection and allocation of lake water for biological, chemical, and physical analyses. 

 

Materials 
Sampling Gear 

Bamboo poles (2) 

Bucket 

Chair 

Chipper bar 

Crazy creek chair 

Grey water carboy, 2 at 

Bonney 

Ice screws 

Silicone tubing (1/4” ID)  

    for Niskin 

Li-Cor LI-1000 

Messenger (2) 

Niskin bottle (5 L) 

Niskin bottle stand 

Parachute cord 

Plastic funnel 

Sieve or net 

Table 

Tarpaulin (opaque) 

Weight for cable 

Winch stand 

Winch with pipes  

Weight for winch cable 

 

Sample Bottles and Supplies 

1000 ml HDPE bottles (2  

amber for each depth + 1 

amber for DNA depths) 

500 ml HDPE amber bottles 

(Phytoplankton) 

Coolers (2-3) 

PPR bottles and transport carrier 

 

Dissolved Inorganic Carbon 

P200 Gilson Pipetman and tips 

30 ml serum bottles 

Aluminum seals 

Capper tool 

Chloroform (0.15 ml 30 ml sample-1) 

Rubber stoppers 

Lab gloves 

      

Dissolved Oxygen (Winkler) 

P1000 Gilson Pipetman and tips (2) 

Alkline-iodide-azide reagent 

Manganese reagent  

Benchcoat 

Kimwipes 

Lab gloves 

Bag for solid non-rad waste 

Scintillation vials for samples 

Serum/scintillation vial transport carrier  

Scintillation vial tray 

 

pH 

Scintillation vials for pH samples 
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Radioisotopes 

 

 

Rad tray with Benchcoat lining 
14C bicarbonate (100-120  Ci ml-1) 

P1000 Gilson Pipetman and tips (rad only) 

Spreadsheet of isotope addition 

Lab gloves 

Ziplock for solid rad waste  

Zip ties   

PPR incubation line     

 

Procedure 

 Before a limno run, it is important to ensure that the sampling and incubation holes are 

completely opened and will allow all sampling instruments to pass through.  Sampling 

equipment should be carefully examined for proper operation and the winch lines should be 

checked for proper depth calibration.  The collection process and filtration of lake water for 

analyses may take up to 18 h to complete, therefore, it is important to start sampling by 5:00 am.  

Also, the primary production in-situ incubation should start no later than 7:30 am to maximize 

“daytime” PAR.  Therefore, it is particularly helpful if all of the sampling equipment and sample 

bottles are prepared (cleaned and labeled) and arranged in the sampling hut the day before a 

limno run.  This includes supplies and reagents used to fix the dissolved oxygen and dissolved 

inorganic carbon samples.  At each depth, lake water samples will be distributed among 3-125 

ml borosilicate glass bottles (PPR), 2-20 ml scintillation vials (pH, DO), 1-30 ml serum vial 

(DIC), 2-1000 ml amber HDPE bottles (BAC, TDR, CN, NUT, DOC, AN/CAT, CHL, PP, plus 

extra water to be used for additional experiments, in case of sample spillage, etc.), 1-500 ml 

HDPE amber bottle (PHYTO) and 1-1000 ml amber HDPE bottle (DNA).  Note:  Some samples 

are not collected at all depths (See Appendix 6.1).  

Ideally, three people are required to perform a limno run; one person will take care of the 

pH, DO, and DIC samples; one person will operate the winch and handle the PPR and HDPE 

sample bottles, and the third person will distribute samples from the water sampler.  To begin 

sampling, prepare the Niskin bottle for deployment, lower to specified depth and trigger the 

closure mechanism with a messenger.  Bring the sampler up to the surface, drain ~10 ml?, and 

gently invert 10x to thoroughly mix the sample.  Place the Niskin bottle into the stand and attach 

the silicone tubing to the stopcock (always attach the same end of the tubing to the sampler to 

minimize contamination). (New silicone tubing should be cleaned with alconox or liquinox, 

rinsing well with DIW because it sticks to tubing. Store tubing in 1% HCL in 500 ml Nalgene 

between Limno Runs. Rinse well before use - soak in 500 ml Nalgene containing DIW before 

using for limno run, and rinse well with sample water). Open the breather valve on the sampler 

and allow water to briefly flow into a bucket to rinse the tubing.  When filling each sample bottle 

or vial it is important to insert the tubing to the bottom of the container and fill from the bottom 

up.  Slowly remove the tubing, taking care not to disturb the sample.  This procedure will reduce 

changes in gas concentrations inside the bottles.  Because there is limited volume of sample, 

sparingly rinse the PPR, DIC, and HDPE bottles; the scintillation vials should be new (unopened 

flats).   
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1. Fill the 3 PPR bottles (rinse 3X with sample water first) (overflow with ~50 ml of 

sample), replace the caps, and return samples to the PPR box (Never allow direct sunlight 

to shine on the bottles).   

2. Fill the DIC bottle (rinse 3X with sample water first) allowing the sample to displace 2X 

the volume (about 5 seconds).  Immediately fix the sample, cap, and return to transport 

carrier.   

3. Fill the pH and DO scintillation vials allowing the sample to displace 2X the volume of 

the vials (about 5 seconds).  Immediately fix the DO sample and cap both samples, then 

return samples to the transport carrier.   

4. Fill the HDPE bottles in the following order: 2 x 1000 ml amber (rinse 3X with sample 

water first), 500 ml amber (fill with 450 mls, leaving room for expansion), 1 x 100 ml 

amber (DNA) (rinse 3X with sample water first).  Once the HDPE bottles are filled, place 

them into a cooler. Continue on to the next sampling depth. 

 

During the collection process it is important to monitor the time because the PPR samples should 

begin their incubation by 7:30 am.  At Lake Hoare and Fryxell, typically all of the sample depths 

can be collected before inoculating the PPR samples with 14C-bicarbonate and still begin the 

incubation period on time.  However, at Lake Bonney it is best to collect all of the samples down 

to the last PPR depth, then inoculate the PPR samples, and continue the deep water sample 

collections after the PPR samples begin their incubation.  Please consult Section 3.2 Primary 

Production for details on the inoculation procedure.  While two people are preparing the PPR 

samples, the third person should prepare the incubation hole for deployment of samples.  This 

includes removing ice from the hole, unwinding the PPR incubation line such that the samples 

may be readily attached and lowered into the water, and securing a tarpaulin over the hole with 

ice screws so the bottles may be handled in a darkened environment. 

 Once the samples have been collected and the PPR samples are incubating, begin the 

PAR time series logging (Section 5.2 PAR).  It is important to record the time of day when the 

PPR incubation and PAR logging began, and the precise bottom depth sampled. After sampling 

with the Niskin is completed, let the Niskin soak in the freshwater in the top of the sampling hole 

for a few minutes to clean it. For the return trip to camp make sure all of the samples are 

carefully packed in coolers for transport (avoid freezing) and the sampling hut is cleaned.  

Following the 24 h PPR incubation, remove the samples from the lake and place directly into the 

transport carrier.  This procedure requires two people and must be performed under the tarpaulin.  

Finally, allow the PAR logging to complete a 24 h cycle before retrieving sensors. 
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Lake Ice Thickness and Piezometric Lake Depth 
 

General Discussion 

Lake ice thickness measurements are recorded at each hole drilled in the ice cap; this includes all 

sampling holes, the incubation hole, sediment trap holes and blue box holes. The “grid” system 

described in Appendix 6.8 to randomize measurements is no longer in use. Since then, statistical 

analyses by Dr. Priscu have shown that measurements from three ice holes are representative of 

the ice thickness measured by the grid system.  Piezometric lake depth is measured at each 

sampling hole.    

 

Materials 

Tape measure  

Aqua-Vu underwater viewing system  

Messenger 

 

Procedure 

The Aqua-Vu underwater viewing system allows us to see the exact point where the 

bottom of the ice cover is located.  Remove slush from the ice hole, and lower the Aqua-Vu 

underwater camera until the bottom of the ice cover is viewed through the above-water viewing 

system and centered vertically in the screen.  Mark the distances from the bottom of the ice cover 

to the piezometric water level (z-water), and to the top of the ice cover (z-ice), on the viewing 

system cord and measure the distances with a tape measure once the viewing system is brought 

out of the ice hole.  If the height of the ice surrounding the hole varies, make several 

measurements of z-ice and take an average. Alternately, a string can be held across the ice hole 

and z-ice measured to the string to obtain an average measurement. The piezometric water level 

is the level at which water rises up through the ice hole due to hydrostatic pressure caused by the 

permanent ice cover.  Subtract z-water from z-ice to obtain freeboard (z-difference).  Together 

these 3 measurements provide some insight into the topographical features of the ice cover as 

well as the density of the ice.  Ice thickness measurements are performed on each hole drilled 

through the ice cover.  Because most limnological sampling holes are drilled in low-lying areas, 

it was thought that ice thickness measurements were biased.  Therefore, notes are taken to 

describe the topography of the ice surrounding the ice hole. 

Piezometric lake depth (the distance from the piezometric water level in the ice hole to 

the bottom of the lake) is measured at each sampling hole at least one day before a limno run is 

performed.  Gently lower a weight tied to the end of the measuring tape until it touches the lake 

bottom and record the distance to the piezometric water level in the sampling hole. Be sure to 

add the distance of the weight from the end of the tape measure. 
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Pelagic Sediment Traps 

 

General Discussion 

Sediment traps have been deployed in the dry valley lakes since 1993 to collect the flux of 

settling particulate matter. From 1993 until 19**, traps were deployed in Lake Fryxell, Lake 

Hoare, East Lake Bonney and West Lake Bonney. Traps were removed from Lake Fryxell and 

Lake Hoare in the late 1990’s, and the traps in East and West Lake Bonney were replaced with 

McLane Parflux Mark 78G-21 traps in 2001?. During the 1819 season, the West Lake Bonney 

trap was moved to Lake Hoare. 

 

The McLane traps are automated conical shaped instruments with a known surface area.  They 

collect the flux of settling particles moving through a water column into discrete 250 ml 

collection bottles.  These traps have a programmable datalogger that records the duration each 

bottle is positioned under the conical funnel during the deployment.  The datalogger controls an 

electric motor that rotates new sample bottles into position.  Since the duration of deployment 

and the area of the traps are known, under-ice sediment deposition rates for discrete time 

intervals can be calculated. Typical deployments are for 2 years, with collections starting in May 

of year 1 and ending in October of year 2, yielding a collection interval of 26 days. 

 

This method is separated into two sections. Section I outlines the process of retrieving and re-

deploying the sediment traps in the field assuming their deployment 2 years prior. Section II 

outlines the processing of sediment samples to determine the flux of particles of different size 

fractions through the water column.  

 

 
Figure 1. McLane Parflux Mark 78G-21 sediment trap.  
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Sediment Trap Location 

The sediment traps in are located approximately 20m from the polarhaven location on each lake 

and are marked with a pallet (seen in Figure 2) to which the traps and the safety line are attached. 

The trap in East lake Bonney is suspended at 35m; the trap in Lake Hoare is suspended at 

approximately 25m.  

 

SECTION I – RETRIEVAL AND REDEPLOYMENT OF SEDIMENT TRAPS 

 

Materials 

McLane Parflux Mark 78G-21 sediment traps (serial numbers 11178 and 11178-01) with main 

line, safety line, and carabineers, attached to an ice pallet – it is assumed these materials are 

already deployed in the lake.  

 

The following materials are stored at Lake Bonney Camp 
Tripod 

Pulleys (snatch block with swinging side gates) (2) 

Carabiners (2) 

ATV or 1000 lb AC Winch 

Peristaltic pump 

Grey water drum (55 gal) (only needed if trap funnel does not drain properly) 

Carboy with spigot 

Graduated cylinder 

 

The following materials are usually kept in the Crary lab between deployments 
21 samples bottles with o-rings and caps 

Laptop computer with USB downloading cable (or cable and USB adapter) 

Crosscut program (can be downloaded from internet) (McLane Term is the new program  

recommended by McLane. It is very similar to Crosscut). 

Vacuum grease (non-conducting) 

Benzalkonium chloride (50% solution) 

10 ml Pipetman and tips for adding Banzalkonium chloride solution to lake water 

Limno set-up (Niskin bottle, winch, etc.) for collecting lake water 

Silica gel desiccant packs (reactivate for re-use by during at 70°C for 24 hours in a drying oven 

            before going to the field) 

 

Purchase prior to season 

Alkaline Battery Packs (A28-1000) from McLane (keep warm!) 

 

 

Removal of Sediment Traps 

Each year the traps are to be removed, a hole should be drilled approximately 1m from where the 

trap and safety lines are attached to the pallet, and the hole melted towards the lines. The traps 

are 91 cm in diameter, so the hole must be melted at least 3m in diameter in order to remove the 

traps (Figure 1a).   
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Figure 1a. Melted hole with sediment trap main line and safety line hanging from the pallet. 

 

Once the hole is melted and the lines are free of the ice, slowly retrieve the sediment traps (this is 

a 2-3 person task that is greatly assisted by the use of an ATV). Alternatively, the trap can be 

removed using a winch (we have a 1000 lb AC Winch), set up as in Figure 1b. V-thread holes 

can be drilled with a Jiffy drill and 5-inch bit. 

 

 
Figure 1b. Winch with V-threads to secure it to the ice. 

 

The sediment trap funnel will be filled with approximately 50 gallons of water and will therefore 

be extremely heavy. Set up the tripod as in Figure 2. Attach cargo straps between each leg of the 

tripod to prevent them from sliding outwards. Ice screws (Figure 2b) can also be put in the tripod 

leg bases to secure them in place, or something heavy like a 5 kw generator can be used to 

weight them down. Using carabiners, attach one pulley (snatch block with swinging side gates) 

to the bottom of one of the tripod legs as in Figure 3 (left) and one pulley (snatch block with 

swinging side gates) to the top of the tripod as in Figure 3 (right). While leaving the safety line 

attached to the pallet to suspend the sediment trap, remove the main line from the pallet and feed 

it first through the pulley at the top of the tripod, then through the pulley on the leg of the tripod. 

Attach the end of this line (marked by ‘A’ in Figure 2; the end of the line marked by ‘B’ will be 

underwater and attached to the sediment trap) to the ATV (or winch), and release the safety line 

from the pallet. Use the ATV (or winch) to slowly pull the sediment trap out of the water while 
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one person retrieves the safety line (it is best to create some friction by wrapping the safety line 

around something, such as the fuel barrels). If you use the winch to pull out the trap, the ATV 

can be used to retrieve the safety line instead.  

 

 
Figure 2. Set-up of the tripod used for retrieving and re-deploying the sediment trap. The 

end of the line marked by ‘A’ is to be attached to the ATV; the end of the line marked by 

‘B’ is to be attached to the sediment trap. In this photo, the traps have already been 

removed. They will be re-deployed and attached to the pallet, which can be seen to the 

side of the hole. 

 

 
Figure 2b. Ice screws in the leg base of the tripod. 
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Figure 3. Location of pulleys on the tripod.  

 

If everything worked properly and the trap finished its deployment cycle, the alignment hole (see 

“Sample Bottle Prep” section below) should be back underneath the funnel, and the water in the 

funnel should drain while the trap is lifted out of the water.  If the full deployment cycle did not 

run, a sample bottle will be underneath the funnel, and the funnel will not drain of water. In this 

case, the water contained in the funnel can be pumped into the grey water drum using a 

peristaltic pump while the trap sits at the surface (Figure 4). Once out of the water, place the 

sediment trap on the ice (Figure 5). Remove the line from the trap and leave it in the tripod for 

re-deployment (marked by ‘B’ in Figure 3). Place the trap onto a sled or ATV and slowly and 

carefully transport it to a warm Polarhaven (Figure 6).   

 

 

 
Figure 4. The peristaltic pump used to pump the water from the funnel of the sediment trap upon 

retrieval from lake (only needed if the funnel does not drain properly). 
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Figure 5. The sediment trap next to the tripod used for retrieval and re-deployment. 

 

 
Figure 6. A sled used to transport the sediment trap between the ice hole and the Polarhaven. 

 

Sample Removal and Data Download  

Upon retrieval, the alignment hole (see “Sample Bottle Prep” section below) should be back 

underneath the funnel if a full event schedule was completed. Before removing sample bottles, 

check that the appropriate cup is underneath the trap funnel and note anything wrong such as a 

jammed carousel (in which case record the number of the sample bottle under the funnel). 

Remove sample bottles from carousel (Figure 7) and cap immediately, making sure they do not 

leak. Store samples at 4° C (DO NOT FREEZE) until further processing.  
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Figure 7. Carousel with sample bottles and motor. 

 

Download data from the previous deployment from the sediment trap data logger using the 

Crosscut program as described in the McLane manual on page 48. Grease the “COM” 

connection port (Figures 9 and 17), connect the controller assembly to the laptop computer using 

the USB communication cable (Figure 17b), and open the Crosscut program. Select option 7, 

“Offload Data”, from the Main Menu (Figure 7a). The program will display the data in a long, 

continuous stream until it has all been displayed (Figure 7b). Use your communication software 

logging option to save the data to disk. 

 

In order to conserve power, the program will put itself in “sleep” mode after 20 minutes of 

keyboard inactivity. While the system is deployed, it will automatically go into sleep mode 

between samples. When you are programming the system, it may be desirable to put it into sleep 

mode at times. To do this, select option 4 from the Main Menu (Figure 7a). To wake the system, 

press <CTRL-C> three times. If you do not plan to set up the trap for deployment now, 

disconnect the trap from the computer. 

 

Open a log file to capture the data onto a disk. Press any key and all the data scrolling by on the 

screen will be captured to disk. Close the log file to save the deployment data. Select option 4, 

Sleep, from the Main Menu to put the system into sleep mode. Disconnect from computer.(this 

was in an earlier section of the McLane manual)  

 

 
Figure 7a. Main Menu of Crosscut Program. 
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Figure 7b. “Offload Data” option from Crosscut Main Menu. 

 

 

 

 

Set-up of sediment trap for re-deployment 

Sample Bottle Prep 

Using a Niskin bottle, collect at least 6L of water from 38m in ELB, or 6L of 38m water from 

WLB, depending on which trap you are deploying, and put in a carboy with a spigot. Add 10 ml 

50% Benzalkonium chloride solution (0.08% final concentration) and mix. Label bottles with the 

lake name, and number 1 through 21. Fill sample bottles with solution from carboy until they are 

almost full. Screw each bottle into the carousel on the trap (each bottle should have an o-ring (do 

not grease) to ensure a good seal with the carousel) in the appropriate order. Tighten snugly by 

hand. Ensure direction of movement of carousel puts cup number 1 under the trap funnel first. 

The gear plate rotates clockwise, looking up at the gear plate. 

 

Connect the controller assembly to the laptop computer using the USB communication cable and 

open the Crosscut program. Remove the black bolt/fill plug, and using the “Fill Bottles” program 

(option 3 in the Main Menu, Figure 7a, 7c), rotate the carousel, filling each bottle the rest of the 

way using the “topping-up” hole (Figure 8). There should be no air gaps visible at the tops of the 

bottles. After all the bottles are full, continue rotating until the open hole (alignment hole) is 

realigned under the trap funnel. This hole has no sample bottle and no thread in the hole. Replace 

the black bolt/fill plug. During this step, you are also able to confirm alignment of the rotator by 

confirming that the fixed plate hole is centered over the hole in the gear plate. If the holes are not 

centered, then the gear plate needs to be re-aligned (see McLane manual). Disconnect the trap 



 Section 2. Field Procedures 

 2.4 Sediment Traps 

LTER Limnological Methods Manual Page 18  Method_Manual_JL_092319.docx 

from the computer when finished with this step. This step should be done before replacing the 

trap batteries. 

 

 
Figure 7c. “Fill Bottles” option from Crosscut Main Menu. 

 

 
Figure 8. “Topping-up” hole used to fill bottles after they have been inserted into carousel. 

 

Battery Replacement 

The Alkaline battery pack that runs the motor must be replaced with each deployment. Be sure to 

keep the battery pack warm while in the field. To access the batteries, disconnect the 

communication cable (“M” in Figure 9) from the sediment trap motor and remove the black 

cover of the white housing by removing the screws on the outside of the cover (Figure 10a). 

With the screws removed, work the cover out of the white housing (Figure 10b). Attached to the 

cover are a cage containing the data logger electronics, and a cage containing the Alkaline 

battery pack (Figure 11). Pull the whole assembly (Mclane calls this the “controller with battery 

pack”) out of the housing as in Figure 10b.   
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Figure 9. Sediment trap housing and motor. The motor connection is denoted by “M” and the 

computer connection is denoted by “COM.” 

 

   

 
Figure 10a. Removal of screws from the sediment trap housing USING A NUT DRIVER. 
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Figure 10b. Removal of the controller with battery pack assembly from the sediment trap 

housing.  

 

 

 
Figure 11. Controller with battery pack assembly containing the data logger electronics and the 

Alkaline battery pack. 
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The Alkaline battery pack is removed by removing the metal cover from the back of the 

assembly (Figure 12), unplugging the wire connector from the electronics panel (Figure 13), and 

sliding the battery out the back of the assembly (Figure 13b).  

 

  
Figure 12. Removal of the metal cover from the back of the assembly. 

 

 
Figure 13. Unplugging of battery pack wires from the electronics panel. 

 

 
Figure 13b. Removal of Alkaline battery pack from assembly (unplug wires first – this photo was 

a demonstration before the wires were unplugged). 

 

The date the battery pack was installed should have been noted on the battery pack during 

installation. Note the date the battery pack was removed on it and remove the old battery pack. 
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Insert the new one, noting the data of installation on it. Plug the wire connector back into the 

electronics panel, and replace the metal cover on the back of the assembly.   

 

There are several silica gel desiccant packs in the electronics compartment to keep the 

electronics dry (Figure 14). These can be reactivated for re-use by drying at 70 °C for 24 hours in 

a drying oven. Replace the packs each time the trap is deployed. 

 

 
Figure 14. Silica gel desiccant packs in the electronics compartment. 

 

Before inserting the assembly back into the housing, the o-rings (2) on the cover (Figure 15) 

need to be greased with non-conducting high-vacuum silicone grease. First, remove the o-rings 

and clean off the old grease. Put a light layer of new grease on the o-rings and replace them. 

Wipe out the inside of the housing if dirty or greasy. Insert the assembly back into the housing 

(Figure 16). Tighten the black assembly cover onto the housing evenly by tightening the screws 

alternatively until all screws are tight. DO NOT OVERTIGHTEN THESE SCREWS!! ONLY 

USE A NUT DRIVER AS SHOWN IN FIGURE 16b (if these screws are overtightened they can 

crack the housing)! 

 

     
Figure 15. O-rings (2) located on the cover of the controller with battery pack assembly. 
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Figure 16. Insertion of the controller with battery pack assembly into the housing. 

 

 
Figure 16b. ONLY USE A NUT DRIVER to tighten the screws into the housing.  

 

Before connecting the communication cable to the sediment trap motor, grease the connector 

(Figure 17) using the non-conducting high-vacuum silicone grease. If this connection is not 

properly greased, saltwater can seep into the connector. 
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Figure 17. Connection ports on the controller with battery pack assembly cover for connection to 

the computer (“COM”) and motor (“M”). 

 

Programming the Schedule 

Grease the “COM” connection port and connect the controller assembly to the laptop computer 

using the USB communication cable (Figure 17b).  

 

 
Figure 17b. Communication cable and USB adapter. 

 

Open the Crosscut program and follow page 39 of the manual to create a schedule for the 

sediment trap. Select the following steps from the Main Menu (Figure 7a). 

 

Set Time <1>: Set the time and date to the current time and date. Note that the trap uses the 

American convention for dates (month/day/year). 

 

When “Set Time” is selected from the Main Menu, the program will display the current date and 

time and ask if you want to change them. If they are correct, press <enter>. If they are not 

correct, type “y” <enter>.  
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The program will ask you to enter the new date and time. To enter the date, type in the month, 

day, and year. To enter the time, type in the hour, minute, and seconds. Each portion of the date 

and time should be separated by any non-alphanumeric character. See Figure 18 for an example. 

 

 
Figure 18. “Set Time” option from Crosscut Main Menu. 

 

Create Schedule <5>: Set the date and time you want the sample collections to start and end, 

and tell the program how many sampling events you want: 

22 sampling events    

Turn on: 5/1/13 00:00:00 

End: 11/01/14 00:00:00 

 

  

When “Create Schedule” is selected from the Main Menu, the program will bring you into the 

create schedule routine. Creating a new schedule causes the system to erase the memory banks. 

DO NOT create a new schedule until you have offloaded any existing data. The program will 

warn you that previous records will be erased, and will prompt you to enter a new schedule 

(Figure 19). 

 

 
Figure 19. “Create Schedule” option from Crosscut Main Menu. 

 

There are 22 possible events to program (21 samples, the 22nd event is the closing of the last 

sample). Enter 22 for the number of events you wish to program, and press enter. You will be 

presented with the schedule menu (Figure 20). Select the third option, “Enter start date and end 

date,” and enter your start and end dates as listed above, following the example in Figure 21 (you 

will have to enter a time as well as a date). The program will calculate evenly spaced sample 

intervals based on the start and end dates/times you enter. Once you have entered the dates and 

times, the system will display the schedule for confirmation. If the schedule is correct, type “n” 

<enter> when asked if you want to modify an event. The program will return to the main menu. 

 



 Section 2. Field Procedures 

 2.4 Sediment Traps 

LTER Limnological Methods Manual Page 26  Method_Manual_JL_092319.docx 

 
Figure 20. “Create Schedule” option from Crosscut Main Menu. 

 

 
Figure 21. “Create Schedule” option from Crosscut Main Menu. 

 

Deploy System <6>:  

 

The Deploy System option allows you to enter a new deployment program, confirm it, and enter 

a title for the data run. The program then displays a final systems check, and goes into sleep 

mode waiting for the first event.  

 

 When “Deploy System” is selected from the Main Menu, you are asked if the open hole 

is aligned underneath the cone. If it is, answer “y”, if it is not, answer “n” and go to 

Option 3, Fill Bottles.  

 If previous deployment data is stored in memory, you will be warned before being 

allowed to continue.  

 If you have already entered a schedule, enter “n” when asked if you want to enter a new 

schedule. 

 You will be prompted to check the date and time. If it is correct, enter “n” to the “change 

time and date?” prompt.  

 The program allows you to enter a personalized header of up to three lines of text. It will 

display the current text and let you change it as desired.  

 Once the header is satisfactory, the program will display a final systems status line and 

ask if you are ready to deploy. If the trap is ready to deploy, enter “y”. 
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Detach the communication cable from the controller assembly and replace the dummy plug, 

applying a new layer of grease if necessary to the “COM” connection port. Check again that the 

alignment hole is underneath the trap funnel. The trap is now ready for deployment. 

 

Deployment of Sediment Traps 

Once the trap is ready for re-deployment, use the sled or ATV to transport it back to the ice hole 

and tripod. Attach the main line (‘B’ in Figure 2) to the sediment trap using a shackle (if using 

the same shackle that was used for the previous deployment, be sure to inspect it for corrosion), 

and attach the safety line. Lay the other end of the main line (‘A’ in Figure 2) across the ice and 

attach it to the ATV or winch. While one person (or the ATV if the winch is being used to lower 

the trap) holds tension on the safety line (if a person is holding it, it is best to create some friction 

by wrapping the safety line around something, such as the full grey water barrel if you have one 

or the fuel barrels), slowly lower the sediment trap into the water to a depth of 35m from the ice 

surface to the top of the trap funnel. Once the trap is to the correct depth, position the pallet close 

to the edge of the hole and wrap the safety line around the pallet to hold the trap in position. 

Remove the main line from the pulleys in the tripod and wrap the main line around the main 

board on the pallet approximately 20 times, securing it with a knot. Attach the safety line in the 

same manner and secure.  

 

 

SECTION II – SEDIMENT TRAP SAMPLE PROCESSING 

 

Materials 

Small (or large) sieve set: 250 and 63 µm (Sieve number 60 and 230 from USA Standard Sieve 

         Series)  

Pre-rinsed, combusted and acid-rinsed 25mm Whatman GF/C filters (To pre-rinse, put filter on a  

         fritted base and filter approximately 20 ml of DIW through it, followed by air drying; 

         combust at 475 °C for 4 hrs spread out on aluminum foil that will serve as a wrapper after 

         combustion and acidification; soak in 1% HCL for 3-4 hours, rinse 4X with DIW, lay out 

         on combusted foil to dry, and wrap in foil once dried). If filters are pre-rinsed, combusted 

         and acid rinsed, they will work for CN as well as PP analysis. Pre-rinsed and combusted 

         filters are sufficient for CN analysis.  

20 ml glass scintillation vials, acid rinsed with 1% HCL (vials for 2015-2018 samples were 

combusted) 

Aluminum weigh dishes (dishes for 2015-2018 samples were rinsed with DIW, dried, and 

combusted) 

DI squirt bottles 

250 ml acid washed screw top HDPE centrifuge bottles 

Centrifuge for 250 ml bottles 

Analytical balance accurate to 0.0001g. 

Drying oven 

Muffle Furnace 

Filter tower apparatus with vacuum pump 
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Sample Processing 

1) Clearly label (e.g. “ELB 1 <63”) and record the weight (dish) of an aluminum weigh boat 

using a 4 place analytical balance accurate to the nearest 0.0001g.  For samples where you will 

also need a filter (see steps 4 and 6), place a pre-rinsed, combusted and acid-rinsed GF/C filter 

into the weigh boat and record the weight (dish + filter) to the nearest 0.0001 g. Repeat this 

procedure for the number of weigh boats and filters needed. Weight boats containing filters can 

be stacked on top of each other for storage until use, but be sure to clean the balance, or put clean 

foil down, as the bottom of each weigh dish will touch the top of the filter under it. 

 
2) Sediment trap samples are in ~250ml polyethylene bottles and contain bottom (salty) water 

from Lake Bonney.  A successful deployment will yield 21 bottles from each lobe of Lake 

Bonney (ELB, WLB).  Each bottle contains the particulate matter that has settled from a known 

area per unit time, through the water column.   

A)  Invert and vigorously shake the sample bottles to ensure that the sample is 

homogeneous.  Quickly take 1 ml aliquot for chl-a analysis; place into a 1.5ml 

microcentrifuge tube.  Store at 4C. 

 

B) Take 0.5ml aliquot (again after vigorous shaking) for phytoplankton; place into another 

1.5ml tube.  Store at 4C. 

 

C) Take another 1 ml aliquot (again after vigorous shaking) for DNA analysis and place in a 

labeled microcentrifuge tube.  Freeze at -80C. Another aliquot of DNA should be taken 

from the <63 µm fraction after the rinsing step (again after vigorous shaking). 

 

D) Take another 1 ml aliquot (again after vigorous shaking) for SEM; place into another 1.5 

ml tube. Store at -20 C. 

 

(from old method) Stack the sieves so that the 250 m is on top, the 62 m is in the middle and 

the collection pan is on the bottom.  Place the entire sediment sample into the top sieve and pour 

~ 1000 ml of DI water onto the sample and begin to shake the sieves vigorously.  Ideally the 

water should be of similar NaCl concentration as the material in the trap.  Because all of the 

water is collected, it is best to use as little water as possible to sieve the sample.  Also, it is 

helpful to have a second collection pan to place under the sieves so that once all of the water has 

passed through the sieves, the bottom pan may be removed to pass the water through the sample 

again.  This procedure must be repeated at least 25 times or until each sample is completely 

separated into three size classes. 

Sediments are collected for dry weights and particulate organic C, N and P in three size 

fractions: >250 µm, 63-250 µm, <63 µm.   

3)  Set up the 250 µm screen above the 63 µm screen and place a 2L beaker underneath. Pour the 

trap bottle through the 250 and 63µm screens (Figure 1). Depending on the amount of sediment 

in each bottle and the diameter of screens you are using, the screens may clog. In order to get the 

liquid though the screens, you may need to agitate the sediment in each screen. This can be done 
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using a blunt ended object such as a pestle (Figure 2) and should be done GENTLY – do not put 

any pressure on the screens – just move the particles around so the water can flow through the 

screen. You may also need to break up chunks of clay and sediment – this can also be done 

GENTLY using the pestle. You can also use a squirt bottle filled with DIW to rinse the 

sediments through the screens if needed, but do this sparingly because you want to fit the <63 

µm fraction in a 250 ml centrifuge bottle if possible.  

Once all the water and fine sediments from the trap bottle have passed through the screens, place 

another 2L beaker beneath the screens and pour the contents in the first 2L beaker back through 

the screens.  Repeat this process at least 3 times.  

There may be small clay particles stuck on the larger fractions so be sure to rinse well. Make 

sure to rinse the centrifuge bottle, cap, beaker, pestle etc. into the screens to get all sediment 

through the screens. A good way to see if you have rinsed all the <63 µm fine sediments through 

the sieves is to rinse each sieve with DIW and see if the water coming out of the sieve is clear.  

The goal with this step is to separate the 3 size fractions: >250 µm, 63 – 250 µm, <63 µm. If the 

sediment trap bottle contains a lot of sediment, this may take some effort and you may need to 

centrifuge the <63 µm fraction in more than 1 centrifuge bottle (step 5) and combine them later.  

 

          
 Figure 1.                                           Figure 2. 

 

4)  Rinse the screens containing the 63-250 µm and >250 µm fractions with DIW to remove 

salts, and then transfer each into a weighed aluminum weigh dish. Depending on how much 

sediment you have in each sample, it may be easiest to get the majority of the sediment into the 

weigh dish using the DIW squirt bottle, and to get the remaining sediment out of the screen by 

rinsing with DIW into a filter tower and filtering onto a pre-weighed, combusted and acid-rinsed 

GF/C (Figure 3). This will cut down on the amount of DIW in your weigh dish, but don’t forget 

to subtract out the weight of the filter after drying the sample. 
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Figure 3. a) Rinsing 250 µm screen sediments onto GF/C with DIW; b) filter containing 63 – 250 

µm sediments in aluminum weigh dish; c) >250 µm sediments and filter containing 250 µm 

sediments in Aluminum weigh dish. 

 

5)  Pour the <63 µm fraction (flow through water and fine sediments) into a 250 ml centrifuge 

bottle and spin at 5000g for 5 min.   

At MSU we use the RC5C centrifuge in the CBE department (Figure 4). (As of 2016 the CBE 

has two new centrifuges. During 2019 we used the new centrifuges and spun at 6000 rpm for 7 

minutes with the FiberliteTM F14-6 x 250 LE Fixed Angle Rotor). Below are instructions for the 

older centrifuge: 

Find the rotor for use with the 250 ml centrifuge bottles and place inside the centrifuge. Set the 

rotor code on the centrifuge to match the rotor code for the rotor you are using (currently the 

cover of the rotor we are using says “GSA,” which equals rotor code 10; however it is best to 

check in case the rotor gets replaced in the future). Insert the bottles and tighten the cover on the 

rotor (the cover has 2 threads to tighten). Set the temperature to room temperature (~24-28 C); 

set the speed to 5000 RPM; set the time to at least 10 minutes and time the actual time on a timer 

as the centrifuge timer is not accurate; push down the white start lever to start the centrifuge (the 

“rotor code” light will flash briefly – this is normal) (Figure 5). The centrifuge may shake a bit 

while it is coming to speed, but should be smooth once it is up to speed. If it is shaking 

excessively the bottles are likely not weighted evenly – stop the centrifuge and add DIW to the 

bottles to get the weights even. After 10 minutes, press the stop lever to stop the centrifuge. The 

brake lever can be used to slow the centrifuge at a faster rate.  

Pour off the supernatant gently from the opposite side of the bottle as the sediment (discard 

supernatant in the sink). Refill the bottle with DIW using the force of the DIW from a squirt 

bottle to help break up the sediments.  Re-suspend sediments by vigorously shaking the bottle 

and spin again.  Before putting on the centrifuge bottle caps, check the bottle and cap threads for 

sediment as this will cause the bottles to leak.  
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Repeat this process 3 times to remove salts from the <63 µm sediments. Before and after use it is 

a good idea to clean the rotor with ethanol; make sure to wipe out the bottom of the centrifuge 

after use.   

 

 
Figure 4. 

 

 
Figure 5. 

 

6) Re-suspend the <63 µm fraction sediments in a known volume of DIW (e.g. 100ml) by rinsing 

the sediments into a graduated cylinder and bringing up to volume with DIW. If the sample had a 

lot of sediment in it, particularly clay, you may need to re-suspend in more than 100 ml DIW. If 

there is a lot of clay material in the sample, it may take some work to break up the sediments in 

order to re-suspend them. Vigorous shaking and using the force of DIW from a quirt bottle will 

help to break up these sediments.   

Vigorously mix the <63 µm sample in the known volume of DIW, take a 0.5ml aliquot and place 

onto a filter tower containing a weighed, pre-rinsed, combusted and acid-rinsed GF/C.  These 

sediments will plug the GF/C.  Discretion must be used to not overload the filter.  If this 

happens, it is difficult to know what volume of sample is represented by the sediments on 

the filter. Carefully vacuum filter 0.5ml aliquots; DO NOT “overfill” the filter with sediment. 

Record the volume filtered. The goal is to get as much sediment through the filter as you can 

without it clogging. Generally it is safe to start with ~3 ml, then go to 0.5 ml. Rinse the filter 

funnel with DIW to get residue off the sides of the filter funnel. Check the bottom of the filter 

funnel where it meets the filter when you remove it as residue can get caught there as well. Wipe 

out filter funnels with Kimwipe after samples with a lot of sediment. 
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Once filtered, put the filter with <63 µm sediments into a pre-weighed aluminum weigh dish. 

This will be used to get the weight of the <63 µm fraction sediments and will also be used for 

either CN or PP analysis. If you plan to analyze for both CN and PP, repeat this procedure so one 

filter can be used for CN and one for PP analysis (use pre-rinsed, combusted and acid-rinsed 

filters for both CN and PP, or pre-rinsed and combusted filters for CN and pre-rinsed, combusted 

and acid-rinsed filters for PP).  Write the volume and fraction on the original sediment trap 

bottle, put the re-suspended solution back in the original bottle, and store at 4 °C. 

 

7)  Dry sediments (and filters if used) (63 – 250 µm and >250 µm) and filters (<63 µm fractions) 

in aluminum dishes at 100 °C overnight.   

 

8)  Cool dishes to room temperature and record weights to the nearest 0.0001 g (dish+sediment  

or dish+filter +sediment). Sediments and (filters if used) from the 63 – 250 and > 250 µm 

fraction can be transferred to acid-rinsed scintillation vials for storage at -20 °C until CN and/or 

PP analysis. Filters containing <63 µm fraction sediments can be stacked on top of each other in 

their aluminum weigh boats and stored at -20 °C until CN and/or PP analysis. 

 

9)  Analyze a known amount of each size fraction for CN and PP, following the CN (Particulate 

Organic Carbon and Nitrogen by Elemental Analyzer) and PP (Total Particulate Phosphorus 

Analysis: Manual Method) methods in this manual. For CN and/or PP analysis for the < 63 µm 

fraction, use 1 filter for CN and 1 filter for PP. For  the 63 – 250 µm  and the >250 µm fractions, 

sediment must be weighed for CN and PP analysis; if there is limited material, you may only be 

able to do CN analysis.  

Calculate mg C, N, P in the whole filter for the <63 µm fraction, and mg C, N, P in the weighed 

amount of the 63-250 µm and >250 µm fraction. Be sure to record the weight of the sediment 

used for C, N, P analysis for the 63-250 µm and >250 µm fractions. 

 

Calculations 

1. Calculate the dry weight in each fraction for each bottle by subtracting either the dish weight 

from the dish + sediment weight (if no filter was used), or the dish + filter weight from the dish + 

filter + sediment weight.  

Since the dry weight of the <63 µm fraction represents only the amount that was filtered, 

calculate the dry weight of the total <63 m fraction as follows: 

 

 mg dry weight = mg dry weight on filter * (total suspended vol / vol filtered) 

 

total suspended vol       = total volume in which < 63 µm fraction was suspended 

vol filtered                    = volume of <63 µm fraction filtered  

Calculate the dry weight of all combined fractions for each bottle by adding all 3 fractions. 
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2. Calculate the total flux of dry weight for each fraction and the combined fractions for each 

bottle as follows: 

 

mg dry weight /m2*d = dry weight sediments (mg) 

                                     0.5 m2 * t 

 

 dry weight sediments (mg)       = dry weight of sediments in trap bottle 

 0.5 m2                              = cross-sectional area of trap 

 t                                       = deployment period of bottle in trap 

 

3. Calculate the C, N, P flux for the <63 µm fraction for each bottle as follows: 

 

CNP mg/m2*day =  CNP (mg) * total suspended vol (ml) 

                               vol filtered (ml) * 0.5 m2 * t 

 

 CNP (mg)                          = particulate C, N, or P in sample (on filter) 

 total suspended vol (ml)       = total volume in which < 63 µm fraction was suspended 

 vol filtered (ml)                     = volume of <63 µm fraction filtered for CNP measurement 

 0.5 m2                                  = cross-sectional area of trap 

 t                                           = deployment period of bottle in trap 

 

4. Calculate the C, N, P flux in the 63-250 µm and >250 µm fraction for each bottle as follows: 

 

CNP mg/m2*day =  CNP (mg) * total sediment (mg) 

                                  sediment weight (mg) * 0.5 m2 * t 

 

 CNP (mg)                     = particulate C, N, or P in sample  

 total sediment  (mg)       = total sediment in 63-250 µm or >250 µm fraction 

 sediment weight (mg)    = weight of sediment in which CNP was measured 

 0.5 m2                            = cross-sectional area of trap 

 t                                     = deployment period of bottle in trap 

 

References 

http://www.mclanelabs.com/master_page/product-type/samplers/sediment-traps 

http://www.mclanelabs.com/master_page/product-type/samplers/sediment-traps
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Chlorophyll-a Extraction (revised October 2008 by JP) 

 

General Discussion 

This procedure describes the extraction of chlorophyll-a from glass fiber filters using 90% 

acetone from a known volume of filtered water, and the ensuing analysis of the extracted 

chlorophyll-a using fluorescence. The method is essentially that described by Holm-Hansen et al. 

(1965) as modified by Welschemeyer (1994) to reduce interference by chlorophyll-b and 

phaeopigments. The Welschemeyer method provides sensitive measurements of extracted 

chlorophyll-a free from the errors associated with conventional acidification techniques. 

Fluorometric optical configurations are optimized to produce maximum sensitivity to 

chlorophyll-a while maintaining desensitized responses from both chlorophyll-b and 

pheopigments. This method requires a single fluorescence determination and provides adequate 

sensitivity for small sample sizes (<200 ml) even in the most oligotrophic marine and freshwater 

environments. Note that the Welschemeyer method incorporates cross-comparison to a standard 

calibrated with a spectrophotometer. Samples containing high levels of chlorophyll-a (e.g., mat 

samples) should be analyzed directly on a spectrophotometer to avoid dilution problems and 

interference from accessory pigments.     

 

A description of how to make your working standards is provided along with specific details in 

obtaining consistent standard curves.  The filtration step has been adapted to allow the collection 

of filtrate for nutrient and DOC analyses. Importantly, chlorophyll-a is very sensitive to low 

pH and high light (and to some extent, high temperature). Hence, all sample collection, 

filtration, extraction, and fluorometric readings should be conducted in a neutral (or high) 

pH environment and reduced light. Never work in an environment where acid containers 

exist (e.g., where carboys of acid exist, where glassware is being rinsed with acid) and 

maintain all samples (and standards) under low light from the time of collection to final 

analysis. 

 

The fluorometer should be calibrated before extraction of lake samples to ensure that the 

fluorometer and spectrophometer are working properly. 
 

Materials  

 

Sampling Site 

 1000-mL Amber HDPE bottles (pre-labeled with the water depth that will be sampled). 

This bottle should NOT be acid rinsed to avoid degradation of chlorophyll-a, which is 

very sensitive to acidic conditions and high light.  

 Cooler (Do Not Freeze) 

 

Dry Valleys Lab (filtering lab) 

 Vacuum pump (set to low vacuum pressure <7 inches Hg) 

 100-mL graduated cylinder (plastic) 

 Bell jar filtering apparatus with bottle stands (to collect filtrate for other analyses) 

 25-mm x 200-mL polysulfone filter funnels 
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 25-mm GF/F filters, pre-combusted and acidified. (Combustion protocol: combust at 

475oC for 4 hrs spread out on aluminum foil that will serve as a wrapper after combustion 

and acidification. Acidification protocol: soak in 1% HCL for 3-4 hours, rinse 4X with 

DIW, bring the pH to 8-9 with NaOH, rinse 2X with DIW, lay out on combusted foil to 

dry, and wrap in foil once dried). Combusted and acidified filters are only necessary if 

certain filtrate samples are being collected – they are not required for Chlorophyll 

analysis. Since combusted filters are required for Dissolved Organic Carbon (DOC) 

filtrate (collected from one Chlorophyll replicate), and acidified filters should be used for 

nutrient (Soluble Reactive Phosphorus) filtrate (collected from one Chlorophyll 

replicate), it is recommended to combust and acidify chlorophyll-a filters. 

 3 Forceps (one for moving dry filters; two for removing filters after filtration) 

 Glassine envelopes (used to store sample filters after filtration) 

 Aluminum Foil (used to wrap glassine envelopes containing filters for storage at 4°C) 

 Wash bottle (for DI water) 

 125-mL narrow mouth HDPE bottle (acid washed) – for collection of filtrate for Nutrient 

analysis 

 125-mL amber borosilicate glass bottle (acid washed & combusted) – for collection of 

filtrate for DOC analysis 

 

MCM Crary Lab - Labware (NOTE: this glassware is stored in a labeled box in the Crary Lab 

and should be returned to this box when not in use!) 

 10 ml automatic dispenser 

 Glass scintillation vials (20-ml with HDPE or foil-lined caps)  

 Glass cuvettes (13x100 mm) for use in fluorometer 

 4 ml Pipettor (e.g. P5000 Pipetteman with 5 ml pipette tips) 

 1 cm glass cuvette for spectrophotometer (Perkin Elmer LS-50B (Stock # 050271,  Crary 

# D10913) or equivalent)  

 3 ea – 100 ml Pyrex volumetric flasks (type A) 

 5 ea – 25 ml Pyrex volumetric flasks (type A)  

 7 ea – 10 ml Pyrex volumetric flasks (type A) 

 1 ea – 2000 ml Pyrex graduated cylinder (type TD)  

 2 ea – 10 ml glass volumetric pipettes (type A) 

 4 ea – 5 ml glass volumetric pipettes (type A) 

 2 ea – 3 ml glass volumetric pipettes (type A) 

 1 ea – 2 ml glass volumetric pipette (type A) 

 3 ea – 1 ml glass volumetric pipette (type A) 

 2 ea - 0.5 ml glass volumetric pipette (type A) 

 Pasteur pipette or eye dropper (for acidifying with 3N HCL) 

 Pipette Pump for use with the glass volumetric pipettes 

 125 ml amber bottle (Used to store concentrate) 

 2 ea – wash bottles (For 90% Acetone) 

 4 funnels (HDPE or Glass) 

 500 ml beaker (waste beaker) 
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 4 L Acetone bottles (Once a bottle of Acetone is empty, the 4 L amber bottle is used to 

keep your mixed reagents and waste. Make Sure They Are Well Labeled.)   

 

 Note about cleaning glassware. Use a lab detergent that is basic (high pH, e.g. Liquinox) to 

 clean all glassware.  After washing with detergent, rinse the glassware 6 times with tap water. 

 Then rinse 3 times with DI water to remove the tap water.  Before using the glassware, rinse 

with 

 90% acetone.  Glass pipettes should also be washed following this method. 

 

MCM Crary Lab - Reagents 

 Chlorophyll-a standard, 1 mg from Anacystis nidulans  (Sigma, C6144-1MG, 

066K1862). Other purified sources can be used (e.g., Spinach standard from SIGMA), 

but A. nidulans is preferred because this organism contains no chlorophyll-b. 

 90% Acetone:  Acetone (e.g. Baker HPLC grade, 632262, 9002-03). Pour 200 ml of DI 

water into a 2000 ml graduated cylinder (rinse with 90% acetone prior to use) and bring 

to volume (2000 ml) with 100% acetone.  Place parafilm on the top of the graduated 

cylinder and invert the solution 20 times.  Once this is complete, label a 4L empty 

“Acetone bottle” (or other clean amber bottle): 90% Acetone, date, and your initials. Pour 

new reagent into the bottle carefully. 

 

Notes: Wear gloves at all times.  Acetone should be HPLC grade and this procedure should 

be completed in an acid free hood.  Do not forget to rinse the glassware with 90% acetone 

before starting.  Make sure you pull the funnel out of the volumetric flask when checking the 

volume. 

 

 3N Hydrochloric Acid (add 25 ml of concentrated HCl (12N) to 75 ml DIW). Store in a 

125 ml Nalgene (HDPE) bottle on the shelf. 

 

MCM Crary Lab-- Instruments 

 Fluorometer (Turner 10-AU-10) configured for Chlorophyll-a analysis as described by 

Welschmeyer (1994): 

 

 Lamp: “Blue” F4T4.5B2 (F4T4½B2); Turner #10-089. It should have an “A” imprinted 

on the metal end and is often referred to as: “blue, custom color, Sequoia Turner”.  

   Alternatively, a blue lamp (type 9005)-Turner Designs (No. 10-089) can be used which 

has identical spectral characteristics. A F4T4D daylight lamp, can provide similar 

selectivity but with about a 2-fold reduction in sensitivity. 

 Excitation Filter (blue): 436BP10 047 9401; Turner #10-113 

 Emission Filter (red): 680BP10 357 9405; Turner #10-115 

  NOTE: (The excitation and emission filters should have mirrored side toward the actinic 

light (ie, facing the direction of incoming light)) 

 Sample holder: for 13-cm long tubes  

 

 Visible-range Spectrophotometer (e.g. Beckman DU-640 or equivalent) with: 
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 spectral bandwidth <2 nm 

 1 cm glass cuvette for spectrophotometer (Perkin Elmer LS-50B (Stock # 050271,  

Crary # D10913) or equivalent)  

  

NOTE: A dual beam spectrophotometer is preferred. Use 90% acetone in the reference 

cuvette. 

 

Procedures 

A. Sample Collection 

Fill the 1000ml Amber HDPE bottle (rinse 3x with sample water before filling with sample) 

with sample from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert Niskin ~ 5 

times).  Each bottle should be labeled with: location, date, depth, and limno run.  Place 

bottles in a cooler for transport – avoid freezing. 

STORAGE: These bottles should be stored in the dark at ca. 4oC—DO NOT FREEZE! 

 

B. Filtration -- Dry Valleys Filtering Lab 

  Notes about Lighting and Acids: Chlorophyll-a measurements must be completed in a 

darkened, but not dark, environment (NO DIRECT SUNLIGHT). All light in the room 

should be indirect or diffused, so do not use a flashlight or headlamp to shine a bright beam 

on the sample (“red” headlamp diodes emit light at a wavelength, 660 nm, which is highly 

efficient at exciting chlorophyll molecules, so do not shine directly on sample).  Use a light 

meter to determine appropriate amount of light.  Keep light below 1 E m-2 s-1 (ca. 5 

footcandles, or 50 lux). WORK WELL AWAY FROM ACIDS AND ACID FUMES!  

 Rinse filter towers and graduated cylinders with 1% HCL + 3X with DIW before each limno 

run. Rinse with DIW between different sample depths. 

 

1. Chlorophyll-a samples are taken from the 1000 ml amber HDPE bottle.  Gently invert 

the bottle 3x, thoroughly mixing sample, and decant 100 ml into a 100 ml graduated 

cylinder (avoid using larger graduated cylinders – accuracy and precision will be 

lower). Some depths at ELB and WLB require more sample to be filtered because of 

low chl-a concentration (Table 1): ELB 22-bottom = 200 ml; WLB 17-bottom = 

200 ml. Also, Miers = 200 ml. 

 

Table 1. Volume of lake water filtered for chl analysis. 

 

Lake ml Lake Water Filtered 

Fryxell 100 ml 

Hoare 100 ml 

Miers 200 ml 

East Lobe Bonney top-20m = 100 ml; 22-bottom = 200 ml 

West Lobe Bonney top-15m = 100 ml; 17-bottom = 200 ml 

 

♦♦♦♦♦ Record the volume of water filtered for each depth in each lake. ♦♦♦♦♦ 
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2. Place a combusted and acidified 25 mm GF/F filter onto the filter base which is 

mounted on a vacuum bell jar and replace tower.  To collect filtrate, place either an 

acid washed 125 ml HDPE bottle (for nutrient samples) or acid washed and 

combusted 125 ml amber borosilicate glass bottle (for dissolved organic carbon 

samples) under the filter base—MAKE SURE THAT THE ACID WASHED 

BOTTLES HAVE BEEN RINSED WELL WITH DIW BEFORE USE. 

 

3. Once the GF/F filter is in place and the tower has been tightened onto the filter base, 

pour the 100ml of sample from the graduated cylinder into the tower.  Filter the 

sample under low pressure (<7 inches Hg). Do not rinse the filter tower with DI 

water. Once the sample has been completely filtered, carefully remove the tower from 

the filter base. With two forceps, carefully remove the filter and fold it in half 

(organic matter inside), and carefully place the folded filter into a glassine envelope 

labeled with: <Chl-a>, <lake>, <depth>, and <date>.  Wrap glassine envelopes 

containing filters in aluminum foil to keep them in the dark (glassine envelopes can 

be stacked and wrapped in foil together). Remove the bell jar and cap the filtrate 

bottle. Properly store both filter and filtrate samples until further analysis. Filters can 

be kept on ice in the lab (in a beaker (to keep them dry) placed in an ice bucket) 

during the filtration process, and then placed in a freezer (-20 C) until transport to the 

Crary Laboratory. DOC and Nutrient samples can be kept on the floor of the lab 

during the filtration process, then placed at 4oC and -20oC, respectively, until 

transport to the Crary Laboratory. 

 

4. Repeat steps 1-3 above for a replicate chlorophyll-a sample and either a nutrient or 

DOC sample.  Replicate filters can be placed in the same glassine envelope, but make 

sure that they are not touching each other, or they will freeze together and be difficult 

to separate for the extraction process.  Rinse the filter tower with DI water after both 

replicate samples are filtered. 

 

5. Once all samples are filtered, label the foil pouch containing the glassine envelopes 

with <Chl-a>, <lake>, and <date> and immediately freeze until the extraction 

procedure. 

 

STORAGE: Nutrients and Chl-a filters are stored frozen in the dark at -20oC; DOC 

samples are Do Not Freeze and should be stored at 4oC.  Chl-a samples should not be left 

on lab bench for extended periods of time - keep them frozen and dark!  

 

 

C. Preparing Chlorophyll standards 

 

Chlorophyll-a  Stock Concentrate ~10,000 µg/L:   
Notes about Lighting and Acids: All chlorophyll-a stocks should be prepared and handled 

in a low light environment. All light in the room should be indirect or diffused, so do not use 

a flashlight or headlamp to shine a bright beam on the sample (“red” headlamp diodes emit 

light at a wavelength, 660 nm, which is highly efficient at exciting chlorophyll molecules – 
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so do not shine directly on sample).  Use a light meter to determine appropriate amount of 

light.  Keep light below 1 mol photons m-2 s-1 (ca. 5 footcandles, or 50 lux).  KEEP THIS 

STOCK AWAY FROM ACIDS OR ACID FUMES! 

 

Tap the glass ampoule containing the chlorophyll-a standard (1 mg Anacystis nidulans) to 

move all of the powder to the bottom.  Using a paper towel, carefully break the top of the 

ampoule and keep both pieces.  Carefully tip the bottom portion of the ampoule into a 100 ml 

glass volumetric flask and flick the ampoule to get the powder to drop into the flask.  Once 

most of the powder has been removed, fill the top and bottom of the ampoule with 90 % 

acetone, and pipette the liquid out of the ampoule to remove any remaining chlorophyll using 

a 100 µl pipette.  Repeat filling the ampoule top and bottom until the liquid is not green.  

Dispose of both pieces of the broken ampoule properly. Bring the chlorophyll-a concentrate 

up to 100 ml in the volumetric flask with 90% acetone.  Pour this concentrate into a 

labeled125 ml glass amber bottle wrapped in aluminum foil for storage. The bottle should be 

kept in a dark refrigerator at 4 oC (with NO ACIDS).  This concentrated stock can be used for 

the entire season to make Diluted Stocks “A” and “B,” and the working standards.  

 

 REMEMBER THAT VOLUMETRIC PIPETS ARE NOT BLOW-OUT 

 

Chlorophyll-a  Dilute Stock A ~ 1,000 µgChl-a/l 

Using a 10 ml glass volumetric pipette, remove 10 ml of the 10,000 µg/l Chlorophyll-a Stock 

Concentrate from the 125 ml amber bottle and place it into a 100 ml glass volumetric flask. 

Bring the solution up to 100 ml volume with 90% acetone, invert 20x, wrap in aluminum foil 

and label “Dilute Stock A ~1000 µgChl-a/l”. Stock A should always be made fresh before 

making Dilute Stock B and new working standards (see below).  Store in the dark at 4 oC. 

 

Chlorophyll-a  Dilute Stock B ~ 100 µgChl-a/l 

Using a 10 ml glass volumetric pipette, remove 10 ml of Chlorophyll-a Stock A from the 100 

ml volumetric flask and place it in a new 100 ml volumetric flask. Bring solution up to 100 

ml volume with 90% acetone, invert 20x, wrap in aluminum foil and label “Dilute Stock B 

~100 µgChl-a/l”. Stock B should always be made fresh before making new working 

standards. Store in the dark at 4 oC. 

 

Standardizing the Chlorophyll-a Stock Concentrate and Diluted Stocks 

The Chlorophyll-a Stock solutions must be measured on a spectrophotometer to determine 

the actual concentration. (Typically the stock concentrate is the only standard that is 

calibrated on the spectrophometer. Because this is a relatively easy measurement, we 

measure the concentrations in Dilute stocks “A” and “B” to ensure that dilutions were made 

properly and no degradation occurred during the dilution step). The dilute stocks are then 

diluted further and used to calibrate the fluorometer as described below.  

 

Turn on the Beckman DU-640 Spectrophotometer (or equivalent), click UV ON and VIS ON 

and allow it to warm up for >30 minutes (Figure 1).  Click FIXED WAVELENGTH (Figure 

1).  
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Figure1. Beckman DU-640 Spectrophotometer screen. 

 

Click “Method” (Figure 2). 

 

 
Figure 2. Beckman DU-640 Spectrophotometer screen. 

 

Choose the ChlA method saved in the computer “A:\chlA.” This method is set to run samples 

at 665 and 750 nm wavelengths (Figure 3). Fill the 1 cm cuvette with 90% acetone, wipe off 

the sides with a Kimwipe, and use to zero the instrument (click BLANK (Figure 3)) at 665 

nm and 750 nm (the 90% acetone blank readings should be very similar. If not, zero the 
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instrument at 750 nm and write down the value at 665 nm). The blank sample can be read at 

665 and 750 nm by clicking “Read Samples” (Figure 3). Note that the 1st cell read is the cell 

towards the back of the instrument. 

 

 
Figure 3. Beckman DU-640 Spectrophotometer screen. 

 

Tap the cuvette on a Kimwipe to remove the acetone, replace the 90% acetone blank with the 

Chlorophyll-a Stock Concentrate, and measure absorbance at 665 nm and 750 nm (non-

acidified readings are denoted by a subscript “o”) by clicking “Read Samples” (Figure 3). 

Remove the cuvette and acidify the Concentrate in the cuvette by adding 2 drops (from a 

glass Pasteur pipette or eye dropper) of 3N HCl. Mix by placing parafilm over the cuvette 

and inverting 6x. Wipe the sides of the cuvette with a Kimwipe and return to the cuvette 

holder in the spectrophotometer in the exact orientation from which it was removed. Reread 

absorbances at 665nm and 750 nm (acidified readings are denoted by a subscript ”a”). The 

acidification step will correct for possible phaeophytin in the sample. NOTE: The absorbance 

at 750 nm is used to correct for light scatter and potential non-pigment absorbance of solvent, 

particles, etc. Repeat the above procedure for the Chlorophyll-a Stock Concentrate to obtain 

three replicates, then repeat three times each for Diluted Stocks A and B. The cuvette should 

be rinsed 6x with DIW and 3x with 90% acetone between each sample.  

 

NOTE THAT AS OF THE 1819 SEASON THE ONLY SPEC AVAILABLE IN 

CRARY IS THE SHIMADZU UV-2501 PC. 

 

During the 1617 season, Amy compared the DU-640 spec to the UV-2501 PC spec in case 

we needed to use that one in the future. The DU-640 was used during the 1718 season. The  

DU-640 was not available during the 1819 season, so the UV-2501 PC and the UV-1601 PC 

were compared and the UV-1601 was used because it seemed to have less variation than the 
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UV-2501 (see David 1819 notebook pg 83). The UV-1601was removed at the end of 1819 

because it had other problems, so all that is available now is the UV-2501. 

 

Below is a summary of how to use the UV-2501 PC. More information can be found in the 

CHL sections of the field notebooks from 1617 (Heather) and 1819 (David). 

 

1. Press power button on left side of spec to ON. 

2. Open UV Probe Program (UV Probe 2.43) 

3. Click “connect” to connect software to spec. 

4. The screen will show a Diagnostics test. 

5. Click on the “photometric mode” button on the toolbar (it looks like this ). 

6. Click on the M button to change the method parameters 

a. Photometric Method Wizard [wavelengths]: 

i. Wavelength Type = point 

ii. Wavelength = enter 665 and 750 and click “add” 

iii. Click NEXT 

b. Photometric Method Wizard [calibration] 

i. Type = Raw Data (all other parameters will go blank when you choose 

this) 

ii. Click NEXT 

c. Photometric Method Wizard [Measurement Parameters (sample)] 

i. Make sure “instrument” is clicked “on” 

ii. For the below items I left them as the defaults: 

1. Sample repetitions = 1 

2. Prompt before repeat = not checked 

3. Delay sample read = not checked 

4. AutoScan, Timed Repeat, checked NONE 

iii. Click NEXT 

d. Photometric Method Wizard [File Properties] 

i. Clicked FINISH 

 

7. Photometric Method Screen: 

a. Instrument Parameters Tab: 

i. Slit width (nm) = 2.0 

ii. Measuring mode = Absorbance 

iii. Light Source change wavelength (wavelength at which lamp changes 

during wavelength scan) = 360-282 nm (I don’t think this matters since 

our wavelengths are higher than this) 

iv. S/R Exchange: Normal 

8. Press CLOSE 

 

Information from the Help Section of the UV Probe Program: 
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BLANKING 

 

During the 1617 season, Amy compared the DU-640 spec to the UV-2501PC spec in case we 

needed to use that one in the future. There was some confusion with how to blank the 

instrument with the UV-2501PC spec: 

 

I believe on the UV-2501, I ran “Autozero” on 750 wavelength with 90% acetone in both cell 

holders. I did not get great results (11% difference) between the UV-2501 and the DU-640 

specs. 

 

I tried different blanking methods on the UV-2501 (see pg 66 of Heather’s 1617 notebook 

and the 1617 CHL file) and actually got closer results between the specs. I wondered if I just 

needed to run the blank more often. 

 

Amy called Shimadzu for advice and was advised by Shimadzu tech help to use the 

“baseline” or “cell blank” instead of the “autozero” because the “autozero” only zeroes on 

1 wavelength, but the cell blank will blank on both of our wavelengths and then subtract out 

the blank from all subsequent samples. It will read the blank (90% acetone for us) and 

display it on the screen and save it in case you need it later. The baseline will blank all 

wavelengths in the range you set but it does not save the values for later. It subtracts the 

blank value from subsequent samples like the cell blank does. (See Heather’s 1617 notebook 

pg 67 for more information). 
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I ran a new standard on both specs and got comparable results, but I don’t know which 

blanking method I used. The data for the comparisons are in the 1617 CHL file. 

 

I got the below information from the Help Section of the UV Probe Program during the 1819 

season: 
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During 1819 Amy did Baseline correction with 90% acetone, and Cell Blanks with 90% 

acetone. Baseline Correction was done before starting samples; Cell Blank was run between 

every few samples. 

 

(I am not sure what the correct procedure is. Should we be doing the Baseline? Should we be 

doing it with nothing in the cell holders or with 90% acetone? The above method seemed to 

work ok and I got results of the chl standards comparable to those read with the UV-1601 

PC spec, (on the UV-1601 I just did cell blanks with 90% acetone (no Autozero or Baseline 

corrections). As noted above, in the end I used the UV-1601). I would advise to run the cell 

blank every 5 samples at least. 

 

Amy’s Methods: 

 

Baseline correction:  

1. entered wavelengths: 

a. start: 800  

b. end: 600 

2. Put cuvette with 90% acetone in back cell holder (this is the blank and remains in the 

instrument). 

3. Put cuvette with 90% acetone in sample cell holder. 

 
4. Close lid 

5. Press Baseline Correction  

 

 

Cell Blank: 

1. Put cuvette with 90% acetone in back cell holder (this is the blank and remains in the 

instrument). 

2. Put cuvette with 90% acetone in sample cell holder. 

 
3. Close lid 

4. Press Cell Blank 

 

  

READING SAMPLES 
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1. Fill sample cuvette (front one) with sample. 

2. Click “read unknown” 

3. The absorbances at both wavelengths will be read. 

 

HELPFUL HINTS 

 Note that you must enter a name in the sample table to be able to press “read 

unknown”. 

 You can change the number of decimal places reported by clicking on the “settings” 

box in the top bar of the screen. 

 

------------------------------------------------------------------------------------------------------ 

 

The following table (Table 2) should be entered in the “chlorophyll-a” data book for the 

“concentrated” and “diluted” (i.e., “A” and “B”) standard solutions. The date, name of the 

analyst and samples processed using standard curves made with these solutions should also 

be entered. 

 

Table 2. Table for spectrophotometer readings of concentrated and diluted standard solutions. 

 Wavelength (nm) Chl-a concn  Avg Chl-a 

concn  

 665o 750o 665a 750a (µg/l) (µg/l) 

Concentrate rep 1       

Concentrate rep 2       

Concentrate rep 3       

Dilute A Stock rep 1       

Dilute A Stock rep 2       

Dilute A Stock rep 3       

Dilute B Stock rep 1       

Dilute B Stock rep 2       

Dilute B Stock rep 3       

  

Date prepared:  

Analyst:  

Samples processed:  

 

Determine the chlorophyll-a content of each stock using the following equation (Strickland and 

Parsons 1972; Parsons et al. 1984): 

 

Chl-a (µg/l)= [26.7*((ABS665o
 - ABS665a) – (ABS750o – ABS 750a))*1000]/l  

 

Where: 

 ABS665o = ABS at 665 nm with no acid 

 ABS665a = ABS at 665 nm plus acid 
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 ABS750o = ABS at 750 nm with no acid 

 ABS750a = ABS at 750 nm with acid 

 l = cuvette path length (1 cm) 

 26.7 is a value that combines the extinction coefficient for pure chlorophyll-a in 90% 

acetone (89 L g-1 cm-1) in concert with an acidification factor that represents the 

absorbance ratio of pure chlorophyll-a:phaeophytin-a following acidification. 

Specifically, 26.7 was derived as follows: [((1/89 L g-1 cm-1)*(1000L m-

3))]=11.23g*cm/m3. Hence, 11.23g*cm/m3 * 2.38 (the acidification ratio)=26.7 g*cm/m3. 

 

Standardizing the Fluorometer 

 The stock chlorophyll-a solutions prepared above will be used to prepare working standard 

dilutions of chlorophyll-a using 90% acetone to dilute the standards. (Use volumetric 

glassware to make these standard dilutions). The working standards will then be used to 

calibrate the fluorometer. Note that the concentration of the working standards is based on 

the spectrophotometrically determined concentration of the Stock Concentrate, which should 

be ~10,000 µChl-a/l, and the Diluted Stocks “A” and “B” which should represent 10 and 

100-fold dilutions of the concentrated stock. Therefore, the actual concentrations of the 

working standards will need to be computed from the spectrophotometrically determined 

concentration of the stocks.  This calibration should be done monthly from the stored 

Concentrated Stock (the concentration of the Concentrated Stock should be determined using 

the spectrophotometer as described above before each calibration). 

 

Working Standards  

Notes: All volumetric flasks should be pre-labeled with numbers indicating the amount (ml) of 

Dilute Stock A and Dilute Stock B you should pipette in each flask.  Dilute A is indicated by red 

tape and Dilute B is indicated by white. While bringing the standards up to volume, if any are 

over filled, start over. Make sure you do not have any air bubbles. After using the glass pipettes 

rinse them with 90% acetone 5 times before placing them back in the aluminum foil. Make sure 

to invert all flasks 20x to ensure complete mixing. Make a table as outlined below (Table 3) in 

the chlorophyll-a data book. These standards should be prepared before the samples are extracted 

to ensure that the fluorometer is responding appropriately (comparison to regression parameters 

of old standard curves should yield similar parameters (slope and intercept). 

  

Table 3. Volume of 90% acetone and stock solution used to make working standards. 

Stock  Stock 

concentrations 

(µg/l) 

Volumetric 

Pipette (ml): 

[Volume of 

stock 

solution] 

Volumetri

c 

Flask (ml): 

[Bring 

stock 

solution to 

mark with 

90% 

acetone] 

Chl-a 

(µg/l) 

[compute exact values 

from 

spectrophotometricall

y determined stock 

concentrations] 

Stock Determined by    
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Concentrate 

~10,000 µg/l 

spectrophotometer 

     

Dilute A 

~1,000 µg/l 

Determined by 

spectrophotometer 

5 10 ~500 

Dilute A 

~1,000 µg/l 

Determined by 

spectrophotometer 

3 10 ~300 

Dilute A 

~1,000 µg/l 

Determined by 

spectrophotometer 

5 25 ~200 

Dilute A 

~1,000 µg/l 

Determined by 

spectrophotometer 

1 10 ~100 

Dilute A 

~1,000 µg/l 

Determined by 

spectrophotometer 

2 25 ~80 

Dilute A 

~1,000 µg/l 

Determined by 

spectrophotometer 

1 25 ~40 

     

     

Dilute B 

~100 µg/l 

Determined by 

spectrophotometer 

5 10 ~50 

Dilute B 

~100 µg/l 

Determined by 

spectrophotometer 

3 10 ~30 

Dilute B 

~100 µg/l 

Determined by 

spectrophotometer 

5 25 ~20 

Dilute B 

~100 µg/l 

Determined by 

spectrophotometer 

1 10 ~10 

Dilute B 

~100 µg/l 

Determined by 

spectrophotometer 

0.5 10 ~5 

Dilute B 

~100 µg/l 

Determined by 

spectrophotometer 

0.5 25 ~2 

Date prepared:  

Analyst:  

Samples 

processed: 

 

 

Read each of these working standards on the fluorometer according to the following protocol: 

 

1. Turn on Fluorometer and allow to warm up for at least 30 minutes. 
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2. Run the High and Low solid standard at the start of each run to check for consistency 

between runs. 

 

o Note that the Fluorometer can be calibrated so the solid standards read 4.0 and 0.8 

(I guess this is what they are supposed to read, but I don’t know where Algal Ops 

got that info). This was never done by Amy, but Algal Ops did it during the 1617 

season. Amy did not do it during 1718 (see notes in Amy’s 1718 notebook pg 

150), but did do it during 1819 (see notes on this in Amy’s 1819 notebook pg 86).  

 

3. Dispense ca. 4 ml of each working standard into a 13-mm x 100 mm glass cuvette.  Wipe 

cuvette exterior with Kimwipe to remove all liquids and place cuvette into the fluorometer 

sample chamber.    

 

4. Allow fluorometer to autoscale, then take reading and record values in notebook. 

 

5. Periodically (e.g. every 10 standards) read a blank sample consisting of 90% acetone to 

check instrument baseline. 

 

6. Rinse cuvettes three times with DI water and three times with 90% acetone to clean them 

between standards, and tap on Kimwipe to remove remaining liquid. 

 

7. Prepare a standard curve of chlorophyll-a concentration vs fluorescence. A typical curve 

prepared during the 2008 season on 11 April follows (Table 4; Figure 4). Slopes and 

intercepts should be similar from run to run (and year to year) if all procedures are 

followed properly and the fluorometer is not altered by such things as changes in gain or 

lamp problems (the lamp should be changed every other year). Always run the 0.8 and 4 

solid standards to check for fluorometer drift over time.  

 

Table 4. A typical standard curve of chlorophyll-a 

concentration vs fluorescence prepared during the 2008 season. 
vol Std "A" (ml)  vol Std "B" (ml) total vol (ml) µgChl-a/l Fluorescence 

Solid 0.8    0.694 

Solid 4    3.650 

BLK (90% acetone) 0 0 0 0.029 

0 0.5 25 1.9 0.209 

0 0.5 10 4.6 0.482 

0 1 10 9.3 0.945 

0 2 10 18.6 1.950 

0 3 10 27.9 2.940 

1 0 25 37.2 3.970 

0 5 10 46.5 4.870 

2 0 25 74.4 7.970 

1 0 10 92.9 10.100 

2 0 10 185.9 19.500 

3 0 10 278.8 28.700 
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5 0 10 464.7 46.400 

 

 
Figure 4. A typical standard curve of chlorophyll-a concentration  

vs fluorescence prepared during the 2008 season. 

 

The concentration of chlorophyll-a in the sample extract is calculated from the standard curve. 

The final chlorophyll-a in the lakewater is calculated as follows: 

 

Chlorophyll-a (µg/l) = (Fo – y-intercept/slope) * (ml extracted/ml filtered) 

 

Where: 

 

Fo = measured sample fluorescence 

y-intercept = fluorescence when Chl-a concentration is zero 

slope = fluorescence/Chl-a (µg/l) 

ml extractred = ml of 90% acetone used to extract the Chl-a on the filters 

ml filtered = ml of actual sample filtered in the field 

 

Method Detection Limit  

The method detection limit is calculated by running the lowest standard seven times to determine 

Fo and Fa, and using the response values from these replicates to solve for chl-a using the 

standard curve equation. The standard deviation from these seven chl-a values is multiplied by 

3.15 to give the method detection limit.  

 

D. Chlorophyll Extraction and Measurement -- MCM Crary Lab 

Notes about Lighting and Acids: Chlorophyll-a measurements must be completed in a 

darkened, but not dark, environment. All light in the room should be indirect or diffused, so 

do not use a flashlight or headlamp to shine a bright beam on the sample (“red” headlamp 

diodes emit light at a wavelength, 660 nm, which is highly efficient at exciting chlorophyll 

molecules, so do not shine directly on sample).  Use a light meter to determine appropriate 

amount of light.  Keep light below 1 E m-2 s-1 (ca. 5 footcandles, or 50 lux). WORK WELL 

AWAY FROM ACIDS AND ACID FUMES! Use the dark room in phase 2 of Crary if 

possible. 

y = 0.1006x + 0.2332
R² = 0.9994

fl
u

o
re

s
c

e
n

c
e

Chl-a  (µg/l)
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1. Place each filter into a labeled 20 ml scintillation vial. 

 

2. Dispense 10 ml of solvent (90% acetone) into each vial using an automatic 10 ml pump 

dispenser and vortex, making sure the filter remains in the 90% acetone following 

vortexing. 

 

3. Incubate the samples for ~24 hours in the dark at 4 oC, vortexing the samples (making 

sure the filter remains in the 90% acetone following vortexing) gently for 15 sec each 

near the middle of the extraction. 

 

4. After extraction, vortex for 15 seconds (making sure the filter remains in the 90% acetone 

following vortexing), and allow to settle in the dark at 4 oC for 1 hour (keep cold while 

running samples?).  

 

5. Turn on Fluorometer and allow to warm up for at least 30 minutes. 

 

6. Run the solid standards and a blank (reading of solid standards should remain consistent). 

 

7. Dispense ca. 4 ml of extract into a 13-mm x 100 mm glass cuvette.  Wipe cuvette exterior 

with Kimwipe to remove all liquids and place cuvette into the fluorometer sample 

chamber.    

 

8. Allow fluorometer to autoscale, then take reading and record values in notebook. Be sure 

to check that sample responses fall within the range of the standard curve. 

 

9. Periodically (e.g. every 10 samples) read a blank sample consisting of 90% acetone to 

check instrument baseline. 

 

10. Rinse cuvettes three times with DI water and three times with 90% acetone to clean them 

between samples, and tap on Kimwipe to remove remaining liquid.   

 

References: 

APHA (American Public Health Association), 1989.  10200 H. Chlorophyll.  Standard Methods 

for the Examination of Water and Wastewater, 17th Ed., pp. 10-31 to 10-39. 

  

Holm-Hansen, O, C.J. Lorenzen, R.W. Holmes, and J.D. Strickland. 1965. Fluorometric 

determination of chlorophyll.  J. Cons. Cons. Int. Explor. Mer  30:3-15. 

 

Parsons, T.R., Y. Maita and C.M. Lalli. 1984.  A Manual of Chemical and Biological methods 

for Seawater Analysis. Pergammon Press. 173 pp. 

 

Strickland J.D.H. and T.R. Parsons.  1972.  Chapter IV.3.I.  Spectrophotometric Determination 

of Chlorophylls and total Carotenoids.  A Practical Handbook of Seawater Analysis. 

Fisheries research Board of Canada, Bull. 167, pp. 185-196.  
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Welschmeyer, N.A. 1994. Fluorometric Analysis of Chlorophyll a in the Presence of 

Chlorophyll b and Phaeopigments.  Limnol. Oceanogr. 39:1985-1992. 
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Phytoplankton Enumeration and Biomass 

 

General Discussion 

Phytoplankton enumeration and biomass estimates are performed on Lugol’s preserved 

samples.  A modified Utermöhl method is used to identify and enumerate phytoplankton with an 

inverted microscope.  Consistent taxonomy is the most important consideration when counting 

and identifying phytoplankton.  In order to compare phytoplankton taxa from one year to the 

next, “type” specimens must be available.  The MCM LTER maintains a photographic archive 

along with archived samples for the comparison and identification of phytoplankton. 

 

Materials  

Sampling Hut 

500 ml Amber HDPE bottles 

Dry Valleys Lab 

Eppendorf repeater pipet and tips 

Off the Ice 

Algal references (http://huey.colorado.edu/LTER/lakedata.html) 

Inverted microscope with high quality oil immersion lens and high numerical aperture (NA), 

equipped with phase contrast lenses or differential interference contrast (DIC), camera 

attachment, camera, film (Nikon Diophot) 

Ocular micrometer (for measurement of cell dimensions) 

Settling chambers and removable settling columns (10 ml) 

Stage micrometer with 1 m graduations (for calibration of ocular micrometer, Whipple grid and 

field of view) 

 

Reagents 

Dry Valleys Lab 

Lugol’s Solution: Dissolve 20 g potassium iodide (KI) and 10 g iodine crystals in 200 ml distilled 

water containing 20 ml glacial acetic acid (made in Crary Lab and transported to Dry 

Valleys for addition to samples). 

 

Procedure 

Sample Collection 

1. Fill a 500 ml HDPE amber bottle with 450 ml of sample (leaving room for expansion) from a 

well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert Niskin ~ 5 times). Place in cooler 

for transport. Note that not all depths (m) are collected for all lakes for phytoplankton 

enumeration and biomass (Table 1): 

 

Table 1. Depths (m) collected for phytoplankton enumeration and biomass. 

 

Fryxell 

(m) 

Hoare 

(m) 

Miers 

(m) 

ELB 

(m) 

WLB 

(m) 

top top top top top 

5 5 5 6 5 

6 8 7 10 10 

http://huey.colorado.edu/LTER/lakedata.html
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8 12 9 13 13 

9 16 11 18 20 

10 20 13 30  

12 25 15     

15  16   

    17     

  18   

    bottom     

 

 

Below step to be conducted in Dry Valleys Lab 

2. Immediately preserve samples with 5 ml Lugol’s solution using Eppendorf repeater pipet.  

Close the lids tightly, seal them with electrical tape and store samples at 4C (Do not freeze) 

in the dark until transport to MCM (All samples are sent to Diane McKnight @ University of 

Colorado for analysis: INSTAAR). 

 

Below steps to be conducted off the ice  

3. Gently invert the HDPE bottle to thoroughly mix the sample; decant 100 ml of sample into a 

100 ml graduated cylinder.  Cover the opening of the cylinder with parafilm. 

 

4. Allow the 100 ml sample to settle for 5 days.  A standard method for settling times is 4 hours 

per cm of water column height (i.e. a graduated cylinder containing a sample height of 30 cm 

should settle for 120 hours; J. Priscu personal communication).  After settling, siphon off 82 

ml of sample with a “J” shaped Pasteur pipet.  To construct a siphon; heat the tip of the 

Pasteur pipet with an open flame and carefully bend the tip into a “J” shape.  Be careful not 

to heat the tip too much, otherwise the glass will melt.  Attach the pipet tip to a filter flask 

and vacuum pump.  Hold the “J” shaped tip just below the surface level and gently siphon the 

upper 82 ml of water.  Note: The volume of water siphoned will depend on the volume of the 

Utermöhl chamber being used (i.e., the actual volume of the 10 ml Utermöhl chamber the 

Priscu lab uses is 18 ml). 

 

5. Gently swirl the remaining 18 ml sample and transfer to a 10 ml Utermöhl chamber.  Allow 

the Utermöhl sample to settle for another 20 hours (4 hours per cm of sample height) before 

preparing slide. 

 

6. Prepare the slide by slipping off the Utermöhl tower, and immediately count the sample 

using an inverted microscope. 

 

7. At least 100 individuals of the most numerous algae are counted per sample at 400 

magnification with species identification being determined at 1000.  To determine the 

number of cells of any particular species per unit volume (cells ml-1) use the following 

equation: 
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VAF

AC

f

U




  ml cells Algal 1-  

 

where C is the total number of algal cells counted, AU is the area of the Utermöhl slide 

mount, F is the total number of fields counted, Af is the area of the field, and V is the volume 

of sample settled. 

 

The total number of individuals counted is dependent on the number of taxa, but usually 

ranges between 300 and 500.  The number of individuals counted is variable; the investigator 

should adjust the number of cells counted in order to obtain an acceptable counting error 

(Table 2). 

 

Table 2. Accuracy obtained at 0.95 confidence limits at differing size counts (Lund 

et al., 1958) 

 

 Approximate 0.95 confidence limits 

Number of Organisms As percentage of count Range 

4 ±100 % 0-8 

16 ±50 % 8-24 

100 ±20 % 80-120 

400 ±10 % 360-440 

1600 ±5 % 1,520-1,680 

10,000 ±2 % 9,800-10,200 

40,000 ±1 % 39,600-40,400 

 

If the distribution of organisms is random and fits a Poisson curve, the counting error (based 

on 95 % confidence limits) may be estimated using the following equation: 

 

 %
N

100 
2

 error  Counting   

 

where N is the number of algal cells counted.  Counting errors in past analyses have ranged 

between 13 and 26%, and vary depending on species.  While some species tend to be evenly 

distributed within the water column, others form colonies, or localized distributions.  These 

biological realities will greatly affect the estimates obtained in a count.  Algal species 

identification are made using Geitler (1932), Seaburg et al. (1979) and Prescott (1962). 

 

8. Cell volumes are estimated for dominant taxa by measuring cell dimensions (length, width) 

of 10 individuals and using closest goemetric formulas of Willen (1976) and Tikkanen 

(1986).  Because algal cell volumes may change over time, due to seasonal changes in 

environment, it is necessary to calculate cell volumes based on samples procured throughout 

the season.  For rare taxa, it is not possible to make as many measurements, and volume 

estimates must be made from fewer cell measurements. 
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9. Once the sample is counted, transfer the sample to a 10 ml glass vial (with a Teflon cap) and 

fill the vial with the sample that remained in the Utermöhl tower.  Add 100 l of Lugol’s and 

archive the sample and store at 4C in the dark.  Note: Make sure the sample is labeled 

properly (i.e. Location code, date and depth). 
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Phytoplankton Primary Production (PPR) Determined by 14C Incorporation 

 

General Discussion 

Primary production is the centralized theme common to all LTER projects, especially 

projects where aquatic environments are the main focus.  The McMurdo Dry Valley lakes 

represent the most productive systems in the ice-free regions of Antarctica.  However, due to the 

extreme supersaturation of gases in these systems, estimates of primary production are very 

difficult to quantify measuring changes in O2 evolution and CO2 consumption.  Therefore, we 

measure primary productivity using an in-situ 14CO2 uptake method.  A known amount of 

radiolabeled bicarbonate is added to a sample containing a known amount of dissolved inorganic 

carbon (CO2) and the samples are allowed to incubate at their respective depth, in the lake.  

Following in-situ photosynthesis, samples are filtered, treated, and analyzed for their amount of 

radioactivity incorporated.  Differential uptake of radiolabeled carbon is corrected for and 

estimates of primary productivity (g C l-1 d-1) are obtained for specific layers of the lake 

through the photic zone. 

 

Materials 

Sampling Hut 

125 ml borosilicate glass bottles with polyethylene-lined screw caps (3 bottles per depth, 2-light 

and 1-dark) 

P1000 Gilson Pipetman and tips (RAD ONLY) 

List of isotope addition volumes 

PPR bottle transport carrier 

Radioisotope safety tray (lined with Benchcoat) 

Vinyl gloves (at least 2 pair per person) 

Ziplock for solid waste 

Depth calibrated incubation line and clips 

Dry Valleys Lab 

25 mm GF/F filters  

Filter manifold with 25 mm Polysulfone filter towers 

Vacuum pump 

Eppendorf repeater pipet with tips for HCL (NO RADS) 

Filter forceps 

Glass scintillation vials (20 ml with HDPE cone caps) 

Heating block 

Benchcoat 

Kimwipes  

Rad waste containers 

MCM Crary Lab 

Repipettor 

 

Reagents 

Sampling Hut 

Ampulated 14C carbonate/bicarbonate:  (Activity should be between 100-120 µCi ml-1, pH ~9.5) 

Dry Valleys Lab 
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3 N HCl 

NaOH 

MCM Crary Lab 

Cytoscint ES scintillation cocktail 

 

Procedure 

Sample Collection 

PPR Bottles: Rinse with 1% HCL + 3X DIW at start and end of season and between Limno Runs 

(this should be done in the hood as any 14C in the bottles will gas off when the acid is added to 

the bottle). Be sure put NaOH into the receptacle for your acidic rinse water to neutralize the 

HCL before putting it into your rad waste carboy to avoid gassing off any 14C that may be in the 

carboy, or may be added to the carboy in the future. Check for light leaks in dark bottles. Check 

hooks on incubation lines.   

 

1. Immediately before sampling, break the 14C ampoule and decant into a clean 20 ml 

scintillation vial.  Carefully wrap vial with kimwipes and place into a 1000 ml HDPE bottle 

for transport (store upright). 

 

2. In a darkened environment, decant water from the Niskin bottle into 2-light and 1-dark 125 

ml Teflon screw-cap bottles (rinse 3x with sample water before filling with sample).  Replace 

bottles into their carrier until all PPR depths are collected.  Note: Insert the hose to the 

bottom of the bottle and fill from the bottom up, overflowing the bottle with ~50 ml of 

sample. 

 

3. Once all of the PPR bottles are filled, inoculate each sample with 14C as follows.  Arrange the 

radioisotope safety tray such that two people may work together during this procedure.  One 

person will add the isotope while the second person thoroughly mixes each sample and 

replaces it into the carrier.  Firstly, decant enough sample so that when the isotope is added 

there is about 1 cc of headspace in the bottle.  Secondly, withdraw an appropriate volume of 

isotope (Table 1), place the pipet tip below the surface and dispense.  Securely replace cap 

and gently invert sample three times.  The second person will check the tightness of the cap 

and gently invert sample another ten times before replacing into carrier. 

 

Table 1.  Volume of 14C bicarbonate working solution (100-120 Ci ml-1) added to each 

sample bottle (15 ml ampules are used for Lake Bonney; 10 ml ampules are used for Lake 

Haore and Fryxell; 5 ml ampule for Lake Miers). 

 

West Bonney East Bonney Hoare Fryxell 

Depth 

(m) 

14C 

(µl) 

Depth 

(m) 

14C 

(µl) 

Depth 

(m) 

14C 

(µl) 

Depth 

(m) 

14C 

(µl) 

top 220 top 220 top 200 top 230 

5 220 5 220 5 200 5 230 

6 220 6 220 6 200 6 230 

8 220 8 220 8 200 7 230 

10 220 10 220 10 200 8 470 



 Section 3. Biological Parameters 
 3.2 Phytoplankton 

LTER Limnological Methods Manual Page 59  Method_Manual_JL_092319.docx 

12 650 12 400 12 310 9 470 

13 650 13 700 14 310 10 500 

14 650 15 700 16 430 11 500 

15 650 18 700 18 430 12 500 

17 650 20 700 20 430   

20 650 22 700 22 430   

Total 14C 15000  15000  10020  10080 

 

Miers 
Depth 14C  

(m) (µl) 

top 100 

5 100 

7 100 

9 100 

11 100 

13 100 

15 200 

16 200 

17 200 

18 200 

bottom 200 

Total 14C 4800 

 

Note:  Use the same calibrated 1000 l Gilson for all isotope additions (for Miers you can use a 

p-200). 

 

4. During sample deployment use an opaque tarpaulin to cover the incubation hole and sample 

carrier, thus preventing any direct sunlight from shining on the bottles.  Carefully attach each 

bottle to the calibrated incubation line (the dark bottle on the lower clip, and the two light 

bottles on the upper clip at each depth, with a cable tie securing the loop on each bottle to the 

cable in case a hook should break) and slowly lower into the lake. Position the PPR 

incubation line in the center of the hole to prevent the incubation line from freezing into the 

sides of the hole.  Secure the incubation line to a stout cane pole (or chipper bar) so that the 

piezometric mark on the line is even with the piezometric water level in the hole.  Attach the 

incubation line to a secure point on the surface of the ice (i.e., hole melter, ice screw).  Keep 

the hole covered with a tarpaulin during the incubation period. 

 

Note: Always attach/detach the PPR bottles to the incubation line while the bottle is in the 

carrier, and begin with the deepest depths first, then lower the line into the hole as the shallower 

depths are attached. 
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5. PPR Incubations should start by 7:30 am and continue for 24 h.  Note: It takes about 2.5 h to 

collect samples before incubations begin.  Hence, collection should begin at 5:00 am. 

 

6. After the 24 h incubation, remove the bottles from the lake and place into the transport 

carrier.  Two people are required to remove the bottles, one person will slowly remove the 

bottles from the lake, being careful not to hit the bottom or sides of the ice hole.  Only 

retrieve one depth at a time; place the bottles over the transport carrier before detaching each 

one from the line.  The other person will attend to the incubation line and assist. 

 

Below steps to be conducted in Dry Valleys Lab 

Sample Analysis 

Rinse filter towers with 1% HCL + 3X with DIW before each limno run (this should be done 

in the hood as any 14C on the filter tower will gas off when rinsed with the HCL). Rinse with 

DIW between different sample depths. Be sure put NaOH into the receptacle for your acidic 

rinse water to neutralize the HCL before putting it into your rad waste carboy to avoid 

gassing off any 14C that may be in the carboy, or may be added to the carboy in the future. 

 

1. Label 3 scintillation vials per depth (A, B, D).  Label the cap on the vial as follows: 

 

 

 

 

 

 

2. Place 25 mm Whatman GF/F filters on the filter base and replace tower (use only rad labeled 

filtering equipment). 

 

3. Pour sample into filter tower and filter under low pressure (< 7 inches Hg).  Make sure tower 

is securely tightened down, it helps to add a small amount of the liquid at first in case there 

are any leaks so you don’t lose the entire sample, then add any remaining sample.  Remove 

filter and place (organic side up) in the bottom of the scintillation vial and cap.  Note: Take 

precautions not to misplace or exchange samples among depths.  

 

4. Once all of the samples are filtered, remove the caps and place scintillation vials on a heat 

block (60 C).  To prevent possible misidentification of samples, position the caps so they 

directly correspond to the order of scintillation vials, and use a Sharpie marker to label each 

scintillation vial on the shoulder of the vial.   

 

5. Using an Eppendorf repeater pipet, add 0.5 ml of 3N HCl to each scintillation vial (Inside 

fume hood). 

 

6. Dry filters slowly (8 h at 60 C) on heating block in fume hood.  Once the filters are dry, 

carefully remove from the heat block and replace cap. (Filters can be removed from heat 

before 8 hours if they are dry). 

 

E30 

PPR 

1 Jan 99 

5 A 
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7. Package scintillation vials and transport to MCM. 

 

Below steps to be completed in MCM Crary Lab 

8. Using a repipettor, add 10 ml of Cytoscint to each sample and count using the calibrated 

Beckman LS6000 Scintillation counter (Priscu PPR channel).  The counter should be 

calibrated using 14C-toluene Quench standards each season. 

 

9. Primary production (g C l-1 d-1) is calculated using the following equation: 
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 where DPML is the average dpm of the light bottles, DPMD is the dpm of the dark bottle, a is 

the concentration of dissolved inorganic carbon at the respective depth, b is the isotopic 

discrimination factor of 14C radiolabeled carbon (1.06), c is a constant to convert units 

(1000), A14Cis the specific activity of the 14C, and t is the incubation period (h). 

 

µ
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Bacterial Enumeration and Biomass 

 

General Discussion 
SYBR® Gold was recently found to have a high quantum yield of fluorescence and less 

fade than Acridine orange (Lisle and Priscu, 2004).  The following method has been used by Dr. 

Priscu in these lakes since 1999(?), and its continued use ensures consistency.  It is important to 

take special care handling samples from the time of water collection to filtering in order to 

minimize contamination.  

 

Materials 

Sampling Hut 

1000 ml Amber HDPE bottles 

Dry Valleys Lab 

Glass scintillation vials (20 ml with HDPE cone caps) 

10ml Gilson Pipetman 

Autoclaved 10 ml pipet tips (autoclave 20 minutes) 

Acrodisc 0.2 µm filters and syringe 

MCM Crary Lab/MSU 

0.2 m 25 mm black polycarbonate filters 

0.45 m 25 mm membrane filters 

Acrodisc 0.2 µm filters and syringe  

P1000 & P200 Gilson Pipetman 

Autoclaved 1 ml pipet tips 

1 ml syringe and sterile 23G1 needle 

Filter manifold and glass filter base/tower  

3 ~1000 ml containers for soaking filter towers (Alconox, 10% HCL, DIW) 

Squirt bottle with 95% ETOH 

Glass cover slips, 25x25 mm  

Glass slides 

Immersion oil (ultra low fluorescence grade) 

Microscope with mercury lamp (100 W lamp is best), UV filter set, 100 objective or greater 

 (SYBR Gold excitation maxima = ~495 and 300 nm; emission maximum – ~537 nm). See 

Appendix 6.8 for instructions on the Nikon Labophot scope with HBO 100W/L2 mercury 

lamp used by the Priscu Lab. 

Microscope camera system (if available) 

Permanent marker  

Water (0.2 m filtered reverse osmosis or distilled)  

 

Reagents 

Dry Valleys Lab 

Formalin: (0.2 m filtered) Buffer by saturating formalin with sodium borate. 

MCM Crary Lab/MSU 

SYBR® Gold Nucleic Acid Gel Stain (10,000X concentrate in DMSO) 

TBE buffer 

Antifade solution (0.1% p-phenylenediamine in a 1:1 solution of PBS/glycerol) 



 Section 3. Biological Parameters 
 3.3 Bacteria 

LTER Limnological Methods Manual Page 63  Method_Manual_JL_092319.docx 

PBS buffer (currently we are using packets that are dissolved in DIW) 

 

Procedure 
Sample Collection 

1.   Fill a 1000 ml HDPE amber bottle (rinse 3x with sample water before filling with sample) 

with 1000 ml of sample from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert 

Niskin ~ 5 times). Place in cooler for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

2. Bacteria samples are taken from the 1000 ml Amber HDPE bottles.  Gently invert the amber 

bottle to thoroughly mix, remove sample cap and pipet 18 ml of sample into a clean 20 ml 

glass scintillation vial, replacing cap immediately.  Preserve all bacteria samples by adding 

0.9 ml (~27 drops from Acrodisc syringe filter) of buffered formalin (0.2 m filtered) to each 

sample.  Store at 4ºC until ready to prepare samples for counting. Do not freeze during 

transport.  Note: Storage for extended periods reduces cell counts.  We count cells within 3 

months of sample collection. 

 

Below Steps to be done in MCM Crary Lab and/or MSU 

1. Prepare a 10X solution of TBE buffer by dissolving in 500 ml DI water: 54g Tris Base, 27.5g 

boric acid, 20 ml 0.5M EDTA (pH 8.0).  Dilute to 1X and filter through a 0.2 m acrodisc 

into a 50 ml sterile, non-pyrogenic, polystyrene tube.  Store at room temperature.  

 

2.   Prepare a 25X SYBR Gold solution: Thaw SYBR® Gold Nucleic Acid Gel Stain (10,000X 

concentrate in DMSO) and briefly centrifuge suspension to separate the dye from the DMSO 

(DMSO will be deposited at the bottom of the tube).  Be sure the dye solution is fully thawed 

before removing an aliquot.  Add 25 µl of dye to 9.975 ml of filtered 1X TBE buffer.  

Vortex.  Filter solution through a 0.2 m acrodisc and into a 15 ml sterile, non-pyrogenic, 

polypropylene tube.  Seal cap with tape so that it is clear whether tubes have been previously 

used.  Wrap tube in aluminum foil (SYBR Gold is light sensitive) and refrigerate at 4ºC.  

25X SYBR Gold solution can be used for up to 5-7 days.  (SYBR Gold solution must be 

poured through activated charcoal prior to disposal).  See www.molecularprobes.com for 

more information on SYBR® Gold Nucleic Acid Gel Stain.   

Caution:  No data are available addressing the mutagenicity or toxicity of SYBR® Gold 

nucleic acid gel stain. Because this reagent binds to nucleic acids, it should be treated as a 

potential mutagen and handled with appropriate care. The DMSO stock solution should be 

handled with particular caution as DMSO is known to facilitate the entry of organic 

molecules into tissues. 

 

3.   Immediately before slides are to be made, prepare a solution of Antifade (0.1% p-

phenylenediamine in a 1:1 solution of PBS/glycerin) by weighing 0.1g of p-

phenylenediamine into a 15 ml sterile, non-pyrogenic, polystyrene tube.  Add 1 ml 0.2 µm 

filtered DI water and vortex until dissolved.  Add 4.5 ml glycerol and 4.5 mls phosphate 

buffered saline (PBS) and vortex.  Filter solution through a 0.2 m acrodisc into a 15 ml 

sterile, non-pyrogenic, polystyrene tube.  Wrap tube in aluminum foil (Antifade solution is 

light sensitive) and refrigerate at 4°C).  Antifade solution is only good for ~12 hours 

http://www.molecularprobes.com/
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(solution will turn a brown color after this time), and must be prepared fresh each day slides 

are to be made. 

 

4. Place a 0.45 m 25 mm diameter membrane filter on a glass fritted filter apparatus base and 

cover with a 0.2 m 25 mm diameter black polycarbonate filter (shiny side up).  Replace 

filter tower (scrubbed with Alconox, soaked in 10% HCL, rinsed in DIW, rinsed with 95% 

ETOH). 

 

5. Invert 20 ml glass scintillation vial containing sample, and add appropriate volume of sample 

to filter tower (2 ml for Lakes Hoare and Fryxell, 3 ml for Lake Bonney. These volumes can 

be changed depending on the amount of cells present in the sample; generally the lower 

depths of Bonney need 5-6 mls).  Add 500 µl of 25X Sybr Gold nucleic acid stain (adjust if 

filtering more sample).  Allow sample to incubate in the dark (foil over tower) for 15 minutes 

before filtering. 

 

6. Filter under low vacuum (0.3 atm; 5 inches Hg).  Just as a thin layer of sample remains, rinse 

filter tower with 1 ml of filtered DI water and continue to filter.  Turn off vacuum as soon as 

the last of the water has filtered. 

 

7. Place filter on a labeled glass microscope slide containing 1 drop of Antifade solution.  Place 

two drops of Antifade solution, using a 1 ml syringe, on top of filter.  Place a cover slip on 

top of filter. 

 

8. Use a clean and blunt object to gently push down on the cover slip in order to form a thin 

even film of Antifade solution between the filter and the cover slip.  There should be no 

bubbles, and the filter should not have any wrinkles. Freeze upright in a slide holder until 

ready to count. 

 

9. Prepare a sample blank by following the above procedure using filtered DI water (without 

sample). This should be done prior to filtering samples, and checked on the microscope to 

assure there is no contamination in any of the solutions. 

 

10. Place a small drop of immersion oil on each cover slip.  Count bacteria at a final 

magnification of 1000 in at least 10 different fields and until at least 300 cells are counted, 

yielding a < 15% counting error. If 300 cells have not been counted after counting 30 

fields, the number of cells counted thus far is sufficient. At least one digital image of each 

depth should be taken for archiving purposes (a picture of the stage micrometer will need to 

be taken for calibration of the camera).  

 

Calculation of Cell Numbers 

1. Calculate cell numbers (cells ml-1) where S is the average number of cells per field in the 

sample, B is the average number of cells per field in the blank, vol is ml of sample filtered, 

filter area is the area (µm2) of the filter containing bacterial cells (determined by 

measurement of the filtration “spot” (dye area) on the filter), field area is the area for each 

field counted (µm2). 
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Notes on Bacterial Protocol 

1. Always wash your hands and wear latex/vinyl gloves when labeling scintillation vials, 

handling pipet tips or preparing bacteria samples. 

 

2. Label scintillation vials before preservation, preferably the night before sampling so that 

samples may be prepared immediately following lake water collection. Use only unopened 

scintillation vial packs.  Once the plastic is removed from a flat of vials, immediately cap 

these vials or don’t plan on using them on any bacteria work.  The best way to cap the vials is 

to cut the plastic on the far edge of the flat and fold it over.  Place caps on vials one row at a 

time, folding the plastic back as you progress through the rows.  Take care to not touch the 

inside of the caps with your fingers.  Label vials accordingly: 

 

 

 

 

 

 

 

3. Use a P10ml Gilson Pipetman and 10 ml pipet tips.  To autoclave these tips, place 20 tips 

with pointy side down into an autoclavable bag (8 in  11in), tape closed with autoclave tape, 

and autoclave for 20 minutes. 

 

4. A Hoefer 10 place manifold with glass towers works well. 

 

5. Clean and scrub filter apparatus with a brush between filtering samples.  Rinse well with DI 

water, followed by 0.2 m filtered water. 

 

6. Two filters may be placed on one microscope slide 

 

7. Counting bacteria may seem ambiguous at first, but as you become familiar with the different 

types of bacteria, consistency can easily be achieved. 
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Some cells look like bacteria, but have chlorophyll and therefore will autofluoresce.  

These cells are red, not orange or green.  Sometimes this is hard to distinguish.  Look at 

any questionable cells under UV light.  If the cells are visible under UV, then they are 

autofluorescent and should not be counted. 

 

Generally, rods look like this             , and cocci like this      , but you will see cells 

shaped like this,            , especially in the deeper waters of Bonney and Fryxell.  If cells 

are long (>5 m) and string like, they are filaments.  If they do not autofluoresce then 

they should be counted.  Move randomly around the filter counting cells in each field (or 

within the Whipple disk if cell number is high enough), and record the numbers of 

filaments, rods, and cocci.  Count at least ten fields. If 300 cells have not been counted 

after 10 fields, continue counting until 300 cells have been counted.  If 300 cells have not 

been counted after counting 30 fields, the number of cells counted thus far is sufficient. 

Individual records should be kept of rods, coccoid and filamentous cells so that cell 

numbers and biovolume can be computed for each type of bacteria.  

 

8. Shipping considerations: 

Check each scintillation vial and make sure the cap is tightened well.  Cover each flat 

with a piece of cardboard and tape it down.  Place upright in a freezesafe and secure with 

bubble wrap to prevent movement during shipping.  Bacteria samples must NOT 

FREEZE, handle samples appropriately.  Although these samples contain formalin, they 

are not hazardous cargo.  The final concentration of Formaldehyde is <2%.  

 

Biovolume Measurements 

Biovolume measurements are no longer performed (since 0203 season). The Biovolume method 

previously used is as follows: 

Measure length and width of cells in one randomly chosen field to determine biovolume.  

Alternatively, pictures can be taken using a microscope camera system, such as the Optronics 

Microfire digital camera system used at MSU, and cell sizes measured later using the Sigma 

Scan program (a picture of the stage micrometer will need to be taken for calibration of the 

camera). 

 

Biovolume is calculated using the following formulas for rods (ellipsoid) and coccoid (sphere) 

cells, respectively:  

 

where A is the length and B is the width of the ellipsoid cell, and A is the diameter of the 

spheroid cell. 

 

Bacterial Degradation Equation 

Based on a time series experiment with SYBR Gold performed from November 2004 – January 

2006, it was determined that bacterial counts need to be corrected for cell degradation from the 

time of collection/preservation to counting (Figure 1).  
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Figure 1. Cells per ml plotted over time for West Lake Bonney samples counted for the time-

course decay experiment for SYBR Gold dye. 

 
 

The degradation equation previously used for Acridine Orange is as follows: 

Correct bacterial counts for cell degradation from the time of collection/preservation to counting 

using the following equation: 
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 where Nt is the number of cells counted at time t, time t is the time elapsed in days, and N0 is 

the number of cells in the sample at time zero (Takacs and Priscu, 1998). 
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Bacterial Production Determined by 3H Thymidine and 3H Leucine 

Incorporation 
 

General Discussion 

Despite the controversy over the shortcomings of the thymidine incorporation method, its 

widespread use in various systems, the relative simplicity of the method, and its repeatability 

make this a useful technique to determine bacterial production.  During the 0607 season, we did 

a comparison of the “filtration method” used in previous seasons (see Appendix; Takacs, C.T. 

and J.C. Priscu. 1998. Bacterioplankton dynamics in the McMurdo Dry Valley lakes: Production 

and biomass loss over four seasons. Microbial Ecology 36:239-250), with the “centrifugation 

method” used by the Palmer (PAL) LTER (Fuhrman, J. A. and F. Azam. 1982. Thymidine 

incorporation as a measure of heterotrophic bacterioplankton production in marine surface 

waters: evaluation and field results. Marine Biology 66:109-120). Results showed no significant 

difference between the two methods (ELB 0-20 m: mean and standard deviation of nM TDR/d 

determined via filtration method, 0.0113 and 0.0091, respectively; mean and standard deviation 

of nM TDR/d determined via centrifugation method, 0.0124 and 0.0122, respectively; paired t-

test T value, -0.7332; P value, 0.4911). We will therefore continue this measurement using the 

centrifugation method during future seasons.  We will also complement our thymidine data with 

3H-leucine incorporation data, as is done in the PAL LTER.   

 

Materials 

Sampling Hut 

1000 ml Amber HDPE bottles 

Dry Valleys Lab 

2 ml microcentrifuge tubes (VWR # SCT-200) (autoclave 20 minutes) 

Tube racks 

Permanent marker  

Eppendorf repeater pipet and sterile 10 ml tips (these cannot be autoclaved – buy sterile tips,  

    which come in bags of 10) 

p10 Gilson Pipetman (rad use only) 

Sterile 10 µl pipet tips 

p100 Gilson Pipetman (rad use only) 

Autoclaved 200 l pipet tips (autoclave 20 minutes) 

P1000 Gilson Pipetman (rad use only) 

Autoclaved 1000 l pipet tips (autoclave 20 minutes) 

MCM Crary Lab 

Permanent marker 

Centrifuge (14,000 rpm; ~15,000 x g) 

Eppendorf repeater pipet and 10 ml tips 

10 ml Repipettor for cocktail in fume hood 

Liquid scintillation counter 

 

Reagents 

Dry Valleys Lab 
3H-Thymidine (20 Ci mmol-1): precursor of DNA, uptake indicates rate of DNA synthesis  
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3H-Leucine (40-60 Ci mmol-1): amino acid, uptake indicates rate of protein synthesis 

Trichloroacetic acid (100% TCA):  Bring 20g of TCA up to 20 ml with DIW.    

MCM Crary Lab 

Trichloroacetic acid solution (5% TCA):  Dissolve 50g of TCA in DI water, and bring volume 

up to 1000 ml.  Store at ~1ºC 

Ethanol solution (80%) 

Cytoscint ES scintillation cocktail 

 

 

Procedure 

Sample Collection 

1.   Fill a 1000 ml HDPE amber bottle (rinse 3x with sample water before filling with sample) 

with 1000 ml of sample from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert 

Niskin ~ 5 times). Place in cooler for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

1. Label five- 2 ml micro centrifuge tubes per depth, preferably the night before sample 

collection.  Two of the five vials are kills and should be labeled K1 and K2.  Three of the 

vials are live treatments and should be labeled T1-T3. Note that not all depths (m) are 

incubated for all lakes (Table 1). 

 

 

 

 

 

 

 

   Table 1. Depths incubated for bacterial production experiments. 

Fryxell 

(m) 

Hoare 

(m) 

Miers 

(m) 

ELB 

(m) 

WLB 

(m) 

top top top top top 

5 5 5 5 5 

6 8 7 10 10 

8 12 9 13 13 

9 14 11 15 14 

10 16 13 18 15 

11 20 15 20 17 

15 25 16 25 25 

bottom bottom 17 30 30 

  18 35 35 

  bottom bottom bottom 
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2. The thymidine stock solution comes in ethanol which eliminates bacterial growth and volatile 

products of self-radiolysis.  Results from experiments done during the 0405 season indicate 

that it is not necessary to evaporate the ethanol from solution as was the procedure in past 

years.  Radiolabeled thymidine is added to each vial to achieve a final concentration of 20 

nM.  If the specific activity of the 3H Thymidine stock is 20 Ci mmol-1, then .6 l of stock 

solution must be added to each vial (See calculation of 3H Thymidine addition at the end of 

this section). In order to achieve an easier pipetting volume, the thymidine stock solution is 

first diluted10-fold in DIW (0.1 ml (100 l) thymidine :0.9 ml (900 l) 0.2 µm filtered DIW).  

6 µl of the diluted solution is then added to each vial. 

 

3. Radiolabelled leucine is added to each vial to achieve a final concentration of 20 nM. If the 

specific activity of the 3H Leucine stock is 84 Ci mmol-1, then 2.52 l of stock solution must 

be added to each vial (See calculation of 3H Leucine addition at the end of this section). In 

order to achieve an easier pipetting volume, the leucine stock solution is first diluted10-fold  

in DIW (0.1 ml thymidine :0.9 ml 0.2 µm filtered DIW).  25.2 µl of the diluted solution is 

then added to each vial. 

 

4.   Add radioisotope-labeled thymidine or leucine to live tubes (6 µl diluted thymidine; 25.2 µl 

diluted leucine) using the appropriate Pipetman. Dispense isotope drop of isotope well within 

vial, touching inside wall with tip to ensure complete dispensing of isotope from tip. Don’t 

add isotope to blank (kill) tubes yet (see below). After inoculation, cap tubes loosely. 

 

5. Bacterial production samples are taken from the 1000 ml amber HDPE bottles.  Gently invert 

the amber bottle to thoroughly mix, withdraw 9-10 ml of sample using the Eppendorf 

repeater pipet with a 10 ml tip, and dispense 1.5 ml into all tubes (live and kill), replacing cap 

immediately.  Pipet water carefully to avoid splashing sample and isotope out of tubes. Use 1 

tip per depth (9 total for each lake), which will leave you 1 tip from the sterile bag for TCA 

addition.  Record time of addition of water to isotopes. (Note: you will incubate the 

samples for 20hrs so plan your inoculation accordingly.  For example it is best to kill the 

samples around 10am the next day so you’d want to start the incubation around 2pm). Cap 

live tubes firmly, and invert several times.  

 

6. Perform activity checks of the thymidine and leucine by pipeting 3 µl from each of five live 

thymidine and leucine treatments (any depths) into 2 ml tubes, using the p10 Pipetman. 

Cover rack of samples with aluminum foil (to keep dark) and place live samples (and activity 

checks) in incubator at 4 ºC. 

 

7. Add 100 µl of cold 100% TCA to each control (kill) tube using the Eppendorf repeater pipet 

and 10 ml tip. Cap, invert several times, and place on ice for 15 minutes. Carefully add 

isotope to dry area on inside of tube near top using the appropriate Pipetman. Do not touch 

pipet tip to the sample containing the TCA. Cap the vials firmly, invert several times, and 

place in incubator with live samples (covered in aluminum foil). 
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8. Incubate the samples in the dark at 1-4ºC for 20 h.  Monitor temperature using Stowaway 

temperature loggers, if it varies, compute a time weighted average temperature for the 

incubation period. 

 

9. Terminate incubation with the addition of 100 µl of cold 100% TCA to each live sample 

using the Eppendorf repeater pipet. Invert tubes several times and store on ice for 15-30 

minutes.  Record time of TCA addition. Store vials in dark at 4ºC until processed. 

 

Below steps to be conducted in MCM Crary Lab  

10.  Centrifuge tubes at 14,000 (~15,000 x g) for 15 minutes. Load tubes with marker tab facing   

       out, and do so for all subsequent centrifugations.  

 

11. Gently pour out the supernatant into a wide-mouth waste jar and gently tap lip of each tube 

on a paper towel to get the last drops of hot liquid off. Pour with the marker tab on tube at the 

top. 

 

12.  Add 1 mL of cold 5% TCA (use Eppendorf repeat pipettor) to each tube. Re-spin for 5 

minutes, loading tubes with marker tab facing out. 

 

13. Gently pour out the TCA and gently tap the lip of each tube on a paper towel to get the last 

adhering drop out. 

 

14. Add 1 mL of cold 80% ethanol (use Eppendorf repeat pipettor) to each tube. Re-spin for 5 

minutes, loading tubes with marker tab facing out.  

 

15. Gently pour out the ethanol and gently tap the lip of each tube on a paper towel to get the last 

drops out. 

 

16. Place open tubes in fume hood until dry (overnight). No ethanol can be left in the tubes. It 

is a quencher! 

 

17. Once the samples are dry, add 1 ml of Cytoscint ES or scintillation cocktail (use Eppendorf 

repeat pipettor), vortex well, and count samples in a liquid scintillation counter on a 

calibrated 3H channel.  Add cocktail to activity check samples and count as well. 

 

18. Thymidine and Leucine uptake rate is determined by: 

 

where DPM treatment is the average DPM of T1-T3, DPM kill is the average treatment of 

the kills, nM thy,leu is the final concentration of thymidine or leucine in the incubation vial 
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(20 nM), Ci is the activity added, 2.2x106 is the number of dpm Ci-1, and t is the 

incubation time (h). 

 

16. Thymidine and Leucine uptake rate is corrected for the incubation temperature as follows: 
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where Ea is the energy of activation of 12,600 kcal mol-1, CI is the incubation temperature 

(C), CA is the ambient lake water temperature at specific depth (C), and R is a gas constant 

(1.987 cal mol-1 K-1), (Priscu, unpublished data). 

 

17. Thymidine uptake rate is converted to bacterial production by empirically determining a 

carbon conversion factor for the assemblage being studied (Kirchman and Ducklow, 1993).  

There are a number of carbon conversion factors reported in the literature to convert 

thymidine and leucine uptake rate to bacterial production.  The MCM LTER uses the 

following conversion factors (Takacs and Priscu, 1998; Kirchman, 1988): 

 

Thymidine: 

2.0x1018 cells mol thymidine-1 

11 fg Carbon cell-1. 

 

Leucine: 

1.420x1017 cells mol leucine-1 

11 fg Carbon cell-1. 

 

 

Calculation of 3H Thymidine addition 

 

In order to compute the volume of 3H-thymidine to add to each experimental vial to yield a 

final concentration of 20 nM, one must first compute the concentration of thymidine in the 

radioactive stock received from the vendor. Assuming the 3H stock solution has a specific activity 

of 20 Ci mmol-1 (specific activity will be noted on product), and an initial concentration of 1 mCi ml-1 

the following calculations are used to compute the concentration of thymidine: 

 



 Section 3. Biological Parameters 
 3.3 Bacteria 

LTER Limnological Methods Manual Page 74  Method_Manual_JL_092319.docx 

 

 

This concentration of thymidine can then be used to compute the volume of radiolabeled stock to 

yield a final concentration of 20 nM in the 1.5 ml sample: 

 

 
where C I is the initial concentration of the stock solution, V I is the volume of stock solution added to 

sample, C F is the desired final concentration of stock solution in the sample, and V F is the total 

volume of the sample. 

 

 
 

Because 0.6 l of stock solution is not easily pipetted with great accuracy, we dilute the stock 

solution 10-fold and pipet 6 l of dilute stock solution (0.1 ml thymidine : 0.9 ml 0.2 µm filtered 

DIW).  Theoretically, 6 l of the reconstituted solution will contain .6 Ci of 3H thymidine. 

 

Calculation of 3H Leucine addition 

 

In order to compute the volume of 3H-leucine to add to each experimental vial to yield a final 

concentration of 20 nM, one must first compute the concentration of leucine in the radioactive 

stock received from the vendor. Assuming the 3H stock solution has a specific activity of 84 Ci 

mmol-1 (specific activity will be noted on product), and an initial concentration of 1 mCi ml-1 the 

following calculations are used to compute the concentration of leucine: 

 

 
 

This concentration of leucine can then be used to compute the volume of radiolabeled stock to 

yield a final concentration of 20 nM in the 1.5 ml sample: 

 

 
where C I is the initial concentration of the stock solution, V I is the volume of stock solution added to 

sample, C F is the desired final concentration of stock solution in the sample, and V F is the total 

volume of the sample. 
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Because 2.52 l of stock solution is not easily pipetted with great accuracy, we dilute the stock 

solution 10-fold and pipet 25.2 l of dilute stock solution (0.1 ml leucine : 0.9 ml 0.2 µm filtered 

DIW).  Theoretically, 25.2 l of the reconstituted solution will contain 2.52 Ci of 3H leucine. 
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DNA for Extraction and Sequencing 
 

General Discussion 

     You are collecting lake water samples onto sterivex filters for DNA extraction and Illumina 

sequencing. We sequence the bacterial and eukaryotic SSU rRNA gene for the depths collected 

for both L1 and L2 limno runs. That gene is like a fingerprint for microbial taxonomy – it can tell 

us who is living in each depth of the water column. Molecular methods are very sensitive to 

contamination, so be sure to use proper techniques, including always wearing gloves and not 

touching contaminated items or surfaces such as your face, using sterile supplies and reagents, 

and being sure not to contaminate sterile supplies. For example, never touch the connections on 

the sterivex filters, caps, or syringes – even if you are wearing gloves.  

 

Materials 

Bring from CONUS 

Sucrose lysis buffer (SLB) – 20mM EDTA, 400 mM NaCl, 0.7 M sucrose, 50 mM Tris, PH 9: For 

1 L, combine 40 ml of 0.5 M EDTA, 8 ml of 5M NaCl and 50 ml of 1M Tris PH 9. Add DIW to 

~ 800 ml, slowly add 239.61g of sucrose powder (FW=342.3). Stir until dissolved. Adjust PH if 

necessary. Filter sterilize. The same batch of sterilized SLB can be used for the whole season, 

and can be used during future seasons if it has remained sterile. 

Bring at least 20 ml to field, that way you have enough for 200ul per sterivex plus a few 

mls extra. Store in several sterile 50ml conical tubes, so that if one spills you still have 

enough to work with. 

Sterivex filters 

You will need 80 for all the samples, and it is good to bring a few spares just in case. 

Luer lock caps for sterivex filters 

 Again, you will need 80 for all the samples, but bring spares. 

Luer lock tubing connector  

Requested on SIP from Crary stockroom 

Peristaltic pump (Crary #0118459 MasterFlex L/S) 

Peristaltic pump head (Crary #0068216) 

Silicone tubing (during 1617 it was size 15; during 1718 we used size 16) to fit pump head and 

sterivex (cleaning protocol is below) (during 1718, we made a set of tubing + tubing connector 

for each lake, and autoclaved each one before use before L1 and L2) 

Get from Crary Open Stock 

1 ml luer lock syringes without needles  

160 plus a few spares (one for each end of Sterivex if the Sterivex has a Leur Lok 

outflow. If not you can use a melted 10 µl pipet tip to cap the outflow.) 

Whirlpaks (D1359: 3 x 7 ¼”)  

One per sample plus a few spares. You will be storing one sterivex filter in each 

Whirlpak.  

Label tape 

Sharpies 

1 L glass corning bottles 

You will need to make 2 L of autoclaved MilliQ water per limno run, but you cannot put 

filled bottles in the autoclave, so get 3 bottles, fill each 75%, autoclave, and combine the 
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water into 2 bottles once they have cooled. (In 1718 we took 1 bottle for each Limno 

Run).  

 

60 ml luer lock syringes for manual backup  

At least 10 so you have enough to do a complete lake profile if the pump fails. 

Gloves  

Autoclave package for dry materials 

Tube rack to hold the conical tubes of SLB 

Small zipties to hold luer lock tubing connector in place 

Get from Limno Team overwinter storage 

Sample Bottles (1L Amber Nalgene) (cleaning protocol is below) 

Waste Bottles (1L Amber Nalgene) 

Get in Crary 

MilliQ water 

1% HCl acid 

 

All items will be used at the Dry Valley Field Camp Labs. The sample bottles will be needed at 

the Sampling Hut to collect samples from the Niskin bottle. 

 

Procedure 

Preparation in Crary 

1. Acid rinse (1X HCL + 3X DIW) 1L Nalgene Sample Bottles used for DNA collection 

and the waste Nalgene Bottles.  

 

2. Autoclave the milliQ water on the liquid setting, in glass 1L corning bottles (3/4 full; 

crack open caps. 

 

3. Flush the tubing and connectors with milliQ water, flush with acid 3 times, then flush 

with milliQ water again. Autoclave the tubing and connectors in an autoclave package on 

the dry setting, no higher than 121 C for 30 minutes. (You can use the same tubing and 

connector for each lake and clean them once at the beginning of the season, but ideally 

you would have 1 set for each lake, if possible, and clean them before each limno run). 

 

4. Wearing gloves, and without touching the inside of tubing or connectors, fit the luer lock 

tubing connector inside one end of the tubing to ensure it fits snugly before going out to 

the field. Use a small zip tie to hold the connector in place. 

 
 

5. Package all materials to go out to the field. Carefully package glass bottles to avoid 

breakage. Put SLB in 50 ml sterile conical tubes in Crary – 1 for each Limno Run. 
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Sample Collection 

1. Wearing clean gloves, rinse the sample nalgene three times with water from the depth 

before filling the nalgene. Never touch the inside of the Nalgene or lid. If touched, rinse 

again thoroughly with sample water from that depth before filling.  

 

2. Fill the nalgene above the shoulder, as close to the top as you can (remove the tubing 

from the Niskin bottle that is used to fill the other bottles during the Limno Run). You 

will use excess sample water to flush the pump tubing before filtering each sample.  

Collect the following depths: 

 

Fryxell Hoare Miers East Bonney West Bonney 

top top top top top 

6 8 7 5 5 

8 12 9 10 10 

9 14 11 13 13 

10 16 15 15 14 

11 20 16 18 15 

15 25 17 20 17 

bottom bottom 18  25 25 

  bottom   

 

3. Keep the samples in a cooler to maintain the sample temperature until filtering. Filter 

within 12 hours of collection. 

 

Below steps to be conducted in Dry Valleys Lab 

Sample Filtering 

1. Wipe down the benchtop and lay out fresh benchcoat. Wear clean gloves whenever 

handling the tubing, sterivex filters, caps, etc.  

 

2. Setup the pump (mode should be INT), pump head, and tubing (select the correct tubing 

size on the pump – the size is printed on the tubing itself). It may be helpful to set the 

pump on a box so that the tubing is at the height of nalgenes. Set the pump pressure to 

just under the max pressure of the sterivex. (Double check the sterivex, but in the past the 

max pressure has been 100mL/min, so the pump has been set to 90 mL/min.)  
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3. Do not connect a sterivex filter yet. Hang the outflow end of the tubing into the waste 

Nalgene so that the connector is not touching the Nalgene. Use a DI squirt bottle 

(specially designated with sterile water) to thoroughly rinse the outside of the intake end 

of the tubing before use. Never touch the length of tubing that will sit inside the sample 

Nalgene. It may be helpful to use a sharpie to mark the length of tubing that fits inside a 

Nalgene so you know never to touch beyond that point.  

 

Waste nalgene 

Sample 
nalgene 

Autoclaved 
milliQ  

Tubing shown with 
connector and 

sterivex attached 
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4. Pour autoclaved water into a sterile 50 ml conical tube and place the rinsed intake end of 

the tubing into the autoclaved milliQ water just enough so that the tip of the tubing is in 

the water. Pump ~100mL of autoclaved milliQ water to thoroughly rinse the tubing 

before use and between sample depths (~3 sec once water is coming out other end; ~10 

sec if it is new tubing).  

 

5. Gently invert the sample bottle several times to mix. Carefully remove the tubing from 

the conical tube of milliQ water and place it into the sample nalgene. Close the milliQ 

bottle or conical tube containing milliQ water right away to avoid contamination and 

keep it closed whenever not in use. Pump the excess water from the sample nalgene to 

prime the tubing. Stop pumping once the water level is at the shoulder of the bottle. 

Empty the waste nalgene. 

 

6. Open just the intake end of a sterivex filter package without touching the ends of the filter 

cartridge, and peel back enough packaging to expose the intake port. Keep the filter in the 

sterile packaging for now, and never touch the ports of the filter cartridge or tubing 

connector. Holding the outside of the luer lock tubing connector, twist the intake port of 

the filter cartridge into the connector to lock it in place. You can now pull the filter 

cartridge out of the packaging, being sure not to touch the outflow port. Set the cartridge 

inside the mouth of the waste nalgene so that the outflow is hanging inside the bottle, not 

touching anything (see picture).  

 

7. Pump the full one liter volume of sample across the filter, checking to make sure the 

sample nalgene is emptied as much as possible. Keep an eye on the waste nalgene and 

always empty it before the water level gets close to touching the sterivex outflow. The 

sample is done pumping once only air runs through the line and the cartridge is almost 

completely empty (it should not be filled with liquid). A syringe can be used to push out 

the extra liquid if needed. Make sure Nalgene bottle doesn’t tip as it empties and become 

lighter. 

 

8. Open an SLB conical, being sure not to touch the inside of the conical or lid. Open just 

the handle end of a 1ml luer lock syringe, and pull out the syringe without touching 

below the handle. The end going into the SLB must remain sterile. If for any reason the 

syringe is contaminated, discard it and use a new one. Sometimes a syringe will “stick” 

the first time it is used, so it may be helpful to pull back the plunger once before use. 

Place just the end of the syringe into the SLB and draw up 200ul. If the sample is not 

done pumping, you can place the sterile end of the syringe back inside the sterile 

packaging until the sample is finished. Close the SLB conical immediately to avoid 

contamination and keep closed whenever not in use. 

 

An alternative to this method is to add the SLB using a p200 pipet with sterile tips. 

 

9. Holding the body of the filter cartridge and outside of the tubing connector, unlock the 

sterivex. Hang the tubing inside the waste nalgene so that the connector does not touch 

anything. Connect the SLB syringe onto the sterivex. Hold the sterivex/syringe vertical so 
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that the sterivex outflow is pointed up. Slowly press the plunger to fill the filter cartridge 

with the 200ul of SLB. Roll Sterivex around to coat the filter (white cylinder) inside of it 

with SLB. The outflow is kept pointed upward so that the SLB does not drip out.  

 

An alternative to this method is to add the SLB using a p200 pipet with sterile tips. 

 

10. Open a sterile luer lock cap package without touching the end that will connect onto the 

sterivex outflow port. Twist into place, again being careful not to touch any connections. 

Remove the SLB syringe and secure a luer lock cap on the intake end of the filter 

cartridge.  

 

11. Use a sharpie and label tape to make a label for the filter cartridge. The label tape will 

wrap around the body of the filter cartridge and should be long enough to stick to itself. 

Labels that do not overlap themselves tend to fall off once the filter is stored frozen. 

Include the lake, sampling round (L1 or L2), depth, and date. Write the same information 

on a whirl-pak bag with a sharpie, and place the labeled sterivex with caps at both ends 

into the whirl-pak. Seal the whirl-pak and store the sample at -20C as soon as possible. 

Package all samples from a lake and sampling round together in a large ziploc (ie, all 

WLB L1 should be in a ziploc together).  

a. If working in a lab where only a refrigerator is immediately available, it is 

acceptable to store finished samples at 4C until you are able to access a -20C 

freezer. Move the samples from 4C into -20C storage the same day and as soon as 

feasible. 

 

12. Remove the tubing from the sample nalgene and rinse the outside thoroughly using a DI 

squirt bottle (specially designated with sterile water). Place the end of the tubing in the 

milliQ water and pump several milliliters to flush the tubing. You can now go back to 

step 5 to start the next sample. Once all samples are completed, flush the tubing 3 times 

with 1% acid, then flush another ~100mL of milliQ water before packing up the 

equipment. 

 

 

This method was written by Heather Buelow, a PhD student for Tina Takacs-Vesbach. Please 

direct questions to Tina at cvesbach@unm.edu. 
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Major ions by ion chromatography 

 

General Discussion 

The dry valley lakes span about 4 orders of magnitude in salt concentrations.  All of the 

lake surface waters are fresh, the deep water of Lake Fryxell is brackish, and the deep waters at 

Lake Bonney are hypersaline.  The entire water column of Lake Hoare is fresh.  Dedicated 

filtration equipment is used at each lake to try to minimize contamination given the wide range 

of salt concentrations between the lakes.  Most of the lake samples need to be diluted before 

analysis due to their high salt content   

 

Anions and cation are analyzed in separate runs on the IC. 

The major anions are F-, Cl-, Br-, NO3
-, and SO4

2-. 

The cations are Li+, Na+, NH4
+, K+, Mg2+, and Ca2+. 

 

Detailed information on operating the Dionex IC can be found in the Instrument manual 

and will not be repeated here.  This section describes the methods used for sample collection and 

preservation.  Information specific to the analysis of the LTER limno samples is also included.   

 

Materials 

Sampling Hut 

1000 ml Amber HDPE bottles 

Dry Valleys Lab 

47 mm magnetic filter towers  

47 mm, 0.4µm Nuclepore filters 

125 ml wide mouth HDPE bottles (acid washed for cations, DI washed for anions: Anion bottles 

 are washed with DI water by rinsing 3 times, then taped with blue label tape. Cation 

 bottles are acid rinsed with 1% HCL for up to 1 hour (fill half-way with 1% HCL, cap, let 

 sit right-side up for ~1 hour, flip upside down for ~1 hour) and DIW rinsed 5 times, then 

 taped with white labeling tape. 1% HCL can be re-used for other acid rinsing since the 

 bottles are new.) 

Bell jars and vacuum pump 

DI water squirt bottle 

Filter forceps 

Ziplock bags 

MCM Crary Lab 

Plastic autosampler vials and caps   

DI water 

Squirt bottle for DI 

White (cations) and blue (anions) label tape 

P1000 Gilson Pipetman and tips (2) 

P5000 Gilson Pipetman and tips 

Disposable micro beakers, 10ml 
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Reagents 

MCM Crary Lab 

Individual ion standards for ions of interest. 

Check standards for anions/cations 

Methanesulfonic acid 

NaHCO3 and Na2CO3 eluent concentrate  

Ultrex or Optima nitric acid  

 

Procedure 

Sample Collection 

1.   Fill a 1000 ml HDPE amber bottle (rinse 3x with sample water before filling with sample) 

with 1000 ml of sample from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert 

Niskin ~ 5 times). Place in cooler for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

Rinse filter towers with 1% HCL + 3X with DIW before each limno run. Rinse with DIW 

between different sample depths. 

 

2. Gently invert the 1000 ml amber HDPE bottle.  2-100 ml aliquots will be filtered (one for 

anions, the other for cations).  

 

3.   Place a 0.4 µm 47 mm Nuclepore filter on the filter base of a 47 mm magnetic filter tower 

mounted on a vacuum bell jar, and replace tower. Be careful to place the filter correct side up 

(shiny side up) and only handle the filter at the edge with forceps.  The filters can be torn easily.  

When in doubt, throw it out! Place either a DI washed 125 ml HDPE bottle for the anion filtrate, 

or an acid washed 125 ml HDPE bottle for the cation filtrate, directly under the filter base. 

 

4.   Pour sample from amber bottle directly into the DI rinsed filter tower; no need to measure 

sample, just use the markings on the filter towers as a guide.  Filter each sample under low 

vacuum (<10 in Hg). First filter 100 ml of sample into an acid rinsed (white tape) 125 ml wide-

mouth bottle for the cation sample.  When finished, replace the acid washed bottle with a DI 

rinsed (blue tape) 125 ml wide-mouth bottle for the anion sample.  Use the same filter tower for 

both the anion and cation aliquots.  Use a new filter between the cation and anion samples (of the 

same depth) if filtering is slow; otherwise, you can use the same filter for both. Maintain quality 

control by carefully rinsing filtration apparatus with DI water between sample depths.   

 

5.   Prepare at least one filtration blank for anions and one for cations by filtering DI water  

      through the filter tower apparatus.   

 

6.   Store samples in labeled Ziploc bags at 4ºC. 

 

Below steps to be conducted in MCM Crary Lab 

1. Preserve the cation samples by adding 0.5 % v/v (0.5 ml acid in 100 ml sample) of 

concentrated Ultrex or Optima HNO3.  Do not acidify the blank.  The anion samples are not 

preserved. 
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2. Store the samples in a cool dark place.  They can be frozen, but avoid successive heating and 

cooling.   

 

Sample Analysis (this method was updated in October 2007 by Kathy Welch with information 

about the new instrument being used. See the Appendix for information about the previously 

used instrument).   

 

 

A Dionex DX-120 ion chromatography dual-column system (Dionex, Sunnyvale, CA, USA) is 

used for the major ion analyses.  The system includes a single piston isocratic pump module, 

high-pressure Rheodyne injection valve with a 25 µl sample loop, Dionex high-performance cell 

with heater (the DS4 Detection Stabilizer), and Dionex AS-40 automated sampler. The system is 

configured for anion and cation analyses with a switching valve to switch between columns. The 

eluent flow rate is set to 1.2 ml/min for both anion and cation analysis.  Dionex Chromeleon 

software is used to automate the system, manage chromatograms and analyze data.   

 

A Dionex IonPac CS12A analytical column (4x250mm) and a CG12A guard column (4x50mm) 

are used for cation analysis.  The eluent is 0.13% methanesulfonic acid solution.  A CSRS Ultra 

II Cation Self-Regenerating Suppressor was used.  The background conductivity is 

approximately 200-250 nS.   

For the anions a Dionex IonPac AS14 analytical column (4x250m) and an AG14 guard column 

(4x50mm) is used.  The eluent is a 1.0mM NaHCO3 and 3.5mM Na2CO3 solution.  An ASRS 

Ultra II Anion Self-Regenerating Suppressor is used.  The background conductivity is 

approximately 16 µS.   

 

Standards 

 Cation and anion stock standards used for a typical batch of samples from the lakes are 

shown in Tables 1 and 2.  

 

Table 1.  Concentrations of cation standards used for calibration (mg/L). 

 

 Li+ Na+ NH4
+ K+ Mg2+ Ca2+ 

Stock std 1 100 10 20 50 50 

std6 0.5 50 5 10 25 25 

std5 0.2 20 2 4 10 10 

std4 0.1 10 1 2 5 5 

std3 0.05 5 0.5 1 2.5 2.5 

std2 0.02 2 0.2 0.4 1 1 

std1 0.01 1 0.1 0.2 0.5 0.5 

 

Table 2. Concentrations of anion standards used for calibration (mg/L) 

 

 F- Cl- Br- NO3
- PO4

- SO4
- 

Stock std 10 100 2 2 2 100 
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std6 5 50 1 1 1 50 

std5 2 20 0.4 0.4 0.4 20 

std4 1 10 0.2 0.2 0.2 10 

std3 0.5 5 0.1 0.1 0.1 5 

std2 0.2 2 0.04 0.04 0.04 2 

std1 0.1 1 0.02 0.02 0.02 1 

 

Due to the high salt concentrations of many samples, dilute samples before analysis (Table 3).  

Lake water dilutions range from 1:2 for surface water of Lake Hoare to 1:5500 for deep water of 

Lake Bonney. Dilute samples by serial dilution using disposable plastic micro-beakers and 

adjustable pipettors.  The stream samples can be run without dilution. 

 

Table 3.  Lake water sample dilutions for each lake. 

 

West Bonney East Bonney Hoare Fryxell 

Depth Anion Cation Depth Anion Cation Depth Anion Cation Depth Anion Cation 

4.5 10 10 4.5 10 10 4.5 10 10 4.5 10 10 

5 10 10 5 10 10 5 10 10 5 10 10 

6 10 10 6 10 10 6 10 10 6 10 10 

8 20 10 8 20 20 8 10 10 7 10 10 

10 100 100 10 100 100 10 10 10 8 55 55 

12 200 100 12 200 100 12 10 10 9 100 100 

13 200 100 13 200 100 14 10 10 10 100 100 

14 1000 1000 15 550 100 16 10 10 11 100 100 

15 2000 1000 18 1000 1000 18 10 10 12 100 100 

17 2000 1000 20 5500 2000 20 10 10 15 100 100 

20 2000 1000 22 5500 2000 22 10 10 18 100 100 

22 2000 1000 25 5500 2000 25 10 10    

25 2000 1000 30 5500 2000 30 10 10    

30 2000 1000 35 5500 2000       

35 2000 1000 38 5500 2000       

39 2000 1000          

 

1. Every 10th sample should be duplicated to check the precision of the dilutions.  The 

percent relative standard deviation (%RSD) of the duplicates should be less that 1%, even 

with dilutions of 1:5500. 

 

100% 
X

SD
RSD  

 

From an analytical perspective, these lakes pose a few problems for analysis.  Cl- 

concentrations in the deep waters of the east lobe of Lake Bonney are ~180,000 mg l-1.  That 

is approximately 10 times the Cl- concentration of seawater.  All of the sampling equipment 

and filtration equipment must be rinsed thoroughly to prevent carryover of salts from one 

sample to the next.  In addition, these samples require extensive dilution before analysis. 
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Dedicated sampling equipment for each lake and for the streams is essential for maintaining 

the integrity of the samples.  For example, the range of Cl- concentration in the lakes under 

investigation varies by more than 3 orders of magnitude and carryover between samples 

becomes a potential problem.  Carryover can also be a potential problem during analysis and, 

therefore analytical blanks are run to monitor this.  In general, if care is taken during sample 

processing and analysis, very good analytical results can be obtained.   

 

References 

 

Welch et al, 1996.  Journal of chromatography
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Dissolved Inorganic Carbon by Infrared Gas Analyzer 
 

General Discussion 

This section describes the collection, preservation and analysis of dissolved inorganic 

carbon (DIC) based on sample acidification followed by infrared gas analysis and comparison to 

standard curves for determination DIC concentration.  Infrared gas analysis is necessary because 

alkalinity based DIC is affected by high levels of H+ accepting compounds other than HCO3
-/CO3

-

2.  Also, DIC is used in the calculation of primary production. 

 

Materials 

Sampling Hut 

30 ml serum vials (Bottles from the previous year can be re-used: check for salt build-up before 

 using. If they are clean, rinse with 1% HCL, then rinse 6X with DIW. It is a good idea to 

 clean the outside of the bottles as they will be in a ziplock bag without stoppers to keep 

 them clean (the stoppers fall out if you put them in). It is best to clean bottles at the end 

 of the season to avoid salt build-up for the next year. If bottles are brand new, they can be 

 DIW rinsed 6X before use. Rinse stoppers 3X with DIW and put in Whirlpak bag for 

 each lake.) 

Serum/Scintillation vial carrier 

P200 Gilson Pipetman and tips 

Crimping tool 

Rubber stoppers and aluminum crimping caps 

MCM Crary Lab 

250 ml volumetric flask 

500 and 1000 l Gastight Syringe with Luer-lock tip 

24 ga.-1 ½ in. needles 

Qubit system (previously a Lira IRGA with HP Integrator or Licor 6252 CO2 analyzer was used. 

These systems were replaced with the Q-bit during the 0708 season) 

Go! Link and Logger Pro 3 program (we no longer use the HP Integrator so these methods have 

been deleted. Peak Simple was used until the 1516 season, when it was replaced with the Go! 

Link and Logger Pro 3 program.) 

 

Reagents 

Sampling Hut 

Chloroform 

MCM Crary Lab 

6 N H2SO4 (16.8 ml of 17.8M H2SO4 up to 100 ml with DIW) 

Sodium Bicarbonate (NaHCO3) 

Anhydrone (Magnesium perchlorate) 

Nitrogen gas 

 

Procedure 

Note: It is best to put chloroform in a scintillation vial and then place this inside a 125ml 

Nalgene for transport. 
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Note: Be sure to ventilate the polarhaven while using the Chloroform and to change your gloves 

if any Chloroform gets on them. Chloroform will go through both Latex and Nitrile gloves! 

 

Sample Collection 

1. Rinse each serum vial 3x with sample water before filling. Place the Niskin bottle tubing 

from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert Niskin ~ 5 times) to the 

bottom of the serum vial and allow the water to overflow, displacing the initial sample 

volume 2x (about 5 seconds).  Carefully remove the tubing keeping turbulence to a 

minimum, making sure the vial is completely filled. 

 

2. Immediately preserve the sample with 0.15 ml chloroform, cap and crimp the bottle.  Place 

sample into the Serum/Scintillation vial carrier for transport. 

 

3. Store the samples in the dark at 4°C until analysis. 

 

Below steps to be conducted in MCM Crary Lab 

4. Assemble the CO2 analyzer (Figure 1).  Place new Ascarite (CO2 filter) and Anhydrone 

(magnesium perchlorate – dessicant (use 70% Anhydrone + 30% teflon boiling stones to help 

prevent the Anhydrone from clumping)) into the scrubber cylinders (cylinders should be 

mounted vertically, with the gas entering from the base).  Always replace the Anhydrone and 

6 N H2SO4 before proceeding to another batch of samples. Recalibration via a new standard 

curve is necessary following replacement. 

 

 
Figure 1. Set up of the DIC analysis system. 
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5. Turn on the Qubit (Figure 2), set to the 2000 ppm range, and allow it to warm up for 90 

minutes before analyzing samples. The Qubit can be turned on and left on for the period of 

time (days) that samples are being run.   

 

 
Figure 2. Qubit 

 

6. Prepare a 60 mg l-1 DIC standard by bringing 0.105 g NaHCO3 to 250 ml with DI water in a 

volumetric flask.  NaHCO3 should first be heated to drive off any moisture by placing in a 

glass beaker, heating in a drying oven at 110° C for at least 1 hour, and cooling in a 

dessicator. Following preparation of standard solution, decant into a bottom arm flask and 

stopper. This standard can be used for up to 2 days, as long as the slope of the standard curve 

stays consistent. 

    

  
 

7.   Using the needle valve, adjust the flow of Nitrogen to 150 ml min-1 +/- 5 (with the old 

instrument we used a flow rate of ~15 ml/min). Check the nitrogen flow between the needle 

valve and the H2SO4 purge trap to obtain this flow rate using a bubble meter (40 seconds for 

100 ml = 150 ml/min). Keep a record of the flow rate for each run. 

 

8. Add 8 ml 6N H2SO4 to the purge trap. (Large purge trap = 10 ml, small purge trap = 6 ml – 

Amy added 8 ml in 0809). (Always turn the gas on before adding acid to the purge trap, and 

empty the acid before turning off the gas flow).  Place a rubber serum vial cap over the 

injection port on the purge trap.  This setup will allow ~ 50 samples (14 DIC standards and 

36 lake samples) to be analyzed in one batch, which is usually one lake. 
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9. Check the flow rate from the back of the Qubit by attaching a hose from the outflow on the 

Qubit to the bubble meter. The flow rate should be close to 150 ml/min. Keep a record of the 

flow rate for each run. 

 

10. Adjust the zero knob on the Qubit to set the baseline reading to zero. If you are unable to 

obtain a reading of zero with the knob, you will need to adjust the coarse zero screw first. 

Find the middle of the zero knob setting, set the coarse zero to approximately zero, and then 

do the fine adjustment with the zero knob. 

 

11. Start Logger Pro 3:  

- Click on “Experiment” > “Set Up Sensors” > “Go!Link:1”. 

- Click on the white box in the window that opens (Figure 3) 

 

   
  Figure 3. 

 

- Click on “choose sensor” and select “CO2 gas”. 

- Click on “Experiment” > “Data Collection” and set up the run as follows (also see Figure 

   4): 

    Mode: Time Based 

    Duration: 10,800 sec (3 hours, or as long as desired) 

    Sampling rate: 1 samples/second, 1 seconds/sample) 

 

   
  Figure 4. 
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- Click on “Experiment” > “Start Collection”. 

- Click on “File” > “Save As” to save the file, and then continue to save it as you do the run. 

- Click on the “Autoscale Graph” icon on the toolbar:  

 

12. Using the 1000 l Gastight syringe with a 1.5” 24 ga. needle, inject replicate samples of the 

DIC standard into the injection port on the purge trap (0.5, 0.7, 0.9, and 1.0 ml volumes) 

(Table 1).  Similarly, use the 500 l Gastight syringe to inject smaller replicate quantities 

(0.05, 0.1, 0.3 ml) (Table 1) (rinse syringe with next standard before injecting).  Note: When 

withdrawing a volume of standard (or sample) from the serum vial be careful not to draw a 

vacuum or to incorporate air bubbles into the syringe, because they will affect DIC results.  

This will require some practice, especially when analyzing West Lobe Bonney. Always allow 

baseline to return to zero both on the Qubit and Logger Pro3 before injecting the next 

standard. Note the time of peak injections on Logger Pro3 so you can later match the peaks to 

their volumes. 

 

Table 1. Volume of DIC standard used to create standard curve. 

 

Lake DIC Standard Injection 

volume (ml) 

  mg C 

       .FRX 1.00 0.060 

     BON                 FRX 0.90 0.054 

     BON    HOR    FRX 0.70 0.042 

     BON    HOR    FRX 0.50 0.030 

MIE 0.40 0.024 

     BON   HOR     FRX 0.30 0.018 

MIE 0.20 0.012 

     BON   HOR     FRX    MIE 0.10 0.006 

  MIE 0.08 0.005 

     BON    HOR    FRX   MIE 0.05 0.003 

HOR 0.03 0.002 

13. Calculate the slope of the standard curve using these standards. Keep a record of the slope for 

each run to check for instrument consistency. 

 

- When you want to integrate a peak, click on “Analyze” > “Peak Integration”. Highlight the 

peak you wish to integrate and click “add” (Figure 5). (It is advised NOT to integrate ALL 

peaks during the run as this can cause the program to hang up. The program is really intended 

for post analysis. Integrating 1 rep of each beginning standard and some “check” standards 

during the run is a good idea to check for drift over the run.) 

 



 Section 4. Chemical Parameters 
 4.2 Dissolved Inorganic Carbon 

LTER Limnological Methods Manual Page 92  Method_Manual_JL_092319.docx 

  
Figure 5. 

 

- Click ok to get back to the main screen. The peaks will now appear with numbers 

corresponding to the retention times and areas, which are listed below the graph (Figure 6). 

Keep track of which sample the peak numbers and integration times correspond to.  For 

peaks that you don’t integrate, keep track of the approximate peak time so you can integrate 

them later. 

 

   
  Figure 6. 

 

- To adjust the axes during the run, right click on the graph and go to “graph options” > “axes 
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options.” Alternatively, if you hold the mouse along the x or y axis, it will allow you to scroll 

the graph along that axis, or increase or decrease the range of the axis. 

 

15. Once the initial set of standards are analyzed and the slope has been checked, begin 

analyzing replicate sample volumes based on the following Table (Table 2) (rinse syringe 

with DIW followed by the next sample between samples).  Sample volumes may be adjusted 

so that data output is within the range of the standard curve.  If the replicate samples are not 

within 5 % of each other (the area of every peak cannot be checked in Logger Pro3, so you 

will have to estimate if the replicates are similar to each other based on the height of the 

peaks), inject a third sample. Always allow baseline to return to zero both on the Qubit and 

Logger Pro3 before injecting the next sample. Note the time of peak injections on Logger 

Pro3 so you can later match the peaks to their sample names. 

 

Table 2.  Volume of DIC sample to inject for each depth and each lake. 

West Bonney East Bonney Hoare Fryxell Miers 

Depth 

(m) 

Injection 

Vol. (ml) 

Depth 

(m) 

Injection 

Vol. (ml) 

Depth 

(m) 

Injection 

Vol. (ml) 

Depth 

(m) 

Injection 

Vol. (ml) 

Depth 

(m) 

Injection 

Vol. (ml) 

4.5 1.0 4.5 1.0 4.5 1.0 4.5 0.6 4.5 1.0 

5 1.0 5 1.0 5 1.0 5 0.6 5 1.0 

6 1.0 6 0.9 6 0.9 6 0.5 7 1.0 

8 0.9 8 0.9 8 0.7 7 0.2 9 0.6 

10 0.9 10 0.8 10 0.5 8 0.2 11 0.6 

12 0.7 12 0.6 12 0.4 9 0.1 13 0.6 

13 0.5 13 0.4 14 0.4 10 0.1 15 0.5 

14 0.5 15 0.2 16 0.3 11 0.1 16 0.5 

15 0.1 18 0.2 18 0.3 12 0.1 17 0.5 

17 0.07 20 0.1 20 0.3 15 0.08 18 0.5 

20 0.06 22 0.1 22 0.2 18 0.08 19 0.5 

22 0.06 25 0.1 25 0.2     

25 0.06 30 0.4 30 0.2     

30 0.05 35 0.5       

35 0.05 38 0.4       

38 0.05         

 

16. Once all the samples are analyzed, inject a single series of DIC standards based on Table 1.  

Combine these standards with the replicate standards run before the lake samples and create a 

standard curve.  These post run standards will adjust for instrument drift that might have 

occurred during sample analysis.   

 

17. When the sample run is done, click “Experiment” > “Stop Collection” and save the file.  
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18. Re-check the flow rate at both the start and end of the system as done above, and keep a 

record of these flow rates. Calculate the end slope for each run and compare to the start slope 

to check for instrument drift during the run. 

 

19. You can now integrate all the peaks, and adjust the integration start and stop points along the 

baseline (Figure 7). If you press the “x” in the corner of the Peak List, it will remove all the 

integrations from the graph. To adjust the axes for closer up integration, right click on the 

graph and go to “graph options” > “axes options.” Alternatively, if you hold the mouse along 

the x or y axis, it will allow you to scroll the graph along that axis, or increase or decrease the 

range of the axis. 

 

 
Figure 7. 

 

20. Enter or copy the areas into an Excel sheet. Once the run has been stopped, you can right 

click on the list of peak integration areas and paste it into a spreadsheet (note that this can 

only be done in newer versions of Logger Pro3 (3.12, 3.14). 

 

21. Graph the Q-bit peak area output (see Logger Pro3 instructions below) versus the known 

concentration of the standards (Figure 2). 

 

22. Use the standard curve regression equation to calculate DIC mg l-1 from the Q-bit output for 

each lake sample (Figure 8).  The final reported DIC value is an average of the replicate 

samples. 
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Figure 8.  Example of regression equation used to calculate DIC from IRGA output. 

 

Sample mgC l-1 = ((Sample Peak Area – Y Intercept)/ Slope))*1000 

            ml injected 

 

Peak Integration (from LoggerPro3 help section): 

Choose Peak Integration from the Analyze menu to analyze your chromatogram using the Peak 

Integration feature.  

Select Peak 

When you choose Peak Integration from the Analyze menu, a dialog will be displayed. Click 

and drag the cursor across the peak to select it. You can autoscale, zoom in, and zoom out using 

the buttons. 

Add 

Click the Add button to perform the integration and add the peak. Values for the Retention 

Time, Area, and Percent Area will be displayed. 

Split 

If you have a double peak (or triple, etc.) that needs to be split, select and add the entire group of 

peaks first. Then, click the point at which you want to split the peaks and click Split. 

Remove 

To remove an integration that has already been added, click the peak to select it, and then click 

Remove. 
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Dissolved Organic Carbon by Total Organic Carbon Analyzer 

 

General Discussion 

Samples for Dissolved Organic Carbon (DOC) are run on the Shimadzu TOC-V series. Total 

Nitrogen (TN) is analyzed during DOC analysis using the Shimadzu TNM-1 analyzer. All 

samples must be acidified to pH 2 with 6N HCl in order to drive off all inorganic carbon. Be sure 

to check the sample pH with paper to ensure that the pH is around 2 – this is especially important 

for the bottom waters in Lake Fryxell and East Lobe Bonney.    

 

Materials 

Dry Valleys Lab 

Graduated cylinder 

125 ml amber borosilicate glass bottles (acid washed w/ 1% HCL: Dump samples from previous 

 year from bottles and remove tape. Rinse caps (new or old as long as Teflon liners are 

 still in caps) in a beaker with 1% HCL followed by 3X DIW.  Rinse bottles 3X with hot 

 tap water, rinse 1X with DIW, fill half-way with 1% HCL and cap with Teflon lined cap, 

 let sit right-side up for at least 1 hour, flip upside down for at least 1 hour, rinse with 

 DIW 3X. Remove caps (lay on foil and cover until bottles are combusted) and place foil 

 loosely over top of bottle. Combust at 475 C for 4 h. Replace caps once bottles are 

 cooled. Tape bottles with any color tape.) 

Green TFE-lined caps (caps can be re-used from previous season if the glue is still holding the 

            Teflon liner in the cap and the cap looks to be in good shape) 

Bell Jar filtering apparatus with bottle stands 

25 mm polysulfone filter funnels 

25-mm GF/F filters, pre-combusted and acidified. (Combustion protocol: combust at 475oC for 4 

 hrs spread out on aluminum foil that will serve as a wrapper after combustion and 

 acidification. Acidification protocol: soak in 1% HCL for 3-4 hours, rinse 4X with DIW, 

 bring the pH to 8-9 with NaOH, rinse 2X with DIW, lay out on combusted foil to dry, 

            and wrap in foil once dried). Combusted and acidified filters are only necessary if certain 

 filtrate samples are being collected. Combusted filters are required for Dissolved 

 Organic Carbon (DOC) filtrate (collected from one Chlorophyll replicate), and acidified 

 filters should be used for nutrient (Soluble Reactive Phosphorus) filtrate (collected from 

 one Chlorophyll replicate). Since the filtrate for both DOC and nutrient samples comes 

 from the chlorophyll-a filtration, it is recommended to both combust and acidify all filters 

 used for chlorophyll-a filtration. 

Eppendorf repeater pipet and tips 

Low range pH paper 

MCM Crary Lab 

 

Reagents 

Dry Valleys Lab 

Hydrochloric acid (HCL): 6N 

MCM Crary Lab 
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Procedure 

Below steps to be conducted in Dry Valleys Lab 

Sample Collection 

1. The filtrate produced from the chlorophyll-a filtration (Section 3.1) is collected for DOC 

analyses. 

 

Rinse filter towers and graduated cylinders with 1% HCL + 3X with DIW before each limno 

run. Rinse with DIW between different sample depths. 

 

2. Gently invert the 1000 ml amber HDPE bottle, thoroughly mixing the sample, and decant 

100 ml of sample into a graduated cylinder. 

 

3. Place a combusted 25 mm GF/F onto the filter base, which is mounted on a vacuum bell jar, 

and replace tower.  Place an acid-washed, combusted 125 ml amber borosilicate glass bottle 

directly under the filter base.  The filter is used as a replicate for Chlorophyll-a analysis (see 

Chlorophyll-a method); therefore, filtering must be performed in the dark.  

 

4. Filter sample under low vacuum (< 7 in Hg).  Collect 100 ml of the filtrate in the 125 ml 

glass bottle. Do not rinse the filter tower with DIW if you still need to filter the nutrient 

sample.  Only rinse the filter towers between sample depths. Carefully remove the bell tower 

and cap the amber bottle. DOC samples can be kept on the floor of the lab during the 

filtration process, or placed at 4 C.  

 

5.   Prepare at least one filtration blank for nutrients by filtering DI water through the filter tower  

      apparatus. This should be done before starting the sample filtration. 

 

6. Once all of the DOC samples are filtered, preserve each 100 ml sample with 1.0 ml of 6N 

hydrochloric acid using the Eppendorf repeater pipet.  If less sample volume is filtered, 

adjust the volume of hydrochloric acid accordingly.  Check the sample pH with paper to 

ensure that the pH is around 2 – this is especially important for the bottom waters in Lake 

Fryxell and East Lobe Bonney.  More HCL may need to be added to these samples to reach a 

low enough pH for analysis. Store the samples in the dark at 4 C until analysis. 

 

Below steps to be conducted in MCM Crary Lab 

The following is the old method – the current method needs to be entered – for current 

method see -  http://www.mcmlter.org/restricted/instruments/shimadzu/Shimdadzu.htm 

 

Sample Analysis 

1. Open precleaned ampoules. 

 

2. Add 2ml of sample to ampoule. 

 

3. Add 200 l of 5% HCL (prepared with Organic free water) to ampule. 

 

4. Purge using air on Purging and Sealing unit for approx. 5 minutes. 
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5. While maintaining purge, add 1 ml of 100 g/l Sodium Persulfate solution (prepared as 

directed by TOC manual and purged with nitrogen) to ampoule. Do this step individually just 

before sealing. 

 

6. While maintaining positive oxygen flow in the ampoule, seal the ampoule. 

 

7. Bake the sealed ampoules at 105 °C for about 8 h to drive the reaction to completion. 

 

8. Prepare a standard curve from the stock organic carbon solution (10 – 50 g C) and a blank. 

 

9. Analyze samples and standard curve with the TOC analyzer (Consult the TOC manual for 

injection procedures). 

 

10. Use the regression equation of the standard curve and calculate the DOC (mg/l) for each 

sample. 

 

Notes: 

1. Samples with greater than 50 g C must be reanalyzed with an appropriately reduced sample 

volume. 

 

2. Some samples will have high carbonates and fizz when acid is added.  Add acid slowly so as 

not to loose sample. 

 

3. It is important to maintain a pure oxygen atmosphere inside the ampoule.  This will ensure 

that atmospheric CO2 does not intrude, and will also aid in complete oxidation of the organic 

carbon. 

 

4. Do not allow the sample to sit for long periods of time between procedure steps 10 and 11, as 

oxidation of carbon within the sample will begin and some carbon will be lost as CO2. 
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Particulate Carbon and Nitrogen Analysis by Elemental Analyzer (Filters and 

Sediment) 

General Discussion 

This method is used in the analysis of carbon and nitrogen on filters (water) and sediment 

samples that have been prepared using ASA Analytical Services method described below. 

Samples are analyzed with a CE Instruments Flash EA 1112 elemental analyzer which flash 

combusts at 1800 C.  Combustion gases pass through a catalyst converting all carbon and 

nitrogen combustion products to CO2 and N2.  The gases are then separated by gas 

chromatography and detected by a thermal conductivity detector.  

 

Materials 

Sampling Hut 

1000 ml Amber HDPE bottles 

Dry Valleys Lab 

Graduated cylinder 

25 mm GF/F filters (combusted at 475 C for 4 h spread out on aluminum foil that will serve as a 

wrapper after combustion) 

25 mm Polysulfone filter towers 

Vacuum pump 

Filter forceps 

Aluminum weigh boats 

Zip Lock Bags 

MCM Crary Lab 

Elemental analyzer: ThermoQuest EA 1112 Flash 

UHP Helium (GC Grade) (carrier and reference gas) 

Oxygen 99.995% (for oxygen inject for sample oxidation) 

Forceps: Assorted sizes and types 

Glass plate 

Metric ruler 

Micro spatula 

Micro-balance 

Pre-formed tin cups (CE Elantech, part # 252-080-00) 

 

Interferences 

1. The elemental analyzer is very sensitive and will detect organic carbon and nitrogen in 

fingerprints.  Keep bench area very clean, wear gloves; handle all samples and standards with 

forceps to avoid contamination. 

 

2. Ensure that the preparation area is clean of any standard when working with samples. 
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Reagents 

Standards: 

Acetanilide (CE Elantech, part # 338-367-00): standard grade, pre-dried at 85 C and desiccated 

(% C = 71.09, % N = 10.36). (see MSDS) 

Soil reference standard (CE Elantech,part #  338-400-25): pre-dried at 85 C and desiccated (% 

C = 3.5, % N = 0.37). 

 

Combustion and reduction reagents: 

Oxidation catalyst: CE Elantech, part # 338-400-60 

High Quality Copper: CE Elantech, part # 338-353-12 

 

Drying Agent: 

Magnesium Perchlorate (see MSDS) 

 

Procedure 

Sample Collection 

1.   Fill a 1000 ml HDPE amber bottle (rinse 3x with sample water before filling with sample)    

     with 1000 ml of sample from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert 

     Niskin ~ 5 times). Place in cooler for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

Rinse filter towers and graduated cylinders with 1% HCL + 3X with DIW before each limno 

run. Rinse with DIW between different sample depths. 

 
2. Particulate organic carbon and nitrogen lake water samples are taken from the 1000 ml amber 

Nalgene bottle.  Gently invert the bottle, thoroughly mixing sample, and decant 500 ml into a 

graduated cylinder. 

 

3. Use a six place manifold with 25 mm polysulfone filter towers.  Place a combusted 25 mm 

GF/F onto the polysufone filter base, replace tower, and filter the sample under low pressure 

(<10 in Hg).  Note:  The filter tower will only hold 200 ml of sample, therefore, continually 

top off the sample until the entire volume is filtered.  Furthermore, many of the Lake Bonney 

samples will take between 6-12 h to filter, thus plan accordingly. The entire volume should 

be filtered, even for chemocline depths at Lake Bonney and Lake Fryxell.  Record the 

volume of water filtered for each depth in each lake. 

 

4. Once the entire volume is filtered, do not wash the filters. Just maintain vacuum (~0.3 to 0.5 

atmosphere) until they are dry unless there is a large particle load sticking to the filter tower 

(such as may occur when filtering muddy stream water).  Filters should be filtered until dry 

to ensure that no (or very little) DIN remains on the filter. However, since filtering until dry 

can burst cells, do not filter dry for extended periods of time. Remove filter with forceps and 

place (organic matter up) in an aluminum weigh boat with the sample information (including 

volume filtered) clearly etched into the bottom of the dish (do not use a Sharpie or lead 

pencil to mark and etch the dishes – use a relatively sharp and clean object, such as forceps). 

Dry at room temperature for 12 h (dry weigh boats on clean aluminum foil). Make sure to 
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keep the bottom of each weigh boat clean as the bottom of each boat will be in contact with 

the filter in the boat under it during packaging.  Following desiccation, stack all of the 

aluminum weigh boats together, ensuring the bottoms are clean. Place an empty one on top. 

Tape together, wrap in foil, and store frozen in a zip lock bag.  Include three GF/F filters 

from the same packet of combusted filters used for the samples to be analyzed as 

blanks. 

 

Below steps to be conducted in MCM Crary or MSU Lab 
Sample preparation 

Both filter and sediment samples must be treated with acid to remove inorganic carbon, 

which can occur as carbonate or bicarbonate.  Fuming HCL converts inorganic carbon in 

samples to CO2 (Grasshoff, K., M. Ehrhardt and K. Kremling (eds). 1983. Methods of 

Seawater Analysis. Verlag Chemie). 

 

1. Place two 50 ml beakers with ~40 mls of concentrated (12N) fuming HCL, and one 50 ml 

beaker with DIW (to increase humidity), into the center of a glass desiccator (without 

desiccant) or a similar covered container of sufficient size to allow for the addition of 

samples.  A glass Pyrex rectangular dish with a second glass Pyrex rectangular dish upside 

down on top, sealed together with high vacuum silicone grease on the edges, works well for 

this (Figure 1). It is advised to use fresh HCL each season and to replace the beakers in the 

acidifying container after two acidification runs. 

 

2. Place filters onto the top of clean, uncovered scintillation vials inside the container (Figure 1) 

and allow to react for 24-48 hrs (keep aluminum weigh dishes once filters have been 

removed for use later).  Soil or Sediment samples can be placed directly into clean vials, 

however ensure that the soil is spread as close to a monolayer as possible (fumes may not 

diffuse through thick soil volumes). Note that the vials cannot be labeled with ink because of 

the acid fumes (the fumes will eat away the label), so be sure to note the order of the vials 

when placing them in the container. Place an aluminum tab from a weigh dish and a few 

strips of litmus paper inside the container to verify that the acid fumes are strong enough (the 

aluminum tab should turn white and fluffy from the acid fumes). If the tab does not turn 

white and fluffy, replace the HCL in the beaker, or, if your HCL was not fresh, obtain fresh 

HCL. 

 

3. Following acidification, place filters back in their aluminum weigh dishes using forceps and 

place in drying oven at 90ºC for 4-12 hours. If you are not ready to analyze the samples after 

drying, they can be stored in a desiccator, or they can stay in the drying oven, until analysis. 
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Figure 1. Acidification of filters. 

 

Instrument Preparation (prior to each season) 

 

Auto Sampler: It is best to check the auto sampler for problems at the start of each season.  

Remove the auto sampler cover by removing the 2 screws on top and 1 in front (Figure 2b). 

When replacing the screws, be sure to only tighten hand tight! The viewing window in the 

auto sampler can be replaced if it cracks. The o-ring under the viewing window can also be 

cleaned or replaced. Clean the auto sampler piston (Figure 2a) once per year or as needed for 

trouble shooting. Software is needed to eject the piston (the CN analyzer must be ON to do 

this. See Instrument set-up steps #1-4 below. If the furnaces start heating up, in the “Edit 

Elemental Analyzer Parameters” screen manually click the boxes to set the furnaces to off 

and press “Send”. It is a good idea to review the Instrument Shut Down section to understand 

the details about the system regarding gas flow, furnace temperatures, the detector, etc.).  

 

In the Eager 300 software, click on Tools → “Cleaning MAS Piston.” Click on “step sampler 

tray position” and the piston will eject from the front of the auto sampler.  Clean the o-rings 

on the piston, put a light coating of high vacuum grease over o-rings, and wipe it off with a 

Kimwipe (there should be no extra grease on the piston or o-rings when you put it back in the 

auto sampler). If the o-rings need to be replaced, you will need the brass tool (Figure 2c). 

Note that o-rings are directional and have 1 tapered end. To put the piston back in, put it back 

in the auto-sampler with the teeth turned downward. Slightly push in on the piston with 1 

finger and click “step sampler tray position” again. The autosampler mechanism will first try 

to eject the piston, then the motor will reverse and the mechanism will pull the piston back in 

(see pg 278 of Operating Manual). When running samples, keep the plastic cover on top of 

the auto sampler to keep the air out.  

 

       
Figure 2a.           Figure 2b.          Figure 2c. 
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Before preparing the reactors check that the furnaces are at room temperature. See 

Instrument Shut Down section below for instructions. 

 

 In the Flash EA 1112 Instrument Operating Manual we use the “NC-soils, NC-

Sediments, NC-Filters Determinations” method. There is also a Software Manual and a 

Parts Manual. 

 

 Use the diagram in Figure 6 (this can be found on page 75 of the operating manual for 

“Analyzer set-up for NC-soils, NC-Sediments, NC-Filters”) as a guide to setting up 

reactor 1, reactor 2, and the adsorption filter.  

 

 
Figure 2. CE Instruments Flash EA 1112 elemental analyzer. 

 

Reactor 1 – HPAR reactor (steel column): HPAR reactor (combustion column). This must be 

changed each season. Remove the autosampler by manually undoing the fixing nut (unscrew 

the autosampler where it attached to the analyzer). Remove the column from the left side of 

the CN analyzer (Figure 2, 5a). To do this, hold the coupling union under the reactor into 

which the steel column is inserted and turn the steel column counter clockwise while pulling 

up.  Pull out the old wool from bottom and use the larger plunger tool (Figure 4) to push out 

the old oxidation catalyst (this will take some effort!). Place quartz wool (use quartz wool in 

the hood because the fibers are an irritant to lungs) at the bottom of the column and gently 

pack down with the smaller plunger tool (Figure 4) (try to keep the long quartz wool fibers 

together when packing; i.e., don’t use small broken pieces of quartz wool but instead long, 

intact pieces) to at least 50 mm (Figure 6). Fill with oxidation catalyst (60 g, CE Elantech, 

part # 338-400-60) by opening the serum vial containing the oxidation catalyst (Figure 5b), 

putting in a beaker and using a spatula to evenly distribute the two types of catalyst into the 

column (Figure 5c). The catalyst comes in 60 ml serum vials with a pre-measured amount to 

fill the column to the correct height. Place quartz wool in the top of the column above the 

catalyst and gently pack down with plunger tool (see note next paragraph). Put enough quartz 
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wool so that when inserted, the crucible sits even with the top of the column (this will be 

more than the 10mm specified in Figure 6). Insert the packed column into the instrument 

from the top of the instrument.  Grasp the bottom of the column and gently push into the 

coupling union while turning clockwise.  While still holding onto the column, place the O-

ring onto the top of the tube.  Seat the auto sampler onto the O-ring and screw the fixing nut 

down hand-tight. Note:  The combustion tube catalysts have a limited sample life.  When 

CCV's start to approach the lower limits of acceptable range, or the tube is full, a new tube 

must be prepared. 

 

DONT OVERPACK THE CRUCIBLE/REACTOR.  It will cause problems if you have to 

compress the quartz wool too much!  For the top wool in the reactor, you should use maybe a 

little more pressure than the weight of the crucible itself.  If you have to pack it more, use the 

“grabber tool” and take out the wool and use less. If you over pack, it could disrupt the 

laminar flow needed in the system.  Also, big voids would allow for excess carrier gas and 

would dilute the system.  Both of these problems could affect precision and sensitivity, 

respectively. 

 

 

 
Figure 4. 

 

         
Figure 5 a, b, c.  
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Figure 6. Filling diagram for NC-Soils, NC-Sediments and NC-Filters. 

 

Reactor Bottom Caps (Coupling Unions): The reactor bottom caps (Figure 7) will get corroded 

over time and will need to be cleaned. Replace the o-rings (use Bottom o-rings (25mm and 

18mm)) and lightly grease with high vacuum grease once a season or as needed for 

troubleshooting. Clean out the channel in which the o-ring sits with a spatula and Kimwipe. 

Scrape corrosion on the inside where the reactor sits with a spatula and Kimwipe.   

 

 
Figure 7.  

 

Reactor Top Caps (Fixing Nuts): Replace the o-rings in the reactor top caps (use Top o-rings) 

and lightly grease with high vacuum grease once a season or as needed to troubleshoot. The 

o-ring for reactor 1 is orange; the o-ring for reactor 2 is black (shown in Figure 8). Wipe out 

the top caps with a Kimwipe.  

 

 
Figure 8. 

 

Instrument Preparation (prior to each run) 
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The crucible and adsorption filter can be changed with the instrument in stand-by mode if 

you don’t want to shut the instrument completely off between sample runs; if you need to 

remove the quartz column the instrument should be shut off and allowed to cool. 

 

Crucible: The crucible must be cleaned before each run. To remove, take off the auto sampler 

and pull the crucible out of reactor 1 using an allen wrench to hook the holes in the top of the 

crucible (it will be very hot if you have just finished a run!). Clean the crucible using the 

smaller plunger tool, taking care to clean out the vents (Figure 9). Pack a plug of quartz wool 

in bottom of the crucible (use quartz wool in the hood because the fibers are an irritant to 

lungs) using the smaller plunger tool, making sure not to pack the quartz wool higher than 

vents. Replace the crucible in reactor 1. 

 

 
Figure 9.  

 

Reactor 2 – Quartz reactor (quartz column): Remove the column from the right side of the 

CN analyzer (Figure 2, 10). DO NOT TOUCH THE COLUMN WITH BARE HANDS – 

WEAR GLOVES. Fingerprints can cause the tube to crack or shatter causing injury. To 

remove the column, remove the fixing nut on top of the column, hold the coupling union 

under the reactor into which the column is inserted and turn the column counter clockwise 

while pulling up. When gray copper in the quartz column fills 2/3 of the height of the furnace 

chamber (Figure 10c – in this figure the furnace height is only ½ gray), (~150 samples), 

change the column. The unused copper can be put back at the top of the column once the 

bottom is filled with new copper. Clean the old quartz column or use a new one (use each 

column only twice as the glass will get brittle after being used and cleaned). Pack the bottom 

(beveled end) of the new (or cleaned) column with at least 50 mm of quartz wool (use quartz 

wool in the hood because the fibers are an irritant to lungs). Fill the column with High 

Quality Copper from approximately two 50g ampoules (CE Elantech, part # 338-353-12) by 

shaking it into the column (the shaking also helps decrease air spaces in the column) to a 

height as in Figure 10a and 10b. See also Figure 6.  Extra copper that is not used can be 

saved in a serum vial and stored in the dessicator.  Tap the column on a bench to settle the 

copper pieces in the column. Put a plug of quartz wool on top of the copper. Insert the packed 

column into the instrument (the bottom of the column is the beveled end) from the top of the 

instrument, being careful not to chip the end of the column on the inside of the furnace.  

Grasp the bottom of the column and gently push into the coupling union.  While still holding 

onto the column, place the O-ring onto the top of the tube.  Seat the fixing nut of reactor 2 

onto the O-ring and screw down hand-tight. 
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Figure 10 a, b, c.  

 

Adsorption filter (glass): This is a moisture trap. Put quartz wool in the ends and fill with 

magnesium perchlorate (Anhydrone) (Figure 2, 6). Change every 2-3 runs or as needed. The 

red end caps contain Teflon liners that can be replaced. Quartz wool can be re-used when 

replacing mg perchlorate. Use quartz wool in the hood because the fibers are an irritant to 

lungs. 

 

Once the instrument is ready, proceed with instrument set-up and perform a leak check (before 

heating up the system and after it is to temperature) to ensure a helium tight seal. 

 

 

Instrument set up 

1. Open the valves to the oxygen and helium cylinders. Set the gas pressure on the 

regulators to 36.25 psi for Helium and 43.5 psi for Oxygen. When gases are at 500 psi, 

replace the tank. 

 

2. Turn the main instrument power switch on (located in the lower back right of the 

instrument). Remove brass vent plug (see red circle in Figure 8) before turning 

instrument on.  

 

 If reactor 1 has been changed, you will need to run the system (turn on the temperature 

 and flow (see below); the detector does not need to be on for this) with the top cap of 

 reactor two removed to vent out moisture in reactor 1. You will see moisture in the 

 connector tube between the bottom of reactor 1 and 2. It will take approximately 2 hours 

 for the moisture to disappear. You can also look for moisture at the top of the copper 

 column. Note that once the system is running, it will take 30-45 samples to condition the 

 system with the new reactor.  

 

3. Turn on the instrument computer and boot up the Eager 300 software package “Eager 300 

for EA 1112.” 

 

4. Click “Eager 300 for EA1112” → click on “EA1112 #1.” 
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5. Perform a leak test:  A leak test should be done when the instrument is at room 

temperature, before heating the reactors. If the system is not leak tight, the furnaces 

should not be heated up. Once the system is leak tight, it is safe to bring it to operating 

temperature. 

 

A Helium tight seal is indicated by a carrier flow reading < 5 ml/min @ 360 seconds, as 

per CE’s “official leak test procedure.” The Flash EA 1112 Operating Manual says the 

carrier flow and reference flow should be < 3 ml/min. 

 

a. Click “View Elemental Analyzer Status” → “Special Functions” → “Leak Test.” 

Don’t check the boxes → Click Start, click Yes when the program asks if you 

want to auto-zero, (Figure 11). The Carrier Flow should be <5 ml/min before 360 

seconds. Press Stop when it reaches the target value or time (usually the flow will 

drop to 1 ml/min if you wait). Click Done. If the system does not pass the leak 

test, try and isolate the leak by isolating different sections of the system. The 

exhaust from the instrument comes from hole #4 on top of the instrument (Figure 

2). It can be plugged to troubleshoot leaks. During the run it should remain open. 

It should be plugged when not in use. 

 

 

 
Figure 11. 

 

A leak test should be done again when the instrument is up to temperature. 

 

6. The instrument parameters should be set as below, according to the instrument operating 

manual.  Once set, they should not have to be changed. 

 

a. Temperature 

i. Left Furnace: 950 C (This was the current factory recommendation in 2014; 

we changed to using 950 C from 900 C at this time) 

ii. Right Furnace: 840 C (This was the current factory recommendation in 2014; 

we changed to using 840 C from 700 C at this time) 

iii. Oven: 50 C 

b. Flow/Timing 
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iv. Carrier: 140 ml/min 

v. Oxygen: 250 ml/min (This was the current factory recommendation in 2014; 

we changed to using 250 ml/min from 225 ml/min at this time) 

vi. Reference: 100 ml/min 

c. System Timing 

a. Cycle: 340 sec 

b. Sample Delay: 12 sec (This was the current factory recommendation in 2014; 

we changed to using 12 sec from 10 sec at this time) 

c. Oxygen inject end: 12 sec 

 

To set the parameters, click on “Edit Elemental Analyzer Parameters” (Figure 12) and set the 

Temperature (Figure 13) and Flow/Timing (Figure 14) as above. Click “Send” on the 

Temperature and Flow/Timing tabs, once you have set the parameters, to turn the 

Temperature and Flow in the system on. After you have entered the values, you can click no 

on the “save option” since you will be saving the parameters from your run after the run (step 

9 below).   

 

 
Figure 12. 

 

  
Figure 13.                                                                Figure 14. 

 

7. Click “View Elemental Analyzer Status” to see when the system is up to temperature 

(Figure 15, 16). 

 

 
Figure 15. 
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Figure 16. 

 

8. Click “Send” in the Detector tab (Figure 17) to turn on the detector if you are ready to run 

samples.  

 

 
Figure 17. 

 

9. Make a new folder and save the method into it by clicking on File → Save Method. This 

will direct all the files from your run into this folder. After your run if you save the 

method again and overwrite the first one you saved, it will have all the parameters you 

used during the run as well as your sample table information. You can make a new folder 

for every run and save the method each run, or continue filling in the sample table with 

several runs and save it at the end of your runs if you haven’t changed the method in 

between runs. Saving the method is a good idea because if you need to troubleshoot with 

CE Elantech, they will ask for the method file as well as the .dat files. An .eam file is 

automatically saved with the method, which contains your run parameters, and they will 

want this file as well. 

 

10. Perform a leak test:  Perform a leak test as described above once the system is up to 

temperature.  

 

11. Reset Maintenance Program: Click on “View” in main screen → “View Maintenance” 

→ “Edit - Reset Maintenance program.” Left 1 = crucible – reset; left 2 = oxidation 

catalyst - reset; right = copper – reset. Reset each of these when they have been replaced. 
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This will remind you of when maintenance is due based on the number of samples run. 

The times for maintenance in the program have been set manually by our instrument 

technician. 

 

12. Auto-adjust the baseline: Click “View Elemental Analyzer Status” → “Detector” and 

auto-adjust at 1000 µv. At the end of a run the baseline may have dropped to 980 µV - 

this is ok.  

 

Instrument Calibration 

 It is a good idea to run a standard curve before running your samples to ensure the system is 

working properly, but standards will also be run with every sample sequence and combined 

from all the sample runs to create a master calibration curve for the season. Below is an 

outline for running the standard curve. 

 

1. Calibration standards are made in tin cups (CE Elantech, part # 252-080-00). Standards 

must be weighed on a microbalance. We do not have a microbalance in the Priscu Lab 

and have been using the one in the LRES EAL (Environmental Analytical Lab) in Leon 

Johnson Hall. The standards (acetanilide and soil reference) should be dried at 85° C for 

24 hours and stored in a desiccator at room temperature until use.  

 

2. Clean items that will be used for packing the tin cups (glass plate, forceps, micro-spatula, 

crimper and cylindrical tool (Figure 16)) with acetone or ethanol, wipe well with a 

Kimwipe, and wipe down with DIW.   

 
Figure 16. 

 

3. Using forceps, place a single tin cup on the micro-balance and tare.  Remove the cup 

from the balance and place on the glass plate. 

 

4. Use the micro-spatula to add a small amount of acetanilide standard (CE Elantech, 338-

367-00, % C = 71.09, % N = 10.36) to the tin cup.  Record the weight of the tin cup 

containing standard. Place the tin cup in the crimper and use the cylindrical tool to fold 

the top of the cup over, crimp and compact. Weigh again to ensure no standard was lost 

during crimping. Prepare a range of acetanilide standards, making a total of at least six 

standards, ensuring the weights are spread out evenly between 25 and 1000 g (0.025-1 

mg).  Based on numerous past analyses of the same filtration volumes for lake water 

samples, the lowest standard needed for N is ~ 50 µg acetanilide and for C is ~ 90 µg 

acetanalide. The highest standard needed for both is 0.6 mg for ELB, WLB, HOR, MIE, 

and the highest for FRX is 1 mg. 

 

5. Weigh between 5-30 mg of soil reference standard (CE Elantech, 338-400-25, % C = 3.5, 

% N = 0.37) following the procedure for the acetanilide standards. When done with the 



 Section 4. Chemical Parameters 
 4.4 Particulate Organic Carbon and Nitrogen 

LTER Limnological Methods Manual Page 112  Method_Manual_JL_092319.docx 

micro-balance, press the brake and shut off, unless you plan you use it within a week or 

so. It is best to leave it on to keep it warmed up and stable if you will be using it again. 

 

6. Crimp three empty tin cups to be used as blanks. 

 

7. Load the auto sampler rack, starting with three instrument blanks (empty places in the 

auto sampler), the three tin cup blanks, and ending with the high standard. Position the 

rack to the zero place (put the empty hole at the zero place) BEFORE filling the rack. 

NOTE that the bottom of the autosampler tray can be removed and cleaned by taking out 

the 3 screws on the bottom of the tray.  

 

8. Set up the Sample Table in the Eager 300 Software by clicking on the “Sample Table” 

icon as shown in Figure 17. Clear the sample table, or continue at the end of the previous 

sample table (any samples previously run will still be saved in the sample table): click on 

“Edit sample” → “Fill sample table.” This will pre-populate the table with rows for all 

your samples. 

i. Sample name: No name. 

ii. File name = Enter date. 

iii. No. samples = Enter the number of samples you have in the auto sampler, 

including zero. 

iv. Sample name index = 0 

v. File name index = 001 

vi. Leave the “unknown” box checked. 

vii. Click “Add” to add rows to table. 

viii. Double click on each sample name cell in the table to enter sample names 

manually. 

ix. Click column A on the row of your first sample and click the box in the window 

that pops up to set the program to the actual sample that will be acquired once you 

start the instrument. This will set the program to record data for the correct 

sample once you start the run. 

 

 
Figure 17. 



 Section 4. Chemical Parameters 
 4.4 Particulate Organic Carbon and Nitrogen 

LTER Limnological Methods Manual Page 113  Method_Manual_JL_092319.docx 

 
Figure 18. 

 

9. Manually rotate the toothed wheel clockwise until the guide location on its rim is aligned 

with the metal pin of the autosampler body. Put the auto sampler containing samples on the 

CN analyzer with the zero place in the start position, in line with the metal pin. When you 

start running the sample sequence, the first sample analyzed will be the one in the zero spot 

(this is always an instrument blank).  

 

10. Reset the baseline with auto-adjust if it has drifted. 

 

11. Start the run by pressing the green arrow on the main screen “Start sequence of samples.” 

 

12. Choose the conditions you want when the sequence of samples is finished and press “Start 

now.” You can choose to have the instrument go into Standby mode (choose this option if 

plan to continue using the instrument within the next 2-3 days), or to have the instrument 

shut down once it finishes the sample run. If you choose to have the instrument shut down, it 

will shut off the detector, and shut down the carrier gas (Helium), reference gas (Helium) and 

furnaces, but not the Oxygen or oven. These can be turned off manually before turning off 

the tanks and analyzer (see Instrument Shut Down section below).  

 

13. (This was Rob VanTreese’s method, but it is not recommended by the manufacturer to run so 

many blank samples. Three at the start of the run should be fine). If you have a lot of samples 

to run and the auto sample tray is full, it is useful to have 10 or so “purge” samples listed at 

the top of the sample table. These can be used while you are setting up your sample run to 

purge the instrument of air before you start your samples. This way you won’t need to use 

auto sampler places in the tray containing your samples for purging during your sample run. 

Place an empty auto sampler tray on the instrument and set the instrument to run the purge 

samples from the sample table.  Once you are ready to start your samples, press stop to stop 

the purge run, replace the auto sampler tray with the one containing your samples, and start 

the run over on the appropriate sample in the sample table. However, keep in mind that 

running excessive purges will use up the copper column faster than needed, so it is best to 

only run as many as needed to get a good baseline. 
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14. To view the sample being run, click on “View” – “View sample being acquired.” This will 

show the chromatogram of the current sample. See the Data Processing section below to 

learn how to determine the peak areas of your standards and samples. 

 

15. Determine the theoretical yield of carbon and nitrogen for each standard.  Acetanilide 

contains 71.09% C and 10.36% N.  Multiply each standard weight by the fraction of C and N 

in the standards to determine the expected g of each C and N, respectively. For example, 25 

g acetanilide contains 17.77 g C and 2.59 g N; 550 g acetanilide contains 390.99 g C 

and 56.98 g N. 

 

16. Plot the peak area vs. the expected mg for each standard and ensure a linear fit with a 

correlation of 0.995 or better, to validate calibration (note that one curve will be made for 

carbon and one curve for nitrogen) (Figure 19). Include the average C and N tin cup blank 

area in the standard curves as 0 mg C and N. Because the CN analyzer is typically very 

stable, standards run with each set of samples can be added to this curve and the resulting 

master curve (C or N) can be used to determine the mass of carbon or nitrogen in each 

sample (see CN Calculations section below). 

 

 
Figure 19. 

 

Sample Analysis (acid-treated filters): 

1. Using forceps (clean as described above), place sample filter on a clean glass plate. 

 

2. Using forceps, fold the filter onto itself twice, and place into a tin cup that has been 

inserted into the crimper. (More detailed instructions can be found in the Flash EA 1112 

Operating Manual, page 121).   Be careful not to puncture holes in the tin cup. Crimp and 

compact the tin cup over to completely cover the sample filter using the cylindrical tool 

(Figure 16).    

 

Note:  This step is largely technique based and, if possible, should be demonstrated by an 

experienced analyst. 

 

3.   Prepare at least 6 acetanilide standards, a soil reference standard and several tin cup 

blanks as described above in the Instrument Calibration section. 
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4. Place the encapsulated samples into the cells of the autosampler tray, dispersed with the 

acetanilide standards, the soil reference standard, the tin cup blanks, filter blanks and 

instrument blanks (see Quality Control section below).  Enter the samples into the sample 

table of the Eager 300 program, and start the run as described in the Instrument Calibration 

section. The acetanilide standards from all sample runs will be combined to create a master 

curve for Carbon and a master curve for Nitrogen (Figure 19).   

 

It is best to run the samples in a random order because the instrument will not stay consistent 

over several runs without cleaning out the crucible, and there is drift as the crucible fills up 

and gums up.  Scatter samples and stds, as well as blanks, as this is the most objective way to 

analyze them.  No carryover has been seen in the instrument unless you grossly overload the 

detector/reactor with sample.  It does gum up, which can cause some carryover.  It is minor 

after one, moderate after two autosampler trays through the same crucible.   

 

Sample Analysis (acid-treated soil/sediment): 

1. Ensure that sediment samples are as homogeneous as possible.  Handle all sample cups 

with forceps to prevent contamination from your skin. 

 

2. Weigh out 15-250 mg of dried sediment (105 C for >24 h) into a tared, pre-formed tin 

cup.  The same tools are used for sediment samples as outlined above for filters. 

 

Note:  This step is largely technique based and, if possible, should be demonstrated by an 

experienced analyst. 

 

3. Follow the same method as describe above for filters for setting up the sample run. 

 

Quality Control 

1. Analyze one blank cup per 20 samples.  Ensure that the blank measures at or below the 

instrument detection limit to check for instrument drift. 

 

2. Analyze one mid-range standard per 20 samples.  Ensure a percent recovery between 90 - 

110 %, when compared to the standard curve, to continue analysis.  If the recovery is not 

within this range, check instrument operation. 

 

3. Analyze one duplicate sample per 20 samples.  Ensure a coefficient of variation of 

between 70 - 130 % to confirm precision.  

 

Instrument Shut Down 

 The instrument can be shut down in a variety of ways. The service specialists at CE Elantech 

recommend leaving the instrument in Standby mode when not in use for up to 2-3 days (i.e. 

over the weekend). If you are not going to use the instrument for longer than this, it can be 

shut down. Standby mode is meant to keep the instrument stable while saving power and gas. 

The part of the instrument that can have instability is the detector, so this is automatically left 

on when the instrument is in Standby mode, and the gases are left on at a low flow (10 

ml/min). The important thing is to never have the detector on when the gases are off. 
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However, the tech at CE Elantech also said we should shut off the gases for a 2-5 minutes 

before opening up the system, and that it was ok to leave the detector on when the gases are 

off for the short time when working on the system. 

 

If the instrument was set to shut down after your sample run, the detector, carrier gas 

(Helium), reference gas (Helium) and furnaces should be off, but not the Oxygen or oven.  In 

the “Edit Elemental Analyzer Parameters” screen, manually click the boxes next to “Oven” 

(Temperature tab) and “Oxygen” (Flow/Timing tab) to shut these off and press “Send.” Then 

follow the bullets below: 

 

If the instrument was set to Standby mode after your sample run, the furnaces should be at 

50% of operating temperature, and the Helium flows (Carrier and Reference) should be at 10 

ml/min. The detector will still be on. In the “Edit Elemental Analyzer Parameters” screen 

manually click the boxes to set the furnaces, oven, detector and gases to off and press “Send” 

(remember to never have the detector on when the gases are off). Then follow the bullets 

below: 

 

 Turn the main power to the instrument off.  

 Then turn the gas flow at the gas cylinders off (never have the gases off while the 

instrument is on).  

 Replace vent plug (brass plug in Figure 8) when completed and instrument is off to 

keep dust out of the instrument. Also be sure to replace the plexiglass cover over the 

autosampler when the instrument is stored for a while. 

 

If you want to turn off the instrument when it is at full temperature, it is best to let the 

furnaces cool down before turning off the gases (this will help avoid cracking in the quartz 

column).  This is most easily accomplished by setting it to Standby mode by clicking the box 

next to “Set instrument to Standby” in the “Edit Elemental Analyzer Parameters” screen and 

clicking “Send.” This will allow the furnaces to cool down with the gases at Standby flow 

(10 ml/min). Once the furnaces reach stand-by temperature, follow instructions above for 

turning off the instrument from Standby mode.  

 

If you need to prepare the reactors after a run, the furnaces should be shut off, and the 

Helium flow reduced using the Standby function. This can be done in the “Edit Elemental 

Analyzer Parameters” screen by clicking the boxes next to the furnaces to shut them off, and 

by clicking the box next to “Set instrument to Standby,” and clicking “Send.” It is best to 

leave the Helium on at low flow while changing the reactors to keep the detector stable by 

avoiding getting a lot of air in the system. 

 

Note that every time you click “send” to send a new temperature, flow setting, etc. to the 

instrument, it will ask if you want to save it. It is best to click no to this option so that these 

temporary changes (setting the instrument to standby, turning off flows to change columns, 

etc.) are not saved to the .eam file, and only the working parameters will be saved to that file.  

 

Data Processing 
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During 2014, CE Elantech had us change the integration parameters in the Eager 300 program. 

The Eager program is able to store a standard curve (you would have to run samples as 

standards in the sample table; blanks as blanks, etc) and calculate results, but we do not use 

it in this way. We run all of our samples as unknowns and do our standard curve calculations 

externally. Some of the changes they had us make would affect how the program makes the 

standard curve, but some helped with peak integrations. We felt that the C and N peaks were 

better integrated with these changes. Details are in the 2013 CN Analytical Notebook (pg 

43).   

 

1. Open Eager 300 for EA 1112 

a. Click on “View” → “View chromatograms.” 

b. Click on “File” → “Load chromatogram” and choose the file you want to view 

based on the date and number of sample as it was run (0 spot on autosampler is 

sample #1). The file name will be as you named it but you can’t see the sample 

name until you open the file (Figure 20). 

c. Set the manual scale to look at the chromatogram: Click on “View” → “Set 

manual zoom” and set: Full Scale V = 10; Scale offset = 0; Start time = 0; end 

time = 5.67 min (340 sec) (this is how long it takes to run each sample). 

d. The computer program quantifies the carbon peaks; you may need to quantify the 

N peaks manually.  

e. Click and drag the box to zoom in on the N or C peak. For the N peak, zoom in to 

view the peak at ~1.7 mvolt scale to look at peak (it is best to be consistent with 

the scale between samples if you need to manually integrate the peak). Retention 

times: N = 1.8 min (108 sec); C = 3.6 min (216 sec).  

f. Manual integration: To manually integrate a peak (this can only be done if the 

peak has NOT been automatically integrated by the program) click on “Peak” → 

“Add peak.” Hold the cursor above the baseline where you think the peak starts 

and a red line will appear on the baseline. Click where you want peak to start, and 

a dotted line will appear. Drag the cursor to where want the peak to end and click 

there to end integration. It is best to manually set the window to be the same every 

time when manually integrating peaks (i.e. 0-1.7mV on y-axis and 1.2 min (72 

sec) to 2.4 min (144 sec) on the x-axis for a nitrogen peak).  

g. When you have adjusted the peaks as desired, click on “show” → “view peak 

data” and write down the area values. The arrow at the bottom of the 

chromatogram tells you which peak you are viewing. When zoomed out the arrow 

is on the last peak you were looking at. 

h. If want to start over, click on the “Home” button (Figure 20).  

 

You may see a dip in the baseline at ~0.25 minutes. The dip represents the 

pressure drop that occurs when the autosampler indexes to the next position. As 

long as it stabilizes before the analyte gases come off the column, its ok. 
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Figure 20. 

 

CN calculations (filters): 

 

The mass of carbon and nitrogen in each sample is calculated from the master standard curve 

(described in the Instrument Calibration section above) using the peak area for each sample 

(Figure 19). The final concentration in the lakewater is calculated as follows: 

 

 

Carbon (µg/l) =   (((sample area – blank area)-y-intercept)/slope)*1000*1000 

                                         ml filtered 

 

Where: 

sample area = area determined by the CN analyzer (sample + filter + tin cup) 

blank area = average area of blank filters determined by the CN analyzer (filter + tin cup) 

y-intercept = area when Carbon or Nitrogen mass is zero 

slope = area/mg C or N 

1000 = conversion factor (µg / mg) 

1000 = conversion factor (ml / L) 

ml filtered = ml of sample filtered in the field 

 

The calculation for soil/sediments is the same, except a filter blank does not need to be 

subtracted, and the sample area will = (sample + tin cup). 

 

Technical Support 

 

CE Elantech: 732-370-5559 

 

 Rick Hancock is the president of the company and is very helpful, but anyone at this number 

can help. Trish Rose is the person to talk to for ordering supplies. Questions can also be sent 

to service@ceelantech.com. If you want the tech people to look at files from the Eager 300 

program, send them the .dat, .eam, .mth files.  

 

References 

CE Instruments Flash 1112 Elemental Analyzer Operating Manual. 

mailto:service@ceelantech.com
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CE Instruments Eager 300 Software Operating Manual.  

CE Instruments Flash EA 1112 Consumables and Spare Parts Catalog. 
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Total Particulate Phosphorus Analysis: Manual Method 
(This analysis was started during the 2003-2004 season) 

 

General Discussion 

This method for the analysis of total particulate phosphorus in natural waters is based on 

the digestion procedure to Solorzano and Sharp (1980), and on a modification developed by 

Murphy and Riley (1962) and Strickland and Parsons (1972).  Residue collected on a filter is 

treated with magnesium sulfate and baked at high temperature to decompose organic phosphate.  

The residue is then treated with hydrochloric acid to hydrolyze polyphosphates and the 

orthophosphate is measured by the Molybdate method (see method for SRP analysis in this 

manual). Analysis of orthophosphate depends on the reduction of a stable phosphomolybdate 

complex by ascorbic acid in the presence of antimony. A blue sol is produced, proportional in 

color intensity to orthophosphate concentration within the range 5-250 µg P liter-1. This method 

is linear in the range of 0.2 – 8.5 M P.  Solórzano and Sharp (1980) and Angelo (Ph.D. 

dissertation, 1988) showed that the method gives 100% recovery with refractory phosphorus 

compounds. 

 

Materials 

Sampling Hut 

1000 ml Amber HDPE bottles 

Dry Valleys Lab 

Graduated cylinder 

Vacuum pump 

25-mm GF/F filters, pre-combusted (to remove organic phosphorus) and acidified. 

 (Combustion protocol: combust at 475oC for 4 hrs spread out on aluminum foil that will 

 serve as a wrapper after combustion and acidification. Acidification protocol: soak in 1% 

 HCL for 3-4 hours, rinse 4X with DIW, lay out on combusted foil to dry, and wrap in foil 

 once dried). 

25 mm Polysulfone filter towers 

Aluminum weight boats 

Zip Lock Bags 

Filter forceps 

MSU Lab - Labware (sample processing – NOTE: glassware should be kept together for use 

only for PP analysis) 

Spectrophotometer with 5 cm glass cuvette 

Aluminum Foil 

Glass scintillation vials (20 ml): acid rinsed with 1% HCL + 3X DIW  

Plastic-lined Caps for scintillation vials: acid rinsed with 1% HCL + 3X DIW  

 (an easy method for rinsing the vials is to fill them ½ way with HCL, put the caps  on, 

soak for ~ 15 min, flip them over, soak ~ 15 min, and rinse with DIW. The  vials can be 

dried in the oven at ~50 C with the caps off.) 

50 ml Falcon tubes 

Volumetric flask set for standards (1 x 1000 ml, 8 x 100 ml, 1 x 50 ml, 3 x 500 ml)  

Volumetric pipet set for standards (2 ml, 5 ml, 10 ml, 20 ml) 

Graduated cylinders (glass) (1000 ml, 500 ml, 100 ml for mixed reagent) 



 Section 4. Chemical Parameters 
 4.5 Total Particulate Phosphorus 

LTER Limnological Methods Manual Page 121  Method_Manual_JL_092319.docx 

Glass bottles (for storing reagents) (1000 ml x 3, 500 ml x 5)  

p-1000, p-10ml Pipetman and Eppendor repeater pipet plus tips (1% HCL + 3X DIW  rinsed) 

Transfer pipets (1% HCL + 3X DIW rinsed) 

Falcon tubes 

Parafilm 

 

RINSE ALL GLASSWARE WITH 1% HCL + 3X DIW. As with all organic analyses, special 

care including prior acid-washing is required with the glassware. The glassware should be used 

only for the organic phosphorus determination. We have found that Falcon tubes do not interfere 

with the chemistry involved in color development during soluble reactive phosphorus 

determination. 

 

MSU Lab Reagents (make prior to start of sample processing) 

Magnesium sulfate solution (0.017 M MgSO4):  Dissolve 2 g MgSO4 (or 4.2 g MgSO4 7H2O) in 

1000 ml DI water.  Store in a glass bottle (Stable for months).  

 

Sodium sulfate solution (0.17 M Na2SO4):  Dissolve 12 g anhydrous Na2SO4 in 500 ml DIW.  

Store in a glass bottle (Stable for months). 

 

Hydrochloric acid (0.2 M HCl):  In a 1L graduated cylinder, dissolve 16 ml of concentrated HCl 

in 800ml DI water.  Bring to volume with DI H20.  Store in a glass bottle (Stable for 

months). 
 

Hydrochloric acid (2.0 M HCl): In a 500 ml graduated cylinder, dissolve 80ml of concentrated 

HCl into 300 ml of DI water.  Bring to volume with DI water.  Store in a glass bottle (Stable 

for months). 
 

Sulfuric acid (5N) (STRONG ACID!):  Carefully add 140 ml concentrated sulfuric acid (H2SO4) 

to 800 ml DIW in a 1000 ml graduated cylinder.   Caution: mixture will become very hot!  Bring 

to 1000 ml with DI water.  Store in a glass bottle on the shelf.   

 

Color Reagents (TOXIC) 

Potassium antimonyl tartrate (PAT) solution (TOXIC):  Bring 2.73 g of potassium antimony 

tartrate (K(SbO)C4H4O6 ½H2O) to 500 ml with deionized water in a 500 ml graduated cylinder.  

Place parafilm over the cylinder and carefully invert until the salt is in solution.  Transfer to a 

clean 500 ml glass bottle and store in the dark at 4 C. This solution is stable for months. 

 

Ammonium Molybdate solution (TOXIC):  Add 15 g ammonium molybdate ((NH4)6 Mo7 O24 

4H2O) to 500 ml graduated cylinder and bring to volume with deionized water.  Place parafilm 

over the cylinder and carefully invert until the salt is in solution. Transfer to a clean 500 ml glass 

bottle and store in the dark at 4 C. This solution is stable indefinitely. 

 

Standards 

NIST SRM 1515 – Apple Leaves (0.159% +/- 0.011% P): pre-dried at 80 degrees C for 2 hours and 

desiccated. 
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Procedure 

Sample Collection 

1.   Fill a 1000 ml HDPE amber bottle (rinse 3x with sample water before filling with sample) 

with 1000 ml of sample from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and invert 

Niskin ~ 5 times). Place in cooler for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

Rinse filter towers and graduated cylinders with 1% HCL + 3X with DIW before each limno 

run. Rinse with DIW between different sample depths. 

 

2. Particulate phosphorus lake water samples are taken from the 1000 ml amber Nalgene bottle.  

Gently invert the bottle, thoroughly mixing sample, and decant 500 ml into a graduated 

cylinder. 

 

4. Use a six place manifold with 25 mm polysulfone filter towers.  Place a combusted and acid 

leached 25 mm GF/F onto the polysufone filter base, replace tower, and filter the sample 

under low pressure (<10 in Hg).  Note:  The filter tower will only hold 200 ml of sample, 

therefore, continually top off the sample until the entire volume is filtered.  Furthermore, 

many of the Lake Bonney samples will take between 6-12 h to filter, thus plan accordingly. 

The entire volume should be filtered, even for chemocline depths at Lake Bonney and Lake 

Fryxell.   

 

♦♦♦♦♦ Record the volume of water filtered for each depth in each lake. ♦♦♦♦♦ 

 

4. Once the entire volume is filtered, remove with forceps and place the filter (organic matter 

up) in an aluminum weigh boat with the sample information (including volume filtered) 

clearly etched into the bottom of the dish (do not use a Sharpie or lead pencil to mark and 

etch the dishes – use a relatively sharp and clean object, such as forceps). Store weigh boats 

on clean aluminum foil while the rest of the samples are filtered. Make sure to keep the 

bottom of each weigh boat clean as the bottom of each boat will be in contact with the filter 

in the boat under it during packaging. Once all the samples are filtered, stack the aluminum 

weigh boats together, ensuring the bottoms are clean. Place an empty one on top. Tape 

together, wrap in foil, and store frozen in a zip lock bag. Include three GF/F filters from the 

same packet of combusted and acidified filters used for the samples to be analyzed as 

blanks. 
 

Below steps to be conducted in MCM Crary or MSU Lab 

 

A. Standard preparation 

 

Preparation of Stock Standards: 

 

Always fill volumetric flasks partway with DIW before adding reagents. Always pipet reagents 

out of Falcon tubes to keep stocks clean. 
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Stock phosphate standard “A” (1 mM P):  Bring 0.1361 g KH2PO4 (fw 136.1) (dry in desiccator 

before use) to 1000 ml with deionized water in a volumetric flask. Store refrigerated in a clean 

glass bottle. This stock should not change for at least 4 months if stored properly and not 

contaminated (e.g. shows no signs of bacterial growth). 

 

Intermediate phosphate standard “B” (0.01 mM P): Using a glass volumetric pipette, bring 5 ml 

of room temperature (put a fresh aliquot in a Falcon tube each day) stock “A” to 500 ml with 

DIW in a volumetric flask. Make this standard fresh daily.  

 

Preparation of Working Standards: 

 

Always pipet reagents out of Falcon tubes to keep stocks clean. Rinse volumetric pipets in 

standard before use to get out DIW from rinsing.  

 

Solution C: For each working standard through #5 in Table 1, add 0.3 ml 0.17 M Na2SO4 (use 

Pipetman), 2 ml 0.017 M MgSO4 (use Pipetman), 3 ml 2M HCl (use Eppendorf repeat 

pipettor), to approximately 60 ml deionized water in an acid-rinsed 100 ml volumetric flask. 

(If you choose to use a 500 ml flask for 1a and 1b, be sure to scale the above reagents 

appropriately for the new flask size). 

 

Use a volumetric pipet to add intermediate phosphate standard “B” to each volumetric flask as 

outlined in the table below. Do not “blow out” the pipet; just touch the side of the flask to get 

any drops off the pipet. Bring volume to 100 ml with deionized water and mix by inverting 

three times.  

 

Prepare standards # 6 and #7 if needed. 

 

Standards can be kept at room temperature with caps on and used for 1 day. Glassware can be 

DIW rinsed (HCL rinse not needed after the initial cleaning) before the next use as long as 

the same flasks are used for the same standards each run.  

 

 

Table 1. Working Standards: Prepare the working standards according to the 

below table.  Use glass volumetric pipettes and volumetric flasks only. This 

range of standards should cover the concentrations of hydrolyzed PP that exist 

in Lake Bonney. Include a 2 M standard if sample absorbances exceed that of 

the 1 M standard. 

 

Preparation of working standards for PP analysis 
STD # mls of 0.01 mM stock “B” to 

solution “C”. Bring to 100 ml with 

deionized water 

Final Concentration. (M 

P) 

Blank 0 0 
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Blank 0 0 

1a 1 (or 5 ml to 500 ml DIW) 0.1 

1b 1 (or 5 ml to 500 ml DIW) 0.1 

2a 2 0.2 

2b 2 0.2 

3a 5 0.5 

3b 5 0.5 

4 10 1 

5 20  2 

6 Volumetrically transfer Equal parts of 

“stock B” and  DIW (1:2 dilution of 

stock B) using 20ml vol. pipet into 

50ml falcon tube 

5 

   

*if needed: 30mL stock B                       10 uM P 

  

 

Preparation of Mixed Reagent 

 

Mixed Reagent (TOXIC).  In a 100 ml graduated cylinder, carefully mix 37.5 ml of 5 N H2SO4, 

15 ml of ammonium Molybdate solution, and 7.5 ml of potassium antimonyl tartrate solution.  

Use the graduated cylinder labeled with the fill volume for each reagent – each reagent can be 

poured into the graduated cylinder up to the appropriate volume. Dissolve 0.81 g of Ascorbic 

acid into this solution and bring the solution to 75 ml with deionized water; cover with parafilm 

and invert to mix (can also be vortexed, but this is difficult in a 100 ml graduated cylinder). This 

solution must be made fresh for each sample run.  

 

Tips for making mixed reagent: 

 Let all reagents reach room temperature (for cold reagents, put a fresh aliquot in a Falcon tube 

to bring to room temperature each day) before they are mixed and mix in the order given. Mix 

after addition of each reagent.  

 If turbidity forms in the combined reagent, mix and let stand for a few minutes until turbidity 

disappears before proceeding.  

 This solution should be yellow, not blue! Blue indicates phosphate contamination. 

 This mixed reagent is stable for ~4 h (a fresh mixture should be made for each sample run).  

 75 ml of this reagent is adequate to run 50 samples. 

 

Remove a 30 ml aliquot of each working standard and place into a clean (new, or DIW rinsed 

and dried if using the same tubes for the same standards each run) Falcon tube (this can be 

measured by pouring the aliquot and measuring using the Falcon tube gradations).  Add 3.0 

ml of mixed reagent (at the same time reagent is added to samples – see Sample Processing 

and Measurement section below) and vortex.  30ml volume allows absorbance to be recorded 

before and after sample set. 
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Zero the spec with DIW, and after 1 hour but not more than 3 hours, read absorbance of each 

standard at 885 nm in a 5 cm cuvette (see instruction for using the Ocean Optics 

spectrophotometer at MSU in the Spectrophotometer Procedures section below).    Run the 

standard curve from low concentration to high concentration in duplicate (each standard 

concentration is prepared in duplicate and analyzed to generate a calibration curve with two 

replicates). Be sure to run an end standard curve after running samples. 

 

Prepare a standard curve of phosphate concentration vs absorbance using both the beginning and 

end curves. A typical curve follows (Figure 1).  

 
Slope: 0.10810 

Y int: -0.00685 

R Squared: 0.9983 

 

Figure 1. A typical standard curve of phosphate concentration vs absorbance. 

 

The concentration of phosphate in each sample is calculated from the standard curve using the 

absorbance for each sample. The final phosphate concentration in the lake water is calculated 

as follows: 

 

P (µg/L) =   ((Sabs-Babs)-y-int/slope)*0.015L*D  * 30.973g 

                         Vol filtered (L)                     mol 

 

Where: 

Sabs = measured sample absorbance 

Babs = average measured absorbance of blank filters (corrected for dilution factor, 

                i.e. dilution of 4 = Babs*0.25) 

y-intercept = absorbance when P concentration is zero 

slope = absorbance/µM P 

 0.015 L = Extract volume (15 ml = 5 ml of 0.2 M HCL + 10 ml DIW) 

 D = Dilution factor (i.e. 1 ml sample + 9 ml DIW = 10 fold dilution = Dilution factor  

       of 10 

 Vol filtered (L) = Volume of sample filtered in the field 

 30.973g/mol = molar mass of P  

Standard Curve: three separate runs (combined)
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B. Sample Processing and Measurement 

 

Always pipet reagents out of Falcon tubes to keep stocks clean.  

 

1. Place filter on a clean 25 mm fritted base and rinse filter twice with 2-ml aliquots of 0.17 M 

Na2SO4.  Filter at < 7 in Hg.  (Just a step to rinse excess salts off filters.)  

 

2. Transfer filter to an acid-rinsed 20-ml scintillation vial and add 2 ml 0.017 M MgSO4. 

              

3. Dry the sample completely in a clean oven at 95 C with no cap on the scintillation vial.  

 

4.  Loosely cover the vial with aluminum foil.  Transfer the vial to a muffle furnace and bake at 

500 C for 2 h.  Sharpie labels will burn off the glass vials in the muffle furnace, so be sure to 

keep track of the order the vials are put in the furnace. After cool, cap tightly with acid rinsed 

caps.  Samples can be stored at this point. Samples can be stored at any temperature but 

it is best to keep them in a dry location, either in a box with some silica gel packs or in a 

desiccator if available. However, if the vials are well sealed this is probably not 

necessary. 
 

5. When ready to proceed, add 5 ml of 0.2 M HCl and cap tightly (acid-rinsed polypropylene-

lined). 

 

6. Heat sample in an 80 C oven for 30 min.  Make sure the samples do not boil or evaporate 

off (i.e. be sure oven doesn’t rise above 80 C.) 

 

7. Remove vials from oven and allow to cool.  Then, uncap and add 10ml deionized water to 

the scintillation vial (total volume in vial will be 15 ml).   

 

8. Add 1.5 ml of mixed reagent and vortex thoroughly. (1:10 v/v ratio of mixed reagent to 

sample) 

 

9.   If cloudy, transfer solution to a clean 50ml Falcon tube and centrifuge at ~2000 rpm for ~ 5 

min (to decrease turbidity). This step can be omitted if the solution is clear. Rob said you 

could alternately syringe filter the sample.  

 

10. Zero the spec with DIW (see instruction for using the Ocean Optics spectrophotometer at 

MSU in the Spectrophotometer Procedures section below) and run the standard curve before 

running the samples (outlined above in Standard Preparation section).  

 

11. After 1 hour but not more than 3 hours from the time the mixed reagent was added, read 

absorbance of samples at 885 nm in a 5 cm cuvette.  Rinse cuvette with DI water between 

samples.  Run samples from low to high concentration based on the color of each sample 

(light blue = low concentration; dark blue = high concentration). Every 10 samples run DIW 

and one standard (the standard will have to be re-used for the end curve since there is only 

enough standard to run twice). Remember to run an end standard curve and finish by running 
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DIW one last time (see the Spectrophotometer Procedures section below for more details on 

running samples and standards). 

 

NOTES: 

 A 5 cm cell holds 13 ml of sample and should be filled completely (e.g., so sample enters the 

filler tubes) for accurate readings.   Be sure to turn spec on at least 30min before beginning 

analysis to let lamp warm up. 

 

 The MgSO4, is used as an acidic solution (after addition to the water sample, the pH should be 

~3) to minimize silicate leaching from the glassware during evaporation step. The acid and 

heating are necessary to hydrolyze any condensed phosphates in the final mixture. 

 

 Optimal color development occurs at pH > 0.7.  

 

 The samples can be processed through the drying step then stored capped at room temperature 

for later analysis.   

 

C. Internal Apple Leaf Standard  

 

To test the recovery of the method, an internal apple leaf standard (NIST SRM 1515 – Apple 

Leaves (0.159% +/- 0.011% P) should be run with each set of samples. Recoveries should be 

between 90 and 110%. If they are out of this range, the reagents should be checked and the 

standards rerun.  

Before starting, decontaminate all surfaces involved in the process (weigh dish, microbalance 

tray, forceps, etc) by soaking them in 1% HCl for at least 10 minutes. 

Weigh between 1 and 3 mg of dried and desiccated standard onto a combusted and acidified 

GF/F using the Cahn microbalance. Record the mass of the standard. The filter will need to be 

folded in half in order to fit it onto the pan of the microbalance. 

 

Treat the filter containing the standard the same way as your samples, starting with the addition 

of 0.017 M MgSO4 (exclude the 0.17 M Na2SO4 rinsing step). While samples are in the oven 

drying, be sure to cover loosely with aluminum foil to ensure no contamination due to settling 

dust particles. 

 

Calculate the percent recovery of Calculated P / Measured P. 

 

Calculated µMP = (µg apple leaf std * 0.00159)  *   _mol_  

                                                  0.015 L                    30.973g 

 Where: 

 0.00159 = 0.159 % P in apple leaf standard / 100 

 0.015 L = Extract volume (15 ml = 5 ml of 0.2 M HCL + 10 ml DIW) 

 30.973g/mol = molar mass of P 
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Measured µMP = (abs-y-int)/slope 

 

Where: 

abs = measured absorbance of apple leaf standard 

y-intercept = absorbance when P concentration is zero 

slope = absorbance/µM P 

 

D. Spectrophometer Procedures for the Ocean Optics Jaz 

 

 The halogen light source is used for detection of phosphorus 

 Don’t kink the blue cables between components of the system; keep the bend angles of 

the cable large. 

 

1. Turn on the light by turning the power switch on the light source to “on” (make sure the 

shutter is closed by switching the shutter lever to the middle position) (Figure 2, 3). 

 

2. Let the light warm up for 15 minutes. 

 

3. Press the red “on” switch on the spectrometer (Figure 2, 4). 

 

4. Open the SpectraSuite program on the laptop (Figure 6). 

 

5. With the shutter still closed, click the “black light bulb” in the menu at the top of the 

SpectraSuite graph to store the dark spectrum. 

 

6. Click the “- black light bulb” to subtract out the dark spectrum. The red baseline in the graph 

should go to zero. 

 

7. Fill the cuvette with DIW using a transfer pipet (rinse with 1% HCL + 3X DIW before 

using). Clean ends of cuvette with Kimwipe and put in cuvette holder as shown in Figure 2, 

5. It is important to always put the cuvette in the holder in the same position and orientation 

to reduce any effects of light transmittance through different parts of the glass. Place the 

black cover on the cuvette holder (shown in Figure 5). NEVER OPEN THE CUVETTE 

COVER WITH THE LIGHT SOURCE SHUTTER OPEN. 

 

8. Open the shutter on the light source by switching the lever to “OPEN.” 

 

9. A peak will appear in the SpectraSuite graphs that will be flat on top. Decrease the 

integration time to 10 miliseconds, and then increase until the peak is at its max, but is not 

flat on top (~ 31 milliseconds). Record value. 

 

10. Increase the Scans to Average to 10 (this will reduce the noise). Record value. 

 

11. Set the BoxCar width (slit width) to 6. Record value. 
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12. Click the “white light bulb” in the menu to store the reference spectrum. 

 

13. Click the “A” in the menu to go to the Absorbance screen (if you need to go back to the 

previous screen, click the “S”). 

 

14. Click on the axis or in the plot close to 885 nm wavelength  on the x-axis and Source and 

Wavelength boxes will appear at the bottom of the screen.  

 

15. Set the wavelength as close as possible to 885 nm (because of the BoxCar width you may not 

be able to get exactly 885 nm. It will likely be 885.14). 

 

16. Record the absorbance from the bottom of the graph (red numbers to the right of the 

Wavelength setting). It should be zero for the DIW. 

 

17. Close the light source shutter before opening the cover of the cuvette holder.   

 

18. Run the standard curve and samples as directed above and following the below guidelines: 

a. Run standards and samples from low to high concentration 

b. Rinse the cuvette with DIW between samples (use a transfer pipet to get the last 

sample or standard out of the cuvette before adding a new one). 

c. Every 10 samples run DIW and one standard (the standard will have to be re-used for 

the end curve since there is only enough standard to run twice).  

d. Remember to run an end standard curve and finish by running DIW one last time. 

e. Fill cuvette to the neck with standard / sample. 

f. Be sure there are no bubbles when filling the cuvette. 

g. Always make sure the light source shutter is closed before opening cuvette holder 

cover. 

 

 
Figure 2. Ocean Optics spectrophotometer. 
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       Figure 3. Light source                     Figure 4. Spectrophotometer 

 

 
Figure 5. Cuvette holder with cover. 

 

 
Figure 6. Ocean Optic SpectraSuite software.
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Ammonium Analysis by Autoanalyzer 

General Discussion 

Ammonia is reacted with alkaline phenol followed by sodium hypochlorite, forming 

indophenol blue.   Sodium nitroprusside is added to enhance sensitivity and the sample is 

analyzed by spectrophotometer on a Lachat autoanalyzer. 

  

Interferences 

1. Salinity has an effect on this analysis. 

2. Calcium and magnesium interfere and are removed with EDTA during the analysis. 

3. Chlorine is an interference and can be removed with sodium thiosulfate.  

4. Turbid samples must be filtered or centrifuged before analysis. 

5. Interferences may also be removed with a distillation step before analysis. 

 

Materials 

Dry Valleys Lab 

Graduated cylinder 

125 ml narrow mouth HDPE bottles (acid washed w/ 1% HCL: Fill half-way with 1% HCL, cap, 

 let sit right-side up for ~1 hour, flip upside-down for ~1 hour, DIW rinse 5 times. Tape 

 with white labeling tape.  1%  HCL can be re-used for other acid rinsing since the bottles 

 are new.) 

Bell jar filter apparatus 

25 mm polysulfone filter funnels 

25-mm GF/F filters, pre-combusted and acidified. (Combustion protocol: combust at 475oC for 4 

 hrs spread out on aluminum foil that will serve as a wrapper after combustion and 

 acidification. Acidification protocol: soak in 1% HCL for 3-4 hours, rinse 4X with DIW, 

 bring the pH to 8-9 with NaOH, rinse 2X with DIW, lay out on combusted foil to dry, 

            and wrap in foil once dried). Combusted and acidified filters are only necessary if certain 

 filtrate samples are being collected. Combusted filters are required for Dissolved 

 Organic Carbon (DOC) filtrate (collected from one Chlorophyll replicate), and acidified 

 filters should be used for nutrient (Soluble Reactive Phosphorus) filtrate (collected from 

 one Chlorophyll replicate). Since the filtrate for both DOC and nutrient samples comes 

 from the chlorophyll-a filtration, it is recommended to both combust and acidify all filters 

 used for chlorophyll-a filtration. 

MCM Crary Lab 

20 ml polycarbonate tubes with snap caps 

Assorted volumetric flasks (100, 250, 500 ml). 

Lachat QuikChem AE Analyzer. 

P1000 Gilson Pipetman and tips 

P200 Gilson Pipetman and tips 

P5000 Gilson Pipetman and tips 

Stir plate 
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Glassware preparation 

1.Wash glassware using standard laboratory technique:  Liquinox soap, rinse 3x with tap water; 1 

% HCl,  then 6x with DI water. 

 

Reagents 

EDTA Buffer:  Dissolve 50.0 g of disodium ethylenediamine tetraacetate (EDTA) and 5.5 g of 

sodium hydroxide (NaOH) in 900 ml of DI water.  Dilute to 1000 ml with DI water.  

 

Sodium hypochlorite:  Dilute 250 g of Clorox bleach to 500 ml with DI water.  Prepare weekly. 

 

Sodium phenolate:  Add 41.5 g of crystalline phenol (C6H5OH) to 300 ml DI water, in a 500 ml 

beaker.   Add a stir bar and dissolve by stirring at a moderate speed.  Turn the stir speed 

down to slow and, carefully, add 16 g of sodium hydroxide (NaOH).  Cool the solution and 

dilute to 500 ml with DI water. 

Stock Ammonia solution: NH4
+ (1000 mg l-1).  Dissolve 3.819 g of anhydrous NH4Cl in 1000 ml 

of DI water. 

 

Standard Ammonia solution: NH4
+ (10.0 mg l-1).  Dilute 10.0 ml of stock ammonia solution to 

1.0 l with DI water. 

 

Spiking Ammonia solution: NH4
+ (50 mg l-1).  Dilute 5.0 ml of stock ammonia solution to 100 ml 

with DI water. 

 

Procedure 

Below steps to be conducted in Dry Valleys Lab 

Sample Collection 

1.  The filtrate produced from the chlorophyll-a filtration (Section 3.1) is collected for nutrient 

analyses. 

 

Rinse filter towers and graduated cylinders with 1% HCL + 3X with DIW before each limno 

run. Rinse with DIW between different sample depths. 

 

2. Gently invert the 1000 ml amber HDPE bottle, thoroughly mixing the sample, and decant 

100 ml into a graduated cylinder. 

 

3. Place a combusted 25 mm GF/F onto the filter base, which is mounted on a vacuum bell jar, 

and replace tower.  Place an acid washed 125 ml narrow mouth HDPE bottle directly under 

the filter base.  The filter is used as a replicate for Chlorophyll-a analysis (see Chlorophyll-a 

method); therefore, filtering must be performed in the dark. 

 

4. Filter the sample under low pressure (<7 in Hg).  Collect 100 ml of the filtrate in the narrow 

mouth HDPE bottle. Do not rinse the filter tower with DIW if you still need to filter the DOC 

sample.  Only rinse the filter towers between sample depths.  Carefully remove the bell jar, 

cap the nutrient bottle (one bottle is used for analysis of all nutrients) and immediately freeze 
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sample (nutrient samples can be kept on the floor of the lab during the filtration process, then 

placed at -20oC). Store frozen until analysis. 

 

5. Prepare at least one filtration blank for nutrients by filtering DI water through the filter tower 

apparatus. This should be done before starting the sample filtration. 

 

Below steps to be conducted in MCM Crary Lab 

Instrument preparation 

1. Inspect the pump tubing and PTFE tubing and replace as needed.   Pump tubing is inspected 

by rolling the tube between your thumb and index finger and checking for flat spots.  The 

PTFE tubing is generally changed out completely at the beginning of each season. 

 

2. Fill the diluter bottle and the water reservoir with fresh DI water directly from the purifier.   

Ensure that the waste container has enough empty space for the full day’s analysis and that 

the waste lines are properly positioned in the container.  Allow the instrument to warm up for 

15 minutes. 

 

3. Turn the instrument on and wait for the instrument computer to boot up.  Type 'Q' and then 

'tester' and hit enter.   The instrument will check all functions for proper operation.  Prime the 

diluter by hitting 'P' and enter.  Type 'QQ' to quit tester.   Type CC to start analysis program. 

 

4. On the auxiliary (Win95) computer, double click on the Lachat icon.  From 'methods' go to 

'analysis select' then 'download'.  Select the method and wait for method to load. 

 

5. Identify the sample line and the carrier line, rinse the ends well with DI water and place into 

the water reservoir.  Cover the top of the reservoir with parafilm to prevent contamination 

into the reservoir. 

 

6. Identify the NH4
+ channel reagent lines (3) and place them into a beaker filled with DI water. 

 

7. Identify the reagent, carrier and sample line pump cartridges (5).   Adjust the line tension all 

the way loose and lock them in place on the pump.   Increase the line tension  two clicks. 

 

8. Turn the pump on and run DI water through all the lines to clear any air bubbles. 

 

9. Remove the reagent lines from the beaker.  Allow a few cm of air to enter the lines, tap ends 

on side of beaker to remove water from the fittings and place in their respective reagent 

bottles  

 

10. Allow the air bubbles from step 9 to be expelled from the system. 

 

11. Turn the pump flow to low and allow the system to equilibrate while preparing standards. 
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Instrument calibration 

1. Prepare five NH4
+-N standards (A-E).  To labeled, 100 ml, volumetric flasks, add 2.0, 1.0, 

0.50, 0.50 and 0 ml of NH4
+-N standard ammonia solution, diluting to volume, to make 200, 

100, 50, 5 and 0 g/l standards, respectively. 

 

2. Pour each standard into a separate, labeled, 20 ml polypropylene scintillation vial and place 

in the labeled spaces in the calibration rack of the instrument. 

 

3. On the auxiliary computer, select calibration, start calibration to begin instrument calibration. 

 

4. Observe the first standard's (A) deflection and ensure that the sample window encloses the 

high part of the deflection.   If window is out of this range, turn the column bypass valve to 

bypass flow and consult the Lachat operation manual to move window.   Allow instrument to 

equilibrate and repeat steps 3 and 4 until satisfactory measurements are made. 

 

5. After calibration standards are all analyzed, go to the Results/Approval area on the auxiliary 

computer and ensure that both curves have a correlation coefficient of 0.995 or better to 

validate calibration. 

 

Sample Analysis 

1. Perform dilutions on samples listed on the "Dilutions for Nutrients on Lachat Autoanalyzer" 

chart located in the operating manual and on page 94 of this manual. 

 

2. Pour each sample into a polycarbonate tube and place in the autosampler tray.  The pH of 

samples, wash water, and calibration standards should be approximately the same. 

 

3. Enter the sample numbers and dilutions under the tray definition section of the auxiliary 

computer and submit to start analysis. 

 

Quality Control 

1. Analyze one reagent blank (DI water) per 20 samples.  Ensure that the blank measures less 

than the instrument detection limit to check for instrument drift. 

 

2. Analyze one mid-range standard as continuing calibration verification (CCV) per 20 samples.   

Ensure a percent recovery between 90 - 110% to continue analysis. 

 

3. Analyze one duplicate analysis per 20 samples.   Ensure a relative percent deviation of 

between 80-120% to confirm precision. 

 

4. Prepare one sample spike for every 20 samples.  Fill a 10 ml volumetric flask to mark with 

sample.   Add 40 l of 50 mg l-1 spiking solution and vortex.   This makes a 200 g l-1 NH4
+-

N spike.  Ensure a percent recovery of between 80-120% to verify no matrix interference. 
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Instrument Shutdown 

 

1. Remove the reagent lines from the reagent, tapping the ends on the side of the bottle to 

remove excess reagent and place in a beaker containing DI water.   Flush the system to 

remove all reagents from the channel tubing. 

 

2. Turn the pump off, release tension on the pump cartridges and release the cartridges from the 

pump. 

 

3. Remove reagent lines from the DI water and place ends in a clean beaker.   Remove the 

sample and carrier lines from the water reservoir and place ends in a separate beaker.   Cover 

the beakers with parafilm to prevent contamination. 

 

4. Turn off the instrument. 

 

5. Place lids on all reagent and water bottles.   Check waste bottle and empty if necessary. 
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Nitrite and Nitrate Analysis by Autoanalyzer 

 

General Discussion 

This method is utilized for the analysis of water samples for nitrate (NO3
-) and nitrite 

(NO2
-) by autoanalyzer.  Nitrite levels are determined by diazotization, with sulfanilamide, and 

then coupled with a diamine to produce a pink dye analyzed by spectrophotometer on a Lachat 

autoanalyzer.  Nitrate levels are determined by reducing nitrate to nitrite by passing the sample 

through a copperized cadmium column and analyzing for nitrite, as above, giving a nitrate + 

nitrite (N+N) concentration.   The nitrate concentration is determined by subtracting the nitrite 

concentration from the N+N concentration. 

  

Interferences 

The efficiency of the cadmium column can be affected when samples contain sulfur, residual 

chlorine, heavy metals, or oil and grease.  Samples can be treated by adding EDTA to the sample 

for metals removal, sodium thiosulfate for chlorine removal, organic extraction for oil and grease 

removal, and dilution for sulfur removal.  The column efficiency must be verified. 

 

Materials 

Dry Valleys Lab 

Graduated cylinder 

125 ml narrow mouth HDPE bottles (acid washed w/ 1% HCL: Fill half-way with 1% HCL, cap, 

 let sit right-side up for ~1 hour, flip upside-down for ~1 hour, DIW rinse 5 times. Tape 

 with white labeling tape. 1%  HCL can be re-used for other acid rinsing since the bottles 

 are new.) 

Bell jar filter apparatus 

25 mm Polysulfone filter towers 

25-mm GF/F filters, pre-combusted and acidified. (Combustion protocol: combust at 475oC for 4 

 hrs spread out on aluminum foil that will serve as a wrapper after combustion and 

 acidification. Acidification protocol: soak in 1% HCL for 3-4 hours, rinse 4X with DIW, 

 bring the pH to 8-9 with NaOH, rinse 2X with DIW, lay out on combusted foil to dry, 

            and wrap in foil once dried). Combusted and acidified filters are only necessary if certain 

 filtrate samples are being collected. Combusted filters are required for Dissolved 

 Organic Carbon (DOC) filtrate (collected from one Chlorophyll replicate), and acidified 

 filters should be used for nutrient (Soluble Reactive Phosphorus) filtrate (collected from 

 one Chlorophyll replicate). Since the filtrate for both DOC and nutrient samples comes 

 from the chlorophyll-a filtration, it is recommended to both combust and acidify all filters 

 used for chlorophyll-a filtration. 

MCM Crary Lab 

20 ml polycarbonate tubes with snap caps 

Assorted volumetric flasks (100, 250, 1000 ml) 

Glass test tubes: 13 x 100 mm 

Lachat QuikChem AE Analyzer. 

P1000 Gilson Pipetman and tips 

P200 Gilson Pipetman and tips 

P5000 Gilson Pipetman and tips 
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Stir plate 

 

Glassware preparation 

Wash glassware using standard laboratory technique:  Liquinox soap, rinse 3 with tap water 

then 3 with DI water. 

 

Reagents 

Imidazole Buffer:  Add 13.6 g of imidazole to 1000 ml beaker containing 800 ml of deionized DI 

water.  Add a stir bar to the beaker and stir at medium speed to mix.   Adjust the pH of the 

solution to 8.0 with 1.0 N HCl and adjust the volume to 1000 ml with DI water. 

Sulfanilamide color reagent:  Add 100 ml of 85% phosphoric acid to 600 ml DI water in a 1 

beaker and vortex.  Add 40.0 g sulfanilamide and 1.0 g N-(1-naphthyl)-ethylenediamine 

dihydrochloride (NED).  Place a stir bar in the beaker and stir at medium speed until 

dissolved.  Dilute to 1000 ml with DI water in a volumetric flask.   Store in a dark bottle.  

Reagent should be discarded when pink. 

 

Stock Nitrite solution: NO2
--N (1000 mg l-1).  Dissolve 6.072 g KNO2 (dried in a desicator for 24 

h) in nitrite-free water and dilute to 1000 ml. 

 

Stock Nitrate solution: NO3
--N (1000 mg l-1).  Dissolve 7.218 g of KNO3 (dried in an oven at 

105 C for 24 h) in water and dilute to 1000 ml. 

 

Standard Nitrite-Nitrate solutions: (10 mg l-1).  Dilute 10.0 ml of each stock solution to 1000 ml 

with DI water. 

 

Spiking Nitrite-Nitrate solutions: (50 mg l-1).  Dilute 5.0 ml of each stock solution to 1000 ml 

with DI water. 

 

Procedure 

Below steps to be conducted in Dry Valleys Lab 

Sample Collection 

1.  The filtrate produced from the chlorophyll-a filtration (Section 3.1) is collected for Nutrient 

analyses. 

 

Rinse filter towers and graduated cylinders with 1% HCL + 3X with DIW before each limno 

run. Rinse with DIW between different sample depths. 

 

2. Gently invert the 1000 ml amber HDPE bottle, thoroughly mixing the sample, and decant 

100 ml into a graduated cylinder. 

 

3. Place a combusted 25 mm GF/F onto the filter base, which is mounted on a vacuum bell jar, 

and replace tower.  Place an acid washed 125 ml narrow mouth HDPE bottle directly under 

the filter base.  The filter is used as a replicate for Chlorophyll-a analysis (see Chlorophyll-a 

method); therefore, filtering must be performed in the dark. 

 



 Section 4. Chemical Parameters 
 4.6 Macronutrients / Nitrite-Nitrate 

LTER Limnological Methods Manual Page 138  Method_Manual_JL_092319.docx 

4. Filter the sample under low pressure (<7 in Hg).  Collect 100 ml of the filtrate in the narrow 

mouth HDPE bottle. Do not rinse the filter tower with DIW if you still need to filter the DOC 

sample.  Only rinse the filter towers between sample depths.  Carefully remove the bell jar, 

cap the nutrient bottle (one bottle is used for analysis of all nutrients) and immediately freeze 

sample (nutrient samples can be kept on the floor of the lab during the filtration process, then 

placed at -20oC). Store frozen until analysis. 

 

5.  Prepare at least one filtration blank for nutrients by filtering DI water through the filter tower  

     apparatus. This should be done before starting the sample filtration. 

 

 

Below steps to be conducted in MCM Crary Lab 

Instrument Preparation 

1. Inspect the pump tubing and PTFE tubing and replace as needed.   Pump tubing is inspected 

by rolling the tube between your thumb and index finger and checking for flat spots.  The 

PTFE tubing is generally changed out completely at the beginning of each season. 

 

2. Fill the diluter bottle and the water reservoir with fresh DI water directly from the purifier.   

Ensure that the waste container has enough empty space for the full days analysis and that the 

waste lines are properly positioned in the container.  Allow the instrument to warm up for 15 

minutes. 

 

3. Turn the instrument on and wait for the instrument computer to boot up.  Type 'Q' and then 

'tester' and hit enter.   The instrument will check all functions for proper operation.  Prime the 

diluter by hitting 'P' and enter.  Type 'QQ' to quit tester.   Type CC to start analysis program. 

 

4. On the auxiliary (Win95) computer, double click on the Lachat icon.  From 'methods' go to 

'analysis select' then 'download'.  Select the method and wait for method to load. 

 

5. Identify the sample line and the carrier line, rinse the ends well with DI water and place into 

the water reservoir.  Cover the top of the reservoir with parafilm to prevent contamination 

into the reservoir. 

 

6. Identify the NO2
-/NO3

- channel reagent lines (2 for each channel) and place them into a 

beaker filled with DI water. 

 

7. Identify the reagent, carrier and sample line pump cartridges (7).   Adjust the line tension all 

the way loose and lock them in place on the pump.  Increase the line tension  two clicks. 

 

8. Turn the pump on and run DI water through all the lines to clear any air bubbles.  Note: 

Ensure that the cadmium bypass valve is in bypass position so that no water or air passes 

through the column if present. 
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9. Remove the reagent lines from the beaker.  Allow a few cm of air to enter the lines, tap ends 

on side of beaker to remove water from the fittings and place in their respective reagent 

bottles (sulfanilamide and imidazole (2 lines in each)). 

 

10. Allow the air bubbles from step 9 to be expelled from the system. 

 

11. If necessary, install a cadmium column.  Remove the old column, if present.  Using a beaker 

to catch waste, turn the bypass valve in-line, allowing reagent to flow out the line.  Being 

careful not to introduce air into the column, remove the column spacer line and screw one 

end of the column onto the flowing reagent line.  Make sure that there is flow out of the other 

end of the column and connect to the outflow line. 

 

12. Turn the pump flow to low and allow the system to equilibrate while preparing standards. 

 

Instrument calibration 

1. Prepare five NO2
--N standards (A-E).  To labeled, 100 ml, volumetric flasks, add 2.0, 1.0, 

0.50, 0.50 and 0 ml of NO2
--N standard nitrite solution, diluting to volume, to make 200, 100, 

50, 5 and 0 g l-1 standards, respectively. 

 

2. Prepare five NO3
--N standards (F-J).  To labeled, 100 ml, volumetric flasks, add 8.0, 4.0, 2.0, 

1.0 and 0 ml of NO3
--N standard nitrate solution, diluting to volume, to make 800, 400, 200, 

100 and 0 g l-1 standards, respectively. 

 

2. Pour each standard into a separate, labeled, 20 ml polypropylene scintillation vial and place 

in the labeled spaces in the calibration rack of the instrument. 

 

3. On the auxiliary computer, select calibration, start calibration to begin instrument calibration. 

 

4. Observe the first standard's (A) deflection and ensure that the sample window encloses the 

high part of the deflection.   If window is out of this range, turn the column bypass valve to 

bypass flow and consult the Lachat operation manual to move window.   Allow instrument to 

equilibrate and repeat steps 3 and 4 until satisfactory measurements are made. 

 

5. After calibration standards are all analyzed, go to the Results/Approval area on the auxiliary 

computer and ensure that both curves have a correlation coefficient of 0.995 or better to 

validate calibration. 

 

Cadmium Column Efficiency 

1. Fill a 13 100 mm test tube with the 100 g l-1 NO2
--N standard and place in space 1 of the 

sample rack on the autosampler.  Repeat for the 100 g l-1 NO3
--N standard and a blank (DI 

water), placing them in spaces 2 and 3, respectively.  

 

2. On the auxiliary computer, go to the tray definition section and enter the sample names for 

space 1,2 and 3.  Submit the tray to start the analysis. 
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3. Calculate the column efficiency (CE) by the following equation: 

 

 

The acceptable range for CE is 90 - 110 to validate nitrite values.  If the column efficiency is 

outside of this range, a new column must be installed, a new calibration performed and the 

CE procedure repeated. 

 

Sample Analysis 

1. Perform dilutions on samples listed on the "Dilutions for Nutrients on Lachat Autoanalyzer" 

chart located in the operating manual and on page 94 of this manual.   

 

2. Pour each sample into a 13 x 100 mm test tube and place in the autosampler tray. 

 

3. Enter the sample numbers and dilutions under the tray definition section of the auxiliary 

computer and submit to start analysis. 

 

Quality Control 

1. Analyze one reagent blank (DI water) per 20 samples.  Ensure that the blank measures less 

than the instrument detection limit to check for instrument drift. 

 

2. Analyze one mid-range standard, per analyte, as continuing calibration verification (CCV) 

per 20 samples.  Ensure a percent recovery between 90 - 110% to continue analysis. 

 

3. Analyze one duplicate analysis per 20 samples.  Ensure a relative percent deviation of 

between 80-120% to confirm precision. 

 

4. Prepare one sample spike for every 20 samples.   Fill a 10 ml volumetric flask to mark with 

sample.   Add 40 l of 50 mg l-1 spiking solution and vortex.  This makes a 200 g l-1 NH4
+-

N spike.  Ensure a percent recovery of between 80-120% to verify no matrix interference. 

 

Instrument Shutdown 

1. Turn the column bypass valve to the bypass position. 

 

2. Remove the reagent lines from the reagent, tapping the ends on the side of the bottle to 

remove excess reagent and place in a beaker containing DI water.   Flush the system to 

remove all reagents from the channel tubing. 

 

3. Turn the pump off, release tension on the pump cartridges and release the cartridges from the 

pump. 

 

  
 

100
NO

NONONO
CE

2
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4. Remove reagent lines from the DI water and place ends in a clean beaker.   Remove the 

sample and carrier lines from the water reservoir and place ends in a separate beaker.   Cover 

the beakers with parafilm to prevent contamination. 

 

5. Turn off the instrument. 

 

6. Place lids on all reagent and water bottles.   Check waste bottle and empty if necessary. 

 

References 
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Soluble Reactive Phosphorus by Mixed Molybdate: Manual Method 

 

General Discussion 

 

Materials 

Dry Valleys Lab 

Graduated cylinder 

125 ml narrow mouth HDPE bottles (acid washed w/ 1% HCL: Fill half-way with 1% HCL, cap, 

 let sit right-side up for ~1 hour, flip upside-down for ~1 hour, DIW rinse 5 times. Tape 

 with white labeling tape. 1%  HCL can be re-used for other acid rinsing since the bottles 

 are new.) 

Bell jar filter apparatus 

25 mm Polysulfone filter towers 

25-mm GF/F filters, pre-combusted and acidified. (Combustion protocol: combust at 475oC for 4 

 hrs spread out on aluminum foil that will serve as a wrapper after combustion and 

 acidification. Acidification protocol: soak in 1% HCL for 3-4 hours, rinse 4X with DIW, 

 bring the pH to 8-9 with NaOH, rinse 2X with DIW, lay out on combusted foil to dry, 

            and wrap in foil once dried). Combusted and acidified filters are only necessary if certain 

 filtrate samples are being collected. Combusted filters are required for Dissolved 

 Organic Carbon (DOC) filtrate (collected from one Chlorophyll replicate), and acidified 

 filters should be used for nutrient (Soluble Reactive Phosphorus) filtrate (collected from 

 one Chlorophyll replicate). Since the filtrate for both DOC and nutrient samples comes 

 from the chlorophyll-a filtration, it is recommended to both combust and acidify all filters 

 used for chlorophyll-a filtration. 

MCM Crary Lab 

25 ml test tubes (acid soaked and rinsed) 

500 ml amber glass bottles 

Assorted beakers (100, 250, 500, 1000 ml) 

Assorted graduated cylinders (100, 500, 1000 ml) 

Assorted volumetric flasks(100, 250, 1000 ml) 

P10 ml Gilson Pipetman and tips 

Spectrophotometer with 10 cm cells 

 

Reagents 

5N Sulfuric acid (H2SO4):  Carefully add 140 ml concentrated H2SO4 to 800 ml DIW in a 1000 

ml graduated cylinder.  Bring to 1000 ml with DI water.  After cool, store in a polyethylene 

bottle on the shelf. 

Ammonium molybdate solution:  Bring 15 g ammonium molybdate to 500 ml in a 500 ml 

graduated cylinder and vortex.  Transfer to a clean 500 ml glass bottle and store refrigerated. 

Potassium antimonyl tartrate solution:  Bring 2.73 g of Potassium antimonyl tartrate to 500 ml in 

a 500 ml graduated cylinder and vortex.  Transfer to a clean 500 glass bottle and store at 4 

C. 

Stock solution (0.1 mM):  Bring 0.0136 g K2PO4 to 1000 ml with DI water. 

Mixed Reagent:  In a 100 ml graduated cylinder, carefully vortex 50 ml of 5 N H2SO4, 20 ml of 

ammonium molybdate solution, and 10 ml of potassium antimonyl tartrate solution.  Dissolve 



 Section 4. Chemical Parameters 
 4.6 Macronutrients / Phosphate 

LTER Limnological Methods Manual Page 143  Method_Manual_JL_092319.docx 

1.08 g of Ascorbic acid into this solution and bring the solution to 100 ml with DI water.  

This solution should be yellowish not blue.  If it is blue, there has been some phosphate 

contamination.  Make this fresh at the time of each assay. 

 

Procedure 

Below steps to be conducted in Dry Valleys Lab 

Sample Collection 

1.  The filtrate produced from the chlorophyll-a filtration (Section 3.1) is collected for Nutrient 

analyses. 

 

Rinse filter towers and graduated cylinders with 1% HCL + 3X with DIW before each limno 

run. Rinse with DIW between different sample depths. 

 

2. Gently invert the 1000 ml amber HDPE bottle, thoroughly mixing the sample, and decant 

100 ml into a graduated cylinder. 

 

3. Place a combusted 25 mm GF/F onto the filter base, which is mounted on a vacuum bell jar, 

and replace tower.  Place an acid washed 125 ml narrow mouth HDPE bottle directly under 

the filter base.  The filter is used as a replicate for Chlorophyll-a analysis (see Chlorophyll-a 

method); therefore, filtering must be performed in the dark. 

 

4. Filter the sample under low pressure (<7 in Hg).  Collect 100 ml of the filtrate in the narrow 

mouth HDPE bottle. Do not rinse the filter tower with DIW if you still need to filter the DOC 

sample.  Only rinse the filter towers between sample depths.  Carefully remove the bell jar, 

cap the nutrient bottle (one bottle is used for analysis of all nutrients) and immediately freeze 

sample (nutrient samples can be kept on the floor of the lab during the filtration process, then 

placed at -20oC). Store frozen until analysis. 

 

5.   Prepare at least one filtration blank for nutrients by filtering DI water through the filter tower  

      apparatus. This should be done before starting the sample filtration. 

 

 

Below steps to be conducted in MCM Crary Lab 

1. Add the following volumes of stock solution (Table 1) to 10 ml of DI water in acid rinsed 25 

ml test tubes.  These tubes will serve as calibration standards. 

 

2. Pipet exactly 10 ml of sample into 25 ml test tubes. 

 

3. Add 1 ml of mixed reagent to each tube and vortex. 

 

4. Allow color to develop for at least 20 minutes but not more than 3 h. 

 

 

Table 1.  Volume of stock solution used to prepare standard solutions. 
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Tube # Vol. of 0.1 mM stock (ml) Final Concentration. (M) 

1 0 0 

2 0 0 

3 0.01 0.1 

4 0.01 0.1 

5 0.02 0.25 

6 0.02 0.25 

7 0.05 0.5 

8 0.05 0.5 

9 0.1 1.0 

10 0.1 1.0 

 

5. Calibrate spectrophotometer to read zero absorbance (100% transmittance) against DI water. 

Measure the absorbance of the calibration standards and samples at 885 nm.  Use the same 

cuvette for all readings.  Rinse cuvette with DI water between samples. 

 

6. Use the standard curve regression equation to calculate PO4
-3 values (M) for each sample. 
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Dilutions for Nutrients on Lachat Autoanalyzer 

 
ELB: 

NH4: 3-14m=no dilution; 15m and below, dilute 1 in 10 (sample:DIW) 

NO2: 3-14m=no dilution; 15m and below, dilute 1 in 10 (sample:DIW) 

NO3: 3-14m=no dilution; 15m and below, dilute 1 in 10 (sample:DIW) 

SRP: NO DILUTIONS 

 

WLB: 

NH4: 3-10m=no dilution; 12m and below, dilute 1 in 10 (sample:DIW) 

NO2: NO DILUTIONS 

NO3: 3-10m=no dilution; 12m and below, dilute 1 in 10 (sample:DIW) 

SRP: NO DILUTIONS 

 

FRX: 

NH4: 0-9m no dilution; 10-11m, dilute 1 in 10 (sample:DIW); 11m and below, dilute 1:100 (?) 

NO2: NO DILUTIONS 

NO3: NO DILUTIONS 

SRP: 0-9m no dilution; 10m and below, dilute 1 in 10 (sample:DIW) 

 

HOR: 

NH4: NO DILUTIONS 

NO2: NO DILUTIONS 

NO3: NO DILUTIONS 

SRP: NO DILUTIONS 

 
Vanda: 

NH4: 3-45m=no dilution; 46-60m, dilute 1 in 10 (sample:DIW) 61m and below dilute 1:100 

NO2: NO DILUTIONS 

NO3: 3-55m=no dilution; 55m and below, dilute 1 in 10 (sample:DIW) (55m - salinity still low and 

doesn’t need dilution because of curve) 
SRP: 3-45m=no dilutions; 46m and below, dilute 1 in 10 
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Dissolved Oxygen by Mini-Winkler Titration 

 

General Discussion 

 

Materials 

Sampling Hut 

Benchcoat 

Kimwipes 

P1000 Gilson Pipetman and tips (2-one for each reagent) 

Vinyl gloves (at least 3 pair) 

Glass scintillation vials (20 ml vials with HDPE cone caps) 

Serum/Scintillation vial carrier 

Plastic scintillation tray 

Ziplock bag for waste 

Dry Valleys lab 

Benchcoat 

Kimwipes 

P1000 Gilson Pipetman and tips (3-one for each reagent) 

DI squirt bottle 

Eyedropper 

Forceps 

Gilson micro-buret (2 ml) 

Lamp or good sunlight 

Latex/vinyl gloves (at least 3 pairs) 

Magnetic stir plate 

Micro stir bar 

Mini beakers (10 ml) 

Waste bottle 

Ziplock for lab waste 

 

Reagents 

Sampling Hut 

Alkaline-iodide-azide solution: In a volumetric flask bring the following reagents to 250 ml 

using DI water (KEEP IN DARK AS POTASSIUM IODIDE IS LIGHT SENSITIVE!!): 

  2.5 g sodium azide (NaN3) 

  25 g potassium iodide (KI) 

  80 g sodium hydroxide (NaOH) 

Manganous solution (Mn++): In a volumetric flask bring 100 g of MnCl2  4H2O to 250 ml using 

DI water. 

Dry Valleys Lab 

Alkaline-iodide-azide solution (see above) 

Manganous solution (Mn++) (see above) 
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Phosphoric acid (H2PO4): Concentrated 

Sodium thiosulfate titrant (Na2S2O35H2O): In 0506 we started using a pre-maid sodium 

thiosulfate (1.0 N) solution and diluting it to .01 N.  

Starch solution (1%): Dissolve 1 g of laboratory–grade soluble starch in 100 ml of hot DI water. 

 

Procedure 

Sample Collection 

1. Place the Niskin bottle tubing from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and 

invert Niskin ~ 5 times) to the bottom of the 20 ml scintillation vial.  Allow the water 

overflow, displacing the initial sample volume 2x (about 5 seconds).  Carefully remove the 

tubing, keeping turbulence to a minimum, making sure the vial is completely filled with no 

air bubbles. 

 

2. Fix the sample by adding the following reagents (directly into sample): 

0.9ml of the Mn2+ solution 

0.9ml of the alkali-iodide-azide solution 

 

3. Cap the sample and invert several times to ensure mixing.  Use benchcoat on the table top 

and kimwipes to mop up the excess fluid that is displaced. 

 

4. Place sample into the Serum/Scintillation vial carrier for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

Sample Analysis 

1. Prepare each sample for titration by adding 1 ml of phosphoric acid.  Invert each sample 

several times and wait for precipitate to dissolve. 

 

2. Dilute the concentrated sodium thiosulfate solution by bringing 1 ml of the concentrated 

solution to 100 ml in a volumetric flask using DI water to achieve a .01N solution. 

 

3. Sample titration: Place a kimwipe on the stir plate and position the plate such that it is in 

direct light (a desk lamp may be used) to easily observe colorimetric change. 

 

5. Withdraw 2 ml of the diluted sodium thiosulfate into the microburet.  Note: To minimize 

contamination of the thiosulfate, fill a scintillation vial with thiosulfate and use instead of the 

diluted solution stock. 

 

6. Pipet 1 ml of sample into a small glass beaker or scintillation vial, and place a micro stir bar 

into the sample. 

 

7. While keeping the tip of the microburet in the sample, slowly titrate to a pale straw yellow 

color; add 1-2 drops of starch solution (heat starch solution prior to addition to make sure 

starch is in solution), this will turn the sample dark blue; then titrate to endpoint (first 

disappearance of blue color).  Place a mini beaker containing 2 ml of DI water alongside the 

sample beaker.  This will provide a reference color during sample titration.  Note:  If the 
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sample does not turn dark blue, the starch may have precipitated.  Resuspend the starch by 

heating solution (hot, but not boiling). 

 

8. Record the volume of titrant, and repeat titration.  Titrate each sample at least 2 times.  

Variation among the replicates should be less than ± 0.5%. 

 

Note: After each titration, rinse the buret with DI water (into a waste bottle), and wipe dry with a 

kimwipe.  Then refill with the thiosulfate solution, and wipe the buret dry again.  Also, pour 

the titrated sample into the waste bottle; rinse the beaker with DI water and wipe dry. 

 

9. Determine oxygen concentration as follows. 

 

     

  









bottle of ml

1.8-bottle of ml
 titratedsample ml

8000M titrantml
l mgOOxygen  Dissolved thio1-

2  

 

where Mthio is the molarity of thiosulfate, and 8000 converts thiosulfate equivalents to 

oxygen equivalents and ml filtered to liters. 

 

 

References 

 

Carpenter, J.H. 1965. The Chesapeake Bay Institute technique for the Winkler Dissolved Oxygen 

method. Limnology and Oceanography. 10(1):141-143. 



 Section 4. Chemical Parameters 
 4.8 Hydrogen Ion  

LTER Limnological Methods Manual Page 149  Method_Manual_JL_092319.docx 

Hydrogen Ion concentration (pH) 
 

General Discussion 

The following method utilizes a pH meter consisting of a potentiometer, a polymer body 

Ag/AgCl probe and a temperature compensating probe. 

 

Materials 

Sampling hut 

Glass scintillation vials (20 ml vials with HDPE cone caps) 

Serum/Scintillation vial carrier 

Scintillation tray 

Dry Valleys Lab 

DI water 

Kimwipes 

Portable pH meter with appropriate pH electrode, ATC probe and cables (Beckman PSI 10) 

Waste Beaker 

 

Reagents 

Dry Valleys Lab 

pH Buffers (4, 7, 10 pH) 

Probe storage and filling solution 

 

Procedure 

Sample Collection 

1. Place the Niskin bottle tubing from a well-mixed Niskin bottle (i.e., drain ~ 10 ml first and 

invert Niskin ~ 5 times) to the bottom of the 20 ml scintillation vial.  Allow the water to 

overflow, displacing the initial sample volume 2x (about 5 seconds).  Carefully remove the 

tubing, keeping turbulence to a minimum, making sure the vial is completely filled.  Place 

sample into the Serum/Scintillation vial carrier for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

2. Calibrate (double endpoint) the pH meter and probe using pH 4 and 7 buffers. 

 

3. Place the pH probe into the sample and manually agitate in an up and down motion (~1 cm). 

The pH and temperature probes will not simultaneously fit into a scintillation vial.  

Therefore, place the temperature probe into the next sample to obtain a temperature reading. 

 

4. Once the pH and temperature probe have stabilized, record the values. 

 

5. Rinse the electrode with DI water between standards and samples and blot dry with 

Kimwipes. 
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Underwater Time Series PAR Logged During Primary Production 

Experiment 

General Discussion 

 

Materials 

Licor LI-1400 Data logger with downloading cable and USB converter 

30 m underwater cable 

Licor LI-193SA spherical quantum sensor 

Licor LI-190SA quantum sensor 

Leveling fixture 

Lowering Frame 

Tarpaulin (opaque) 

 Set up the UW sensor in the lowering frame as below and mark the cable in 1 meter 

intervals so that zero is at the middle of the UW sensor. 

 

 
Licor LI-1400 Data Logger with 30m underwater cable.Downloading cable (left) and USB 

converter (right). 

 

 
Licor LI-190SA ambient sensor with levelling fixture. 
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Licor LI-193SA UW sensor with lowering frame. 

    

Procedure 

 Clear the memory of the LI-1400 by pressing FCT and scrolling with the right arrow until 

you see CLEAR MEMORY. Press Enter. The cursor should be on “Clear=.” Use the right 

arrow to choose “All.” Press the down arrow three times to move the cursor to “!Clear Mem 

?NO !” and use the right arrow to change the NO to YES.  Press enter. The instrument should 

say “Clearing Memory...”  

 Set the date and time (this can also be done through the software) by pressing SETUP and 

scrolling with the right arrow until you see CLOCK. Press enter. The cursor should be on 

“Date.” Press enter. On the screen that says “Editing Date,” enter the year, month and day. 

Press enter. Use the down arrow to scroll to “time.” Press enter. On the screen that says 

“Editing Time,” enter the time. Press enter. Press ESC to get back to the SETUP menu. 

 Note that the LI-1400 screen will blink on and off when the batteries are low. 

 

1. Configure the LI-1400 to record light data on channels 1 (underwater sensor) and 2 

(ambient sensor) and to log data. This can be done using the logger key pad: 

 

 SETUP → CHANNELS (Press enter to get to the “Setup Channels” screen and use the 

up and down arrows to select I1): 

o I1 = Light: Use the right and left arrows to select “light,” then press enter to get to 

the “Set up Light” screen. Press enter to edit Descr, then press enter to return to 

the “Set up Light” screen and ↓ to get to next parameter. Follow the same method 

for Mult and Label. Log Routine, Calc and Min/Max can be changed by using the 

right and left arrows to toggle between options: 

 Desc= UW  

 Mult= enter multiplier of UW sensor  

 Label= UM (umol photons/m2/s)  

 Average= 1 sec (only used when viewing data in instantaneous mode) 

 Log Routine= LR1 (the start and stop times, sampling and logging period 

will be set in the LOGGING setup described below). 

 Calc= Mean (Defines form in which data are collected and stored). 

 Min/Max= No (Stores min and max data points during logging period). 

 Tcoef= Not used if mean values are stored to memory. 
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Press esc to return to “Set up Channels” 

 

o I2 = Light: Use the right and left arrows to select “light,” then press enter to get to 

the “Set up Light” screen. Press enter to edit Descr, then press enter to return to 

the “Set up Light” screen and ↓ to get to next parameter. Follow the same method 

for Mult and Label. Log Routine, Calc and Min/Max can be changed by using the 

right and left arrows to toggle between options: 

 Desc= Ambient  

 Mult= enter multiplier of UW sensor  

 Label= UM (umol photons/m2/s) 

 Average= 1 sec (only used when viewing data in instantaneous mode) 

 Log Routine= LR1 (the start and stop times, sampling and logging period 

will be set in the LOGGING setup described below). 

 Calc= Mean (Defines form in which data are collected and stored). 

 Min/Max= No (Stores min and max data points during logging period). 

 Tcoef= Not used if mean values are stored to memory. 

 

Press esc to return to “Set up Channels” 

Press esc to return to Setup Menu 

 

2. Configure the LI-1000 to Log Mean PAR values every 10 minutes. This can be done 

using the logger key pad: 

 

 SETUP → LOGGING (press enter): 

o “Set up Logging” (use the left and right arrows to set the following parameters for 

Logging, Auto Print, Overwrite and PwrDelay. Use the down arrow to get to the 

next parameter).  

 Logging= ON 

 Auto Print= NO 

 Overwrite= YES 

 PwrDelay= 0 sec 

 LR1: press enter and set up a Log Routine as follows: 

o “Set Log Routn” (Press enter to edit Start Time and Stop Time then press enter to 

return to the “Set Log Routn” screen and ↓ to get to next parameter. Sampling 

Period and Logging Period can be changed by using the right and left arrows to 

toggle between options.) 

 Start Time= make Start Time = Stop Time for logging to occur 24 hours a 

day (use the back arrow to erase the current time, and then enter the 

desired time). 

 Stop Time= make Start Time = Stop Time for logging to occur 24 hours a 

day (use the back arrow to erase the current time, and then enter the 

desired time). 

 Sampling Period= 5 sec 

 Logging Period= 5 min 
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** Note that logging starts when you set logging to ON, not at the time you set for the 

Start Time ** 

 

Press esc to return to “Set up Logging.” 

 

 Press esc to return to Setup Menu.  

 Press VIEW: You will see the message “Implementing New Setup” if you changed 

any of the configurations.  

     

3. The time series logged data is recorded inside the weatherport sampling hole.  Once all of the 

water samples have been collected, lower the underwater sensor frame to a depth of 10 m (7 

m at Lake Fryxell) below the piezometric water level and secure to the winch frame.  Place 

the ambient sensor frame as far away from the weatherport as possible and attach both cables 

to the appropriate channels on the LI-1000.  Make sure you give yourself enough time, once 

the reset time is programmed, to position the sensors and data logger. 

 

4. Allow the LI-1000 to log for a 24 h period. Stop logging by going to SETUP → 

LOGGING and setting the Logging to OFF.  Note: Due to logistic and time constraints it 

is difficult to immediately start PAR logging once the PPR samples are placed in the 

incubation hole. 

 

Download the recorded data to a computer using the LI-1400 Data Logger Windows Interface 

Software program.   

 

 Change the baud rate on the LI-1400 to 9600 by pressing SETUP and scrolling with the 

right arrow until you see HARDWARE. Press enter. Press the right arrow until the 

“Baud=xxxx” line reads 9600. The LI-1400 automatically saves this setting. Press ESC to 

get back to the “SETUP” menu. 

 

 Connect the LI-1400 to the computer and open the LI-1400 Data Logger Windows 

Interface Software program. Click on REMOTE → CONNECT and enter the correct com 

port (2).  A message that says synchronizing will be displayed until communication is 

established. 
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 Click on REMOTE → RECEIVE DATA. 

 

 
 

 When prompted, select a directory and choose a file name. Click save. Data is saved as a 

tab delimited text (.txt) file that can be opened in a spreadsheet. Once the data are 

successfully downloaded, data can be cleared using the Windows Interface program by 

clicking on REMOTE → CLEAR DATABASE, or by using the logger key pad as 

described above.   

 

When the data are opened in a spreadsheet, the 3 character code for each channel should be I1M 

and I2M. In the code I1M and I2M, the first” I” signifies a current channel, the number signifies 

the channel used, and the “M” signifies that the mean was logged for the channel. Data are listed 

for the channels in the columns designated with the 3 character codes. The “Desc” (UW and 

Ambient) and the “Label” (UM) entered during “setup channels” are listed below the 3 character 

code. 

 

In the spreadsheet, a “0” in column A shows which channels were active; a “1” in column A 

shows which channels were logging on LR1, a “2” shows which channels were logging on LR2, 

and so on through LR5. Data are designated with a “1” in column A because they were logged 

with LR1.  
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Underwater Profile PAR and Attenuation 

General Discussion 

 

Materials 

Licor LI-1400 Data logger  

30 m underwater cable 

Licor LI-193SA spherical quantum sensor (UW sensor) 

Licor LI-190SA quantum sensor (ambient sensor) 

Leveling fixture 

Lowering Frame 

Tarpaulin (opaque) 

 Set up the UW sensor in the lowering frame as below and mark the cable in 1 meter 

intervals so that zero is at the middle of the UW sensor. 

 

 
Licor LI-1400 Data Logger with 30m underwater cable. 

 

 
Licor LI-190SA ambient sensor with levelling fixture. 
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Licor LI-193SA UW sensor with lowering frame. 

 

Procedure  

3. Configure the LI-1400 to record light data on channels 1 (underwater sensor) and 2 

(ambient sensor) and to provide instantaneous point values. This can be done using the 

logger key pad: 

 

 SETUP → CHANNELS (Press enter to get to the “Setup Channels” screen and use the 

up and down arrows to select I1): 

o I1 = Light: Use the right and left arrows to select “light,” then press enter to get to 

the “Set up Light” screen. Press enter to edit Descr, then press enter to return to 

the “Set up Light” screen and ↓ to get to next parameter. Follow the same method 

for Mult and Label. Average and Log Routine can be changed by using the right 

and left arrows to toggle between options. The rest of the parameters are not used 

when doing instantaneous measurements: 

 Desc= UW  

 Mult= enter multiplier of UW sensor  

 Label= UM (umol photons/m2/s) 

 Average= 1 sec (this gives an instantaneous value updated every second) 

 Log Routine= none  

 Calc= (only used if using a log routine) 

 Min/Max= (only used if using a log routine) 

 Tcoef= (only used if using a log routine) 

 

Press esc to return to “Set up Channels” 

 

 SETUP → CHANNELS (Press enter to get to the “Setup Channels” screen and use the 

up and down arrows to select I2): 

o I2 = Light: Use the right and left arrows to select “light,” then press enter to get to 

the “Set up Light” screen. Press enter to edit Descr, then press enter to return to 

the “Set up Light” screen and ↓ to get to next parameter. Follow the same method 

for Mult and Label. Average and Log Routine can be changed by using the right 
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and left arrows to toggle between options. The rest of the parameters are not used 

when doing instantaneous measurements: 

 Desc= Ambient  

 Mult= enter multiplier of UW sensor  

 Label= UM (umol photons/m2/s)  

 Average= 1 sec (this gives an instantaneous value updated every second) 

 Log Routine= none  

 Calc= (only used if using a log routine) 

 Min/Max= (only used if using a log routine) 

 Tcoef= (only used if using a log routine) 

 

Press esc to return to “Set up Channels” 

 

 Press esc to return to Setup Menu.  

 Press VIEW: You will see the message “Implementing New Setup” if you changed 

any of the configurations.  

 Use the right arrow to toggle to “New Data” and press enter. 

 Any of the four lines (use up and down arrows) can be toggled between I1I (channel 1), 

I2I (channel 2), the current date and time, and how much memory has been used. Both 

the UW and Ambient sensors can be viewed at once by setting line 1 to I1I and line 2 to 

I2I. 

(In the code I1I and I2I, the first” I” signifies a current channel, the number signifies the 

channel used, and the second “I” signifies an instantaneous value updated at the length of 

time it was set to (1 sec)). 

 

2. Collect the PAR profile data in a covered incubation hole (use a tarp).  Situate the incident 

surface PAR sensor nearby on a level surface, and lower the wet sensor frame into the water.  

Collect PAR data on 0.5 m increments beginning at just under the surface of the water in the 

ice hole and continue until the underwater PAR = 0.  Once the underwater sensor stabilizes, 

record both the underwater and incident PAR values. 

 

Note:  Always record the time of day, any snow present on the ice cover, and ambient weather 

conditions (i.e., cloud cover, sunshine, etc.) when profile is collected. 
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Biospherical Profiling Natural Fluorescence  
 

General Discussion 

The PNF-300 is an integrated optical system specifically designed to measure natural 

fluorescence - the fluorescence from the phytoplankton community stimulated by available 

sunlight.  Research has shown that natural fluorescence is correlated to 14C photosynthetic rates 

and chlorophyll concentrations. Unlike strobe fluorometers, a natural fluorometer measures 

fluorescence emitted under the ambient light conditions which is driving in situ photosynthesis. 

 

Materials 

Biospherical PNF-300: 

Underwater PNF Instrument with cable 

Surface PAR sensor with cable 

Deck box 

Computer cable with USB converter (a special USB converter is supplied by Biospherical 

      Instruments – Figure 1) 

Instruction manual 

PC laptop computer 

LoggerLight program 

 

 

 
Figure 1. USB converter supplied by Biospherical Instruments. 
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Procedure 

Instrument Calibration 

1. Install the PNF-300 software, “LoggerLight,” onto the PC laptop.  

 

2.   Make a folder for PNF files on the c: drive and go to “Edit” → “Options.” In the Data 

Recording and Sampling tab, choose this folder to save the PNF cast files to. If you have 

newly installed the LoggerLight program, this option will be given to you the first time you 

open the program. 

 
 

3. The PNF 300 should be calibrated every year by Biospherical Instruments Inc. and a 

calibration sheet should be supplied.  The calibration information is stored in the PNF 

instrument, and can be checked against the calibration sheet by going to “View” → 

“Calibration.” This window displays the calibration information that is stored in the 

instrument, as well as any values for field offset (F.offset v) (see “Zero and Dark Offset 

correction” below) which are only stored in the registry of the computer. 
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NOTE: Check the serial number on the surface sensor unit to ensure it matches the serial number 

on the calibration certificate. There is more than one surface sensor in Crary Lab, but only 

one is sent out each year for calibration with the PNF. 

 

Data Collection 
 

Pre-Deployment 

1. Connect the surface PAR sensor and PNF to the deck box (they can be plugged in either 

serial port), connect the deck box to the computer, and position the cable so the PNF can 

be easily deployed. Start the LoggerLight program.  

 

2. Perform the Zero and Dark Offset correction:  

a. In LoggerLight, go to “Edit” → “Dark Correction” 

b. Check the UW PAR sensor box (EoZPAR) 

c. Check the surface PAR sensor box (QSR – S/N 10459) 

d. Check the depth sensor box (Depth) 

e. Cover sensors – ensure that both the surface and UW PAR sensors are covered 

with the supplied black covers, and that the PNF is out of the water.  

f. Press “Correct Selected” 

g. Press “Save” 

  

NOTE: This calibration is stored in the computer only, NOT in the PNF. It is used as a field 

adjustment to the baseline. 

 
 

3. Go to “Edit” → “Options” (CTRL “O”) and check the “Rapid sampling, maximum rate, 

no statistics” box under the Data Recording + Sampling tab. This will ensure the highest 

resolution of data for the profile cast. 
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4. Go to “Edit” → “Options” (CTRL “O”) and check that the UW sensor (EoZPAR) box is 

checked in the “Immersion coefficient” section under the Calibration tab. 

 
 

5. Pressing “view” → “depth” will show the large numerical display of instrument depth (in 

the image above it says “paused”). “Data” and “Log” should also be checked so you can 

view these on the screen. 
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Deployment 

1. The PNF is always cast in an outside hole to minimize shading effects (i.e., Weatherport 

shading).  The sampling hole must be covered with a tarp to minimize direct sunlight 

entering the hole. 

2. The surface PAR sensor should be placed away from the hole to eliminate possible 

shading. 

3. Position the PNF over the center of the hole and lower the PNF until the downwelling 

PAR sensor is covered by water.  Allow the PNF to cool and the pressure transducer to 

stabilize. (about 2 Mins) 

4. Raise PNF into the air and start recording “File” → “Start Recording.” 

5. Lower the PNF back into the water and slowly lower (0.5 m sec-1) to the desired depth, 

pausing at this depth for 10 seconds (take note of the depth). 

6. Stop the cast at this depth by going to “File” → “Close.” 

7. The file will automatically save in the folder you created on the c: drive (“File” → “Save 

As”) 

8. View the file to ensure the instrument was working properly. 

 

Post-Deployment 

1. Record 30-60 seconds of dark with UW sensor covered in order to keep a record of dark 

voltages. 

2. If desired, save the Log File by going to “File” → “Save Log File” 

 

Sensors 

The Teflon may become dirty during normal use. Clean gently with warm water, soap or a 

mild solvent such as alcohol using a soft tissue or towel. Be gentle -- do not twist the 

collector. Do not use acids, abrasive cleaners or brushes, as these will mar the surface and 

invalidate the calibration. Should the collector become disturbed, damaged or heavily soiled, 

return the instrument to the factory for service and recalibration. Before use you can wipe the 

collector, using a soft, clean, lint-free cloth.  
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Seabird 25 Conductivity, Temperature and Depth Instrument 

(using new Seasave V7 software. For method using old version of Seasave (V5.39), see appendix 

of Previously Used Methods) 

 

General Discussion 

 

Materials 

Seabird 25 CTD (80 m) 

Downloading cable and USB converter 

PC laptop computer 

1% Triton-X solution 

DIW water 

60 ml syringe and tubing to connect to the pump outlet 

 

 
CTD with downloading cable and USB converter. 

 

Procedure 

Instrument Calibration (SeaSave)  

1. Install the current version of Windows Seasoft data acquisition software onto the laptop 

computer. SeaSave V7 is used to view and change .con file data, SeaTerm is used to 

communicate with the CTD, do the casts, and download the data, SeaSave V7 is used to 

view the data, and SBE Data Processing is used to process the data (convert .hex files).  

 

2. Configure the data acquisition software based on the current calibration constants provided by 

Sea-Bird Electronics.  Every year the manufacturer sends a paper and electronic (on a CD) copy 

of the calibration values, and an electronic copy (on a CD) of the .con file containing these 

calibration values. Save the current .con file to the computer from the CD and view it in SeaSave 

to check the values.  In SeaSave, click on “configure inputs” → “instrument configuration” then 

“open” and choose the appropriate .con file. If you don’t have a .con file, you can modify an 

existing file with the values from the paper copy.  Enter the values as illustrated below: 

 

 Enter “> than highest” for firmware (Gary Morast from SeaBird said that the 

Firmware version is important to have correct. In 0708 it was 4.02) 



 Section 5. Instruments 
 5.4 Seabird 25 Conductivity, Temperature, and Depth 

LTER Limnological Methods Manual Page 164  Method_Manual_JL_092319.docx 

 “8 scans per second” for Data Output Rate (this is user configurable: When our 

CTD come back from the manufacturer, it is set to store data at 1 scan per second; 

we will change this to 8 scans per second using SeaTerm (see below)).  

 
  

Check the Temperature, Conductivity (Set the Cell Constant = 2000, and the Series 

Resistance = 300), Pressure and Fluorometer values, or enter them from the paper copies 

of the calibration reports if you are not using the current .con file. If you have selected the 

current .con file, these values should match the values in the paper copy. To do this, 

double click on the parameter you want to check, or click on modify. Below are the 1011 

calibration coefficients for the Temperature Sensor. 

 
     Take note of the serial numbers in the .con file for the temperature and conductivity  

     sensors as we will make sure later that the serial numbers in SeaTerm match these. 
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Save the configuration file.  The .con file is used for data processing (conversion of .hex 

files) with SBE Data Processing, and for viewing data in SeaSave. SeaSave and SBE 

Data Processing will not interpret the data correctly without the correct .con file. 

 

When exiting the SeaSave program, if you save changes to the program file when it asks, 

the program will remember the .con file you used in the future. 

 

Instrument Setup (SeaTerm v1.59) 

1. Before using SeaTerm to communicate with the CTD or upload data from the CTD, the 

program must have information about the CTD hardware configuration and about the 

computer. To set these parameters, open the SeaTerm program, go to “configure” and 

click on “SBE 25” (that is the name of our CTD).   

 
 

Information about the CTD’s configuration came with the original instrument purchase:  

 

COM settings (must match CTDs configuration sheet): 

a. Firmware: > 3.0 (updated to 4.02 in 0708) (must be correct according to Gary 

Morast of SeaBird) 
b. Comm port – 2 (this was assigned to the serial to USB converter in 1112 season). 

c. Baud Rate – 600 (the program cycles through the baud rates until it finds the one 

it can use to connect. You can either put 600 and let it find the right one, or put 

the one it uses (usually 4800) to start out with). 

d. Data Bits – 7 

e. Parity – even 

 

Upload settings: 

a. Data Upload Baud Rate – 9600 

b. Upload Data: 1 cast (set as desired) 
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c. SBE 3 - Temperature Sensor Serial Number: 0964 (must match .con file)  

d. SBE 4 - Conductivity Sensor Serial Number: 2396w (must match .con file) 

 

Header Information (set as desired): 

a. Header: Prompt for Header Information  

 

When done, click OK and SeaTerm will save the settings in a SEATERM.ini file. SEATERM 

will not upload data correctly without a properly configured SEATERM.ini file. (If the program 

saves the settings, it has created the .ini file in the root directory; you don’t actually have to do 

anything with the .ini file). 

 

Click “Connect” to communicate with the CTD 

Click “Status” to get information about the CTD. 

 
 

When the CTD comes back from the factory every year, it is set to turn on at a salinity meant for 

using it in seawater. This parameter is called the “minimum conductivity frequency for pump 

turn on.” Since we are using it in the lakes, we need to re-set this value so that the CTD will turn 

on in relatively freshwater. After you have established communications (above), check the 

minimum conductivity frequency for pump turn on in the CTD configuration list that appears. 

Generally it will be ~ 3000 Hz from the factory. To set the new pump start frequency: 

 At the s> or #s> prompt, type cc 

 type Y when it asks Y/N 

 type CTRL Y when it asks CTRL Y/N   

 Press enter to keep the rest of the values as they are, but change the pump start frequency  

 to 5. 

 

When the CTD comes back from the factory every year, it may be set to a Real Time Data 

Output (or Transmission) Rate and Data Storage Rate of 1 scan per second. We need to change 

these to 8 scans per second. (The con file generally has the Real Time Data Output Rate set to 8 

scans per second. This will have been checked in SeaSave already).  After you have established 

communications, check the Data Storage Rate and the Real Time Data Transmission Rate in the 
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CTD configuration list that appears (see above). If they were set to 1 at the factory, set the new 

rates: 

 At the s> prompt, type cc 

 type Y when it asks Y/N 

 type CTRL Y when it asks CTRL Y/N   

 Press enter to keep the rest of the values as they are, but change the Internal Data Storage  

 Rate and the Real Time Data Output Rate to 8. 

 

Data Collection (SeaTerm) 
1. Before sampling, the SBE 25 CTD must be initialized to clear memory modules.  

Connect the SBE CTD to the computer and launch the SeaTerm communication program.  

Press “Connect” to communicate with the CTD, and “Status” to get information about the 

CTD. Following recognition, press “Init Log” to initialize logging, answer YES to the 

questions. 

  

 
  

Disconnect the cable from the CTD and replace the protective plug.  The SBE 25 is now 

ready for deployment. “qs” refers to quiet or quiescient state. The CTD must be in this state 

for 2 minutes before the pump turn on switch will work. You can command “qs” in SeaTerm 

(it automatically did this above), or disconnect the CTD and be sure to wait 2 minutes until 

turning on the pump switch. 

 

2. Typically the SBE 25 CTD is cast in the Weatherport sampling hole, because it does not 

measure natural fluorescence or PAR which is influenced by the shading effect from the 

Weatherport.  Remove all of the ice from the hole, Do Not allow ice crystals to touch the 

probes.  Attach the CTD frame to the winch cable.  Remove the red cap. Use a 60 ml syringe 

to flush the pumping system and sensors with a 1% Triton-X solution.  

 

3.   Connect the CTD to the winch cable using the carabiner. Because of the high salt content at 

the bottom of some of the lakes, the pressure sensor does not accurately record the depth. It is 
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necessary to correct for this by knowing the exact depth the CTD is lowered to, measured 

from the water surface to the pressure sensor on the CTD.  

1. Measure the distance from the top of the “O” ring at the top of the CTD cage to the 

pressure sensor and note this in your notebook (distance a in Figure 1). This will be the 

same throughout the season.  

2. The distance from the end loop on the winch cable to the “zero” mark on the winch cable 

varies with lake (there is a winch for each lake). Measure the distance from the top of the 

“O” ring to the zero mark on the winch cable (distance b in Figure 1). THIS MUST BE 

DONE AT EACH LAKE.  

3. Use the sum of these values to decide which depth to cast the CTD to (~1m from the 

bottom of the lake), and note all measurements in your notebook (i.e. CTD was cast to 

17m on winch cable + 0.855m (distance a) + 0.765m (distance b) = 18.62m from water 

surface to pressure sensor on CTD). It is best to draw a diagram like the one below in 

your notebook to avoid any confusion. 

 

 
Figure 1. 

 

4. Turn the CTD on using the white slider switch on the side of the instrument cage. 

Immediately lower the CTD into the water up to the top of the “O” ring on the cage.  Allow 

the CTD to thoroughly flush water through the system (>60 sec – it takes 45 second for the 

pump to turn on once it is put in the water).  The CTD may have to be raised out of the water 

enough to see that the pump is working (it should be pumping a constant stream of water out 

***). The pump will only turn on at the salinity you entered in step 2, Instrument Set-up. 

Once you ensure that the pump is working, lower the CTD to the “O” ring again, and let it sit 

for approximately one minute. This depth is ~ 0.8m from the pressure sensor, and will be 

used to correct the pressure sensor to the correct depth during data processing, as will the 

bottom depth as measured in the above steps. 

 

*** If there is not a constant stream of water coming from the pump  when you check it, the hole 

in the bleed valve hole at the top of the “Y” fitting at the top of the CTD may be clogged. 

Clean it out with the 0.016” OD wire that should have been supplied by SeaBird after 

calibration. When the CTD is submersed, a steady stream of bubbles should come from the 

hole for at least 5 seconds. Pliers may be needed to get the wire through the hole. 
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5. Lower the CTD (1 m sec-1) to the desired depth ~1 m from the bottom of the lake (Do Not 

allow the CTD to hit the bottom of the lake), stop for 10 seconds, then retrieve at the same 

rate.  Stop again when the top of the “O” ring is at the surface and let the CTD sit for ~ 20 

seconds. Raise the CTD so it is completely in the air above the hole and let it sit for ~10 

seconds to get an air reading, then lower it back to the “O” ring for another ~20 seconds. 

Remove the CTD from the water and immediately turn the instrument off.  Note:  The CTD 

must be turned off to save each cast. Flush the pumping system with DI water after use. 

 

Downloading (SeaTerm) 

1. Connect the SBE 25 CTD to the computer and launch the SeaTerm program.  Press 

“Connect” to establish communications. Once communications are established, press 

“Upload” to Upload data.  Note:  The software may be configured to dump specific casts 

or all, and to include data headers.  Name the file accordingly (i.e., Lake code, date), and 

save to the desired directory.  Every time the pump is turned on and off there is a new 

cast saved.  Therefore, when downloading the data the first cast is 0, second is 1, etc.  

The multiple casts can be downloaded, but they must be specified when you “upload” the 

data in SeaTerm.   

 

 
 

2. View the data to make sure the CTD was operating properly using SeaSave.  You can view a 

plot, or view a readout of the data.  

 

To view a readout of the data, go to “Display” → “Add new fixed display window.” Add 

parameters you want to view (Pressure (db), Temp (ITS-90, °C), Salinity (PSU), Fluorescence 

WetLab Wetstar (mg/m3), Conductivity (S/m), Density (kg/m3)) . Then go to “Archived Data → 

Start,” select data file and .con file, change number of scans to skip over at start to ZERO (or 

however many scans you want to skip over), and press start. 

 

To view a plot of the data, go to “Display → “Add new plot display window.” 

 

Under the “Plot Setup” tab make the following selections: 

Plot Type: Single Y – Multiple X 

Number of Axes = 5 
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Under the “Y-Axis” tab make the following selections: 

Set up the y-axis with Pressure (db) 

 

Under the “X-Axis” tabs make the following selections: 

Set up the x-axes with:  

Temp (ITS-90, °C) 

Salinity (PSU) 

Fluorescence (WetLab Wetstar (mg/m3) 

Conductivity (S/m) 

Set up an appropriate range for each parameter for the lake which you are 

plotting. 

Make any changes to color, etc desired. 

 

To save graph set-up, close set-up window, right click on graph, and “Export Display Settings 

(.dsa file).” 

 

To re-enter plot set-up screen, open graph and click on “Display → Modify,” or right click on 

graph and click on Modify. 

 

To open a dsa file that was already set up, Display → “Import Display Settings (.dsa file). 

 

To draw the graph, go to “Archived Data → Start,” select data file and .con file, change number 

of scans to skip over at start to ZERO (or however many scans you want to skip over), and press 

start. 
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 Note:  In past years, problems with data acquisition have occurred when cable connections 

allowed water to infiltrate and corrode the connections.  If data appears to be chaotic, remove all 

cable connections and thoroughly dry the connections.  Lube the connectors with stopcock 

grease and securely tighten the cables.   

 

CTD Data Conversion from .hex files – SBE Data Processing 

SBE tech help – Gary Morast (425) 643-9866 

 

June 2010: 

We began using the new version of SBE Data Processing, “Version 7.20d, 2010,” in June 2010 

for the 0910 data. This version is able to calculate density and salinity to the deep depths of Lake 

Bonney, and any other lakes with high density and salinity water.  It also calculates conductivity 

with greater resolution in the lower depths of Lake Bonney. Prior to this we were using version 

5.25. 

 

Sept 2013:  

We began using the new version of SBE Data Processing, “Version 7.23.1” in Sept 2013 for the 

1213 data. The revisions listed online that applied to the SBE25 CTD were: 

 Derive Teos-10 module added (John decided we should stick with the original (PSS-78) 

derivations). 

 Now ignores a 'w' in conductivity sensor serial number in configuration file (indicating 

wide range conductivity calibration) when checking against serial number in data file. 

Previously, it would give an error message saying that serial numbers did not match. 

 Add selection of units for calculating and outputting Specific Conductance. 

 

August 2016: 

We began using the newest version of SBE Data Processing, “Version 7.26.1.8” (released 1 June 

2016) in Aug 2016 to process the 1516 data. The revisions listed online that applied to the 

SBE25 CTD were:  

 ASCII Out - Add comma as a Column Separator selection. 



 Section 5. Instruments 
 5.4 Seabird 25 Conductivity, Temperature, and Depth 

LTER Limnological Methods Manual Page 172  Method_Manual_JL_092319.docx 

October 2017:  

We began using the newest version of SBE Data Processing, “Version 7.26.7” (released 26 July 

2017) in Oct 2017 to process the 1617 data. The revisions listed online that applied to the SBE25 

CTD were:  

 Bin Average – allow user to select scans to omit from processing at the end of the file, 

and minimum and maximum scans per bin (bins that fall outside this range are omitted 

from output file). 

 

To convert the .hex files, you will need to use the SBE Data Processing program. 

 Programs – Sea-Bird – SBE Data Processing Win 32 

You will also need the .con file for that season 

It helps to put all the hex files in 1 folder. 

 

1. Set up configuration file 

a. Configure – SBE 25 – you can look at the configuration (.con or .xmlcon) file. 

Click open and open your .con file. Go into each parameter and make sure the 

coefficients are correct from the configuration file (disk or printout). 

b. Exit when done 

 

2. Run – Data Conversion  

a. Tab: File set-up 

i. Program set-up file (.psu or .psa) – default (use default file) (you can use 

any psu file, it is just saving what parameters you set up during your 

conversions, but you will check these anyway). 

ii. Instrument configuration file – select configuration file for that year (.con) 

iii. Input directory – the program will change the folder depending on where 

you get your files. 

iv. Input files – select all to convert (.hex) – it is best to put all the files in 1 

folder so you can easily select them all at once 

v. Output directory – default or pick your own; the program may change the 

folder depending on where you get your files. 

b. Tab: Data set-up 

i. In the 7.23.1 version there is a box to click for “Process scans to end of 

file” – I left it clicked 

ii. Begin scans to skip over – don’t skip over any now but if CTD went slow 

may need to 

iii. Output format – ASCII 

iv. Convert data from – downcast 

v. Create file types – CNV 

vi. I did not click “Merge separate header file” which is new in the 7.23.1 

version – talked to SeaBird tech help and they said not to click it unless 

we have something else we want to include with header. 

c. Tab: Data set-up - Select Output Variables 

i. Pressure (db) 

ii. Conductivity (mS/cm) 
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iii. Temp – ITS-90 (C) 

iv. Fluorescence – Wetlab Wetstar (mg/m3) 

v. Scan count 

d. Tab: Data set-up  

i. I left the default (“Instrument’s time stamp) for “Source for start time in 

output .cnv header” which is new in the 7.23.1 version. 

ii. I did not click “Prompt for start time and/or note” – not sure in which 

version this box appeared (maybe 7.26.7). 

e. Tab: Miscellaneous: latitude when NMEA not available: 77 (doesn’t cause a 

difference in depth) 

f. Tab: Header view 

i. Tells about each file – stuff is manually entered for each cast – put in date, 

lake, weather, time (takes from computer so check). I don’t usually change 

anything on this page. 

g. Tab: Go back to file set-up 

h. START PROCESS – (if you get an error because the temp serial number in the 

header and con file don’t match, you can change it in the con file to match.) 

i. Exit once done (saved changes to .psu or .psa file) 

 

3. Run – Bin Average 

a. Tab: File set-up 

i. Program set up file – same as before 

ii. Input directory – same as before 

iii. Input files – select all (.cnv) 

iv. Output directory – same as before 

b. Tab: Data set-up 

i. Bin type – pressure, no interpolation 

ii. Bin size - 0.1 

iii. Click box to include # of scans per bin (I left box clicked to exclude bad 

scans) 

iv. Begin scans to skip over – 0 

v. End scans to omit – 0 

vi. Min scans per bin – 1 

vii. Max scans per bin – left default - 2147483647 

viii. Cast to process – downcast 

ix. Include surface bin – no (if include, will put #s in first bin line, but rest of 

values below the first bin line are the same whether surface bin is included 

or not). 

c. Tab: Header view – tells info 

d. Tab: Go back to File set-up 

e. START PROCESS – overwrite .cnv – yes to all 

f. Exit – save changes 

 

f. Run – Derive (may say created default file – say ok) 

a. Tab: File Set-up 
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i. Program set-up file – default 

ii. Instrument configuration file – select file for this year 

iii. Input directory – same as above 

iv. Input files – choose all (.cnv) 

v. Output directory – same as above 

b. Tab: Data set-up 

i. Select derived variables (secondary derivations using formulas)  

1. Density (kg/m3) 

2. Density (sigma-theta, kg/m3) 

3. salinity (PSU) 

4. Depth - freshwater (m)   

c. Tab: Miscellaneous: latitude when NMEA not available: 77 (doesn’t cause a 

difference in depth) 

d. Tab: Header view – just info 

e. Tab: Go back to File set-up 

f. START PROCESS – overwrite all .cnv files - yes (adds on new data) 

g. Exit – save changes to psa or psu file - yes 

 

g. Run – Buoyancy  (may say created default file – say ok) 

a. Tab: File set-up – same as above – select all .cnv files 

b. Tab: Data set-up  

i. buoyance variable: Latitude  

ii. Latitude: - 77 (the program takes an absolute value for latitude) 

iii. window size: 3 

iv. units  

1.  buoyancy frequency [N^2, rad^2/s^2] 

2. stability, E (rad2/m)  

c. Tab: Header view – just info 

d. Tab: Go back to File set-up 

e. START PROCESS – overwrite all .cnv files - yes (adds on new data) 

f. Exit – save changes to psa or psu file - yes 

 

h. Run – ASCII out (separates header into different file) – (creates default file) 

a. Tab: File set-up – same as above - select all .cnv files 

b. Tab: Data set-up – check top 3 boxes 

i. Lines – 60 

ii. Label columns – top of the file 

iii. Column separator – space 

iv. Julian days – julian days (this was in the 7.20d version) - In version 

7.23.1, there is a box to click on for “Select Time Conversion Formats” – I 

left them all as “Do not convert” 

v. Other 2 boxes blank (this was in the 7.20d version) - In version 7.23.1 

there is an “Add first column” box – I left it blank) 

vi. Replace bad flag – don’t check (makes no difference if check box) 

vii. Select output variables (all should be checked) 
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c. Tab: Header view – just info 

d. Tab: Go back to File set-up 

e. START PROCESS  

f. Exit – save changes to psa or psu file - yes 

 

The files are now in the folder you chose as the Output Directory. You have CNV, ASCII 

(Wordpad) and HDR files. Use ASCII files because these have headers, CNV do not. Open 

Excel – open Word Pad (ASCII) files – save as Excel. 

 

In order to check the surface and bottom CTD depths for depth correction applications, or to 

process any pause tests, you will need to convert the files into unbinned datasets. To do this, run 

Data Conversion, skip the Bin Average step, and run Derive for Depth (m). You can skip the 

Buoyancy step so go straight to ASCII out.   
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bbe Fluoroprobe – Underwater Spectral Fluorometer 

 

General Discussion 

 The bbe Fluoroprobe is a submersible spectrofluorometer which differentiates the four 

major groups of phytoplankton in the lakes (cyanobacteria, Chlorophyta, Chrysophyta, 

Cryptophyta) based on the chlorophyll-a fluorescence excitation spectra of the light harvesting 

apparatus. Algal chlorophyll-a is excited with light of five LEDs (emission wavelength 450 nm, 

525 nm, 570 nm, 590 nm, 610 nm). Dissolved yellow substances measured at 370 nm are used to 

correct for background fluorescence in the algal algorithms. Algal group concentrations are 

given in μg chl-a/L water sample. (This instrument was new in 0405 season). 

 

Materials 

bbe Fluoroprobe  

Downloading cables and USB converter 

PC laptop computer 

Sealant  

Auto start plug 

Fluoroprobe case 

 

The Fluoroprobe program version 1.8.4 was used until the 11-12 season, and the below methods 

are for that version. A new laptop was purchased for this season which would no longer run 

version 1.8.4. We started using the newest version (2.2.6.2) during this season. Any changes with 

the new program are noted below. 
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Figure 1 (left) and bbe Fluoroprobe with auto start plug (right). 

 

Procedure 

Instrument Calibration (according to the engineers at bbe, Transmission, Distilled water offset 

and Sample Temp do not have to be calibrated by the end user after calibration at the bbe 

workshop. These were done until the 1617 season. At this point John Priscu said we could check 

the parameters (check the temp readings against another thermometer, measure transmission in 

DIW), to keep on record, but do not change any settings in the instrument. 

Validate communication between the probe and the computer by hooking the probe cable up to 

the computer cable.  You can also save the probe battery by using the combo cable that plugs 

into the main power, the probe and the computer. 

 Test connection: ctrl+T (or ProbeTest connection)  

 Test voltage battery voltage: Probe Battery voltage --if voltage is around 11V, recharge 

the battery with the charger overnight. 

 Set the date and time on the Fluoroprobe by going to Probe  Set date/time. If the probe 

has been sent to the manufacturer for calibration, the time may be set to a different time 

zone. 

 

1. Sample Temperature - 2-point Calibration 

(For the 2 point calibration, water of 2 different temperatures, >10° C apart, and preferably 

covering the common range of the samples, are needed. Since the temperature range of our 

samples is not very large and is typically very low, it is difficult to cover the range of our 

samples). During the calibration measurement the Fluoroprobe has to be moved permanently (I 

think this is supposed to be “continuously”):  

 Go to File  Get data and parameters  Parameters only - the computer will pull the 

parameters stored in the Fluoroprobe to the computer. 

 Go to Calibration  Sample Temperature (Figure 2).   
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 Place the probe in a bucket of ice cold water measured with a thermometer, such that the 

water covers the temperature sensor (Figure 1).   

 Enter the temperature of the water as read on the thermometer in the “first calibration 

point” window. 

 Allow the current probe temperature as read in the display window to stabilize.  

 Press Hold next to the “first calibration point” window.  

 Place the probe in a bucket of room temperature water measured with a thermometer, 

such that the water covers the temperature sensor (Figure 1). 

 Enter the temperature of the water as read on the thermometer in the “second calibration 

point” window. 

 Allow the current probe temperature as read in the display window to stabilize. 

 Press Hold next to the “second calibration point” window. 

 Press Apply to send the results of the calibration (new offset and gradient) to the 

FluoroProbe. (Next time you get parameters from the Fluoroprobe, the program will pull 

these calibrations from the instrument). 

 Press X to exit this display window. 

 

 
Figure 2. 

 

2. Transmission Calibration 

 Go to Probe  Get data and parameters  Parameters only - the computer will pull the 

parameters stored in the fluoroprobe to the computer (this will already have been done if 

doing the above calibration). 

 Go to Calibration  Transmission (Figure 3). 

 Press Start under the offset section of the display window.  

 The probe will instruct the user to darken the detector window – Remove the protective 

case surrounding the fluoroprobe, and darken the detector window with a black cloth or 

piece of paper (Figure 1). 
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 Follow the instruction to calibrate the offset – the probe will take 10 measurements.  

**With the new 2.2.6.2 program that we began using during the 11-12 season, pressing 

the start button triggers a continuous transmission measurement. The readings are then 

shown in the scrolling window to the right. If you press the button "apply" the new offset 

is taken and shown in the small frame under the old offset. The readings in the window to 

the right continue flowing - that is normal. Put the fluoroprobe into water then and start 

the calibration with the start button related to the gradient calibration. The readings reach 

somewhere around 100%. By pressing the "apply" button a new value for the gradient is 

taken - like before.  (I got this information from Tim Doyle (our US Fluoroprobe rep), 

because it was still described in the new manual as it was in the old manual version). ** 

 Press Apply in the offset section of the display window (sends the results of the offset 

calibration to the FluoroProbe. Next time you get parameters from the Fluoroprobe, the 

program will pull the new offset calibration from the probe.) 

 Press Start under the gradient section of the display window  

 The probe will instruct the user to place the probe in Distilled water - Place the probe in a 

bucket of distilled (use DI) water such that the water covers the detector window.   

 Follow the instruction to calibrate the gradient – the probe will take 1 measurement. 

 Press Apply in the gradient section of the display window (sends the results of the 

gradient calibration to the FluoroProbe. Next time you get parameters from the 

Fluoroprobe, the program will pull the new gradient calibration from the probe.) 

 Press X to exit this display window. 

 

 
Figure 3. 

 

3. Distilled Water Offset Calibration (ultrafiltrated offset calibration is not needed for Limno 

Sampling – the ultrafiltrated offset is only used when the determination of yellow substances is 

turned off; the distilled offset is used when the determination of yellow substance is turned on) 

 Place the probe in a bucket of distilled (use DI) water such that the water covers the 

sampling window (need at least 30 cm of clearance) (Figure 1). 
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 Avoid artificial light during calibration, especially fluorescent lamps! Therefore, shut off 

all lights. 

 Go to Probe  Get data and parameters  Parameters only - the computer will pull the 

parameters stored in the fluoroprobe to the computer (this will already have been done if 

doing all the above calibrations). 

 Go to Calibration  Offsets (distilled) (Figure 4). 

 Press Start – the probe will take 10 measurements and display the new distilled water 

offsets. 

 The transmission will be displayed following the calibration - the transmission should 

read approximately 100%.  If it is not, re-do calibration of the transmission. 

 Press Apply (sends the results of the calibration to the FluoroProbe. Next time you get 

 parameters from the Fluoroprobe, the program will pull the new Distilled water offsets 

from the probe). 

 Choose OK in response to probe warning. 

 

 
Figure 4. 

 

Check the Calibrations (you can take screen shots of the calibrations that are in the instrument to 

keep on record if desired). 

 Once the probe is connected to the computer, go to Probe  Get data and parameters  

Parameters only - the computer will pull the parameters stored in the fluoroprobe to the 

computer. 

 The Sample Temperature and Transmission offset and gradient calibrations will be 

displayed in the “Parameters of Measurement” tab (Figure 5). 

 The Distilled Water Offsets will be displayed in the “Parameters of Fit” tab (Figure 6). 
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Figure 5. 

 

 
Figure 6. 

 

Data Collection 
1.  Check parameters: 

 Connect probe to computer 

 Test connection: ctrl+T (ProbeTest connection) 

 Test voltage battery voltage: Probe Battery voltage --if voltage is around 11V, recharge 

the battery with the charger overnight. 

 Delete old data stored on the fluoroprobe: Probe  Delete data  type “0” 

 Go to Probe  get data/parameters  choose parameters only 

 Check current common probe parameters under the common parameters tab (Figure 7). 

 



 Section 5. Instruments 
 5.5 Underwater Spectral Fluorometer 

LTER Limnological Methods Manual Page 182  Method_Manual_JL_092319.docx 

 
Figure 7.  

 

For Depth Profiles: 

  Warm up: 30 s  

Measuring duration 2 1/10 s (ie. 0.2 s) 

Measuring interval 0 s 

LED measuring time 20 1/10s 

LED measuring interval 60 s 

  Measurement: continuously 

  Switches: check all parameters 

 

Click “Send” to send the parameters to the probe if you change them. Next time you connect 

with the probe they should be the same because it will download the parameters from the probe 

that were saved.  

 

 For Time Course Experiments: 

  Parameters as above except increase measuring interval to 300 s 

 

2. Set Air Pressure (to get a correct measurement of the depth from the integrated pressure 

measurement, it is necessary to subtract the air pressure): 

 Go to “Probe” – Set Air Pressure (Figure 8). 

 A Window will appear displaying the pressure read by the pressure sensor on the probe. 

 With the probe above water, click Apply on the average pressure as displayed in the 

window (note the pressure chosen in your field notebook). 

 The air pressure will be set to the new value in the computer, and the pressure you chose 

will be displayed in the “Parameters of Measurement” tab (Figure 9).  
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This pressure will be used in the depth calculation by the program once the data are uploaded 

to the computer after the cast. Since the air pressure is set in the computer, it is best to leave 

the Fluoroprobe program open during the cast (between starting the cast and uploading the 

data), and to use the open program with which the air pressure has been set to upload the data 

from the Fluoroprobe. If the program is closed between casting and uploading the data from 

the probe, the pressure will need to be reset AND sent to the probe before downloading data 

from the probe. To do this, enter the correct pressure into the “Parameters of Measurement” 

screen in the “air pressure” field of the “pressure” section, and click “send” to send the data 

to the probe. Then upload the data by “getting data and parameters,” and the depth will be 

calculated correctly.  

 

 
Figure 8. 

 

 
Figure 9. 
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3. Press F5 to start measurement (or probe  start measurement): The probe will start 

continuous measurement. The probe will continue recording as long as it is hooked up to the 

computer (you will see records begin to appear in the “data” tab – Figure 10). Pull the computer 

plug from the Fluoroprobe to disconnect it from the computer and place on the protective cap. 

Once you disconnect the cable from the probe, it will stop taking measurements, until you plug 

in the auto-start plug. Once you plug in the auto start plug, the probe will continue 

measurements. These will be downloaded to the computer after the cast is done. Don’t plug in 

the auto start plug until you are ready to start the cast because measurements will be taken, and 

there is a limited amount of space in the probe. The fluoroprobe will hold maximum 1700 data 

points before it rewrites over previous data. 

 

 
  Figure 10. 

 

4. Connect the Fluoroprobe to the winch cable using the carabiner. Because of the high salt 

content at the bottom of some of the lakes, the pressure sensor does not accurately record the 

depth. It is necessary to correct for this by knowing the exact depth the Fluoroprobe is 

lowered to, measured from the water surface to the bottom of the Fluoroprobe (this is where 

the pressure sensor is located).  

a. Measure the distance from the top of the shackle at the top of the Fluoroprobe to the 

bottom of the Fluoroprobe and note this in your notebook (distance a in Figure 11). This 

will be the same throughout the season.  

b. The distance from the end loop on the winch cable to the “zero” mark on the winch cable 

varies with lake (there is a winch for each lake). Measure the distance from the top of the 

shackle to the zero mark on the winch cable (distance b in Figure 11). THIS MUST BE 

DONE AT EACH LAKE.  

c. Use the sum of these values to decide which depth to cast the Fluoroprobe to (~1m from 

the bottom of the lake), and note all measurements in your notebook (i.e. Fluoroprobe 

was cast to 17m on winch cable + 0.710m (distance a) + 0.765m (distance b) = 18.475m 

from water surface to bottom of Fluoroprobe). It is best to draw a diagram like the one 
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below in your notebook to avoid any confusion. 

 

 
Figure 11. 

 

4.  To cast: 

 Remove protective cap. Remove dirty/dried sealant and reapply to plastic areas as 

necessary. Reapply sealant to plastic areas of auto start plug if necessary. 

 When ready to cast, insert auto start plug (ensure that plug fits tightly and makes a 

popping sound when it seals).  

 Lower the Fluoroprobe into the water up to the top of probe case. Let it sit for ~ 30 

seconds. Raise the Fluoroprobe into the air to get an air reading for ~10 sec. This depth is 

~ 0.4m from the bottom of the Fluoroprobe, and will be used to correct the pressure 

sensor to the correct depth during data processing, as will the bottom depth as measured 

in the above steps. Lower the Fluoroprobe back to the top of the probe case and let it sit 

for another ~30 sec. 

 Lower the Fluoroprobe at a rate of 5-7 seconds per meter, to the desired depth ~1 m from 

the bottom of the lake, so that each meter has at least 10 data points. Stop at the bottom 

depth for ~10 sec, then retrieve the probe at any rate.  

 Rinse the probe in the surface water by moving it around, then remove it from the water. 

 Remove the auto start plug immediately to stop the probe from recording data. 

 

Downloading 

 Hook the Fluoroprobe up to the computer 

 (If the probe continues recording when it is plugged back into the computer - press F6 to 

  stop the measurement (or Probe  stop measurement). 

 Choose Probe  get data parameters  choose data and parameters. This will upload the 

data and parameters that are stored in the Fluoroprobe from your cast. 

 Check that the cast was successful by checking data in the data tab (Figure 10) or the 

graphics tab (Figure 12). 

 Save data on computer by exporting to a text file by clicking on FileExport; this can 

later be converted to Excel. You can also save the .flp file (FileSave As) if you would 

like to view the graphics later in the Fluoroprobe program.  
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Figure 12. 

 

bbe Fluoroprobe information: 

Contact Name: Rudiger Olbrich (engineer)  

Phone: ++49 431-380400 

Email: Rolbrich@BBE-moldaenke.de 

 

US Contact (Mass):  

Tim Doyle, Product Specialist: td@ppsystems.com 

 

Fluoroprobe Serial Number:  TS-14-16 
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HOBO Pendant Temperature Data Logger 

Materials 
HOBO Optic USB Base Station – Part No. BASE-U-4 (with USB cable) 

HOBO Pendant Temp Logger 

Onset Coupler for Pendant – Part No. COUPLER2-A 

HOBOware program 2.2 or later 

 

 

Procedure 

Download the HOBOware PRO program onto the laptop. 

Attach the Coupler to the Optic USB Base Station and plug the Pendant logger into the Coupler. 

Plug the Optic USB Base Station into the Laptop. 

To start logging: 

Open the HOBOware PRO progam and click on “Device” > “Launch” (Figure 2). Note that the 

logger time is set to sync with the laptop time. 

 Set the Logging Interval to 5 minutes. 

 Set “Start Logging” to “Now”. 

 Press “start” to begin logging. 

 
Figure 2. 

Put logger in incubator with Thymidine incubation (put on clean towel!) 

To retrieve data: 

Open the HOBOware PRO program. Click “Device” > “Stop” (if you forget this step, it will ask 

if you want to stop the logger when you download the data). Click on “Device” > “Readout”.  

Choose where to save the file and click “Plot” (Figure 3). This file can be opened in the HOBO 

program later to plot the data. 
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Figure 3. 

Click on “File” > “Export Table Data” and click “Export”. A csv file will be saved where you 

choose. 

Notes:  
Do not store the logger in the coupler. It consumes more battery when it is plugged in.  

Keep the logger away from magnets.  

The logger requires one 3-volt CR-2032 lithium battery.  
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Sample and Data Submission 

 

Sample Chain of Custody 

 Chlorophyll-a, Anions/Cation, Dissolved Organic Carbon, Particulate Organic Carbon 

and Nitrogen, and Macronutrient samples are analyzed by Analytical Services each season; the 

rest of the samples collected are analyzed by Limno Team members, either in McMurdo or upon 

return to Montana State University.  Submission of analytical samples is done through the 

Analytical Services Team Leader using the Chain of Custody (COC) forms.  These forms 

provide the Analytical Team in the field and the Data Manager with information on all the 

samples being submitted for analysis. The COC forms also contain information on Limno runs 

performed each season, on in-situ measurements made, and on data which will be submitted to 

the MCM Database from samples analyzed by the Limno Team. Because information from the 

COC forms is uploaded into the MCM database, the forms must be filled out completely and 

accurately by the group submitting the samples. These forms provide a permanent record of all 

information gathered from each Limno Run for each season.  COC forms can be found on the 

MCM website at http://www.mcmlter.org/restricted/analytical_services.htm.  

 

Data Submission 

 Data from all analyses and measurements performed during Limno Runs are submitted to 

the Data Manager to be uploaded into the MCM database. Data must be submitted in specific 

formats. Data submission formats and instructions can be found on the MCM website at 

http://www.mcmlter.org/restricted/data_management/limno_submission.htm. 

 

The above sites are part of the restricted access portion of the MCM-LTER website. For access,  

email the data manager at mcmlter@bprc.mps.ohio-state.edu for the username and password.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.mcmlter.org/restricted/analytical_services.htm
http://www.mcmlter.org/restricted/data_management/limno_submission.htm
mailto:mcmlter@bprc.mps.ohio-state.edu
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BOTTLE WASHING 

 

To make 1% HCL, bring 100 ml (0.1L) concentrated HCL to 10L DIW. 

 
Sample Bottles 

1L amber wide mouth HDPE bottles 

For new sample bottles, do a 10% HCL rinse and DIW rinses before using them. 

 

At the end of each season, bring sample bottles back and let them sit in MCM with 1% HCL in 

them to clean them for next season.   

 

At the start of each season, dump 1% HCL that was in bottles over winter. Rinse 2X with DIW. 

Fill bottles with at least 500 ml DIW. Replace cap. Let sit right-side up for 1 hour; let sit upside 

down for 1 hour. Rinse 3X with DIW. 

 

Rinse sample bottles with DIW between Limno runs. 

 

DOC 

125 ml amber borosilicate glass bottles  

Dump samples from previous year from bottles and remove tape. Rinse caps (new or old as long 

as Teflon liners are still in caps) in a beaker with 1% HCL followed by 3X DIW.  Rinse bottles 

3X with hot tap water, fill at least half-way with 1% HCL and cap with Teflon lined cap, let sit 

right-side up for at least 1 hour, flip upside down for at least 1 hour, rinse with DIW 3X. Remove 

caps (lay on foil and cover until bottles are combusted) and place foil loosely over top of bottle. 

Combust at 475 C for 4 h. Replace caps once bottles are cooled. Tape bottles with any color 

tape. 

 

Include extra bottles for blank. 

 

Anion/Cation 

125ml clear wide mouth HDPE bottles.  

 

Anions: Wash with DI water by rinsing 3 times, then tape with blue label tape. 

 

Cations: Acid soak with 1% HCL for at least 1 hour: Fill at least half-way with 1% HCL, cap, let 

sit right-side up for ~1 hour, flip upside-down for ~1 hour, DIW rinse 5 times. Tape with white 

labeling tape. 1% HCL can be re-used for other acid rinsing since the bottles are new. 

 

Include extra bottles for blank. 

 

Nutrients 

125 ml clear wide mouth HDPE bottles 

Acid soak w/ 1% HCL for at least 1 hour: Fill at least half-way with 1% HCL, cap, let sit right-

side up for ~1 hour, flip upside-down for ~1 hour, DIW rinse 5 times. Tape with white labeling 

tape. 1% HCL can be re-used for other acid rinsing since the bottles are new. 
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Include extra bottles for blank. 

 

DIC 

30 ml serum vials 

Bottles from the previous year can be re-used: check for salt build-up before using. If they are 

clean, rinse with 1% HCL, then rinse 6X with DIW. It is a good idea to clean the outside of the 

bottles as they will be in a ziplock bag without stoppers to keep them clean (the stoppers fall out 

if you put them in). It is best to clean bottles at the end of the season to avoid salt build-up for the 

next year. If bottles are brand new, they can be DIW rinsed 6X before use. Rinse stoppers 3X 

with DIW and put in Whirlpak bag for each lake. 

 

DNA 

Acid rinse 1L Nalgenes used for DNA collection and the waste Nalgene. 1X 1% HCL + 3X 

DIW. 

 

 

FILTER PREP 

 
CHL filters 

25-mm GF/F filters, pre-combusted and acidified. 

Combustion protocol: combust at 475oC for 4 hrs spread out on aluminum foil that will serve as 

a wrapper after combustion and acidification.  

Acidification protocol: soak in 1% HCL for 3-4 hours, rinse 4X with DIW, bring the pH to 8-9 

with NaOH, rinse 2X with DIW, lay out on combusted foil to dry, and wrap in foil once dried.  

Combusted and acidified filters are only necessary if certain filtrate samples are being collected – 

they are not required for Chlorophyll analysis. Since combusted filters are required for Dissolved 

Organic Carbon (DOC) filtrate (collected from one Chlorophyll replicate), and acidified filters 

should be used for nutrient (Soluble Reactive Phosphorus) filtrate (collected from one 

Chlorophyll replicate), it is recommended to combust and acidify chlorophyll-a filters. The 

NaOH step is done because acid will degrade the chlorophyll samples. 

 

CN filters + Aluminum weigh boats 

25 mm GF/F filters and aluminum weigh boats, combusted. 

Combust at 475 C for 4 h spread out on aluminum foil that will serve as a wrapper after 

combustion. 

 

PP filters 

25-mm GF/F filters, pre-combusted (to remove organic phosphorus) and acidified.  

Combustion protocol: combust at 475oC for 4 hrs spread out on aluminum foil that will serve as 

a wrapper after combustion and acidification.  

Acidification protocol: soak in 1% HCL for 3-4 hours, rinse 4X with DIW, lay out on combusted 

foil to dry, and wrap in foil once dried. 
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Filtration Notes 

 

Remember:  Always rinse filter towers, graduated cylinders, and filter forceps between samples 

to reduce cross-contamination. 

  

Remember:  Always check vacuum on vacuum pump.  6-7 inches Hg vacuum is max for CHL 

and PPR. 10 is max for PP, CN and AN/CAT. 

 

Chlorophyll-a, Nutrient, and Dissolved Organic Carbon Analyses 
 Use bell jars with bottle stands, 25 mm polysulfone filter towers, combusted GF/F filters. 

 

 Take sample aliquots from 1000 ml amber bottles. 

 

 Decant 100 ml of sample (CHL, NUT, DOC) into a graduated cylinder (don’t forget to invert 

sample). 

 

 Darken the room as much as possible.  Filter 100 ml of sample for NUT into an acid washed 

125 ml narrow mouth bottle.  After the samples finish filtering, turn off the vacuum pump 

and wait a few seconds for the vacuum to clear. Remove the GF/F filter, fold in half (organic 

matter inside) and place in a labeled glassine envelope.  Next, for DOC, filter 100 ml of 

sample into a combusted 100 ml amber glass bottle.  Again, filter is folded and placed in the 

glassine envelope.  Use one envelope for both filters.  Both filters will be used for replicate 

Chl-a analysis. 

 

 Sample Preservation: 

CHL:  Wrap all of the glassine envelopes in foil, label the pack, and freeze. 

NUT:  Place samples in a freezer (if possible) or the coldest place possible. 

DOC:  Add 1 ml of 6N HCL, store bottles in their boxes at 4C, DO NOT FREEZE 

 

Particulate Carbon and Nitrogen  

 Use a six place manifold with 25 mm polysulfone filter towers and combusted GF/F filters. 

 

 Take sample aliquot from 1000 ml amber bottle. 

 

 Decant 500 ml of sample into a 500 ml graduated cylinder and filter the entire volume.  Note:  

The entire volume should be filtered, even for chemocline depths at Lake Bonney and Lake 

Fryxell.  Record the volume of water filtered for each depth in each lake. 

 

 After filtering, rinse filter while still in filter tower with approximately 20 ml of DI to remove 

salts.  Remove filter with forceps, place in a labeled aluminum pan and let the filter dry.  

When dry, stack pans, wrap with a piece of labeling tape, put stack in a zip lock and freeze. 
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Anions/Cations 

 Take 100 ml sample aliquot from 1000 ml amber bottle. 

 

 Use bell jars with bottle stands, 47 mm magnetic filter towers and 0.4 m nuclepore filters.  

Be careful to place the filter correct side up (see package instructions) and only handle the 

filter at the edge with forceps.  The filters can be torn easily.  When in doubt, throw it out! 

 

 Pour sample from amber bottle directly into DI rinsed filter tower, no need to measure 

sample, just use the markings on the filter towers as a guide.  First filter 100 ml of sample 

into an acid rinsed (white tape) 125 ml wide-mouth bottle for the cation sample.  When 

finished, replace the acid washed bottle with a DI rinsed (blue tape) 125 ml wide-mouth 

bottle for the anion sample.  Use the same filter tower for both the anion and cation aliquots.  

Use a new filter between the cation and anion samples (of the same depth) if filtering is slow; 

otherwise, you can use the same filter for both.  Also filter at least one filter blank using same 

procedure.  Pack the AN and CAT samples in separate plastic bags and place in coolers.  OK 

to freeze. 
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Preparation of Standard Solutions 
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Example:  Prepare 500 ml of a stock molybdenum solution containing 0.1 mg (100 micrograms) 

of molybdenum per ml using Na2MoO4  2H2O. 

 

At. Wt. of Mo = 95.95 

 

Formula Wt. of  Na2MoO4   2H2O = 241.98 

 

(500)  (0.1) = Wt. of salt required  (95.95/241.98) 

 

Wt. of salt required = (241.98/95.95)  (500)  (0.1) 

 

Wt. of salt required = 126.1 mg 

 

Therefore place 126.1 mg of hydrated sodium molybdate in a 500 ml volumetric flask and add 

DI water up to the mark.  Vortex well. 

 

Dilutions 

Sometimes it is necessary to prepare a more concentrated stock solution and then make sub-

dilutions from it.  This may be necessary when the amount of salt required is too small to be 

accurately weighed or for the solutions which do not store well when very dilute. 
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Example:  Prepare 100 ml of  molybdenum solution containing 0.005 mg (5 micrograms) of 

molybdenum per ml using the previously prepared stock solution. 

 

(100)  (0.005) = Vol. of stock soln.  (0.1) 

 

Vol. of stock soln. = (100  0.005)/0.1 = 5 ml 

 

therefore 5 ml of the stock solution should be added to a 100 ml volumetric flask and enough 

deionized water added to bring the volume up to 100 ml. 

 

Molar Solutions 

A one molar (1 M) solution contains one gram molecular weight of a salt in enough water to 

make one liter. 
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Example:  Prepare 250 ml of 0.4 M sodium molybdate. 

 

Wt. of salt required = 250  0.4  241.98 

Wt of salt required = 24,198 mg = 24.198 grams. 

 

Therefore, dissolve 24.198 grams of the hydrated sodium molybdate in enough water to make 

250 ml. 

 

Dilutions 
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Example:  Prepare 100 ml of 0.87 M sodium molybdate from a 3 M stock solution. 

(100)  (0.87) = Vol. of stock required  3.0 

Vol. of stock required = (100  0.87)/3.0 = 29 ml 

Therefore, 29 ml of the 3.0 M stock solution are diluted up to 100 ml with DI water. 

 

Normal Solutions 

A one normal (1N) solution contains one gram equivalent weight of a salt in enough water to 

make one liter.  The equivalent weight of an acid is the weight which yields one mole of 

hydrogen ions.  The equivalent weight of a base is the weight which reacts with one mole of 

hydrogen ions.  The molar formulas can be used by substituting gram equivalent weights for 

gram molecular weights and normalities for molarities. 

 

Miscellaneous 

1 microgram atom of a particular element equals the atomic weight of that element expressed in 

micrograms (i.e. A solution containing one microgram atom of molybdenum per liter would 

contain 95.95 micrograms of molybdenum per liter). 

 

0.001 grams = 1 mg = 1000 micrograms 

 

for dilute solutions; 

1 ppm = 1 mg/liter 

1 ppb = 1 microgram/liter = 1 mg/m3 

0.05% of a constituent equals 500 ppm because 0.05% = 0.05/100 = 500/106 = 500 ppm 



 Section 6. Appendices 
 6.5 Standard Solutions 

LTER Limnological Methods Manual Page 199  Method_Manual_JL_092319.docx 

Preparation of Common Acid Solutions 
 

1. Prepare the following reagents by carefully adding the required volume of concentrated acid 

to the desired volume of DIW (stir continuously).  Never add water to concentrated acid. 

 

Table 13.  Dilution factors for common acid solutions. 

Desired Solution 
Hydrochloric 

acid (HCl) 

Sulfuric acid 

(H2SO4) 

Nitric acid 

(HNO3) 

Percent active ingredient in concentrated 

reagent 

36-37 96-98 69-70 

Normality of concentrated reagent 11-12 36 15-16 

Volume (ml) of concentrated reagent to 

prepare 1 l of: 

   

    18 N solution - 500 (1 + 1) - 

    6 N solution 500 (1 + 1) 167 (1 + 5) 380 

    1 N solution  28 64 

    0.1 N solution 8.3 2.8 6.4 

Volume (ml) of 6 N reagent to prepare 1 l 

of 0.1 N solution 

17 17 17 

Volume (ml) of 1 N reagent to prepare 1 l 

of 0.02 N solution 

20 20 20 
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Spectrophotometry 

It is often possible to determine the concentration of a constituent in water by reacting it 

with chemicals to form a colored species, and then measuring the light absorbance of this 

species.  For this method to work, the constituent to be measured must be the limiting reactant in 

the fraction forming the colored species.  All other reactants are added in excess.  For example, 

dissolved oxygen concentrations may be measured by determining the amount of light absorbed 

by the yellow iodine solution produced in the Winkler Method.  This is possible since the 

amount of yellow iodine released is limited by the amount of oxygen present. 

To understand spectrophotometry you need to understand factors affecting light 

transmittance.  The amount of light transmitted through a medium decreases in a geometric 

progression as the length of the optical path increases arithmetically.  Also, for a given optical 

path, the transmittance decreases in a geometric progression.  These relations can be expressed in 

the Fundamental Law of Spectrophotometry, The Beer-Lambert or simply Beer’s Law: 

 

  

a = absorptivity of compound 

b = optical path length 

c = concentration of compound 

A = absorbance 

 

Absorbance is an easy term to use in spectrophotometry since it is normally related linearly to 

concentration and path length.  Beer’s law is only strictly applicable for a single wavelength of 

light.  In practice, a narrow band width of light is produced by a colored filter or by a 

monochromator.  This wavelength selected for a particular analysis  is usually that which 

produced the greatest difference in absorbance between the colored species of interest and any 

interfering compound (i.e. , color introduced in reagents, turbidity). 

 

Photometers are most accurate when readings on samples fall in the range of 0.1 to 1 absorbance 

with respect to a blank adjusted to read 0 absorbance (100% transmittance).  The analyst can 

adjust the path length of light by selecting the proper spectrophotometer curvette.  Path lengths 

of 1,4,5, & 10 cm are commonly used.  By selecting the proper path length, absorbance can often 

be made to fall in the proper range. 

 

In its simplest form, the concentration of an unknown substance can be determined by: (1) 

Adding reagents which will react with the substance to form a colored species; (2) Measuring the 

absorbance of the colored complex at an appropriate wavelength; (3) Constructing a standard 

curve by measuring the absorbances of known concentrations of the substance after treatment 

with the color forming reagents.  If Beer’s law is followed, a linear relationship between 

concentration and absorption is found and the line will pass through the origin; (4) Comparing 

the absorbance of the unknown against the standard curve to estimate its concentration. 
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There are three factors which often interfere with this simple procedure.  (1) Turbidity or color of 

the sample water may cause additional absorbance of light in addition to that of the colored 

species of interest. (2) The reagents themselves often introduce significant quantities of the 

constituent of interest. (3) The distilled water used for the standard solutions and reagents may 

contain significant quantities of the constituent to be measured. 

 

I.  If #1 and #2 are important the following procedures should be followed: 

a. The standard curve is prepared by balancing the photometer to zero absorbance with plain 

distilled water and reading all the standards, including a zero standard (Reagent blank) against 

the distilled water.  If significant contamination is present in the reagents, the line relating 

concentration to absorbance will not pass through the origin. 

 

b. To correct for #1, the sample to be tested is divided into two aliquots.  One is treated with all 

of the reagents except the color-forming reagent.  This sample blank is then placed in the 

photometer and it is adjusted to read zero absorbance by adjusting the slit width. 

 

The aliquot with the color-graming reagent is then tested, and its absorbance is compared with 

the standard curve and concentrations calculated directly.  Any significant increase or decrease is 

volume caused by the omission or addition of reagents must be considered in the calculations. 

 

II.  In some situations, the distilled water used to prepare the reagents and the standards may 

have significant quantities of the constituent to be measured.  If it is known that this is the case, 

and the reagents contribute insignificant contamination, a special procedure is necessary.  After 

treatment, all of the reagent blanks, standards, and water samples contain the same amount of 

reagents, but different amounts of distilled water.  The standards all contain 100% distilled 

water.  Therefore, in constructing the standard curve the full value of the reagent blank (0 

standard) is subtracted from each standard. 

 

(Acorr = Astandard - Areagent blank) 

 

Acorr  is then plotted against concentration.  That is, the standard curve is adjusted to pass through 

the origin. 

 

To measure the sample absorbance, the photometer is first adjusted to zero absorbance using the 

sample blank as described previously.  The absorbance of a sample with the color-forming 

reagent present must be corrected for the amount of constituent added by the distilled water.  For 

example, assume that we are adding 5 ml of reagents to 100 ml of lake water.  The true 

absorbance of the samples is calculated as follows: 

 

 

 

Once a standard curve has been constructed and if it is found to be a linear relationship, it is 

often easier to use a linear regression equation to determine concentrations than to manually plot 

absorbance values on graph paper. 
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For example, in I above, a relationship between iron concentration (ppb) in the standards and 

absorbance might be: 

 

Absorbance= .00343  (conc.) + 0.0333 (as in Figure 1) 

 

If the absorbance of the lake water sample is known, its concentration can then be easily 

calculated. 

 

Once the relationship between concentration and absorbance is known, a complete set of 

standards need not be prepared for every single set of samples to be analyzed.  However, it is 

necessary to prepare a reagent blank and at least one standard in the upper end of the optimum 

concentration range, along with every group of samples, in order to verify any unsuspected 

changes in the reagents, instruments, or the technique.  At regular intervals a complete set of 

standards (5-6) should be prepared.  The standards should cover the range of values expected 

from the water samples. 

 It is possible that a water sample will contain solutes that will interfere with detection 

(i.e. color formation) of the species of interest.  To determine if this is occurring, an internal 

standard can be run.  In this procedure a lake water sample is split into two series.  A known 

quantity of the species if interest is added to each flask in the first series.  For example, 10 g  

atoms Fe-liter-1 might be added to each container.  Flasks in the second series would receive an 

equal amount of distilled water.  The two samples are then normally processed.  If the mean of 

the second series was 5.0 g  atoms  fe-liter-1, the mean of the first series with the internal 

standards should yield a value of 15 g  atoms Fe  liter-1.  If the second value differed 

significantly from 15.0, interference is probable.  Internal standards may be used in other types 

of quantitative analysis besides calorimetric analysis. 
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Preparation of 14C-bicarbonate Stock Solution 
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1. Prepare the ampoules for ampulation.  Autoclave the ampoules if they appear unclean. 

Quantity of ampules required 

(one scenario) 

Qty  ampoule vol. Total Volume (ml) 

28  15 ml 420 

28  10 ml 280 

6  5 ml 30 

10  2 ml 20 

 

2. Boil 675 ml of nanopure/organopure water and cool.  Place a stir bar in the flask and stopper 

the flask with an ascarite scrubber.  This will prevent CO2 from entering the flask during the 

cooling period.  Note: There is a special flask for this procedure in the ampulating kit, Crary 

Laboratory.  

3. Adjust the pH of the water to 10 with 5N NaOH (final pH should be 9.5-10.0). 

4. Add the 75 mCi of 14C-bicarbonate stock to the 675 ml of boiled nanopure water. 

5. Recheck the pH and adjust accordingly. 

6. Ampulate while mixing the stock solution. 

7. Autoclave the ampoules (slow-cool setting) in phenolpthaline bath to detect leaks (leaky vials 

will suck in liquid upon cooling, and the phenolphthalein will turn the ampoule pink by 

reacting with the pH 9.5 14C-bicarbonate solution). 

 

Phenolthalein indicator solution: dissolve 5 g phenolthalein disodium salt in distilled water and 

dilute to 1 l. 

 

 

8. Wash the ampoules thoroughly, and record the total number and volume of ampoules 

prepared. 
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Preparation of 14C-toluene Quench Curve and Standardization 

   

1. Use a certified 14C-toluene standard and calibrated P100 Gilson Pipetman to prepare quench 

curve standards. 

2. Calculate the present day activity (Nt) of the 14C-toluene standard. 
 tk

t NN  e  

 where N is the specific activity at date of manufacture, k is the decay constant for 14C 

(-0.0001210968), and t is the elapsed time in years since manufacturing. 

 

 Note: 2.2106 dpm µCi-1 

 

3. Prepare each quench standard according to the following table, the volume of 14C-toluene 

will represent a known dpm added to each vial.  Count each vial and determine the actual 

dpm for each vial before adding the acetone. 

 

Vial # Volume of 
14C-toluene 

added (µl) 

Volume of 

Acetone 

added (µl) 

Q1 25 0 

Q2 25 50 

Q3 25 100 

Q4 25 200 

Q5 25 300 

Q6 25 400 

Q7 25 500 

Q8 25 800 

Q9 25 1000 

BLANK 0 0 

 

4. Add 10 ml of cytoscint cocktail to each 20 ml scintillation vial and recount the Quench 

Curve. 

5. Compare the new Quench Curve to the old one and determine the percent difference: 

 

 
100 

 vialdpm old Average

 vialdpm new Average -  vialdpm old Average
difference %

1-

-1-1









  
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Preparation of 3H-toluene Quench Curve and Standardization 

   

1. Use a certified 3H-toluene standard and calibrated P100 Gilson Pipetman to prepare quench 

curve standards. 

2. Calculate the present day activity (Nt) of the 14C-toluene standard. 
 tk

t NN  e  

 where N is the specific activity at date of manufacture, k is the decay constant for 3H 

(-0.0565373), and t is the elapsed time in years since manufacturing. 

 

 Note: 2.2106 dpm µCi-1 

 

3. Prepare each quench standard according to the following table, the volume of 14C-toluene 

will represent a known dpm added to each vial.  Count each vial and determine the actual 

dpm for each vial before adding the acetone. 

 

Vial # Volume of 3H-

toluene added 

(µl) 

Volume of 

Acetone 

added (µl) 

Q1 25 0 

Q2 25 50 

Q3 25 100 

Q4 25 200 

Q5 25 300 

Q6 25 400 

Q7 25 500 

Q8 25 800 

Q9 25 1000 

BLANK 0 0 

 

4. Add 20 ml of cytoscint cocktail to each 20 ml scintillation vial and recount the Quench 

Curve. 

6. Compare the new Quench Curve to the old one and determine the percent difference: 

 

 
100 

 vialdpm old Average

 vialdpm new Average -  vialdpm old Average
difference %

1-

-1-1









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SNC and Sample Run Methods for the TriCarb Scintillation Counter – written 

during 1819 season by Amy 
 

TO RUN SWIPES (OR SAMPLES ONCE YOU HAVE AN ASSAY SET UP AND 

PROTOCOL NUMBER ATTACHED TO IT) USING THE TRICARB SCINTILLATION 

COUNTER AND QUANTA SMART PROGRAM. 

 

1. Daily Calibration, Normalization and Instrument Performance Assessment (IPA) 

 

 Run the SNC (Self-Normalization and Calibration) cassette containing the unquenched 
14C standard, the unquenched Tritium standard and the background standard as shown 

and outlined below: 

 
Figure 1. 

 

 Make sure to move the “Cycle Flag” (see Figure 1) to the left. This will tell the 

instrument the cassette has not yet been counted. Once the rack is counted, the flag will 

be pushed to the right.  

 This calibration must be run daily, every 23 hours. If the SNC cassette is left on the 

instrument counting deck at all times, the calibration, normalization and IPA procedures 

will automatically be performed every 23 hours. The instrument has an internal timer that 

is set each time the SNC cassette is run. You can also run the SNC cassette manually by 

resetting the “Cycle Flag” on the rack to the left.  
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 Note that the scintillation counters in Crary are not online and therefore are not able to 

print, so the cassette following the SNC cassette (if you load swipes or samples to count 

after the SNC cassette) may not start automatically since the program tries to print the 

SNC results once the cassette is finished running. You will need to cancel the print job, 

then press the green flag to start your swipes or samples (Figure 2).  

 

2. Counting Swipes/Samples 

 Look in the “Protocol Tree” (Figure 2) to find which protocol number is associated with 

the method you would like to run.  

o Both scintillation counters in the Crary rad lab use protocol 5 for Swipes (not 

shown in Figure 2 as this is an example from the instrument manual). 

 
Figure 2. 

 

 Load cassette with your swipes/samples and attach the appropriate protocol number to the 

left side of the cassette (Figure 3). 
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Figure 3. 

 

 Slide the “Cycle Flag” to the left (Figure 3). (Only the first cassette in the run of a 

protocol needs to contain the protocol number flag). 

 Click on the green flag in the Quanta Smart window (Figure 2). 

 While your samples are running, the status bar (Figure 4) will show the protocol, cassette 

number and sample number being run: 

 
Figure 4. 

 

 Click on the “Window” menu in Figure 4 to switch between the “SpectraView Window”, 

which shows a real-time spectrum view of the sample being counted, and the “Report 

Output Window”, which shows the results of the counts. 

 If you are running swipes, once the counts are complete, a csv file and rich text document 

will be saved in the “Crary Lab Swipes” folder on the desktop. It is best to rename these 

files and move them to your own folder so the files are not overwritten the next time 

someone runs swipes and their results are saved in the “Crary Lab Swipes” folder.  

 Currently, you cannot print the results files because the scintillation counters are not 

online. There is a USB port on the side of the screen that will allow you to save your 

files, and print them from another computer if you want. 
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Some other useful commands in Quanta Smart: 

 

 
 

 
 

 
 

 

 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 Section 6. Appendices 
 6.10 TriCarb Scintillation Counter - Quench and DPM Assays 

LTER Limnological Methods Manual Page 210  Method_Manual_JL_092319.docx 

 

Setting up Quench and DPM Assays on the TriCarb Scintillation Counter – written 

during 1819 season by Amy  

 
There are 2 assays that need to be set up. The Quench Standards Assay and the DPM Assay.  

 

The below method uses both pictures of the QuantaSmart program from the TriCarb manuals, 

and screen shots taken after setting up the north counter in the Crary Rad Lab, in December 

2018. 

 

Quench Standards Assay 

 
The following methods will guide you through setting up a Quench Standards Assay to run the 

quench curve for 14C and the quench curve for 3H. 

 

Click on “File” > “New Assay” and select “Quench Standards” from the “Select Assay Type” 

window (Figure 1).  

 

 
Figure 1. 

 

You will be directed to the “Assay Definition Window” (Figure 2), where you can use the 7 tabs 

to set up your Quench Assay parameters. The details of this window will differ whether you are 

setting up the Quench Standards Assay or the DPM Assay. 
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Figure 2.  Default image from TriCarb manual. 

 

A. Create Quench Curve in Quench Standards Library 

Click on the “Name” button in the “Standards Group” section in the “Count Conditions” tab 

(Figure 2). This will bring you to the “Quench Standards” window (Figure 3), which is linked to 

the “Quench Standards Library”. 

 

Note that you can get to this window directly by clicking on “Libraries” > “Quench Standards”. 

 

 
Figure 3. 

 

Here you create the quench curve you want to run, the Maximum keV, and the DPMs of the 

quench standards to be counted (you can use the Decay Calculator button to calculate the decay 
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adjusted DPMs of your quench standards). Note that the program does not allow decimal places 

to be entered for the DPMs in the Quench Standards window, or when calculating the decay 

adjusted DPMs using the Decay Calculator. 

 

To create your quench curve, click “Add” in the “Quench Standards” window.  

 

We added 14C and 3H Quench Curves and named them “14C Quench Priscu” and “3H Quench 

Priscu”. The Maximum keV was kept at 156.0 for 14C and at 18.6 for 3H (these were the 

defaults) (Figure 3).  

 

The Number of Standards, Count Mode, Coincidence Time, Delay Before Burst, Count Started 

and Count Ended will automatically be filled in once you count your standards.  

 

B. Set up the Quench Standards Assay Parameters 

Next, set up the parameters to run the Quench Curve using the 7 tabs in the “Assay Definition 

Window”.  

 

1. Count Conditions: Figure 4a and 4b show the Count Conditions for the 14C and 3H 

quench curves. The maximum keV was set when the Quench Curve was set up. 

Everything else was left as default.  

 
Figure 4a. 
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Figure 4b. 

 

2. Count Corrections: Figure 5a and 5b show the Count Conditions for the 14C and 3H 

quench curves. Everything was left as default. 

 
Figure 5a. 
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Figure 5b. 

 

3. Report Definition: Figure 6a and 6b show the Report Definition for the 14C and 3H 

quench curves. The Report can be named in the “Report List” section in Figure 21. We 

left the default of “Report 1”.  Everything was left as default, except it looks like 

LUMEX (% sample luminescence), DATE, TIME and CPMa (counts/minute-alpha 

region) were added to the 3H curve. 

 
Figure 6a. 
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Figure 6b. 

 

4. Report Output: Figure 7a and 7b show the Report Output for the 14C and 3H quench 

curves. We set the “Text Data Files” section to generate an Excel file with output for 

“Sample”, “Include Column Header” and “Include Assay Definition Block Data.” 

Everything else was left as default. 

 

 
Figure 7a. 
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Figure 7b. 

 

5. Special Files: Figure 8 shows the Special Files for the 14C quench curve. No boxes were 

checked in either the 14C or 3H quench curves.  

 

 
Figure 8. 

 

6. Assay Details: Figure 9 shows the Assay Details for the 14C quench curve. No 

additional information was added for either the 14C or 3H quench curves.  
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Figure 9. 

 

7. Save the file 

Click on “Save As” and save the assay in the “Assays” folder. The file will be an .lsa file. 

This folder can be accessed via C: Packard > Tricarb > Assays and can be opened by clicking 

on “File” > “Open Assay” (Figure 9b). The Priscu Assays are circled in red. 

 

 
Figure 9b. 

 

The parameters in an assay can be changed by opening the .lsa file, editing the parameters in the 

“Assay Definition” window, pressing “Apply”, then “OK”. 
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C. Associate the Quench Standards Assay with a Protocol Number 

In order to run the quench standards, you will need to associate the Quench Standards Assay 

with a protocol number. Choose an available protocol flag number from the protocols tree. 

 

Select “File” > “Associate Assay” to open the “Associate Assay” window to select an assay to 

associate with the protocol flag number.  

 

Alternatively, associate an assay by right-clicking on a protocol flag number and selecting 

“Associate Assay” from the menu displayed. 

 

Associate the flag with the desired .lsa file in the “Associate Assay” window. 

 

Figure 10 shows that the 14C Quench Curve has been associated with protocol flag number 1, 

and the 3H Quench Curve has been associated with protocol flag number 2. 

 

 
Figure 10. 

 

The data files set up in the “Report Output” tab of the “Assay Definition” window are stored to 

the location defined for each protocol. When an assay is associated with a protocol flag number 

for the first time, users are prompted for data path information. We set up for the results to be 

saved to the following folder - C: Packard > Tricarb > Results > Priscu. 
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D. Run your Quench Standards using the 14C or 3H Quench Standards Assay protocol. 

Run the SNC cassette if 23 hours have passed since it was last run. 

 

1. Load a cassette with your quench standards and attach the appropriate protocol number to 

the left side of the cassette (Figure 11). 

 
Figure 11. 

 

2. Slide the “Cycle Flag” to the left (Figure 11).  

3. Click on the green flag in the Quanta Smart window. 

 

After running the standards, the file designated in the “Report Output” tab of the “Assay 

Definition” window will be saved as noted above. The program also automatically creates a 

folder for files run under each protocol and saves it in C:Packard > Tricarb > Results > 3H 

sample counting or C:Packard > Tricarb > Results > 14C sample counting, in a folder with the 

same name as the protocol. For the Quench Standards Assay, the folders will be as follows: 

 

 C:Packard > Tricarb > Results > 3H sample counting > 3H Quench Priscu 

 C:Packard > Tricarb > Results > 14C sample counting > 14C Quench Priscu 

In each of these folders, the files for each run are saved in a folder with the date and a number 

(i.e. 20181228_1739). There will be a .results file and a .csv file.  

 

DPM Assay 

 
The following methods will guide you through setting up a DPM Assay to run 14C and 3H 

samples.  

 

Click on “File” > “New Assay” and select “DPM (Single)” from the “Select Assay Type” 

window (Figure 12).  
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Figure 12. 

 

You will be directed to the “Assay Definition Window” (Figure 13), where you can use the 7 

tabs to set up your DPM Assay parameters. 

 

 
Figure 13. Default image from TriCarb manual. 

 

A. Choose Nuclide to Count from the Sample Nuclides Library 

When you are setting up the DPM Assay, you will choose or add the nuclide you want to count, 

and the Quench Standard Set to use, in the “Count Conditions” tab of the “Assay Definition 

Window” (Figure 13).  

 

Click on the “Name” button in the “Nuclide Group” section in the “Count Conditions” tab 

(Figure 13). This will bring you to the “Sample Nuclide Groups” window (Figure 15), which is 

linked to the “Sample Nuclides Library”. 
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Note that you can get to this window directly by clicking on “Libraries” > “Sample Nuclide 

Groups”. 

 

Choose the nuclide group for the samples you want to run. You will set up a DPM Assay for 14C 

and a DPM Assay for 3H.  

 

1. Click on the nuclide under the column “Quench Set: Low” to count one nuclide in one 

counting region (Figure 14 and 15).  

 
Figure 14. 

 

 
Figure 15. Default image from TriCarb manual. 

 

2. You will be brought to the “Quench Standards” window (Figure 16). Choose the quench 

curve to be used for calculating DPM values. 
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Figure 16. 

 

Once you choose the quench curve, the name should appear on the “Quench Set Buttons” in the 

“Sample Nuclide Groups” window. Figure 17 shows the 3H and 14C Quench Curves we set up 

linked to the 3H and 14C Nuclide Groups. 

 

 
Figure 17. 

 

The name of the Quench Curve should also appear in the “Quench Standard Set” field of the 

Count Conditions tab in the Assay Definition Window. Figure 18 shows the 14C Quench Curve 

we set up in the 14C DPM Assay we set up.  
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Figure 18. 

 

B. Set up the DPM Assay Parameters  

Next, set up the parameters to run the DPM Assay, which you will use to run your samples, 

using the 7 tabs in the “Assay Definition Window”.  

 

1. Count Conditions: Figure 19a and 19b show the Count Conditions for the 14C and 3H 

DPM assays.  

 
Figure 19a. 
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Figure 19b 

 

2. Figure 20a and 20b show the Count Corrections for the 14C and 3H DPM assays. 

Everything was left as default. 

 
Figure 20a 
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Figure 20b 

 

3. Report Definition: Figure 21a and 21b show the Report Definition for the 14C and 3H 

DPM Assays. The Report can be named in the “Report List” section in Figure 21. We left 

the default of “Report 1”.  Not sure why only 3H has a:2S% (2 sigma % error – Alpha 

region) and A:2S% (2 sigma % error – Region A) added. Eff Nuc 1 in A = counting 

efficiency of nuclide 1 in Region A. 

 
Figure 21a 
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Figure 21b 

 

4. Report Output: Figure 22a and 22b show the Report Output for the 14C and 3H DPM 

Assays. We set the “Text Data Files” section to generate an Excel file with output for 

“Sample”, “Include Column Header” and “Include Assay Definition Block Data.” 

Everything else was left as default.  

 

 
Figure 22a 
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Figure 22b 

 

5. Special Files: Figure 23 shows the Special Files for the 14C DPM assay. No boxes were 

checked in either the 14C or 3H DPM assays.  

 

 
Figure 23. 

 

6. Assay Details: Figure 24 shows the Assay Details for the 14C DPM Assay. No 

additional information was added for either the 14C or 3H DPM Assays.  
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Figure 24. 

 

7. Save the file 

Click on “Save As” and save the assay in the “Assays” folder. The file will be an .lsa file. 

This folder can be accessed via C: Packard > Tricarb > Assays and can be opened by clicking 

on “File” > “Open Assay” (Figure 25). The Priscu Assays are circled in red. 

 

 
Figure 25. 

 

The parameters in an assay can be changed by opening the .lsa file, editing the parameters in the 

“Assay Definition” window, pressing “Apply”, then “OK”. 
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C. Associate the Quench Standards Assay with a protocol number 

In order to run samples using the DPM Assay, you will need to associate the DPM Assay with a 

protocol number. Choose an available protocol flag number from the protocols tree. 

 

Select “File” > “Associate Assay” to open the “Associate Assay” window to select an assay to 

associate (link) with the protocol flag number.  

 

Alternatively, associate an assay by right-clicking on a protocol flag number and selecting 

“Associate Assay” from the menu displayed. 

 

Associate the flag with the desired .lsa file in the “Associate Assay” window. 

 

Figure 26 shows that the 14C DPM Assay has been associated with protocol flag number 3, and 

the 3H DPM Assay has been associated with protocol flag number 4. 

 

 
Figure 26. 

 

The data files set up in the “Report Output” tab of the “Assay Definition” window are stored to 

the location defined for each protocol. When an assay is associated with a protocol flag number 

for the first time, users are prompted for data path information. We set up for the results to be 

saved to the following folder - C: Packard > Tricarb > Results > Priscu. 

 

D. Run your samples using the 14C or 3H DPM Assay protocol. 

Run the SNC cassette if 23 hours have passed since it was last run. 
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1. Load a cassette with your samples and attach the appropriate protocol number to the left 

side of the cassette (Figure 26). 

 
Figure 26. 

 

2. Slide the “Cycle Flag” to the left (Figure 27).  

3. Click on the green flag in the Quanta Smart window. 

 

After running the samples, the file designated in the “Report Output” tab of the “Assay 

Definition” window will be saved as noted above. The program also automatically creates a 

folder for files run under each protocol and saves it in C:Packard > Tricarb > Results > 3H 

sample counting or C:Packard > Tricarb > Results > 14C sample counting, in a folder with the 

same name as the protocol. For the DPM Assay, the folders will be as follows: 

 

 C:Packard > Tricarb > Results > 3H sample counting > 3H Priscu sample counting 

 C:Packard > Tricarb > Results > 14C sample counting > 14C Priscu sample counting 

In each of these folders, the files for each run are saved in a folder with the date and a number 

(i.e. 20181228_1739). There will be a .results file and a .csv file.
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Nikon Labophot Microscope Notes 

 

The Nikon Labophot located in the Priscu lab is ** with an HBO 100W/L2 mercury lamp. The 

mercury bulb should be changed every 200 hours according to manufacturer instructions. The 

Priscu lab follows a schedule of changing the bulb every 500 hours per instruction by John 

Priscu. The schedule of bulb changes since 1996 is as follows: 

 

Date Hours Logged on previous Bulb Notes 

1 April 1996  New bulb 

14 March 1998 210 New bulb installed 

29 January 2003 525 New bulb installed; Hour logger reset 

6 October 2008 1162 New bulb installed; Hour logger reset 

 

Instruction for changing the Mercury Lamp Bulb 

 

To take the lamp socket out of the scope – remove 2 small black screws on 10 and 2 positions on 

top of the lamp socket (sticks out of right side of lamp housing, which is the big black box on the 

back of the scope). 

 

To take the bulb out of the lamp socket – loosen rigid (base) end screw first, raise bulb out, then 

loosen loose end screw and take bulb out.  

 

If you accidently touch the bulb – clean it off with alcohol and lens paper or the oils from your 

hand will burn into the bulb.  

 

To re-install new bulb into lamp socket 

The base and top of the lamp socket are 2 different diameters, so you can’t put the bulb in 

backwards. Make sure the bulb seats all the way in so the silver part at the end of the bulb 

disappears. Hold the bulb at the top and tighten screw (don’t hold actual bulb, hold the covering 

on the end).  Make sure the bottom screw is loose, push bulb in, and tighten. Only the glass part 

of bulb should be showing.  

 

Instruction for centering the Mercury Lamp Bulb 

Put a white piece of paper on the stage and take out one of the objectives. 

 

The 3 screws on the back of the lamp housing are for moving mirrors in inside to center bulb – 

you shouldn’t need to use these when a new bulb is installed.  

 

1).  The two screws on the right side of the lamp housing (vertical and horizontal) are primary 

adjustments (1 on top and 1 on side). Bring 2 light points showing on stage so that 1 is above and 

1 is below each other.  
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2).  Collector focusing knob (most forward knob on right side of housing) – adjusts for even 

illumination. Put slide in and look through objective (20X works). Move knob until get even 

illumination – fill field with light by turning knob. 

 

3).  Centering tool – The centering tool screws into the place of an objective. Use vertical and 

horizontal (primary adjustment) knobs to move 2 bright light spots in centering tool (can see 

which one is mirror image by moving mirror adjustments on back and seeing which one moves). 

You want 2 light points sitting edge to edge vertically in the middle of the centering tool cross-

hairs. 

 

4).  Go back to slide on 20X objective – check collector knob illumination. 

Note: 

Don’t put immersion oil next to the mercury lamp power supply because it will heat up the oil 

and change the refractive index. 

 

Contact for Nikon Labophot: 

 

Jan A. Strelow 

Vice President 

Meridian Instrument Co., Inc. 

P.O. Box 519 

Freeland WA. 98249 

Answering service     360 331-0266 

Fax                             360 331-1297 

Cell                            206 940-9752 

  

Jan Strelow supplies the mercury bulbs, but they can also be ordered: 

 

Lamp Technologies 

1654 Sycamore Ave 

Bohemia NY 11716 

1-800-533-7548 
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Lake Ice Thickness and Piezometric Lake Depth  
(method used until 0304 season – this parameter continues to be measured, but a new 

method has been implemented) 

 
General Discussion 

Lake ice thickness measurements are recorded at each hole drilled in the ice cap; this 

includes all sampling holes, the incubation hole, sediment trap holes and blue box holes. 

However, in an effort to better monitor annual lake ice variation and to randomize 

measurements, a 1000 m2 (100  100 m) sampling grid has been created on each lake (Lakes 

Bonney; east and west lobe, Hoare, and Fryxell).  Each grid is located along a 100 m baseline 

due south of the blue instrument box on each lake (See Section 2.1).  Within this grid, 10 random 

ice thickness measurements are performed during the third and fourth weeks of November. 

 

Materials 

100 m tape measure (2) 

2” cutting bit extensions (2) 

2” flight extensions (8) 

Badger power head 

Ice thickness measuring tape: A 10 m tape measure attached to the mid-point of a 30 cm long 

brass rod, with 10 m of 1/8” rope attached to one end of the rod. 

Messenger 

 

Procedure 

Before drilling the 10 random ice holes in the 1000 m2 grid, generate ten pairs of random 

numbers between 0 and 100 and use these as south and east coordinates (west coordinates for 

Lake Hoare) for each lake.  For example, if the sampling coordinates are (56S, 72E), the hole 

would be located 56 m due south along a baseline from the blue instrument box, then similarly, 

72 m due east of that baseline.  At Lake Hoare, the easterly coordinates are changed to west due 

to extreme ice conditions not representative of the entire ice cap. 

 To begin sampling, stretch out a 100 m tape due south of the blue instrument box and 

secure both ends.  Similarly measure the easterly distance from the baseline and mark the 

coordinate with a flagged ice screw.  After all of the sample locations have been identified, begin 

drilling a 2” ice hole at the first location.  Once the hole completely penetrates the ice cap, take 2 

flight extensions (attached to one another) and use a plunger to remove as much slush as possible 

Note: Do Not drop the extensions otherwise they will be lost forever!  Lower the brass rod 

completely through the ice layer and pull upward on the tape measure causing the rod to catch 

the bottom of the ice.  Record the distances between the bottom of the ice cover and the 

piezometric water level (z-water) and the top of the ice cover (z-ice).  The piezometric water 

level is the level at which water rises up through the ice hole due to hydrostatic pressure caused 

by the permanent ice cover.  Viewing the piezometric water level may be difficult when it is 30 

cm or more below the top of the ice surface.  Therefore, move the tape measure in a side to side 

motion, pushing as much slush to the sides of the hole then record the distance to the water level.  

Subtract z-water from z-ice to obtain freeboard (z-difference).  Together these 3 measurements 
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provide some insight into the topographical features of the ice cover as well as the density of the 

ice.  Note: Correct for offset due to the way the brass rod is attached to the tape measure. 

 Piezometric lake depth is measured at each sampling hole the day before a limno run is 

performed.  Attach a sample messenger to the end of a 100 m tape measure and lower the 

messenger to the lake bottom.  Record the piezometric water level in the sampling hole.  Note:  

Adjust the depth measurement to account for offset due to messenger. 
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Protozooplankton Enumeration and Biomass  
(method used until ?? season) 

 

General Discussion 

Light microscopy is used to count and identify ciliates and epifluorescence microscopy is 

used to enumerate flagellates. A number of methods exist to measure ingestion rates of protozoa 

including the dilution method (Landry, 1993), genetically marked minicells (Wikner, 1993) and 

the use of fluorescently labeled prey (Sherr and Sherr, 1993). The latter method was chosen, as 

grazing rates can be determined over a short time period, there is minimum manipulation of the 

sample, the protozoan predator species can be identified and prey selection can be assessed. 

When possible fluorescently labeled algae (FLA) and fluorescently labeled bacteria were used in 

preference to fluorescently labeled microspheres (FLM) as certain protists have been found to 

actively select against FLM (Nygaard et al., 1988). Growth was measured directly by measuring 

abundance changes in a water sample (McManus, 1993). Advantages of this method include the 

additional information that can be gained (such as cell size), that growth is measured directly and 

not by some biochemical indicator (e.g. carbon and ATP) and that it is not technically difficult to 

perform. This method is labor intensive, however, and changes in species composition can take 

place over the relatively long incubation periods.  

 

Materials 

1m and 2 m 25 mm polycarbonate membrane filters 

500 ml graduated cylinders 

5m 25 mm backing filters 

Centrifuge 

Epifluorescence microscope with ultraviolet and blue filters. 

Filter rack with waste trap and vacuum pump 

Glass filter set 25mm x 15ml  

Glass slides and cover slips 

Immersion oil (ultra low fluorescence grade) 

Line graticule 

Sedgewick Rafter counting chamber 

Whipple grid 

 

Reagents 

Phosphate buffered glutaraldehyde 

DAPI:  4’, 6-diamidino-2phenylindole. Dissolve 10mg of DAPI in 100ml of distilled water.   

Lugol’s solution:  Dissolve 20 g potassium iodide (KI) and 10 g iodine crystals in 200 ml 

distilled water containing 20 ml glacial acetic acid. 

 

Procedure 

Nanoflagellates (modified method of Booth, 1993) 

1. Decant 54 ml of sample from a 1000 ml HDPE clear bottle into a 60 ml HDPE widemouth 

bottle, prepare duplicates.   
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2. Preserve samples with 6 ml of phosphate buffered glutaraldehyde (2% final concentration) 

and store in the dark at 4oC before analysis. Analyze the samples within one month to avoid 

fading of the autofluorescence. 

 

3. Place a 5 m backing filter onto the glass filter base followed by a 1 or 2 m polycarbonate 

membrane filter and replace tower.  The 5 m backing filter will help minimize nonrandom 

distribution. 

 

4. Decant 50 ml of the sample into the glass filter funnel apparatus and stain with three drops of 

DAPI.  Filter sample under a low vacuum (<7 in Hg). 

 

5. Remove the polycarbonate filter and mount onto a glass slide. Add a drop of low-

fluorescence immersion oil in the middle of the filter and place the cover slip on top. 

 

6. Examine the slide immediately under epifluorescence at a magnification between 400 and 

1000.  

 

7. Count all the flagellates under the UV filter and then switch to the blue filter in order to 

distinguish phototrophic nanoflagellates (PNAN) from heterotrophic nanoflagellates 

(HNAN).  Under the blue filter, phototrophic organisms will fluoresce red, whereas the 

heterotrophic organisms will show no red fluorescence.  Count the number of HNAN and 

PNAN in 20 Whipple grids.  If the abundance is low continue to count until at least 100 

PNAN and 50 HNAN have been counted. 

 

8. Measure the effective filter funnel diameter. 

 

4. Calculate cell abundance from: 

 

 

Dilution factor is dependent on the volume of glutaraldehyde added and is calculated: 

 

 

11. To estimate biovolume, select the nearest geometric shape that approximates the organism, 

and measure the length and width of the cells at 1600x using a line graticule. 

 

12. To convert biovolume to biomass, use a carbon conversion factor of 200 fg m-3 (Borsheim 

and Bratbeck, 1987). 
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Ciliates 

1. Decant 500 ml of sample directly from the Niskin water sampler into a 500 ml HDPE amber 

bottle. 

 

2. Preserve samples to a final concentration of 1% Lugol's solution. 

  

3. Settle the samples in 500ml graduated cylinders for 5 days. 

  

4. Siphon off surface water until approximately 50 ml of the sample remains. Stop siphoning if 

the bottom is disturbed. 

 

5. Place sample into a 50 ml centrifuge tube and centrifuge at 1000 rpm for 12 minutes. 

 

6. Concentrate the sample to 1ml and store in the refrigerator before analysis. 

 

7. Count and identify ciliates in a Sedgewick-Rafter counting chamber at x160.  

 

8. Determine ciliate sizes using a line graticule at 320x and calculate biovolume using the 

nearest geometric shape. 

 

9. Convert biovolume to biomass using a carbon conversion figure of 190 g C m -3 (Putt and 

Stoecker, 1989). 
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Protozooplankton Feeding and Growth Rates 
(method used until ?? season) 

 

General Discussion 

When measuring growth rates of protists, run two incubations simultaneously. The first 

sample is unscreened and is used as a control. The second sample is screened through a 10 m 

mesh for nanoflagellates, or a 100 m mesh for ciliates, to remove any predators. In the Dry 

Valley lakes there are no mesozooplankton predators and many of the ciliates species are capable 

of squeezing through a 10m mesh.  Therefore, run only one unscreened incubation.  

 

Materials 

1m and 2 m 25 mm polycarbonate membrane filters 

4 l container 

500 ml graduated cylinders 

5m 25 mm backing filters 

Centrifuge 

Epifluorescence microscope with ultraviolet and blue filters. 

Filter rack with waste trap and vacuum pump 

Fluorescently labeled algae (FLA) and fluorescently labeled bacteria (FLB) made from 

nanoflagellates and bacteria present naturally in the lakes. See Sherr and Sherr (1993) for 

instructions on how to make FLA and FLB.  

Glass filter set 25mm x 15ml  

Glass slides and cover slips 

Immersion oil (ultra low fluorescence grade) 

Incubator 

Line graticule 

Sedgewick Rafter counting chamber 

Whipple grid 

Whirl-pak bags or Nalgene bottles 

 

Procedure for Feeding rates (modified method of Sherr and Sherr, 1993) 

1. Decant 50 - 400 ml of sample directly from the Niskin sampler into rinsed Whirl-pak bags or 

Nalgene bottles depending on the concentration of protists. 

 

2. Place samples into an incubator that approximates in situ light and temperature conditions of 

the lake. 

 

3. Determine in situ bacteria and nanoflagellate abundance using the methods in the 

Enumeration and Biomass section.  

 

4. Calculate the concentration of fluorescently labeled algae (FLA) or fluorescently labeled 

bacteria (FLB) which will be added to the samples. Add FLB to equal approximately 10% of 

the total bacterioplankton for ciliate uptake and about 30% of total bacterioplankton for 

flagellate uptake.  For ciliate ingestion, add FLA to equal about 30% of the total 

nanoflagellate concentration. 
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5. Vortex the fluorescently labeled prey (FLP) for two 5- second bursts. 

 

6. Add the FLP and vortex the sample gently. 

 

7. At selected time intervals (~ how much time) remove subsamples (the volume will depend on 

the abundance of protozoa) and preserve in ice cold, buffered glutaraldehyde to a final 

concentration of 2%. Store in the dark at 4oC until epifluorescence analysis. 

 

8. Stain the subsample with DAPI and filter onto a membrane filter (pore size 2 m for 

nanoflagellates, 5 – 8 m for ciliates). 

 

9. Examine using epifluorescence.  Locate individual protistan cells using the UV filter set and 

then switch to the blue filter set to inspect each cell for ingestion of FLP. Count the number 

of FLP ingested by 50 individual protistan cells and determine the concentration of protists in 

the sample. 

 

10. Plot FLP protist-1 against time. A linear regression model will provide a rate of FLP uptake 

by the protists of interest. Divide the FLP uptake rate (FLP protist-1 h-1) by the concentration 

of FLP to obtain an hourly clearance rate ( ml protist-1 h-1). Multiply the clearance rate by the 

in situ prey abundance to obtain individual ingestion rates (prey protist-1 h-1). The community 

grazing rate (prey ml-1 d-1) can be calculated by multiplying the ingestion rate (ml protist-1 d-

1) by the protist concentration (protist ml-1). Calculate the assemblage clearance (d-1) by 

multiplying the clearance rate (ml protist-1 d-1) by the protist concentration (protist ml-1). 

 

Procedure for Growth Rates (modified method of McManus, 1993) 

1. Gently pour 3-4 l of sample into a 4 l HDPE bottle. 

 

2. Incubate the sample at in situ light and temperature conditions. 

 

3. At given time intervals (this will depend on the protist in question) remove at least 3 

subsamples and fix with buffered glutaraldehyde, final concentration 2%. There should be at 

least 8 time intervals over the duration of one experiment. 

 

4. Count protist abundance in each subsample using the methods in the Enumeration and 

Biomass section.  

 

5. Assuming population dynamics respond exponentially, the following equation may be use to 

calculate the populations exponential growth rate: 
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where k is the intrinsic growth rate, and Nt and N0 are the abundances at the final and initial 

sampling times. As multiple time points are sampled, a linear regression of ln (Nt ) vs time 

will have a slope equal to k.  However, the exponential growth model may not always be 

appropriate.  If the growth trajectory is linear, this may indicate the population is near the 

inflection point of the logistic curve, in which case the growth rate may be calculated by: 

 

 

where Nx  is the value of N at the midpoint of the incubation, and dN/dt is the slope of the N 

vs time regression. 
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Bacterial Production Determined by 3H Thymidine Incorporation 
(method used until 0506 season – this parameter continues to be measured, but a new 

method has been implemented) 

 

General Discussion 

Despite the controversy over the shortcomings of the thymidine incorporation method, its 

widespread use in various systems, the relative simplicity of the method, and its repeatability 

make this a useful technique to determine bacterial production.  We have complemented our 

thymidine data with leucine and adenine uptake data, and microautoradiography.  Our leucine 

uptake method is included here for comparison.  A complete review of the thymidine method 

may be found in Robarts and Zohary (1993) and Bell (1993).  The leucine method is discussed in 

Kirchman, et al. (1985) and Kirchman (1993). 

 

Materials 

Sampling Hut 

1000 ml Amber HDPE bottles 

Dry Valleys Lab 

Glass scintillation vials (20 ml with HDPE cone caps) 

Permanent marker  

10 ml Gilson Pipetman (non-rad use) 

Autoclaved 10 ml pipet tips (autoclave 20 minutes) 

Acrodisc 0.2 µm filters and syringe 

P20 Gilson Pipetman (rad use only) 

P200 Gilson Pipetman (rad use only) 

Autoclaved 200 l pipet tips (autoclave 20 minutes) 

10 ml Repipettor 

MCM Crary Lab 

Glass scintillation vials (20 ml with HDPE cone caps) 

Permanent marker 

0.2 m, 47 mm, polycarbonate filters 

Glass filter apparatus 

10 ml Repipettor for cocktail in fume hood 

Liquid scintillation counter 

 

Reagents 

Dry Valleys Lab 
3H-Thymidine (20 Ci mmol-1) 

Trichloroacetic acid solution (10% TCA):  Dissolve 100g of TCA in DI water, and bring volume 

up to 1000 ml.  Store at ~1ºC.  The TCA may be preweighed and placed into a 1000 ml 

HDPE bottle and stored until needed, then bring to volume the day of experiment. 

Formalin buffered with sodium borate (0.2 m filtered) 

MCM Crary Lab 

Trichloroacetic acid solution (5% TCA):  Dissolve 50g of TCA in DI water, and bring volume 

up to 1000 ml.  Store at ~1ºC 

Cytoscint or other scintillation cocktail 
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Procedure 

Below steps to be conducted in Dry Valleys Lab 

1. Label 5 scintillation vials per depth, preferably the night before sample collection.  Two of 

the five vials are kills and should be labeled K1 and K2.  Three of the vials are live 

treatments and should be labeled T1-T3. 

 

 

 

 

 

 

 

2. The thymidine stock solution comes in ethanol which eliminates bacterial growth and volatile 

products of self-radiolysis.  Therefore the ethanol must be evaporated from solution.  

Withdraw 200 l of the thymidine solution and pipet into a clean 7 ml scintillation vial.  The 

volume of thymidine solution to be dried down depends on experimental design.  

Radiolabeled thymidine is added to each vial to achieve a final concentration of 20 nM.  If 

the specific activity of the 3H Thymidine stock is 20 Ci mmol-1, then 4 l of stock solution 

must be added to each vial (See calculation of 3H Thymidine addition at the end of this 

section).  If there are 45 vials in the experimental design, then at least 180 l of thymidine 

should be dried down.  However, dry down 200 l to ensure there will be enough to complete 

the experiment.  To dry down the thymidine solution, use either filtered exhaust air from a 

vacuum pump or nitrogen gas and place the air flow directly over the mouth of the 

scintillation vial so that the air turbulence will evaporate the ethanol from solution.  This 

procedure must be performed inside a fume hood.  

 

3. Reconstitute the thymidine with four times as much filtered distilled water.  For example, if 

200 l of thymidine solution is dried down, then add 800 l of 0.2 m filtered DI water. 

 

4. Bacterial production samples (TDR) are taken from the 1000 ml amber HDPE bottles.  

Gently invert the amber bottle to thoroughly mix, withdraw 10 ml of sample and dispense 

into scintillation vial, replacing cap immediately.  Prepare all TDR samples and preserve the 

Kill Treatments (K1, K2) by adding 0.5 ml of 0.2 m filtered formalin (~15 drops from 

Acrodisc syringe filter).  Thoroughly mix the kill treatments.  Store these at 4ºC in the dark 

until you add the thymidine.  (Note: you will incubate the TdR samples for 20hrs so plan 

your inoculation accordingly.  For example it is best to kill the samples around 10am the next 

day so you’d want to start adding the reconstituted thymidine around 2pm.  It takes ~1hr to 

dry down the original thymdine.) 

 

23. Pipet 16 l of reconstituted thymidine into each vial (20 nM thymidine final concentration) 

and thoroughly mix.  Note:  Start with all the live treatments, then do the kills.  Note the time 

of the additions.   

E30 

1 Jan 99 

TDR 

5m T1 
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24. Perform activity checks of the thymidine by pipeting 20 µl from each of five live treatments 

(any depths) into scint vials.  

 

7. Incubate the samples in the dark at 1-4ºC for 20 h.  Monitor temperature, if it varies, compute 

a time weighted average temperature for the incubation period. 

 

8. Prepare 10% TCA by dissolving 100g of TCA to distilled water.  Bring volume up to 1000 

ml.  Store at ~1ºC.  The TCA may be preweighed and placed into a 1000 ml HDPE bottle and 

stored until needed, then bring to volume the day of experiment. 

 

9. Terminate incubation with the addition of 10 ml of ice cold 10% TCA (use repipettor on jar) 

to each vial.  Store vials at 4ºC until filtered. 

 

Below steps to be conducted in MCM Crary Lab  

10. Label a new set of scintillation vials as described in step 1, so that once the sample is filtered 

the filter may be placed into a clean scintillation vial. 

 

11. Prepare 5% TCA by dissolving 50 g of TCA into 1000 ml of distilled water.  Store on ice. 

 

12. Place 0.2 m 47 mm polycarbonate filters onto each glass filter base and replace tower. 

 

13. Pour sample into filter apparatus and filter under low vacuum (<7 in Hg). Rinse scintillation 

vial 3 times with ice cold 5% TCA and pour into filter tower.  Rinse filter tower 3 times with 

5% TCA.  Filter until filter is dry.  Place filter into its respective scintillation vial. 

 

14. Once the samples are filtered, add 20 ml of cytoscint or comparable scintillation cocktail (use 

repipettor attached to cocktail bottle in hood), and count samples in a liquid scintillation 

counter on a calibrated 3H channel.  Add cocktail to activity check samples and count as well. 

 

15. Thymidine uptake rate is determined by: 

 

where DPM treatment is the average DPM of T1-T3, DPM kill is the average treatment of 

the kills, nM thymidine is the final concentration of thymidine in the incubation vial (20 nM), 

Ci is the activity added (4 Ci), 2.2x106 is the number of dpm Ci-1, and t is the incubation 

time (h). 

 

16. Thymidine uptake rate is corrected for the incubation temperature as follows: 
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where Ea is the energy of activation of 12,600 kcal mol-1, CI is the incubation temperature 

(C), CA is the ambient lake water temperature at specific depth (C), and R is a gas constant 

(1.987 cal mol-1 K-1), (Priscu, unpublished data). 

 

17. Thymidine uptake rate is converted to bacterial production by empirically determining a 

carbon conversion factor for the assemblage being studied (Kirchman and Ducklow, 1993).  

There are also a number of carbon conversion factors reported in the literature to convert 

thymidine uptake rate to bacterial production.  The MCM LTER uses the following 

conversion factors (Takacs and Priscu, 1998): 

 

2.0x1018 cells mol thymidine-1 

10 fg Carbon cell-1. 
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Calculation of 3H Thymidine addition 

Use the following equation to calculate the volume of 3H Thymidine stock solution to be 

added to each sample to achieve a concentration of 20 nM thymidine: 

 

(C I) (V I) = (C F) (V F) 

 

where C I is the initial concentration of the stock solution, V I is the volume of stock solution 

added to sample, C F is the desired final concentration of stock solution in the sample, and V F is 

the total volume of the sample. 

 

Assuming the 3H stock solution has a specific activity of 20 Ci mmol-1 (specific activity will be 

noted on product), and an initial concentration of 1mCi ml-1. 

 

Because 4 l of stock solution is not easily pipetted with great accuracy, we dilute the stock 

solution 4 and pipet 16 l of dilute stock solution.  Therefore, pipet 200 l [4 l  45 TdR 

treatment vials = 180 l + 20 l (for insurance) = 200 l stock 3H thymidine solution] into a 

clean 7 ml scintillation vial and evaporate the ethanol solution.  Once the 3H thymidine solution 

is completely dry, reconstitute with 800 l of 0.2 m filtered DI water and thoroughly mix to 

achieve a homogeneous solution.  Theoretically, 16 l of the reconstituted solution will contain 4 

Ci of 3H thymidine. 
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Bacterial Production Determined by 3H Leucine Incorporation 
(method used until ?? season – measurement of this parameter began again during the  

0607 season with a new method) 

 

General Discussion 

The leucine procedure is similar to the thymidine procedure until the filtering step.  

Follow the above procedure, except the volume of leucine to add is different.  The final 

concentration of leucine in each vial should be 20 nM.  Our present leucine stock is 5 mCi ml-1, 

52 Ci mmol-1, so add 10.4 l of reconstituted stock.  It is not necessary to reconstitute the leucine 

with 4 as much water because 10.4 l is more easily pipetted with accuracy.   

 

Materials 

0.2 m, 47 mm, polycarbonate filters 

P10 ml Gilson Pipetman 

P20 ml Gilson Pipetman 

P200 ml Gilson Pipetman 

Autoclaved 200 l pipet tips 

Autoclaved 10 ml pipet tips  

Glass filter apparatus 

Glass scintillation vials (20 ml with HDPE cone caps) 

Heating block or water bath 

Liquid scintillation counter 

Permanent marker  

 

Reagents 

Trichloroacetic acid solution (10% TCA):  Dissolve 100g of TCA in DI water, and bring volume 

up to 1000 ml.  Store at ~1ºC.  The TCA may be preweighed and placed into 1000 ml HDPE 

bottles and stored until needed, then bring to volume the day of experiment. 

Trichloroacetic acid solution (5% TCA):  Dissolve 50g of TCA in DI water, and bring volume 

up to 1000 ml.  Store at ~1ºC 
3H-Leucine 

Formalin buffered with sodium borate (0.2 m filtered) 

 

Procedure 

1. Follow steps 1-8 as outlined in the thymidine uptake procedure, however, in step 5 add 10.4 

l of 3H Leucine. 

 

2. Label a new set of scintillation vials before filtration. 

 

3. Heat samples to 80ºC for 15 minutes and cool under ambient conditions. 

 

4. Place 0.2 m 47 mm polycarbonate filters onto the glass filter base and replace tower. 

 

5. Pour sample into filter apparatus and filter under low vacuum (<7 in Hg). Rinse scintillation 

vial 3 times with ice cold 5% TCA and pour into filter tower.  Rinse filter tower 3 times with 
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ice cold 5% TCA and follow with 3 rinses of ice cold 80% ethanol.  Filter until filter is dry.  

Place filter into its respective scintillation vial. 

 

6. Once the samples are filtered, add 20 ml of cytoscint or comparable scintillation cocktail, and 

count samples in a liquid scintillation counter on a calibrated 3H channel. 

 

Biomass production is calculated based on the following equation and literature based values. 

 

Production = Leu ×131.2 × (%Leu)-1 × (C/Protein) × ID 

 

Where Leu is the rate of leucine incorporation, 131.2 is the formula weight of leucine, %Leu is 

the fraction of leucine in protein (0.073), C/Protein is the ratio of cellular carbon to protein 

(0.86), and ID is isotope dilution =2 (Kirchman 1993). 
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Virus Like Particles Enumeration 
(method used until ?? season) 

 

General Discussion  

Virus-like particles (VLP) are enumerated using the method of Hennes and Suttle (1995).   

Freshly collected samples are filtered onto 0.02 m pore-size Anodisc 25 membrane filters 

(Whatman) and stained with the cyanine-based dye, Yo-Pro-1 (4-[3-methyl-2,3-dihydro-(benzo-

1,3-oxazole)-2-methylmethyledene]-1-(3’-trimethylammoniumpropyl)-quinolinium diiodide; 

Molecular Probes, Eugene, OR). Virus densities were then estimated using epifluorescent 

microscopic direct counts (EMC) at a magnification of 1250 using a Zeiss Standard 16 

microscope with 100W Hg lamp and Zeiss P/N 09 combination filter set.  At least 400 VLP are 

counted on each membrane filter. 

 

Materials 

0.02 µm filtered sterilized water 

100 x 15 mm sterile, plastic petri dish 

20 cc plastic syringe 

25 mm 0.45 µm cellulose nitrate filters 

9.0 cm Whatman #2 qualitative filter paper 

Aluminum Foil 

Cover slips 

Disposable Acrodisc filters 

Epifluorescence Microscope 

Glass Slides 

Whatman Anodisc 25, 0.02 µm Al2O3 filters 

 

Reagents 

Aqueous NaCl solution (0.3% wt/vol) 

Glycerol (Spectrophotometry-grade) 

DMSO 

NaCN 

Yo-Pro-1 Stock solution (supplied by Molecular Probes) 

 

Procedure 

1. Collect samples and process immediately without fixation or preservation. 

 

2. Dilute stock solution of Yo-Pro-1 (1 mM Yo-Pro in a 1:4 solution of DMSO and H2O) to 50 

M in an aqueous solution of 2 mM NaCN.  Vortex well and store the 50 M Yo-Pro 

working solution in the dark at 4o C. 

 

3. Place a series of 80 l drops of Yo-Pro working solution in a 10 cm plastic Petri dish, spaced 

so that 25 mm filters may be placed on each drop without overlapping. 

 

4. Label the Petri dish on the bottom side with sample ID’s corresponding to each drop of Yo-

Pro. 
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5. In the lid of the Petri dish, place a 9.0 cm Whatman #2 qualitative filter paper soaked with 2 

ml of an aqueous 3% NaCl solution.  Close the Petri dish containing the drops of Yo-Pro. 

 

6. Clean filter funnels thoroughly with 0.02 m filter-sterilized water (3 rinses of approx. 5 ml 

each) 

 

7. Place backing filters, 25-mm 0.45 m cellulose nitrate or equivalent, on filter towers and top 

with Whatman Anodisc 25, 0.02 m Al2O3 filters.  The Anodisc filters are very fragile so 

handle carefully with clean filter forceps, touching only the plastic support ring which 

surrounds each filter. 

 

8. Replace clean filter funnels and add unfixed sample.  For lake waters, volumes between 100-

200 l are sufficient.  Cover filter funnels with clean Petri dish tops when not in use in order 

to avoid contamination. 

 

9. Pipet sample onto the center of the Anodisc filter and bring sample volume to 2.0 ml with 

0.02 m filter-sterilized, DI water.  Add this water drop-wise using a 20 cc plastic syringe 

and disposable 0.02 m Acrodisc filter.  Gently filter samples (< 15 kPa psi units???), and 

remove filter funnel once the sample has been completely filtered.  Sometimes small drops of 

liquid remain around the edge of the Anodisc filter.  Filter towers must be tapped vigorously, 

while vacuum is reapplied, to make sure that all the sample is filtered. 

 

10. Remove Anodisc filters while still moist and place one filter (sample side up) on each drop of 

Yo-Pro in the previously-prepared Petri dish.  Backing filters can remain on the towers and 

reused several times. 

 

11. Replace the lid and cover the Petri dish with aluminum foil to exclude light.  Incubate at 20 

C for 2 days. 

 

12. Following the incubation period, place the filter onto a clean filter tower and rinse twice with 

800 l of 0.02 m filtered DI water. 

 

13. Place the rinsed filter onto a glass slide; add a drop of spectrophotometry-grade glycerol to 

the center of the filter and a cover slip.   Store prepared microscope slides in the dark at -

20oC. until processed.  Dispose of Petri dishes. 

 

14. Enumerate VLPs using an epifluorescence microscope (1000) with an acridine orange filter 

set, and a 100 W Hg lamp. 

 

15. Count at least 400 VLP on each membrane filter using a  calibrated Whipple grid. 

 

Note: Do not assume that the entire 25-mm diameter area of any filter is covered with particles 

of interest following filtration.  The effective surface area for any combination of filter towers, 

funnels, and filters should be determined directly by microscopic measurement using a calibrated 

scale, graticule, or the Whipple grid itself.
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Viral Production Determined by 3H Thymidine Incorporation 
(method used until ?? season) 

 

General Discussion 

 Virus production is estimated by 3H thymidine incorporation into TCA-insoluble <0.2 m 

DNAse-resistant material by a method modified from Steward et al. (1992) and Fuhrman & Noble 

(1995).  Samples are collected in 50 ml conical centrifuge tubes and 3H-thymidine is added to a 

final concentration of 5 nM.  Centrifuge tubes are incubated under in situ light and temperature 

conditions.  Subsamples (7 ml) are collected through time for up to 48 h, and 5 ml of each is 

filtered through a 0.2 m Acrodisc HT Tuffryn syringe filters (Gelman).  Filtrate is split into 

duplicate 2 ml samples in 5 ml borosilicate glass test tubes.  DNAse, RNAse, and micrococcal 

nuclease are added to the 2 ml samples and then incubated for 1 h.  Next, 40 l of 0.2 m filtered 

formalin is added to each tube to stop enzyme activity and the samples are stored at 4 C until 

processed.  Within 2 days, samples are divided into 900 l subsamples and placed into 2 ml 

microfuge tubes on ice.  A carrier solution (50 g ml -1 each of DNA, RNA and BSA) is added to 

each replicate subsample.  To each subsample, 300 l of ice cold 20% TCA is added; one duplicate 

remains on ice while the other is incubated in a hot water bath at 100C for 1 h.  Hot samples are 

cooled on ice and all tubes are vortexed to resuspend precipitates.  Samples are filtered through 25 

mm HA Millipore filters; tubes are rinsed with 1 ml of 5% TCA and the rinse filtered.  Empty 

microfuge tubes are discarded as isotope-contaminated solid waste.  Filters and filter funnels are 

rinsed 3 times with 1 ml of cold 5% TCA.  Remove funnels and rinse the edges of the filter 3 times 

with 1 ml of cold 5% TCA.  Filters are placed in 20 ml glass scintillation vials, and 1 ml of 1 N 

HCl is added to each scintillation vial.  Scintillation vials are heated (90-100 C) for 1 h to 

hydrolyze nucleic acids.  Make sure the filters are dry.  Once the samples are cooled to room 

temperature, add 5 ml of Cytoscint or Ecoscint (National Diagnostics) scintillation cocktail to each 

sample.  Samples are counted using a liquid scintillation with quench correction. 

 

Materials 

0.02 µm Acrodisc (Gelman) filters 

2.0 ml microfuge tubes 

20 ml glass scintillation vials 

25 mm HA Millipore filters 

5 cc syringes 

5 ml test tubes 

50 ml conical centrifuge tubes 

Ice 

 

Reagents 
3H Thymidine 

Carrier solution: containing equal volumes of DNA,RNA, and BSA at a concentration of 50 g 

ml-1. 

Cytoscint cocktail:  (or comparable scintillation cocktail) 
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Formalin 

1 N HCl 

Trichloroacetic acid (20% TCA) 

TCA (5%) 

TCA-insoluble < 0.2 µm DNAase resistant material 

 

Procedure 

1. Decant 40 ml duplicate samples into 50 ml conical centrifuge tubes (2 tubes per sample) 

 

2. Add 3H thymidine to a 5 nM final concentration in each tube (See bacterial production 

procedure for the calculation of 3H thymidine volume added to each tube). 

 

3. Collect 6 ml subsamples at 0, 6, 15, 24 & 48 h (10-5cc syringes per sample). 

 

4. Filter 5 ml of each subsample thru 0.2 m Acrodisc (Gelman) filters and split into duplicate 

2-ml subsamples in 5 ml test tubes. 

  (10 filters per sample) 

 (20 tubes per sample) 

 

5. Add nucleases to the 2-ml subsamples; 

 10 l DNase I at 1 unit l-1 = 10 units  20 subsamples =  (200 units per sample) 

 10 l Rnase at 1 unit l-1 = 10 units  20 subsamples =  (200 units per sample) 

 10 l Micrococcal nuclease at 5 unit l-1 = 50 units  20 subsamples = (1000 units per sample) 

 

6. Incubate at 20 C for 1 h. 

 

7. Add 40 l of 0.2 m filtered formalin to kill each sample. 

 

8. Store samples at 4 C until processed. 

 

9. Split into duplicate 0.90 ml subsamples and place in 2.0 ml microfuge tubes on ice (40 

microfuge tubes per sample) 

 

10. Add 100 l of carrier solution containing 50 g each of DNA, RNA & BSA (2 mg per 

sample) 

 

11. Add 300 l of cold 20% TCA to each subsample (2.4 ml TCA per sample) 

 

12. Leave one duplicate on ice and incubate the other at 100oC for 1 h. 

 

13. Cool hot sample on ice for 10 minutes. 

 

14. Vortex each tube to resuspend precipitates. 
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15. Place 25 mm HA Millipore filters onto filter base and replace tower.  Filter sample under low 

vacuum (< 7 in Hg) and rinse microfuge tubes with 1 ml of 5% TCA (40 filters per sample). 

 

16. Rinse filters and funnels 3 times with 1 ml of cold 5% TCA. 

 

17. Remove funnels and rinse edges of filters 3 times with 1 ml of 5% TCA. 

 

18. Place filters in 20 ml glass scintillation vials and add 1ml of 1N HCl. 

 

19. Heat vials to 90-100oC for 1 h to hydrolyze nucleic acids. 

 

20. Allow vials to cool and add 5 ml of Cytoscint. 

 

21. Count samples using a liquid scintillation counter with quench correction. 
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Community Respiration Determined via the Electron Transport System 

(method used until 0203 season) 

 

General Discussion 

This assay measures the oxidation of the coenzyme Q-cytochrome B complex, the rate-

limiting step in the respiratory Electron Transport System (ETS).  Coenzyme Q normally 

receives electrons from succinate or NADH and passes them to cytochrome-B556.  In this assay, 

the cells are lysed and adequate substrate provided, however cytochrome-B566 is inactivated.  

This results in the liberation of electrons, which reduce a tetrazolium salt (INT) to produce a pink 

formazin dye.  The amount of the dye produced is proportional to the activity of the 

mitochondrial ETS.  Electron transport system activity (ETS) is measured by the in vitro 

reduction of a tetrazolium salt (INT).  Samples are collected with a 5L Niskin bottle during 

normal LTER limno sampling.  Water is filtered through a Whatman GF/F filter, filters are 

homogenized in buffer, then assayed by a 2 h controlled temperature incubation resulting in the 

reduction of INT to the violet-colored formazan.  Light absorbtion (Abs) is measured 

spectrophotometrically, and is directly proportional to the moles of electrons transferred through 

the electron transport system.  Temperature correction used Ea=15000 cal mol-1 (Q10=2.66, 

taken as average literature value) for all stations.  However, J. Priscu found Ea=9720 (Q10=1.89) 

for Bon E30 5m, 0-10 C, on 9 Nov 90. 

 

Materials 

1 cm square cuvette 

15 ml centrifuge cone tubes 

30 ml Wheaton tissue homogenizer 

47 mm GF/F filters 

47 mm magnetic filter funnels 

5 ml culture tube with screw caps 

Assorted volumetric flasks (125, 250 and 500 ml) 

DI rinse bottle 

Electric drill 

Filter manifold 

Forceps 

Glassine envelopes 

Heat plate 

Ice 

Kimwipes 

P1000 Gilson Pipetman and tips (2) 

P5000 Gilson Pipetman and tips 

Nicer bucket 

Spectrophotometer 

Vortex genie 
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Reagents 

The volumes of reagents presented below are sufficient to perform at least 12 ETS assays (i.e., 

12 complete limno runs; 3 ETS assays per West and East Bonney, Hoare, and Fryxell).  

However, adjust volumes appropriately based on different experimental design. 

  

Homogenization Buffer: A 50 mM sodium phosphate buffer solution containing the following 

reagents: 

 MgSO4H2O (Magnesium sulfate monohydrate) or ............0.0064 g 

 MgSO47H2O (Magnesium sulfate heptahydrate)..........0.0093 g 

 PVP (Polyvinylpyrrolidone) ................................................0.7500 g 

 Stock A.................................................................................9.0 ml 

 Stock B .............................................................................114.0 ml 

 Triton X-100 ........................................................................1.0 ml 

Bring to 500 ml with DIW and adjust to pH 8.0 with  10 N NaOH.  Note: bring the buffer to 

~ 475 ml with DIW, then add the Triton X-100, and continue diluting to 500 ml.  This will 

help prevent unnecessary foaming of solution. 

 

Stock A: Dissolve 0.05 moles monobasic sodium phosphate, NaH2PO4 (6.0 grams anhydrous 

or 6.9 grams monohydrate monobasic sodium phosphate) in DIW and bring to 250 

ml.  Final solution will be 0.2 N. 

 

Stock B: Dissolve 0.1 moles dibasic sodium phosphate, Na2HPO4 (14.2 grams) in DIW and 

bring to 500 ml.  Final solution will be 0.2 Normal. 

 

Sodium Cyanide solution: A 0.1 M Sodium Cyanide solution..  Bring 0.6125 g of Sodium 

Cyanide: NaCN to 125 ml with DIW.  Store at room temperature. 

 

Substrate Buffer: A 50 mM Sodium Phosphate buffer containing the following reagents:  

 Stock A...........................................16.8 ml 

 Stock B .........................................184.0 ml 

 Triton X-100 ....................................1.6 ml 

 Bring to 800 ml with DIW and adjust to pH 8.0 with  10 N NaOH.  Decant 52 ml aliquots 

into HDPE bottles and store at -20 C. 

  

Note: Before preparing the Substrate Solution, remove 2 ml of Substrate Buffer and prepare the 

Turbidity Blank.  This will leave 50 ml of Substrate Buffer for the Substrate Solution. 

 

Substrate solution: A reagent containing 0.133 M disodium succinate; 0.835 mM NADH (di-

sodium salt, f.w. = 709); 0.24 mM NADPH (tetrasodium salt, type III, f.w. = 833.4).  Weigh 

the following dry reagents (15 replicates each) and place in 7-ml borosilicate sample vials 

and store in the dark at -20 C until the day of analysis. 

 Disodium Succinate (Succinic acid) ............1.0773 g 

 NADH ..........................................................0.0297 g 

 NADPH ........................................................0.0100 g 
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 Prepare Substrate solution immediately before use, by combining 1 vial each of the 

preweighed reagents with 50 ml of ice cold Substrate Buffer: 

 

INT solution: A 2.5 mM solution of INT 

  

 

 Bring 0.3792 g of INT to 300 ml with DIW.  Decant 20 ml aliquots into 60 ml HDPE bottles 

and store in the dark at -20 C. 

 

Termination Solution: A 1:1 mixture of 1 M Sodium Formate and Formalin.  Bring 6.8 g Sodium 

Formate (f.w. = 68) to 100 ml with DIW; adjust to pH = 3.5 with 10 N HCl and combine 

with 100 ml formalin (37% Formaldehyde).  Place solution in a 250 ml HDPE bottle and 

store at 4 C. 

 

Procedure 

1. Place 47 mm GF/F filters onto the magnetic filter base and replace the tower. 

 

2. This assay requires a concentration > 1 g of chlorophyll-a on the GF/F, thus large volumes 

of lake water must be filtered Table 6.  Gently invert the clear 1-l HDPE bottle to thoroughly 

mix and decant 500 ml into a graduated cylinder.  Filter this volume of water and repeat as 

necessary until the total volume is filtered. 

 

Table 6.  Volume of lake water filtered at each depth in each lake. 

 

West Bonney East Bonney Hoare Fryxell 

Depth 

(m) 

Volume 

(ml) 

Depth 

(m) 

Volume 

(ml) 

Depth 

(m) 

Volume 

(ml) 

Depth 

(m) 

Volume 

(ml) 

5 1000 4.5 1000 4.5 2000 4.5 1000 

10 1000 5 1000 5 2000 5 1000 

13 1000 10 1000 8 2000 6 1000 

14 1000 13 1000 10 2000 8 1000 

15 1000 15 1000 12 2000 9 1000 

17 1000 18 1000 14 2000 10 1000 

25 1500 25 1200 16 2000 11 1000 

30 1500 30 1500 20 2000 15 1000 

 

3. Once the total volume is filtered, gently remove the filter, fold in half (organic material 

inside), and place in a labeled glassine envelope.  Store glassine envelope on ice, in the dark, 

until homogenization (< 1 h). 

 

4. Prepare Homogenization Solution.  Decant 49 ml of Homogenization Buffer and place in a 

HDPE bottle, add 1 ml of Sodium Cyanide Solution and mix solution thoroughly. 
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5. In an ice bath, homogenize sample filter in 2.5 – 3 ml of Homogenization Solution (2.5 ml 

for Lake Bonney and Hoare, 3.0 ml for Lake Fryxell) for 90 seconds ensuring the filter is 

completely homogenized.  Adjust amount of Homogenization Solution to suit experimental 

design (0.5 ml of the extract will be needed for each replicate; allow at least 1 ml for loss in 

centrifuge). 

 

6. Decant into a chilled centrifuge tube and rinse tissue homogenizer with two (0.5 ml) rinses of 

Homogenization Solution and decant into centrifuge tube.  Place in ice bath until centrifuged. 

 

7. Centrifuge on medium for 3 minutes at < 4 C, and briefly vortex samples, then centrifuge on 

high for 10 minutes at < 4 C.  Promptly remove and place in ice. 

 

8. Aliquot 0.5 ml of extract supernatant into three acid-washed culture tubes (labeled A, B, K).  

The tubes labeled A and B are replicate live treatments, and K is a killed treatment.  Place the 

live treatment tubes in an ice bath.   

 

9. Boil the killed treatment tubes for 10 minutes, and cool in an ice bath. 

 

10. Prepare the Substrate Solution by adding the prewieghed dry reagents (Disodium Succinate, 

NADH, NADPH) to 50 ml of ice cold Substrate Buffer.  Note: Begin to thaw one bottle each 

of the Substrate Buffer and INT Solution at room temperature while the ETS samples are 

filtering. 

 

11. In each culture tube (A, B, K) combine the following reagents: 

 

 Substrate Solution ............................1.5 ml 

 INT Solution ....................................0.5 ml 

 

Prepare two additional control blanks to analyze with the samples.  The sum of the Absorbance 

for these blanks will yield the total blank.  

 

 Abiotic blank ....................................0.5 ml Homogenization Buffer replaces 0.5 ml of sample 

 Turbidity blank.................................2.0 ml of Substrate Buffer is used in place  

of the 1.5 ml Substrate Solution and 0.5 ml INT 

solution 

 

 Briefly vortex samples and incubate in an ice-water bath (0 – 2  C) for 1 h. 

 

12. Stop the reaction by adding 0.5 ml of Termination Solution to each culture tube and briefly 

vortex. 

 

13. Calibrate spectrophotometer with a DI blank and read absorbance at 490 nm using a 1 cm 

square cuvette.  Note:  Use the same cuvette for all readings and rinse with DI water between 

samples.  Wipe the cuvette with a Kimwipe before analysis. 
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14. Community ETS (mol O2 l
-1 h-1) is calculated using the following equation: 

 

 

where AbsR is the average absorbance of the replicate live treatments, AbsK is the absorbance of 

the killed treatment, a is the ratio of the volume of homogenate (ml) to the volume of lake water 

filtered (ml; a concentration factor), b is the ratio of the final volume of the assay (ml) to the 

volume of extract supernatant used (ml; a dilution factor), c is the stoichiometric extinction 

coefficient for formazan (31.8 Abs cm-1 mol O2
-1 ml-1; Kenner and Ahmed 1975), and t is the 

incubation time (h).  Community ETS is adjusted to ambient lake temperature (ETSA) using the 

Arrhenius equation: 

 

 

where Ea is the energy of activation (15,000 cal mol-1, Q10 = 2.66), °CI is the incubation 

temperature (°C), °CA is the ambient lake water temperature at specific depth, R is a gas 

constant (1.987 cal mol-1 °K-1). 

 

15. A first-order relationship exists between ETS activity and respiratory capacity in aquatic 

microorganisms (e.g., Kenner and Ahmed 1975, Christiansen et al. 1980).  In Lake Bonney, 

44 % and 56 % of measured ETS activity is from bacterioplankton and phytoplankton, 

respectively (Takacs 1999).  Using these percentages, in concert with published 

respiration:ETS ratios (Packard 1985), we derived the following relationship between 

community respiration and ETS for Lake Bonney: 
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 ETS samples are taken from the 1000 ml clear HDPE bottles.  Do not use the amber HDPE 

bottle. 

 

 Use either a 3 or 6 place manifold with 47mm magnetic filter towers and 47mm GF/F filters. 

 

 Sample volumes vary with lake and depth.  Decant 500 ml into a graduated cylinder and 

filter the entire 500 ml before decanting the rest of the sample in the graduated cylinder. 

 

West Bonney East Bonney Hoare Fryxell 

Depth 

(m) 

Volume 

(ml) 

Depth 

(m) 

Volume 

(ml) 

Depth 

(m) 

Volume 

(ml) 

Depth 

(m) 

Volume 

(ml) 

5 1000 4.5 1000 4.5 2000 4.5 1000 

10 1000 5 1000 5 2000 5 1000 

13 1000 10 1000 8 2000 6 1000 

14 1000 13 1000 10 2000 8 1000 

15 1000 15 1000 12 2000 9 1000 

17 1000 18 1000 14 2000 10 1000 

25 1500 25 1200 16 2000 11 1000 

30 1500 30 1500 20 2000 15 1000 

 

 Watch filter towers carefully, do not allow filters to go dry.  Turn the valve on the manifold 

to the off position when there is still about 1mm of water left to go.  Then remove the filter 

from the tower, fold in half (organic matter inside), and place in a labeled glassine envelope.  

Store the filters in a Nicer bucket containing ice until analysis. 
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Major ions by ion chromatography 

(A new instrument is currently being used. Methods for the old instrument follow) 

 

Sample Analysis 

A Dionex DX-300 ion chromatography system (Dionex, Sunnyvale, CA, USA) is used for 

the major ion analyses.  The system includes a gradient pump module (GPM), high-pressure 

injection valve with a 25 µl sample loop, Dionex conductivity detector (CDM-3), advanced 

computer interface (ACI), and automated sampler.  The timed events and data collection are 

controlled by the Dionex AI-450 chromatography software for Windows.  Only one ion 

chromatography system is used and is switched back and forth between anion and cation 

configurations.  For the anions, a Dionex Ionpac AS4A-SC analytical column (4  250 mm) and 

AG4A-SC guard column (4  50 mm) are used along with an Anion Self-Regenerating 

Suppressor-1 (ASRS-1).  The eluent is a 1.8 mM Na2CO3/1.7 mM NaHCO3. The gradient pump 

flow rate was 2 ml min-1.  Background conductivity should be approximately 16 µS.  For the 

cations, the Dionex Ionpac CS12 analytical column (4  250 mm) and CG12 guard column (4  

50 mm) are used with a Cation Self-Regenerating Suppressor-1 (CSRS-1).  The eluent is 0.02 M 

methanesulfonic acid (MSA).  The eluent flow rate is 1.0 ml minute-1 and background 

conductivity was approximately 200-250 nS.   
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Dissolved Organic Carbon by Total Organic Carbon Analyzer 
(This method was used until the 0102 season. Since then samples have been run on the 

Shimadzu TOC-V series. Total nitrogen (TN) is also now analyzed during DOC analysis 

using the Shimadzu TNM-1 analyzer.)  

 

 

General Discussion 

The Dissolved Organic Carbon (DOC) procedure requires that samples be classified either as 

saline or fresh water.  Saline samples (i.e., below 13 m Lake Bonney, below 9 m Lake Fryxell, 

Blood Falls) must be amuplated to allow complete wet-oxidation of organic carbon by sodium 

persulfate before analysis by TOC analyzer (OI analytical Model 700).  Fresh water samples 

(Lake Haore, Lake Miers, Lake Joyce, Trough Lake, shallow waters of Lake Bonney and Lake 

Fryxell) may be run directly on the TOC analyzer without ampulization.  

 

Materials 

Dry Valleys Lab 

Graduated cylinder 

125 ml amber borosilicate glass bottles (acid washed w/ 10% HCL; combusted at 475 C for 4 h) 

Green TFE-lined caps 

Bell Jar filtering apparatus with bottle stands 

25 mm polysulfone filter funnels 

25 mm GF/F filters (combusted at 475 C for 4 h) 

Eppendorf repeater pipet and tips 

MCM Crary Lab 

1000 ml Volumetric Flask (2) 

Ampoule Purging and Sealing apparatus (OI Analytical Model 524)  

Microwave for Lab use 

P1000 Gilson Pipetman and tips 

P200 Gilson Pipetman and tips 

Precleaned ampules  

TOC analyzer (OI analytical Model 700) 

 

Reagents 

Dry Valleys Lab 

Hydrochloric acid (HCL): 6N 

MCM Crary Lab 

Organic free water 

Potassium acid phthalate (KHP) 

Sodium persulfate 

Stock Organic Carbon solution: Dissolve 2.1254 g anhydrous potassium biphthalate (C8H5KO4) 

in carbon-free water and dilute to 1000 ml; 1 ml = 1 mg carbon. 

 

Procedure 

Below steps to be conducted in Dry Valleys Lab 
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Sample Collection 

1. The filtrate produced from the chlorophyll-a filtration (Section 3.1) is collected for DOC 

analyses. 

 

2. Gently invert the 1000 ml amber HDPE bottle, thoroughly mixing the sample, and decant 

100 ml of sample into a graduated cylinder. 

 

3. Place a combusted 25 mm GF/F onto the filter base and replace filter tower.  Collect 100 ml 

of the filtrate in an acid-washed, combusted 125 ml amber borosilicate glass bottle.  Filter 

sample under low vacuum (< 7 in Hg).  Do not rinse the filter tower during this step.  Only 

rinse the filter towers between sample depths. 

 

4. Carefully remove the bell tower and cap the amber bottle. 

 

5. Once all of the DOC samples are filtered, preserve each 100 ml sample with 1.0 ml of 6N 

hydrochloric acid using the Eppendorf repeater pipet.  If less sample volume is filtered, 

adjust the volume of hydrochloric acid accordingly.  Store the samples in the dark at 4 C 

until analysis. 

 

Below steps to be conducted in MCM Crary Lab 

 

Sample Analysis 

1. Open precleaned ampoules. 

 

2. Add 2ml of sample to ampoule. 

 

3. Add 200 l of 5% HCL (prepared with Organic free water) to ampule. 

 

4. Purge using air on Purging and Sealing unit for approx. 5 minutes. 

 

5. While maintaining purge, add 1 ml of 100 g/l Sodium Persulfate solution (prepared as 

directed by TOC manual and purged with nitrogen) to ampoule. Do this step individually just 

before sealing. 

 

6. While maintaining positive oxygen flow in the ampoule, seal the ampoule. 

 

7. Bake the sealed ampoules at 105 °C for about 8 h to drive the reaction to completion. 

 

8. Prepare a standard curve from the stock organic carbon solution (10 – 50 g C) and a blank. 

 

9. Analyze samples and standard curve with the TOC analyzer (Consult the TOC manual for 

injection procedures). 

 

10. Use the regression equation of the standard curve and calculate the DOC (mg/l) for each 

sample. 
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Notes: 

1. Samples with greater than 50 g C must be reanalyzed with an appropriately reduced sample 

volume. 

 

2. Some samples will have high carbonates and fizz when acid is added.  Add acid slowly so as 

not to loose sample. 

 

3. It is important to maintain a pure oxygen atmosphere inside the ampoule.  This will ensure 

that atmospheric CO2 does not intrude, and will also aid in complete oxidation of the organic 

carbon. 

 

4. Do not allow the sample to sit for long periods of time between procedure steps 10 and 11, as 

oxidation of carbon within the sample will begin and some carbon will be lost as CO2. 
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Particulate Carbon and Nitrogen Analysis by Elemental Analyzer (Filters and 

Sediment) 
(Samples are currently being analyzed with a CE Instruments Flash EA 1112 

(ThermoQuest) elemental analyzer. The method outlined below was used until the 0203 

season.) 

General Discussion 

This method is used in the analysis of carbon and nitrogen on filters (water) and sediment 

samples that have been prepared using ASA Analytical Services method described below. 

Samples are analyzed with a Carlo Erba NA 1500 elemental analyzer which flash combusts at 

1800 C.  Combustion gases pass through a catalyst converting all carbon and nitrogen 

combustion products to CO2 and N2.  The gases are then separated by gas chromatography and 

detected by a thermal conductivity detector.  

 

Materials 

Sampling Hut 

1000 ml Amber HDPE bottles 

Dry Valleys Lab 

Graduated cylinder 

25 mm GF/F filters combusted at 475 C for 4 hrs spread out on aluminum foil that will serve as 

a wrapper after combustion. 

25 mm Polysulfone filter towers 

Vacuum pump 

Filter forceps 

Aluminum weigh boats 

Zip Lock Bags 

MCM Crary Lab 

96-well plate:  polystyrene 

Cork borer (1 cm) 

Elemental analyzer: Thermofinnigan EA 1112 Flash 

Filter apparatus 

Forceps: Assorted sizes and types 

Glass plate 

Metric ruler 

Micro spatula 

Micro-balance 

Pre-formed silver cups (Type H) 

Pre-formed tin cups (Type A) 

Quartz combustion tube 

Quartz wool 

 

Interferences 

1. The elemental analyzer is very sensitive and will detect organic carbon and nitrogen in 

fingerprints.  Handle all samples and standards with forceps to avoid contamination. 
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2. Ensure that the preparation area is clean of any standard when working with samples. 

 

Reagents 

Acetanalide: standard grade, pre-dried at 70 C and desiccated (% C = 71.09, % N = 10.36).  

Reagents for combustion and reduction are described in the instrument manual 

 

Procedure 

Sample Collection 

1.   Fill a 1000 ml HDPE amber bottle with 1000 ml of sample from the Niskin bottle.  Place in 

cooler for transport 

 

Below steps to be conducted in Dry Valleys Lab 
2. Particulate organic carbon and nitrogen lake water samples are taken from the 1000 ml amber 

Nalgene bottle.  Gently invert the bottle, thoroughly mixing sample, and decant 500 ml into a 

graduated cylinder. 

 

3. Place a combusted 25 mm GF/F onto the polysufone filter base, replace tower, and filter the 

sample under low pressure (<10 in Hg).  Note:  The filter tower will only hold 200 ml of 

sample, therefore, continually top off the sample until the entire volume is filtered.  

Furthermore, many of the Lake Bonney samples will take between 6-12 h to filter, thus plan 

accordingly. 

 

4. Once the entire volume is filtered, place the filter (organic matter up) in a labeled aluminum 

weigh boat, and dry at room temperature for 12 h.  Following desiccation, stack all of the 

aluminum weigh boats together; place an empty one on top, ensuring the bottoms are clean; 

tape together and store frozen in a zip lock bag.  Include a GF/F filter from the same packet 

of combusted filters used for the samples to be analyzed as a blank. 

 

Below steps to be conducted in MCM Crary Lab 
Sample Analysis (filters) 

1. Using forceps, place sample filter on a clean glass plate. 

 

2. Place the filter into one compartment of a 24-well plate. 

 

3. Place the 24-well plate, with the top removed, into a dessicator containing ~50 ml of 

concentrated HCl.  Allow the filters to fume overnight to remove inorganic carbon.   Samples 

may be stored at -20C or processed further at this point. 

 

4. Using forceps, place the filter section on a type A tin cup that has been unfolded.  Be careful 

not to puncture holes in the foil; fold the foil over and totally cover the filter section.  Keep 

folding the foil as to encapsulate the section to a size of, approximately, 3 mm square.  The 

sample must fit into the sample chamber of the Carlo Erba NA 1500. 

 

Note:  This step is largely technique based and, if possible, should be demonstrated by an 

experienced analyst. 
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5. Place the encapsulated sample into a cell of a 96-well plate.   Samples may be analyzed 

immediately or stored at -70 C. 

 

Sample Analysis (sediment) 

1. Ensure that sediment samples are as homogeneous as possible.  Handle all sample cups with 

forceps to prevent contamination from your skin. 

 

2. Pre-formed silver cups must be cleaned before use. 

Rinse a 1000 ml beaker with 50 ml of acetone. 

Pour silver cups into beaker. 

Add enough acetone to beaker to cover silver cups and mix with a stir rod to ensure all 

surfaces are covered. 

Pour off acetone. 

Put cups into a tin foil boat and place into a 70 C drying oven overnight. 

Put individual cups into cells of a 96-well plate, cover and tape closed to minimize 

exposure of cleaned cups. 

 

3. Weigh out 15-20 mg of dried sediment (105 C for >24 h) into a clean, pre-formed silver 

cup. 

 

4. Place cup into a cell of a new 96-well plate (record cell #).  With the lid of the plate removed, 

place it into a dessicator, containing ~100 ml of concentrated HCl, overnight. 

 

Note:  Do not leave silver cups in an acidic environment for more than 14 h.   The acid will 

cause the cups to become brittle and they will break and crack when they are manipulated. 

 

5. Remove the 96-well plate.  Carefully crimp the tops of the cups and compact the them into a, 

3 mm or smaller cube. 

 

Note:  This step is largely technique based and, if possible, should be demonstrated by an 

experienced analyst. 

 

6. Return the sample to the 96-well plate.  These samples should be analyzed as soon as 

possible as traces of acid will continue to react with the silver cups. 

 

Instrument Preparation 

1. It is important to wear gloves when handling and packing the combustion tube.  Fingerprints 

can cause the tube to crack or shatter causing injury. 

 

2. Use combustion tube diagram, in the instrument manual, and a ruler to measure and pack the 

column, with copper wires and tungstic anhydride, using the quartz wool to separate 

catalysts.  Note:  Tungstic anhydride comes prepackage in the correct amount needed for 

packing. 
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3. Insert the packed tube into the instrument, from the top side of the instrument, being careful 

not to chip the end of the tube on the inside of the furnace.  Grasp the bottom of the tube and 

carefully place the locking nut, metal spacer and O-ring onto the tube as shown in the 

instrument manual.  Seat the locking nut on the coupling and tighten hand-tight. 

 

4. While still holding onto the tube, place the O-ring onto the top of the tube.  Seat the 

autosampler onto the O-ring and tighten the locking nut hand-tight. 

 

5. Proceed with instrument set-up and perform a leak check to ensure a helium tight seal. 

 

Note:  The combustion tube catalysts have a limited sample life.  When CCV's start to approach 

the lower limits of acceptable range, or the tube is full, a new tube must be prepared. 

 

Instrument set up 

1. Open the valves to the air, oxygen and helium cylinders. 

 

2. Turn the main power switch on. 

 

3. The instrument parameters should be set according to the instrument operating manual.  Once 

set, they should not have to be changed. 

 

4. If the combustion tube has been changed, perform a leak test. 

 

5. Allow the combustion chamber to come to stand-by temperature and turn on the sample 

purge valve. 

 

6. Turn the instrument off of stand-by and allow to come to operating temperature. 

 

7. Turn on the instrument computer and boot up the HP Chemsoft software package. 

 

Leak Test 

1. Turn the carrier gas and detector gas regulators (the regulators on the instrument panel, not 

the regulators attached to the cylinders) below 100 psi.   

 

2. Cap off the carrier and detector outlet lines with the provided plugs. 

 

3. Carefully, so as not to overshoot, adjust each regulator (instrument panel) to 100 psi and 

allow the pressure to equilibrate for a few seconds. 

 

4. Turn the carrier and detector gas regulators (instrument panel) down several turns. 

 

5. Observe the pressure gauges for 60 seconds and ensure that there is no drop in pressure.  If a 

drop in pressure is observed, check combustion tube fittings and repeat the leak test.  If a leak 

is still present, refer to the instrument technical manual for a more thorough test procedure 

that will narrow and identify the leak. 
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6. Remove plugs from outlet lines and adjust the regulators back to manual specifications. 

 

Setting Instrument Flow rates 

1. Set-up the flow-meter, as described in the flow-meter manual. 

 

2. Attach the flow-meter hose to the carrier gas outlet and measure the flow.  If the flow rate is 

off, according to the instrument manual, adjust the carrier gas pressure regulator (instrument 

panel) until the correct flow is achieved. 

 

Note:  If the pressure needed to achieve proper flow rates is above 100, there is a block in the 

carrier line.  A common cause of this is saturated drying material in the water trap. 

 

3. Repeat the flow check on the detector and oxygen lines and adjust as necessary. 

 

Instrument Calibration 

1. Calibration standards for filter samples are made in tin cups.  For sediment samples, silver 

cups are used. 

 

2. Using forceps, place a single cup on a micro-balance and tare.  Remove the cup from the 

balance and place on a clean glass plate. 

 

3. Use the micro-spatula to assist in weighing between 25 and 550 g of acetanalide standards.  

Record the weight. 

 

25. Make a total of six standards, ensuring the weights are spread out evenly between 25 and 550 

g. 

 

5. Crimp and fold three cups to be used as blanks and place in the 96-well plate. 

 

6. Load the auto sampler, starting with the three blanks and ending with the high standard. 

 

7. Enter the blanks and standard amounts into the sample table of the chemsoft program, as 

described in the software manual, and start the run. 

 

26. Determine the theoretical yield of carbon and nitrogen for each standard.  Acetanalide 

contains 71.09% C and 10.36% N.  Multiply each standard weight by the fraction of C and N 

in the standards to determine the expected g of each C and N respectively (25 g acetanilide 

contains 17.77 g C and 2.59 g N; 550 g acetanilide contains 390.99 g C and 56.98 g 

N). 

 

9. Plot the peak area vs. the expected g for each analyte and ensure a linear fit with a 

correlation of 0.995 or better, to validate calibration. 
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Quality Control 

1. Analyze one blank cup per 20 samples.  Ensure that the blank measures at or below the 

instrument detection limit to check for instrument drift. 

 

2. Analyze one mid-range standard per 20 samples.  Ensure a percent recovery between 90 - 

110 %, when compared to the standard curve, to continue analysis.  If the recovery is not 

within this range, check instrument operation. 

 

3. Analyze one duplicate sample per 20 samples.  Ensure a coefficient of variation of between 

70 - 130 % to confirm precision.  

 

Instrument Shut Down 

1. Turn the sample purge flow off. 

 

2. Turn the instrument to stand-by and wait for the combustion chamber to reach stand-by 

temperature. 

 

3. Turn the gas flow at the gas cylinders off. 

 

4. Turn the main power to the instrument off. 

 

References 

Carlo Erba Elemental Analyzer, Instrument Manual. 

Carlo Erba Elemental Analyzer, Technical Manual. 
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Ammonium Analysis Using a Manual Method 
(Samples are currently analyzed for Ammonium using the Autoanalyzer) 

 

General Discussion 

 

Materials 

P10 ml Gilson Pipetman 

25 ml test tubes (acid soaked) 

Assorted volumetric flasks (100, 250, 1000 ml) 

 

Reagents 

Alkaline citrate solution:  Dissolve 50 g of analytical reagent grade trisodium citrate dihydrate 

and 2.5 g of analytical reagent grade sodium hydroxide in 250 ml of DI water. 

 

Ammonium stock solution (1 mM):  Bring 0.1070 g oven-dried (>4 h at 100 C) NH4C1 to 2000 

ml with DI water.  This will make a 1 mM solution.  Store at 4 C. 

 

Oxidizing solution:  Mix 100 ml of the alkaline citrate solution with 25 ml of sodium 

hypochlorite solution.  Prepare this mixture fresh daily. 

 

Phenol-ethanol solution.  Dissolve 10 g of analytical reagent grade phenol in 100 ml 95% 

ethanol.  Handle with caution. 

 

Sodium hypochlorite solution:  Use analytical reagent grade sodium hypochlorite solution 

(NaOCL) or a household bleach.  Note: These solutions loose chlorine over time and may 

have to be replaced often. 

 

Sodium nitroferricyanide solution:  Dissolve 0.5 g of analytical reagent grade sodium 

nitroferricyanide in 100 ml of DI water.  Store at 4 C in a dark bottle wrapped with 

aluminum foil, replace monthly. 

 

Procedure 

1. Thoroughly rinse acid soaked 25 ml test tubes and rinse 6 with DI water. 

 

2. Add exactly 10 ml of DI water to each of the first ten tubes and then add the appropriate 

volume of ammonium stock solution (Table 12) and vortex.  These tubes will serve as 

standards: 
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Table 12.  Volume of stock ammonium solution use to create standard solutions. 

 

Tube # Volume of 1 mM stock added (ml) Final Standard. Concentration (M) 

1 0 0 

2 0 0 

3 0.05 4.975 

4 0.05 4.98 

5 0.10 9.901 

6 0.10 9.901 

7 0.20 19.608 

8 0.20 19.608 

9 0.30 29.126 

10 0.30 29.13 

 

3. Fill the remaining tubes with 10 ml of sample.  For saline samples requiring 1:10 dilution 

(See Dilutions on Page 94), add 9 ml of DI water to 1 ml of sample. 

 

4. Add 0.4 ml of the phenol-ethanol solution to each tube and vortex. 

 

5. Add 0.4 ml of sodium nitroferricyanide solution to each tube and vortex. 

 

6. Add 1.0 ml of oxidizing solution to each tube and vortex. 

 

7. Place all the tubes in total darkness; let color develop for a minimum of 2 h. 

 

8. Calibrate spectrophotometer to read zero absorbance (100% transmittance) against DI water. 

Measure the absorbance of the calibration standards and samples at 640 nm.  Use the same 

cuvette for all readings.  Rinse cuvette with DI water between samples. 

 

27. Use the standard curve regression equation to calculate NH4
+ values (M) for each sample. 
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Nitrate Analysis by Spongy Cadmium Reduction (Manual Method) 
(Samples are currently analyzed for Nitrite using the Autoanalyzer) 

 
 

General Discussion 

In this assay, the concentration of nitrate is determined by cadmium reduction to nitrate 

followed by a diatozation-coupling reaction resulting in the formation of a red azo dye, which 

can be analyzed colorimetrically.  Nitrate concentration is assumed to be equal to the difference 

between nitrate concentration of the sample before and after nitrate reduction.  This procedure is 

based on “An Alternate Method for Nitrate Reduction by Shaking with Spongy Cadmium” 

(Jones, 1984) with some modifications adapted from the copper-activated Cadmium column 

reduction method found in Standard Methods (APHA 85).  The method of nitrate reduction 

presented by Jones offers certain advantages over the copper-activated cadmium column method.  

It eliminates the problems of unequal reduction efficiencies among multiple reduction columns 

and prevents the gradual decline in reduction efficiency associated with cadmium columns.  

Also, because the spongy cadmium is cleaned and acidified each time it is used, the danger of 

sample contamination is reduced greatly. 

 

Materials 

25 ml standard test tubes 

50 ml pyrex screw top test tubes 

Assorted volumetric flasks 

P10 ml Gilson Pipetman and tips 

Shaking Table 

Spectrophotometer (providing a light path  1 cm and reading at 543 nm) 

Vortex 

 

Reagents 

Cadmium Sulfate Solution:  Dissolve 20 g of CdSO4 in 100 ml of DI water (20% CdSO4 w/v) 

6N Hydrochloric Acid  

Zinc metal sticks:  Sticks should be roughly 10 cm long and 1 cm in diameter, with purity near 

99.9995%.  However, use of zinc that is slightly less pure should have no detrimental effect 

on the outcome of the assay.  Zinc does not play a direct role in reduction of the sample; 

furthermore, the spongy cadmium is rinsed thoroughly with deionized water after formation, 

thus greatly reducing the possibility of contamination through zinc impurities. 

Spongy Cadmium:  Place two sticks of zinc metal in 80 ml of cadmium sulfate solution 

overnight.  Reaction of two sticks with 80 ml of solution in a slender glass container will 

produce roughly 15 g of wet spongy Cadmium (CdSO4 is nearly completely consumed in this 

reaction.)  Using a plastic spatula or pipet tip, separate the cadmium precipitate from the zinc 

sticks.  Remove the zinc sticks and store.  Acidify the solution with a few drops of 6N HCl 

and drain it from the precipitate.  Cover the cadmium precipitate with 6N HCl and stir, 

breaking up any large aggregates.  Drain the acid, then rinse the precipitate with DI water 

until pH is above 5 ( 10 times) and store under DIW.  It is essential to keep the cadmium 

wet at all times.  After the reduction step is completed, reactivate the cadmium by repeating 

the HCl wash and DI rinse. 
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N-1-napthyl)-ethylenediamine dihydrochloride (NED dihydrochloride):  Dissolve 500 mg NED 

dihydrocholoride in 500 ml DI water.  Store in a dark bottle.  Replace monthly or upon the 

development of a dark color. 

Ammonium Chloride-EDTA buffer solution:  Dissolve 13 g NH4Cl and 1.7 g disodium 

ethylenediamine tetraacetate in 900 ml DI water.  Bring pH to 8.5 with concentrated NH4OH 

(under fume hood) and dilute to 1000 ml.  This solution is less prone to interference by 

metals and turbidity in the water sample than the buffer used by Jones (1984).  Isolate this 

reagent from those used for ammonium determination. 

Sulfanilimide solution:  Add 50 ml concentrated HCl to 300 ml DI water.  Add 5 g sulfanilimide 

and vortex well, dilute to 500 ml.  The solution is stable for several months. 

Stock Nitrate solution: NO3
--N (1000 mg l-1).  Dissolve 7.218 g of KNO3 (dried in an oven at 

105 C for 24 h) in water and dilute to 1000 ml. 

Standard Nitrate solutions: (10 mg l-1).  Dilute 10.0 ml of nitrate stock solution to 1000 ml with 

DI water.  Prepare calibration standards in the range of 0-10 mg NO3
- - N l-1 by diluting the 

following volumes (5, 15, 25, 35, 45 ml) to 50 ml with DI water 

Spiking Nitrate solutions: (50 mg l-1).  Dilute 5.0 ml of each stock solution to 1000 ml with DI 

water. 

 

Procedure 

1. Pipet 10 ml of each sample into an acid-washed 50 ml screw-top test tube.   

 

2. Add 10 ml EDTA buffer solution to each sample.  A bottle-top dispenser is a convenient way 

to distribute the buffer to the tubes.  Note:  Samples that have NO3
-+NO2

- concentrations 

above 30 M should be diluted.  Lake Bonney samples below 15 m are diluted 1:10. 

 

3. Prepare calibration standards in the same manner as samples. 

 

Reduction of NO3
- 

1. Add approximately 0.5 g spongy cadmium to each sample.  To avoid possible metal 

interference, use a plastic spatula (or a plastic pipet tip cut lengthwise) to transfer cadmium.  

Because the cadmium will be present in excess, absolute precision in weighing is not 

necessary.  Weighing a single cadmium sample and then estimating weights for subsequent 

samples is sufficient to ensure consistency in reduction. 

 

2. Screw caps firmly on test tubes and place horizontally on shaker table.  Shake for 

approximately 90 minutes at 100 RPM.  Pipet 10 ml reduced sample into 25 ml test tube. 

 

Color development and measurement 

1. Add 0.4 ml sulfanilamide reagent to each reduced 10 ml sample and vortex.  Let the reagent 

react for 2-8 minutes. 

 

2. Add 0.4 ml of NED-dihydrochloride solution.  Vortex immediately. 

 

2. Allow color to develop for at least 20 minutes but not more than 2 h. 
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3. Calibrate spectrophotometer to read zero absorbance (100% transmittance) against DI water. 

Measure the absorbance of the calibration standards and samples at 543 nm.  Use the same 

cuvette for all readings.  Rinse cuvette with DI water between samples. 

 

4. Use the standard curve regression equation to calculate NO3
- -N values (mg l-1) for each 

sample. 
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Dissolved Oxygen by Mini-Winkler Titration 

(In 0506 we started using a pre-maid sodium thiosulfate solution. The following method 

includes standardization using a bi-iodate standard as was done prior to 0506.)  

 

General Discussion 

 

Materials 

Sampling Hut 

Benchcoat 

Kimwipes 

P1000 Gilson Pipetman and tips (2-one for each reagent) 

Vinyl gloves (at least 3 pair) 

Glass scintillation vials (20 ml vials with HDPE cone caps) 

Serum/Scintillation vial carrier 

Plastic scintillation tray 

Ziplock bag for waste 

Dry Valleys lab 

Benchcoat 

Kimwipes 

P1000 Gilson Pipetman and tips (3-one for each reagent) 

DI squirt bottle 

Eyedropper 

Forceps 

Gilson micro-buret (2 ml) 

Lamp or good sunlight 

Latex/vinyl gloves (at least 3 pairs) 

Magnetic stir plate 

Micro stir bar 

Mini beakers (10 ml) 

Waste bottle 

Ziplock for lab waste 

 

Reagents 

Sampling Hut 

Alkaline-iodide-azide solution: In a volumetric flask bring the following reagents to 250 ml 

using DI water: 

  2.5 g sodium azide (NaN3) 

  25 g potassium iodide (KI) 

  80 g sodium hydroxide (NaOH) 

Manganous solution (Mn++): In a volumetric flask bring 100 g of MnCl2  4H2O to 250 ml using 

DI water. 

Dry Valleys Lab 

Alkaline-iodide-azide solution (see above) 

Manganous solution (Mn++) (see above) 
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Phosphoric acid (H2PO4): Concentrated 

Sodium thiosulfate titrant (Na2S2O35H2O): In a volumetric flask bring 0.620 g of Na2S2O35H2O 

to 250 ml using DI water. 

Standard potassium bi-iodate solution (KH(IO3)2): In a volumetric flask bring 0.03256 g of 

KH(IO3)2 to 100 ml.  However, it is easier to prepare a 10 concentrated solution and 

immediately before titration bring 10 ml of the concentrated solution to 100 ml in a 

volumetric flask with DI water. 

Starch solution (1%): Dissolve 1 g of laboratory –grade soluble starch in 100 ml of hot DI water. 

 

Procedure 

Sample Collection 

1. Place the Niskin bottle tubing to the bottom of the 20 ml scintillation vial.  Allow the water 

overflow, displacing the initial sample volume 2x (about 5 seconds).  Carefully remove the 

tubing, keeping turbulence to a minimum, making sure the vial is completely filled with no 

air bubbles. 

 

2. Fix the sample by adding the following reagents (directly into sample): 

0.9ml of the Mn2+ solution 

0.9ml of the alkali-iodide-azide solution 

 

3. Cap the sample and invert several times to ensure mixing.  Use benchcoat on the table top 

and kimwipes to mop up the excess fluid that is displaced. 

 

4. Place sample into the Serum/Scintillation vial carrier for transport. 

 

Below steps to be conducted in Dry Valleys Lab 

Sample Analysis 

4. Prepare each sample for titration by adding 1 ml of phosphoric acid.  Invert each sample 

several times and wait for precipitate to dissolve. 

 

2. Dilute the concentrated potassium bi-iodate solution.  Bring 10 ml of the concentrated 

solution to 100 ml in a volumetric flask using DI water. 

 

3. Prepare a standard by filling a 20 ml scintillation vial to the brim with the diluted potassium 

bi-iodate solution, and add the following reagents: 

0.9 ml of the alkali-iodide-azide reagent. 

1 ml of phosphoric acid. 

Cap the sample and invert several times to mix. 

 

4. Sample titration: Place a kimwipe on the stir plate and position the plate such that it is in 

direct light (a desk lamp may be used) to easily observe colorimetric change. 

 

5. Withdraw 2 ml of sodium thiosulfate into the microburet.  Note: To minimize contamination 

of the thiosulfate, fill a scintillation vial with thiosulfate and use instead of the reagent bottle. 
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6. Pipet 1 ml of sample (or standard) into a 10 ml disposable beaker, and place a micro stir bar 

into the sample. 

 

7. While keeping the tip of the microburet in the sample, slowly titrate to a pale straw yellow 

color; add 1-2 drops of starch solution (heat starch solution prior to addition to make sure 

starch is in solution), this will turn the sample dark blue; then titrate to endpoint (first 

disappearance of blue color).  Place a mini beaker containing 2 ml of DI water along side the 

sample beaker.  This will provide a reference color during sample titration.  Note:  If the 

sample does not turn dark blue, the starch may have precipitated.  Resuspend the starch by 

heating solution (hot, but not boiling). 

 

8. Record the volume of titrant, and repeat titration.  Titrate each sample at least 2 times and the 

standard at least 4 times.  Variation among the replicates should be less than ± 0.5%. 

 

Note: After each titration, rinse the buret with DI water (into a waste bottle), and wipe dry with a 

kimwipe.  Then refill with the thiosulfate solution, and wipe the buret dry again.  Also, pour 

the titrated sample into the waste bottle; rinse the mini beaker with DI water and wipe dry. 

 

9. Determine oxygen concentration as follows. 

 

     

  









bottle of ml

1.8-bottle of ml
 titratedsample ml

8000M titrantml
l mgOOxygen  Dissolved thio1-

2  

 

where Mthio is the molarity of thiosulfate, and 8000 converts thiosulfate equivalents to 

oxygen equivalents and ml filtered to liters. 
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In-situ Dissolved Oxygen and Temperature Profiles  

(Method used until 99-00 season) 

 

General Discussion 

Dissolved oxygen and temperature profiles are collected from the Weatherport sampling 

hole using an oxygen sensitive membrane polargraphic electrode. 

 

Materials 

YSI Model 58 dissolved oxygen meter 

YSI Model 5739 dissolved oxygen probe with a 50 m cable 

 

Procedure 

1. Before each sampling, check the condition of the batteries in the meter, the connection 

between the probe and cable, and replace the probe membrane and solution.  Use a high 

sensitivity membrane and half saturated KCl solution.  Always store the probe in a water-

saturated air environment with its protective cap in place. 

 

2. Turn the meter on and place the probe, with its protective cap in place, directly above the 

piezometric water level inside the hole.  Allow the probe to polarize and reach temperature 

equilibrium (~15 minutes). 

 

3. To calibrate the instrument, set the SALINITY scale to 0 ppt, adjust the ZERO knob to read 

zero, and set the calibration knob to read the correct dissolved oxygen value based on the 

probe temperature and local atmospheric pressure (Consult the dissolved oxygen saturation 

curve on the back of the meter).  Do not change the SALINITIY scale during measurements.  

Even though the deep water of Lake Bonney exceeds 40 ppt, the salinity scale is set to zero 

for comparative purposes. 

 

4. Lower the probe to the desired depth and slowly agitate the probe in an up and down motion 

(~ 2 cm).  Allow the probe to reach equilibrium and record the temperature, dissolved 

oxygen (mg l-1), and % saturation.  Note:  The temperature value will quickly stabilized, 

however, the dissolved oxygen may take at least 10 minutes to reach equilibrium at each 

depth.  Record data at 1 m increments down the water column.  Do not allow the probe to 

come in contact with the benthos. 
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Underwater Time Series PAR Logged During Primary Production 

Experiment (Using LI-1000) 

General Discussion 

 

Materials 

Licor LI-1000 Data logger with 30 m cable 

Licor LI-193SA spherical quantum sensor 

Licor LI-190SA quantum sensor 

Leveling fixture 

Lowering Frame 

Tarpaulin (opaque) 

 

    
 

Procedure 

1. - Clear the memory of the LI-1000 by pressing “FCT/ON” and scrolling with the down arrow 

until you see “Clear Ram.” Press Enter and say yes. Exit by pressing “FCT/ON.”   

     - Set the date and time by pressing “TIME” and entering the current date and time. 

     - Configure the LI-1000 to record light data on channels 1 (underwater sensor) and 2 (incident 

sensor); enter the appropriate sensor multiplier for each channel (See LI-1000 Manual and 

multipliers attached to each sensor).  

      

2. Configure the LI-1000 to Log Mean PAR values every 10 minutes: 

 1. CFG mode is LOG 

 2. range A (autorange) 

 3. label UM (mol photons s-1 m-2) (this can be left blank for easier 

                                                      data processing) 

 4. multiplier Correct Multiplier on PAR sensor 

 5. per (logging period) 10 

 6. interval 5 (LICOR automatically chooses 5 seconds for a 10 min 

                                                      period) 

 7. reset Time the PAR logging should begin 
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 8. threshold (thr) -1.000E+09 

 9. store Mean 

 10. tcoff 0.0036 (this parameter is only shown if “store” is set to       

                                                     “Int.” 

 11. min/max no 

 12. time stamp yes (this parameter is only shown if “min/max” = yes. 

 

3. The time series logged data is recorded inside the weatherport sampling hole.  Once all of the 

water samples have been collected, lower the underwater sensor frame to a depth of 10 m (7 

m at Lake Fryxell) below the piezometric water level and secure to the winch frame.  Place 

the ambient sensor frame as far away from the weatherport as possible and attach both cables 

to the appropriate channels on the LI-1000.  Make sure you give yourself enough time, once 

the reset time is programmed, to position the sensors and data logger. 

 

4. Allow the LI-1000 to log for a 24 h period, wake up the instrument by pressing the FCT/ON 

button and then turn the instrument off.  Note: Due to logistic and time constraints it is 

difficult to immediately start PAR logging once the PPR samples are placed in the incubation 

hole. 

 

5. Download the recorded data to a computer or ZIP disk.  Follow the instructions provided 

below (http://env.licor.com). 

 

Using Windows®95 HyperTerminal to Download From the LI-COR® LI-1000 

(during the 0405 season, we used Tattle Term instead of Hyperterminal – see below for these 

instructions) 

 

If you use a PC with Windows 95 software, there is an easy way to retrieve data from the LI-

COR LI-1000 without having to use the 1000-90 communications software program available 

from LI-COR.  HyperTerminal (found in the accessories folder of Windows®95) will work just 

fine. 

 

Steps for setting up HyperTerminal 

1. Connect the LI-1000 to one of your PC’s serial connections using either the 1000-03 cable 

with 25-pin connector or the 1000-09 cable with 9-pin connector depending on your PC’s 

requirements 

 

2. Open the HyperTerminal folder and double click on Hypertrm.exe. (If a screen appears 

prompting you to install a modem, select No.). Open Hyperterminal (located in the 

“Communications” folder under “Accessories”: start → programs → accessories → 

communications → Hyperterminal) 

 

3. Select a name for the connection, such as LI-1000 and then select OK. (Note: HyperTerminal 

will automatically add an .ht extension to the filename, so it will appear as LI-1000.ht the 

next time HyperTerminal is opened.) 

 

http://env.licor.com)/
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4. Select the appropriate connector for your connection under “Connect using” (Direct to Com 

1, Direct to Com 2, or…) and select OK. 

 

 
 

5. Change the communications settings to the following: Bits per second = 4800, Data bits = 8, 

Parity = None, Stop bits = 2, Flow control = Xon/Xoff, and then select OK. 

 



 Section 7. Previously Used Methods 
 7.16 Underwater Time Series PAR Logged During PP Experiment 

LTER Limnological Methods Manual Page 283  Method_Manual_JL_092319.docx 

 
 

6. Save the configuration by selecting File/Save on the next screen. At this point, you are saving 

the configuration of HyperTerminal under the file name you selected in step 3. The next time 

you start HyperTerminal, double click on this file, which will allow you to skip steps 3-6 

during future interrogations. When asked if you want to save the connection, click “yes” to 

save the configuration. You can go to the Hyperterminal folder (start → programs → 

accessories → communications → Hyperterminal folder) and create a shortcut to your 

connection for the desktop. 

 

7. From the Transfer menu, select Capture Text. 

 

 
 

8. Select a folder and a type a file name for the data you will be transferring. This will be the 

file name for your data. (Note: If you select a file that already exists, HyperTerminal will not 

overwrite the file, it will simply append the data being downloaded to that file.) Select Start. 
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Steps for collecting LI-1000 data using HyperTerminal 

1. Turn on the LI-1000 and select the OUT button. 

 

2. Change the baud rate to Baud = 48 (for 4800) by using the up and down arrows and select 

ENTER. 

 

3. Set the form to Form = H (for horizontal) by using the up and down arrows and select 

ENTER. 

 

4. Set the len (for length) to len=80 by directly entering the numbers from the keypad and select 

ENTER. 

 

5. Set the dump all to YES or NO (dependent upon your requirements) by using the up and 

down arrows and select ENTER.  (Selecting NO will prompt you to enter the year, month, 

date, hour, and minute for starting and stopping your data dump.) 

 

6. Your data will begin to dump to the HyperTerminal program.  If you have, for example, two 

months of data stored in your LI-1000 and choose only to dump the last month, you may 

have a blank screen for a minute.  The LI-1000 will scroll through all readings until it reaches 

the date marker you set.  Upon reaching the date you set for the dump, you will see the data 

dump to the HyperTerminal screen. 

 

 
 

7. To exit the program, choose Call/Disconnect or click on the Disconnect icon on the toolbar, 

and then exit the program. 

 

 

Tattle Term Instructions for use of Tattle Term instead of Hyperterminal 

1. Open Tattle Term  

2. Select Com 1, Click OK, click OK again 
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3. Select 19200 8N1 in bottom left corner by clicking once 

4. Change baud rate to 4800 and stop bits to 2. (Everything else should read Data bits: 8, 

Parity: none, Com Port: COM1) 

5. Select transfer.  Click on ASCII and select receive. Enter a filename and save. 

6. ON LICOR 1000: press OUT key, baud=48 then ENTER, form=H then ENTER, len=80 

then ENTER, dump all=YES then ENTER. 

7. Wait until all bytes are transferred. 

8. Close Tattle Term and open WordPad (or Notepad). 

9. Open file saved in Step 5 through WordPad. (Will be an All Files type) 

10. Save this file as a WordPad document. 

11. Open Excel. Open file created in WordPad (step 9) through Excel. (All Files) 

12. Click NEXT twice, click FINISH. 

13. Copy and paste data into Master Spreadsheet. 
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Underwater Profile PAR and Attenuation (Using LI-1000) 

General Discussion 

 

Materials 

Licor LI-1000 Data logger with 50 m cable 

Licor LI-193SA spherical quantum sensor 

Licor LI-190SA quantum sensor 

Leveling fixture 

Lowering Frame 

Tarpaulin (opaque) 

 

   
 

Procedure  

1. Configure the LI-1000 to record light data on channels 1 (underwater sensor) and 2 (ambient 

sensor); enter the appropriate sensor multiplier for each channel (See LI-1000 Manual). 

 

2. Configure the LI-1000 to provide instantaneous point values: 

  CFG mode is INST 

  range A (autorange) 

  multiplier Correct Multiplier on PAR sensor 

  label UM (mol photons s-1 m-2) 

  ave 1 

 

3. Collect the PAR profile data in a covered incubation hole (use a tarp).  Situate the incident 

surface PAR sensor nearby on a level surface, and lower the wet sensor frame into the water.  

Collect PAR data on 0.5 m increments beginning at just under the surface of the water in the 

ice hole and continue until the underwater PAR = 0.  Once the underwater sensor stabilizes, 

record both the underwater and incident PAR values. 

 

Note:  Always record the time of day and ambient weather conditions (i.e., cloud cover, 

sunshine, etc.) when profile is collected
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Biospherical Profiling Natural Fluorescence  

(Original Instrument using DOS software – The instrument broke during the 

0708 season, and a new PNF was purchased before the 0910 season.) 

 

General Discussion 

The PNF-300 is an integrated optical system specifically designed to measure natural 

fluorescence - the fluorescence from the phytoplankton community stimulated by available 

sunlight.  Research has shown that natural fluorescence is correlated to 14C photosynthetic rates 

and chlorophyll concentrations. Unlike strobe fluorometers, a natural fluorometer measures 

fluorescence emitted under the ambient light conditions which is driving in situ photosynthesis. 

 

Materials 

Biospherical PNF-300: 

Underwater PNF Instrument with cable 

Surface PAR sensor with cable 

Deck box with AC/DC charger 

Computer cable 

Instruction manual (bring copy from MSU) 

PC labtop computer 

 

Procedure 

Instrument Calibration 

1. Install the PNF-300 software onto the PC laptop. You will need the PROFILE.EXE, 

PROGRAPH.EXE and the CALIBR8.G30 files. A new folder should be made for the season 

with these files copied into it. (See Appendix C of the PNF Manual) 

 

2. The PNF 300 should be calibrated every 2 years and a calibration sheet should be supplied.  

Set the configuration parameters and calibration constants for the data acquisition software. 

Open the PROFILE.EXE program and press ESC to change configuration.  This will bring 

up the Instrument Parameter Window. 
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Use the arrow keys to highlight configuration parameters and press ENTER to set the correct 

values as illustrated above.   

 

3.   Highlight “Change Calibration Constants” and press ENTER. This will bring you to the 

Instrument Calibration Window.  Change the calibration constants according to the 

calibration certificate supplied.  Note:  The calibration constants illustrated below are from a 

1997 calibration certificate and will be different from current constants.  Save the parameters 

to disk in both the “Calibration Constants” and the “Instrument Parameter” windows and exit 

the program.  A new calibration file will be written to the folder (CALIBR8.cal). Next time 

you open the PROFILE.exe program from this folder, these constants will be used.  The 

program is ready for data acquisition.    

 

NOTE: Check the serial number on the surface sensor unit to ensure it matches the serial number 

on the calibration certificate. There is more than one surface sensor in Crary Lab, but only 

one is sent out each year for calibration with the PNF. 

 

Data Collection 

1. The PNF is always cast in an outside hole to minimize shading effects (i.e., Weatherport 

shading).  The sampling hole must be covered with a tarp to minimize direct sunlight 

entering the hole. 

 

2. Connect the surface PAR sensor and PNF to the deck box, connect the deck box to the 

computer, and position the cable so the PNF can be easily deployed.  The surface PAR sensor 

should be placed away from the hole to eliminate possible shading.  Turn on the deck box 

and computer.  Launch the PROFILE program (shown below) which will initialize the PNF, 

then enter the appropriate filename when prompted. 
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3. Position the PNF over the center of the hole and lower the PNF until the downwelling PAR 

sensor is covered by water.  Allow the PNF to cool and the pressure transducer to stabilize.  

In the PROFILE program select F5 (Start profile) to begin recording data (shown below).  

Slowly lower (0.5 m sec-1) the PNF to the desired depth. Continue recording data on the 

upcast and pause at the surface for 10 seconds for reference. Select F6 (Stop profile).  

Perform a second downward cast (if desired) and rinse the PNF. 

 

 

5. View the data to ensure the instrument was working properly.  Following the cast, a .bnd 

and a .txt file will be generated.  Launch the PROGRAPH.EXE program and select the 

appropriate filename (only .bnd files will be displayed. These files must be in the same 

folder as the PROFILE.EXE program for the program to read them).  Select “plot” to 

examine the data.  Select “convert to CSV” to convert the .bnd file to a .csv file. This is 

the file you will use to see the data. Exit the program.  
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Seabird 25 Conductivity, Temperature and Depth Instrument 

(USING SEASAVE WIN32 V5.39) 

 

General Discussion 

 

Materials 

Seabird 25 CTD (80 m) 

PC laptop computer 

1% Triton-X solution 

60 ml syringe and tubing to connect to the pump outlet 

 

Procedure 

Instrument Calibration (SeaSave)  

1. Install the current version of Windows Seasoft data acquisition software onto the laptop 

computer. SeaSave is used to view and change .con file data, SeaTerm is used to 

communicate with the CTD, do the casts, and download the data, SeaSave is used to view 

the data, and SBE Data Processing is used to process the data (convert .hex files).  

 

2. Configure the data acquisition software based on the current calibration constants provided by 

Sea-Bird Electronics.  Every year the manufacturer sends a paper copy of the calibration values, 

and an electronic copy of the .con file containing these calibration values. Save the current .con 

file to the computer from the CD and view it in SeaSave to check the values.  In SeaSave, click 

on “configure” → “new style instrument configuration” then “select instrument configuration” 

and choose the appropriate .con file. Go to “modify selected instrument configuration.” If you 

don’t have a .con file, you can modify an existing file with the values from the paper copy.  Enter 

the values as illustrated below: 

 

 Enter “> than highest” for firmware (Gary Morast from SeaBird said that the 

Firmware version is important to have correct. In 0708 it was 4.02) 

 “8 scans per second” for Data Output Rate (this is user configurable: When our 

CTD come back from the manufacturer, it is set to store data at 1 scan per second; 

we will change this to 8 scans per second using SeaTerm (see below)).  
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Check the Temperature, Conductivity (Set the Cell Constant = 2000, and the Series 

Resistance = 300), Pressure and Fluorometer values, or enter them from the paper copies 

of the calibration reports if you are not using the current .con file. If you have selected the 

current .con file, these values should match the values in the paper copy. Below are the 

0809 calibration coefficients for the Temperature Sensor. 

 

 
 

Save the configuration file.  The .con file is used for data processing (conversion of .hex 

files) with SBE Data Processing, and for viewing data in SeaSave. SeaSave and SBE 

Data Processing will not interpret the data correctly without the correct .con file. 

 

If using the new SeaSave Version 7, go to “Configure Inputs” → “Instrument 

Configuration” and then “Modify” to check and change any of the values as described 

above. 
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Instrument Setup (SeaTerm) 

2. Before using SeaTerm to communicate with the CTD or upload data from the CTD, the 

program must have information about the CTD hardware configuration and about the 

computer. To set these parameters, open the SeaTerm program, go to “configure” and 

click on “SBE 25” (that is the name of our CTD).   
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Information about the CTD’s configuration came with the original instrument purchase:  

 

COM settings (must match CTDs configuration sheet): 

a. Firmware: > 3.0 (updated to 4.02 in 0708) (must be correct according to Gary 

Morast of SeaBird) 
b. Comm port – 1 

c. Baud Rate – 600 (the program cycles through the baud rates until it finds the one 

it can use to connect. You can either put 600 and let it find the right one, or put 

the one it uses (usually 4800) to start out with). 

d. Data Bits – 7 

e. Parity – even 

 

Upload settings: 

e. Data Upload Baud Rate – 9600 

f. Upload Data: 1 cast (set as desired) 

g. SBE 3 - Temperature Sensor Serial Number: 0964 (must match .con file)  

h. SBE 4 - Conductivity Sensor Serial Number: 2396w (must match .con file) 

 

Header Information (set as desired): 

a. Header: Prompt for Header Information  

 

When done, click OK and SeaTerm will save the settings in a SEATERM.ini file. SEATERM 

will not upload data correctly without a properly configured SEATERM.ini file. (If the program 

saves the settings, it has created the .ini file in the root directory; you don’t actually have to do 

anything with the .ini file). 

 

Click “Connect” to communicate with the CTD 

Click “Status” to get information about the CTD. 



 Section 7. Previously Used Methods 
 7.19 Seabird 25 CTD using SEASAVE WIN32 V5.39 

 

LTER Limnological Methods Manual Page 295  Method_Manual_JL_092319.docx 

 

 
 

When the CTD comes back from the factory every year, it is set to turn on at a salinity meant for 

using it in seawater. This parameter is called the “minimum conductivity frequency for pump 

turn on.” Since we are using it in the lakes, we need to re-set this value so that the CTD will turn 

on in relatively freshwater. After you have established communications (above), check the 

minimum conductivity frequency for pump turn on in the CTD configuration list that appears. 

Generally it will be ~ 3000 Hz from the factory. To set the new pump start frequency: 

 At the s> or #s> prompt, type cc 

 type Y when it asks Y/N 

 type CTRL Y when it asks CTRL Y/N   

 Press enter to keep the rest of the values as they are, but change the pump start frequency  

 to 5. 

 

When the CTD comes back from the factory every year, it is set to a Real Time Data Output (or 

Transmission) Rate and Data Storage Rate of 1 scan per second. We need to change these to 8 

scans per second. (The con file generally has the Real Time Data Output Rate set to 8 scans per 

second. This will have been checked in SeaSave already).  After you have established 

communications, check the Data Storage Rate and the Real Time Data Transmission Rate in the 

CTD configuration list that appears (see above). Generally they will have been set to 1 at the 

factory. To set the new rates: 

 At the s> prompt, type cc 

 type Y when it asks Y/N 

 type CTRL Y when it asks CTRL Y/N   

 Press enter to keep the rest of the values as they are, but change the Internal Data Storage  

 Rate and the Real Time Data Output Rate to 8. 

 

Data Collection (SeaTerm) 

d. Before sampling, the SBE 25 CTD must be initialized to clear memory modules.  

Connect the SBE CTD to the computer and launch the SeaTerm communication program.  
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Press “Connect” to communicate with the CTD, and “Status” to get information about the 

CTD. Following recognition, press “Init Log” to initialize logging, answer YES to the 

questions. 

  

 
  

Disconnect the cable from the CTD and replace the protective plug.  The SBE 25 is now 

ready for deployment. “qs” refers to quiet or quiescient state. The CTD must be in this state 

for 2 minutes before the pump turn on switch will work. You can command “qs” in SeaTerm 

(it automatically did this above), or disconnect the CTD and be sure to wait 2 minutes until 

turning on the pump switch. 

 

2. Typically the SBE 25 CTD is cast in the Weatherport sampling hole, because it does not 

measure natural fluorescence or PAR which is influenced by the shading effect from the 

Weatherport.  Remove all of the ice from the hole, Do Not allow ice crystals to touch the 

probes.  Attach the CTD frame to the winch cable.  Remove the red cap. Use a 60 ml syringe 

to flush the pumping system and sensors with a 1% Triton-X solution.  

 

3. Position the CTD over the center of the hole and turn the unit on.  Immediately lower the 

CTD into the water up to the O ring where the frame is attached to the cable.  Allow the CTD 

to thoroughly flush water through the system (>60 sec – it takes 45 second for the pump to 

turn on once it is put in the water).  The CTD may have to be raised out of the water enough 

to see that the pump is working. The pump will only turn on at the salinity you entered in 

step 2, Instrument Set-up. Once you ensure that the pump is working, lower the CTD to the O 

ring again, and let it sit for a minute. This depth is 0.8m from the pressure sensor, and will be 

used to correct the pressure sensor to the correct depth during data processing. This is very 

important as the pressure sensor is not always accurate!! 

 

4. Slowly lower the CTD (1 m sec-1) to the desired depth ~2 m from the bottom of the lake (Do 

Not allow the CTD to hit the bottom of the lake), stop for 10 seconds, then slowly retrieve at 

the same rate.  Remove the CTD from the water and immediately turn the instrument off.  
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Note:  The CTD must be turned off to save each cast.  Following data collection, turn the 

instrument on and lower to 1 m to thoroughly rinse the instrument, remove and place in 

carrier. Flush the pumping system with DI water after use. 

 

Downloading (SeaTerm) 

7. Connect the SBE 25 CTD to the computer and launch the SeaTerm program.  Once 

communications are established press “Upload” to Upload data.  Note:  The software 

may be configured to dump specific casts or all, and to include data headers.  Name the 

file accordingly (i.e., Lake code, date), and save to the desired directory.  Every time the 

pump is turned on and off there is a new cast saved.  Therefore, when downloading the 

data the first cast is 0, second is 1, etc.  The multiple casts can be downloaded, but they 

must be specified when you “upload” the data in SeaTerm.   

 

 
 

2. View the data to make sure the CTD was operating properly using SeaSave.   

1. Create a DSO (display set-up file) file (one for each lake) or select the appropriate DSO 

file if it has already been created:  

a. Select “Screen Display” → “add new display window” → “overlay display” (this 

is the DSO screen we usually work in). 

b. Select “Screen Display” → “edit selected display window” → “Modify display 

parameters.” Enter the range of parameters for each lake (if you need to change a 

parameter, press the “select variable” button). 
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Save the DSO file in a desired location.  You can create a file for each lake at this 

time if you prefer.  

c. If you want to select a DSO file you have already created, Select “Screen 

Display” → “edit selected display window” → “select DSO file” 

2. To display the data from your cast, go to “Archived Data” → “Start.” Select data file, 

select CON file. Click on “Start display.”      
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If using the new SeaSave Version 7, you can view a plot as described above, or view a readout of 

the data.  

 

To view a readout of the data, go to “Display” → “Add new fixed display window.” Then go to 

“Archived Data → Start,” select data file and .con file, change number of scans to skip over at 

start to ZERO (or however many scans you want to ship over), and press start. 

 

To view a plot of the data, go to “Display → “Add new plot display window.” 

 

Under the “Plot Setup” tab make the following selections: 

Plot Type: Single Y – Multiple X 

Number of Axes = 5 
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Under the “Y-Axis” tab make the following selections: 

Set up the y-axis with Pressure (db) 

 

Under the “X-Axis” tabs make the following selections: 

Set up the x-axes with:  

Temp (ITS-90, °C) 

Salinity (PSU) 

Fluorescence (WetLab Wetstar (mg/m3) 

Conductivity (S/m) 

Set up an appropriate range for each parameter for the lake which you are 

plotting. 

Make any changes to color, etc desired. 

 

To save graph set-up, close set-up window, right click on graph, and “Export Display Settings 

(.dsa file).” 

 

To re-enter plot set-up screen, open graph and click on “Display → Modify,” or right click on 

graph and click on Modify. 

 

To open a dsa file that was already set up, Display → “Import Display Settings (.dsa file). 

 

To draw the graph, go to “Archived Data → Start,” select data file and .con file, change number 

of scans to skip over at start to ZERO (or however many scans you want to ship over), and press 

start. 
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Note:  In past years, problems with data acquisition have occurred when cable connections 

allowed water to infiltrate and corrode the connections.  If data appears to be chaotic, remove all 

cable connections and thoroughly dry the connections.  Lube the connectors with stopcock 

grease and securely tighten the cables.   
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Optic Stowaway Temperature Logger (Onset Corporation) 

 

Materials 

Optic Stowaway Temp Logger 

Optis Base Station 

Optic Coupler 

BoxCar Pro 4.3 program 

Downloading cable and USB converter 

 

 
 

 
Figure 1. 

 

Procedure 

Download the BoxCar program onto the laptop. 

 

Plug the Optic Stowaway temperature logger and the Optic Base Station into opposite sides of 

the Optic Coupler as shown in Figure 1. 

 

Open the Box Car program and click on “Logger” – “Launch” (Figure 2) (Note that the logger 

time is set to sync with the laptop time) 

 Set the Interval (Duration) to 5 min. 

 Set the Measurement Unit to Temperature C 

 Unclick all boxes under Advanced Options 
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Figure 2. 

 

To retrieve data: 

 

Open the Box Car program and click on “Logger” – “Readout” (Figure 2) 

 

Save the .dtf file. Go to “File” – “Export” and save as an Excel file. It will save it as a text file, 

and you can open it in Excel. The program will also show you a plot of the temperatures (Figure 

3). 

 

 
Figure
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